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Chapter 1 : 

Introduction 

  

Welcome to LUSAS 

LUSAS is one of the world's leading structural analysis systems. By choosing to use LUSAS 

you are joining a large worldwide community of engineers who use LUSAS everyday to 

solve a wide range of engineering analysis problems. 

Before starting to use LUSAS it is strongly recommended that you read the Getting Started 

Guide in its entirety. It provides an essential overview of the LUSAS Modeller user interface 

and of the processes involved in creating models, running analyses and viewing results. The 

guide also lists the LUSAS documentation available for you to use and provides information 

on additional resources including how to obtain technical support. 

About LUSAS 

The LUSAS system uses finite element analysis techniques to provide accurate solutions for 

all types of linear and nonlinear stress, dynamic, and thermal/field problems. The two main 

components of the system are:  

 LUSAS Modeller - a fully interactive graphical user interface for model building and 

viewing of results from an analysis. 

 LUSAS Solver - a powerful finite element analysis engine that carries out the analysis 

of the problem defined in LUSAS Modeller. 

The Application Products 

LUSAS is made available as different application products with the user interface tailored 

specially to the needs of a particular application. For example bridge engineers will see 

facilities provided specifically for the analysis of bridge structures. Such facilities are 

normally conveniently grouped together inside a product application menu, such as Bridge, 

Civil, Composite etc, that is loaded between the Utilities and Window menu items in the main 

menu.  
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The application products include: 

 LUSAS Bridge – for bridge engineering analysis, design and assessment. 

 LUSAS Civil & Structural – for civil, structural, nuclear, seismic, geotechnical and 

offshore engineering. 

 LUSAS Analyst – for automotive, aerospace, defence, manufacturing, and general 

engineering analysis. 

 LUSAS Composite – for engineers designing composite products or components. 

 LUSAS Academic – available to academic establishments for teaching and research 

use and allows use of all of the above products together with most of the options 

available for those products. 

LUSAS Product Options 

In addition to LUSAS software being provided as particular individual application products, 

product options are also available which extend the analysis capabilities of these products. 

The following options are available for all products: 

 Nonlinear - Nonlinear stress analysis is becoming increasingly important with 

designers employing a wider variety of materials in a multitude of different 

applications. The Nonlinear option, rightly regarded as the leader in nonlinear 

analysis, provides the very latest powerful techniques for solving problems having 

either material, geometric or boundary nonlinearity. 

 Dynamics - Straightforward modal dynamics problems can be solved using Interactive 

Modal dynamics (IMD) techniques provided in all LUSAS products. The Dynamics 

Option contains the facilities required to solve a wider range of dynamic problems in 

both the time and frequency domains. By combining the Dynamics and Nonlinear 

options both high and low velocity nonlinear impact problems can be solved using 

either implicit or explicit solution techniques. 

 Thermal/Field - The Thermal / Field option contains extensive facilities for both 

simple and advanced steady state, and transient thermal / field analyses. By combining 

the Thermal / Field option with other appropriate options, heat transfer due to 

conduction, convection and radiation can be analysed. In addition, the effects due to 

phase change of material may also be included. 

 Heat of Hydration - Allows modelling the heat of hydration of concrete. The heat of 

concrete hydration can be computed during a thermo-mechanical coupled analysis and 

the temperatures and degree of hydration can be read into a structural analysis. 

 Fast Solvers - This option includes additional solvers. The Fast Multifrontal Direct 

Solver can provide solutions several times faster than the standard Frontal Direct 

Solver for certain analysis problems. The Fast Multifrontal Block Lanczos Eigensolver 

can, similarly, return results several times faster than the standard Frontal Eigensolvers 

for certain problems. The complex eigensolver provides efficient solutions for large-

scale damped natural frequency problems. 

 IMDPlus - The IMDPlus option extends the Interactive Modal Dynamics (IMD) 

techniques provided in all LUSAS products. Whilst IMD models a single loading 
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event in a single direction, IMDplus allows multiple loading events with more 

advanced loading conditions to be solved. IMDPlus is used for two primary uses: 

seismic response analysis of 2D and 3D structures subjected to acceleration time 

histories of support motion, and for the analysis of 3D structures, such as bridges, 

subjected to constant moving vehicle or train loads. 

The following options are available for LUSAS Bridge only: 

 Vehicle Load Optimisation - Used to identify critical vehicle loading patterns on 

bridges and apply these loading patterns to analysis models. It reduces the amount of 

time spent generating models and leads to more efficient and economic design, 

assessment or load rating of bridge structures. 

 Rail Track Analysis - Carries out rail track-structure interaction analysis to the 

International Union of Railways Code UIC 774-3. It allows models to be built 

automatically from data defined in MS Excel spreadsheets, an analysis run, and results 

produced in spreadsheet or results file formats. 

What's new 

When you run LUSAS Modeller you will be presented with information that links to a 

‘What’s new’ page.  This will tell you what has changed since the last major version and also 

covers any interim releases.  It will be of particular interest to existing users upgrading from 

an earlier version of LUSAS. 

What is Finite Element Analysis? 

Until the advent of computers, the only way to find the answer to the engineering question 

"What would happen if I did this to my new design?" was to build a prototype and carry out 

the necessary tests. Today computers allow designs to be assessed much more quickly and 

easily. Evaluating a complex engineering design by exact mathematical models, however, is 

not a simple process.  

Since we cannot calculate the response of a complex shape to any external loading, we must 

divide the complex shape up into lots of smaller simpler shapes. These are the finite elements 

that give the method its name. The shape of each finite element is defined by the coordinates 

of its nodes. Adjoining elements with common nodes will interact. 

Engineering Problem 
   

Finite Element Model 
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The real engineering problem responds in an infinite number of ways to external forces. The 

manner in which the Finite Element Model will react is given by the degrees of freedom, 

which are expressed at the nodes. For example, a three-dimensional solid element has three 

degrees of freedom at each node representing the three global directions in which it may 

move. 

Since we can express the response of a single Finite Element to a known stimulus we can 

build up a model for the whole structure by assembling all of the simple expressions into a set 

of simultaneous equations with the degrees of freedom at each node as the unknowns. These 

are then solved using a matrix solution technique. 

For a mechanical analysis, once the displacements are known the strains and stresses can be 

calculated. For a thermal analysis, the gradients and fluxes can be calculated from the 

potentials. 

What Help and Documentation is Provided? 

Comprehensive documentation is provided with LUSAS. Some is available in the form of 

printed manuals, whilst some is only available in electronic format. 

The documentation includes: 

 Installation Guide 

 Getting Started Guide 

 Modeller Reference Manual 

 Examples Manual 

 Application Examples Manual (Bridge, Civil & Structural) 

 Application Manual (Bridge, Civil & Structural) 

 Autoloader Reference Manual 

 IMDPlus User Manual (includes worked examples) 

 Rail Track Analysis User Manual (includes worked example) 

 Element Reference Manual 

 Solver Reference Manual 

 Theory Manual (Volume 1 and 2) 

 Verification Manual 

 CAD Toolkit User Manual 

 LUSAS Programmable Interface (LPI) 

 Glossary 

Installation Guide 

 Details of installing LUSAS software for various licensing options. 

 Available in PDF and printed form. 
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Getting Started Guide 

 Contains a brief overview of LUSAS. 

 Available in PDF and printed form. 

Modeller Reference Manual 

 Provides detailed reference material for modelling and results viewing with LUSAS 

Modeller. 

 Provided in on-line help format and also available in PDF and printed form. 

Examples Manual  

 Contains general worked examples to help you get up to speed with modelling, 

analysis and viewing of results for a range of different analysis types. 

 Available in PDF and printed form. 

Application Examples Manual (Bridge, Civil & Structural) 

 Contains application specific worked examples to help you get up to speed with 

modelling, analysis and viewing of results for a range of different analysis types. 

 Available in PDF and printed form. 

Application Manual (Bridge, Civil & Structural) 

 Describes the bridge, civil and structural application specific features of LUSAS and 

their uses. 

 Available in PDF and printed form. 

Autoloader Reference Manual 

 Provides detailed reference material for Autoloader, a bridge loading optimisation 

module for use with LUSAS. 

 Available in PDF form. 
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IMDPlus User Manual 

 Contains details of how to carry out multiple loading events with advanced loading 

conditions for two main uses: seismic response analysis of structures subjected to 

acceleration time histories of support motion, and for the analysis of 3D structures, 

such as bridges, subjected to constant moving vehicle or train loads.  

 Provided in on-line help format and also available in PDF and printed form. 

Rail Track Analysis User Manual 

 Provides detailed reference material for the Rail Track Analysis option which permits 

track/bridge interaction analysis to the International Union of Railways Code UIC 

774-3. 

 Available in PDF form. 

Element Reference Manual 

 Contains full element specifications. This is the place to go to find out which 

functionality your elements support and what output you will obtain from your 

element selection. 

 Provided in on-line help format and also available in PDF and printed form. 

Solver Reference Manual 

 The data files required by the LUSAS Solver can be edited directly with a text editor. 

This manual contains full details of the data syntax supported by LUSAS Solver. 

 Available in PDF and printed form. 

Theory Manuals (Volume 1 and 2) 

 These contain more detailed theoretical information for the more experienced user. 

They cover topics specific to LUSAS and where appropriate list references to other 

publications. The topics covered include: 

 Analysis procedures including: linear, nonlinear, dynamics, eigenvalue 

extraction, modal analysis, all forms of field analysis, fourier analysis and 

superelement analysis. 

 Geometric nonlinearity. 

 Constitutive material model formulations. 
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 Loads and boundary conditions with particular reference to general load types, 

constraint equations, slidelines and thermal surfaces. 

 More complex post processing calculations, including nodal extrapolation and 

calculation of Wood Armer reinforcement moments. 

 Element formulation theory. 

 Available in PDF and printed form. 

Verification Manual 

 A manual of LUSAS testcase examples benchmarked against known solutions. 

 Available in PDF form only. 

CAD Toolkit User Manual 

 Describes interfaces to LUSAS involving the use of external pre- and post-processing 

packages. 

 Provided in PDF form only. 

LUSAS Programmable Interface (LPI) 

 Provides information for application programmers wishing to customise the LUSAS 

environment or interface LUSAS with other applications. 

 Provided in on-line help format only. This can be accessed from the Start > All 

Programs > LUSAS > LUSAS Help menu. 

Glossary 

 Contains definitions of general terms used in all manuals. 

 Provided in on-line help format. Included in the Modeller Reference Manual. 
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Chapter 2 : Using 

Modeller 

  

LUSAS Modeller User Interface 

LUSAS Modeller is an easy to use Windows-based finite element modelling system. The 

principal regions and components of its user interface are shown on the following image and 

are described below. 

 
LUSAS Modeller Interface 
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Main Menu and Toolbars 

The main menu and associated toolbars which contain toolbar buttons provide the means to 

define model related geometry and other data. On initial start-up of LUSAS Modeller the 

Main, Define and View Toolbars are displayed. All toolbars can be shown, hidden, or 

customised, using the View> Toolbar menu item. When a modelling session is completed the 

current toolbar settings are saved and reloaded the next time Modeller is used. User defined 

toolbars and buttons can also be added to the user interface. Actions are assigned to user 

defined buttons using the scripting language.  

View windows 

A View Window is where each model is developed and manipulated. Any number of view 

windows can be created with each displaying a unique view of a model. The image in a view 

window is built up from several drawing layers as listed in the layers panel in the Tree Frame. 

 Each layer draws over the top of the one before it. 

Tree Frame 

The Tree Frame has six tabbed panels each with its own Treeview. The Treeviews provide 

access to model and results data and show a list of objects of a particular type. The Treeview 

panels comprise: Layers , Groups , Attributes , Analyses  , Utilities  and 

Reports .  

By default a single Tree Frame is displayed. Multiple Tree Frames can be utilised from the 

View> Tree Frame menu item. Treeviews can then be dragged and dropped between Tree 

Frames as required. This is often used to aid copying and pasting of attributes between 

Treeviews.  

Treeviews 

The Treeviews provide access to all defined model data and results data, and show a list of 

objects of a particular type: 

 The Layers  Treeview controls the display of selective model data and results data 

to a view window.  

 The Groups  Treeview is used to store selected user-defined collections of objects 

(geometry, nodes or elements) under a collective name.  

 The Attributes  Treeview contains information relating to the model; the element 

type and discretisation on the geometry; section properties and thicknesses; the 

materials used; how the model is supported or restrained; and how the model is loaded. 

 The Analyses  Treeview shows all analyses defined; loadcases defined including 

analysis control loadcases defined during the modelling stage; results loadcases 

containing solutions for results processing; loadcase combinations and envelopes; and 

IMD and Fatigue calculations.  
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 The Utilities  Treeview contains utility items used in the definition of model 

geometry or attributes, or to control an analysis, or to provide a particular 

functionality, such as to define a load combination or produce a report for example. 

 The Reports  Treeview contains a user-defined folder structure of reports, chapter 

and image entries to allow a report to be generated in a variety of formats. 

The Treeviews use drag and drop functionality. For example, an attribute in the Attributes  

Treeview can be assigned to geometry in a View Window by dragging the attribute onto a 

previously selected object. Each object in a Treeview has its own functionality. This can be 

invoked using its own context menu, the main menu or the toolbar buttons. Treeview data can 

also be copied and pasted between Treeviews. 

Text Output Window 

The Text Output Window displays messages and warnings during a modelling session. 

By default the Text Window appears at the bottom of the View window just above the Status 

Bar. It may be resized using the cursor and may be undocked or hidden from view. The 

View> Text Output menu item may be used to hide or show the Text Window. The Text 

Window context menu allows the Font to be defined and the output to be directed to a log 

file. By default the selection mode is set to select lines of text. This may be changed to select 

characters by changing to Character select mode but subsequent output to the text output 

window will be slower.   

Note: When an error message or warning relating to a particular object is written to the text 

output window, extra information is usually available by double-clicking on that line of text. 

In doing so, a popup window provides options to help identify the offending area of the 

model. For example, if a Modeller error refers to an assignment on line 25 it may be selected, 

moved to the centre of the screen, scaled to fill the screen, have its properties displayed, or be 

identified by an annotation arrow or a temporary indicator. Similarly, if a Solver error or 

warning refers to a particular numbered element, the popup window will help you find that 

element quickly and easily. 

Browse Selection 

This window is not displayed by default but can be viewed using the View> Browse 

Selection menu item. Once visible it will contain a list of all currently selected items which 

may then be individually deselected. Any objects listed in this window can be located on the 

model by using the Find menu item on the context menu for the object. The location of the 

assigned attribute will be identified by a temporary indicator of animating concentric 

shrinking squares. 

Browse Cyclable Items 

This window is not displayed by default but can be viewed using the View> Browse 

Cyclable Items menu item. Once visible it will contain a list of all cyclable items. These may 

then be individually selected or deselected.  Note that once an object is selected other 

selectable items at the same position within the View window can be cycled using the Tab 
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key or by reselecting with the left hand mouse button at the same position within the View 

window. 

Browse Selection Memory 

This window is not displayed by default but can be viewed using the View> Selection 

Memory> Browse Memory Selection menu item. Once visible it will contain a list of all 

items currently in Selection Memory which may then be individually deselected. 

Note: Any objects listed in this window can be located on the model by using the Find menu 

item on the context menu for the object. Its location will be identified by a temporary 

indicator. 

Status Bar 

The Status Bar displays progress messages and help text during a modelling session, the 

model units, the current cursor position in model units (if the model is displayed in an 

orthogonal plane) and the item or number of items in the current selection.  The View> 

Status Bar menu item may be used to hide or show the Status Bar. 

Data tips and Tool tips 

Data tips and tool tips provide basic information about whatever is under the cursor. Datatips 

generally report information relating to the model geometry, attributes and assignments etc. 

Tool tips report on uses of toolbar buttons or expected input for grid cells etc. Data tips are 

invoked when the cursor is hovering over a model feature within the View window (where it 

reports upon all manner of model data). Tool tips are invoked either when the cursor is 

hovering over a toolbar button or a grid cell on a dialog that is expecting dimensional input 

(where the tool tip reports the units that are expected). For the former, if more than one item 

is present at the location on the screen, the Tab key can be used to cycle between all possible 

selectable objects, with the data tip updated each time. As additional feedback, if a object is 

selected, dynamic selection is invoked to highlight each object as it becomes the focus. Thus 

with two intersecting lines or overlapping surfaces, it is clear which one is being displayed in 

the data tip. 

Pressing the Enter key whilst a data tip is active adds the current object to the selection. 

This provides an easy way to select a specified "one of many" objects at a given location. 

Context Menus 

Although commands can be accessed from the main menu, pressing the right-hand mouse 

button with an object selected in the View Window usually displays a context menu which 

provides access to relevant operations. In addition, most items in the various Treeview panels 

also have a context menu which provides access to additional functionality such as editing of 

data, control of visibility, visualisation of assignments, and selective control of results 

plotting on selected attributes. 
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Properties 

General information relating to a model is presented in property dialogs. Properties may 

relate to the whole model or the current window, or a single geometric feature - in fact most 

objects have properties. To view an object’s properties, select it, press the right mouse button, 

then choose Properties from the context menu. 

Getting Help 

LUSAS contains a comprehensive Help system. The Help consists of the following:  

 The Help button  on the Main toolbar is used to get context-sensitive help on the 

LUSAS interface. Click on the Help button, then click on any toolbar button or menu 

item (even when greyed out). 

 Help Topics accessed from the Help menu provides access to the Help files. They 

include the Modeller Reference Manual, reference help files such as the Element 

Reference Manual and access to other manuals that are available in PDF format such 

as the Examples Manuals, Theory Manuals and Solver Reference Manuals. 

 Dialogs normally include a Help button which provides specific information for that 

dialog and links to related topics. 

Using LUSAS 

Carrying out a structural analysis or assessment with LUSAS involves three main stages:  

 Modelling 

 Running the analysis 

 Viewing the results 

Modelling is sometimes referred to as ‘pre-processing’ and viewing and manipulating the the 

results is sometimes referred to as ‘post-processing’. A general overview of the modelling , 

analysis and results processing stages are provided below. 

Model Types 

Two types of model can be created in LUSAS:  

 Feature-based geometry models - these are based on features (such as points, lines, 

surfaces and volumes) that are defined inside LUSAS, or are created from imported 

geometry and require the definition of mesh objects such as elements with their 

associated nodes.  

 Mesh-only models - these comprise only mesh objects (elements and their associated 

nodes, edges and faces) and can only be created by importing only those types of 

LUSAS or third party data that are supported.  

Modelling 

Models are created in view windows. Modelling involves creating a geometric representation 

of a structure and defining its characteristic behaviour in terms of its physical properties such 
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as material, loading, and support. A model will consist of Geometry (Points, Lines, Surfaces 

and Volumes) to which Attributes such as (Mesh type, Materials, Loading, Supports, Mesh, 

etc.) have been assigned . Treeview panels provide access to defined model data. 

 Geometry 

Within LUSAS Modeller the geometry of the model is defined using points, lines, 

surfaces and volumes. A volume needs surfaces to enclose it and to define its 

boundary. Similarly a surface needs lines to form its perimeter and lines need points to 

define their ends. The shape of a surface between its boundary lines, and the shape of 

a line between its end points can be simple (straight lines, flat surfaces) or complex, 

depending on the manner in which it was created.  

Many different tools exist within LUSAS Modeller to aid the creation of geometry. In 

particular the geometry can be entered numerically, in terms of coordinates, by cursor 

(using the mouse) or by copying, splitting, intersecting and transforming previously 

existing parts of the model. Geometry can also be imported from third-party interface 

files. 

 Attributes 

Aspects of the behaviour of parts of the model, or the external factors which are 

imposed on it, are referred to as attributes. Within LUSAS Modeller, there are several 

types of attribute – each representing a particular type of behaviour. For example 

materials, loading and support are all attributes, but are quite different from each 

other. Within each, there are further sub-divisions, for example there are isotropic 

materials, anisotropic materials, and orthotropic materials, among others. 

In each case an attribute is first created, and then subsequently attached to all or part 

of the model. This attachment process is known as assigning. Thus a material can be 

assigned to a line. Once assigned, the line takes on the properties of the material until 

further notice. Assignment often involves specification of additional information that 

does not define the attribute or the geometry, but rather defines how one is applied to 

the other. This includes directions, scale factors and similar.  

A special attribute, called a geometric attribute, is used when some or all of a model is 

comprised of lines or surfaces. In this situation, LUSAS Modeller needs to know the 

cross-sectional appearance and behaviour of lines, and also how thick the surfaces are. 

Geometric attribute assignments provide this information, and therefore form part of 

the model’s appearance. Models comprised entirely of volumes do not need geometric 

assignments. 

Many different tools exist within LUSAS Modeller to give interactive feedback on the 

nature of assigned attributes. This process is generally termed visualisation. 

Visualisation usually takes the form of coloured infills, arrows, textual labels or 

similar. 

 Meshing 

Points, lines, surfaces and volumes allow the exact smooth geometry of the problem to 

be defined or imported. However, to solve the problem, the model must be broken 

down into nodes and elements. This process is known as meshing and the collective 

term for all the elements and nodes, once created, is the mesh. Special attributes, 
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called mesh attributes, can be created and assigned to geometry in the same way as 

other attributes. They define the type and number of nodes and elements that will be 

used to represent each part of the geometry. 

A consequential advantage of this approach is that the density of the mesh can easily 

be changed without rebuilding the geometry or reassigning any attributes. Simply 

modifying a mesh attribute automatically changes the mesh density in any part of the 

model where it is assigned. 

Similarly, the element type can be changed in exactly the same way. Different element 

types are suitable for different kinds of analysis, and the system provides an easy way 

to change from one to another. 

Generally LUSAS Modeller automatically and incrementally updates the mesh 

whenever a change is made to any part of the geometry or any mesh attributes. 

However these automatic updates are not allowed when results are being displayed, 

and they can also be switched off if at other times if required, for example to save 

time. This is known as locking the mesh. When the mesh is locked it will only be 

updated when specifically requested. 

 Loadcases 

In a linear analysis, it is often convenient to gather certain types of applied loading 

together under a common loadcase name such as dead load or live load. Each loadcase 

is solved separately and the results are available separately. Results can be combined 

together during the results viewing stage if required. 

In a nonlinear analysis, LUSAS loadcases are equivalent to analysis stages. Control 

parameters can be set for each loadcase and within each loadcase, the loading, 

supports, or type of analysis can be changed.  

 Utilities 

Some kinds of analysis require or create extra data that is similar to attributes, but 

cannot be assigned to geometry. LUSAS Modeller refers to such data as utilities. 

Tendon profiles, reference paths and the values used to plot a graph are examples of 

utilities. 

 Controls 

Finally, for analyses other than simple linear static, it is sometimes necessary to 

control the analysis process itself.  LUSAS Modeller uses controls for this purpose. 

Controls are either nonlinear, transient, eigenvalue or fourier in nature. 

 Further Modelling Information 

Browse the LUSAS Modeller interactive online help system, or see the Modeller 

Reference Manual for detailed information about any of the above.  

A large selection of tutorial examples are available to help you to get to know LUSAS 

and it is strongly recommended that you work your way through a selection of the 

examples to get a feel for the system before starting on your particular problem.  See 

the Examples Manual and/or the Application Examples Manual (LUSAS Bridge and 

LUSAS Civil & Structural). 
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Running the Analysis 

Once the modelling process is complete, the model is passed to LUSAS Solver for analysis. 

LUSAS Solver will then create results that are automatically loaded back into LUSAS 

Modeller for viewing and optional additional post-processing. 

Viewing the Results 

 Results are available for individual loadcases and can be viewed in many different ways. 

Results can, if desired, be combined with attribute visualisation to make a plot, for example, 

that shows the applied loading and the resulting deformations. 

This is just a selection of some of the results facilities that are available: 

 Averaged (also known as smoothed) contours 

 Unaveraged (also known as unsmoothed) contours 

 Deformed mesh 

 Wood-Armer reinforcement calculations 

 Slicing a plane through a solid 

 Slicing a line across a surface 

 Yield markers 

 Graphs 

 Vectors of stress, displacement, reactions, etc. 

 Animations of the above, either through time or in response to excitation. 

 Combinations and envelopes of results. 

Modeller Licence Selection 

When running LUSAS, the Modeller licence selection dialog lists all software products that 

are available for selection, along with details of the licenced product options, licence type, 

server name, number of available licences and the number of days left until expiry. Invalid 

licences (those that have already been completely taken by others prior to the display of this 

dialog, or are unavailable for some other reason) are greyed out. Licences expiring within 14 

days are displayed in red. 

The licence selection dialog is always displayed on start-up of LUSAS unless it has been 

disabled by unchecking an option on the Licencing page of the LUSAS Configuration Utility, 

or unless there is only one licence available to LUSAS. 

Use the Modeller licence selection dialog to select a licence for use. Use the LUSAS 

Configuration Utility to add licences to the list of those available. 
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License order and usage 

Standalone or network licences are 'tumbled' based upon Configuration Utility settings. The 

order of the licence types listed on the Modeller licence selection dialog follows the order of 

the keys set on the Licensing page of the LUSAS Configuration Utility. If the display of the 

main licencing dialog has been disabled the first licence in the list of those available will be 

used in preference to all others. As licences are used the number of licences available for 

others to use is updated accordingly. When LUSAS Modeller is run the system will work its 

way down the list of licences until a valid and available licence is found.  

Creating shortcuts 

 The Create shortcut... button provides the means to tie a licence type to a shortcut 

used to run Modeller or Solver and with the choice to Emulate LT or use Teaching 

and Training limits. It enables LUSAS Modeller or LUSAS Solver to run without 

having to select a licence type each time (unless that licence has already been used).  

Example of shortcut created: 

 <LUSAS Installation folder>\Programs\lusas_m.exe 

LICNAM=[SENTINELLM,TECHNICAL01,6274(6270)] 
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Licence details 

 By selecting a licence and then selecting Licence details additional information such 

as the product options, the licence version, the Key ID and the licence expiry date can 

be viewed. 

 Selecting a licence that is invalid and clicking the licence details button will yield 

extra details as to why the license in unavailable. 

Refresh 

 Refresh simply updates the numbers of licences available. 

Emulating LT Behaviour  

 When Emulate LT is selected it restricts the user interface to that of an LT licence, 

even though the selected licence may be a standard or plus licence. This may be of use 

when training staff who are new to LUSAS. 

Teaching and training limits 

 When Teaching and training limits is selected no licence is taken. LUSAS can be 

used as normal for this session only but with the restricted model size, node, element 

and loadcase limits of the Teaching and Training version. 

Creating a New Model 

Creating a new model requires a model filename to be entered and a Working folder to be 

defined where the model will be saved. Files relating to a model (such as results files and 

intermediate files) can be saved beneath a model folder. See Model File Locations for 

details. A short model file name is recommended since this is also used to create folders and 

filenames that contain associated model data. If the path to a file is too long, the Windows 

path limit of 260 characters may be exceeded. See File and Folder Naming in LUSAS for 

more information. 

Model details such as a model title and a job number can be optionally defined. A set of 

consistent modelling units must be specified for the model. These can be later updated in the 

Model Properties dialog, however it is recommended these are not changed after the model is 

created. Timescale units can also be defined. 

Choosing an Analysis Type 

When creating a new model it can be defined as being for a Structural, Thermal, or Coupled 

(dependent upon the licence key) analysis. This tailors the interface for the type of analysis to 

be carried out and also defines the class of model. The addition of a  general thermal analysis 

to an existing structural base analysis, or the  addition of a  general structural analysis to an 

existing thermal base analysis will change the user interface accordingly. 
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Choosing a Startup Template 

By selecting a startup template, useful predefined attributes can be setup in the model. 

Previously defined startup templates (scripts) can be made available for selection using the 

button alongside the Startup template drop-down list. These can then be selected from the 

drop-down list. 

Specifying a Vertical Axis 

The vertical axis is used to orientate the model, define a default gravity loading direction, and 

the vertical axis and orientation of particular element types and library items such as steel 

sections). It may be changed subsequently using the Utilities> Vertical Axis menu item. 

Modelling Units 

Model units are specified as part of the creation of a new model and are reported at all times 

in the status bar at the bottom of the Modeller window. Once set, for all dialogs with grid 

cells permitting dimensional input, the units expected are displayed as a tooltip when the 

cursor is hovered over the input cell.  

Timescale units are related to model units and dictate how time-based values are displayed 

on dialogs during modelling, and how they are output when processing results. 

Input  

Metric units may be input in UK/US decimal point, or European comma formats. When 

Imperial modelling units have been set coordinates and lengths can be  input in feet and 

inches, instead of just feet or just inches. For example, a distance of 5 feet, 11 and a half 

inches can be input and output now as 5:11.5 (or as 5'11.5"), rather than either 71.5" or 5.92'.  

Expressions 

Expressions may be entered anywhere in LUSAS Modeller where numbers may be input. For 

example, in point definition, it is possible to enter 3+10, 4*6, and 5-1 as valid coordinates. 

All arithmetic operators, including braces, are available, as well as the standard elementary 

functions sin, cos, log etc. This facility is available in all text entry fields throughout the 

Modeller user interface. See Input and Output of Real Numbers in LUSAS for more 

details 

Units Conversion 

Model units can be converted at the time of input on all dialogs where dimensional input is 

expected by clicking inside the right-hand edge of the edit box or grid cell and accessing the 

Units Converter and Variation Utility. A range of conversion units are supplied according 

to the type of input expected. Model units stated are those previously set. 
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Reporting of expected model units and triggering of the Units Convertor dialog 

For edit boxes, or grid cells, that support coordinate entry the conversion utility allows 

conversion of multiple comma separated values in the one text box. So, for instance, a 

coordinate entered as 100,200,300 would be converted to (0.1, 0.2, 0.3) if a millimetres to 

metres conversion was selected. 

Displaying and reporting 

Displaying and reporting of model and results data (both to a View window and to print file 

output) is done in accordance with the consistent set of units stated on the Model Properties 

dialog. A setting on this dialog provides an option for Imperial modelling units to output 

coordinate and lengths in feet and inches (e.g. 5'11.5") format. 

Changing the modelling units in use 

Modelling units can be changed on the Model Properties dialog after a model has been 

started, but it should be noted that this will change only the label of the units for all existing 

attribute, geometry. loading definitions. For example, a length of one metre in the model will 

become one foot if the model units were changed to imperial. Note this behaviour is different 

to that of changing timescale units. In general, changing modelling units during the creation 

of a model should be avoided.  

Timescale Units 

Timescale units are specified as part of the creation of a new model and can be changed on 

the Model Properties dialog. Choosing a timescale unit dictates how time-based values are 

displayed on dialogs during modelling, and how they are output when processing results. 

Setting a timescale unit does not change the consistent set of model units defined for a 

model, it simply permits the input or display of chosen timescale units in a different unit of 

time to that defined by the model units, wherever they are expected to be defined or 

displayed/output. 

Timescale units may be input in seconds, minutes, hours or days. By default, seconds are 

initially selected to comply with the consistent modelling units options provided.  

Timescale units are displayed as a tooltip when the cursor is hovered over the input cell on 

any dialogs that require time-based values.  
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Timescale units can be changed on the Model Properties dialog after a model has been 

started, in which case the tooltip seen on dialogs that support time-based input will show the 

updated units. Any previously entered time-based values will be dispayed accordingly, for 

example, a value of 60 representing a timescale in seconds will be displayed and reported as 1 

if a timescale unit of minutes was subsequently chosen. Note this behaviour is different to 

that of changing model units. 

Model Types 

Two types of model can be created in LUSAS:  

 Feature-based geometry models - these are based on defined features (such as points, 

lines, surfaces and volumes) or are created from imported geometry and require the 

definition of mesh objects such as elements with their associated nodes. Prior to 

version 14.7 of LUSAS these were the only model type available in LUSAS. 

 Mesh-only models - these comprise only mesh objects (elements and their associated 

nodes, edges and faces) and are created by importing only those types of LUSAS or 

third party data that are supported. Initial support for these models was introduced in 

version 14.7 of LUSAS. 

The Modeller user interface presents different menu and context menu items according to the 

type of model in use. Cursor selection filters also differ according to the model in use.  

Attribute assignments to different model types 

Both feature-based models and mesh-only models require the assignment of materials, 

properties and thicknesses, loading and supports etc to geometric features or the comparable 

and equivalent mesh objects prior to an analysis taking place.  

 

Note: In general, whenever an assignment of an attribute to a geometric feature is described 

in this manual, the same attribute assignment can be made to an equivalent mesh object if a 

mesh-only model is being used. See the table below for details. 

 

 

 
Feature-based model 

Mesh-only solid 
model 

Mesh-only surface 
model 

 
Mesh-only line model 

POINT NODE - - 

LINE ELEMENT EDGE - ELEMENT 

SURFACE ELEMENT FACE ELEMENT - 

VOLUME ELEMENT 
- 

- 

Geometric features and their comparable equivalent mesh objects  

for attribute assignment purposes 
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Feature-based geometry models 

Feature-based geometry models are created using the four geometric feature types in LUSAS 

(points, lines, surfaces and volumes). In LUSAS, geometry is defined using a whole range of 

tools under the Geometry menu, or the buttons on the Toolbars. Feature-based geometry 

models can also be created by importing supported data from third-party software packages 

using the File > Import menu item. Once created, the geometry features are then assigned 

attributes (materials, properties and thicknesses, loading, supports and mesh/element type 

etc.) to fully describe the model prior to an analysis taking place. One of the many benefits 

obtained from using this feature-based modelling method is that built-in associativity ensures 

that if the model geometry is amended, all assigned loadings, supports, geometric attributes 

and particularly any mesh assignments and arrangements are automatically updated to suit. 

When a feature-based geometry model is being edited all user interface menu items 

appropriate to the application software in use are available. 

Mesh-only models 

Mesh-only models are comprised of nodes and elements and do not contain any geometric 

layer data or feature types, or indeed any geometric data at all. As a result, the option to add a 

Geometry layer is not accessible. Mesh only models are created by importing finite element 

data files created either by the prior running of an analysis in LUSAS, or by importing data 

files from other supported software applications. The File &gt; Import menu item is used to 

do this. During the mesh import process, LUSAS Modeller creates separate Groups for each 

element type encountered and for models created from LUSAS data file these will be familiar 

LUSAS element names. For models created from other third-party software they will be the 

names used within that system, whatever they may be. An option to create additional groups 

during the import process based upon the element material type is also available.  

On import of a LUSAS Solver data file, element types that are present in the datafile are used 

directly for the elements that are imported. For datafiles other than those created by LUSAS 

Solver, the proprietary element types that are present in the datafile are mapped to an 

equivalent LUSAS element based upon each element's shape and its topology.  If the Coupled 

analysis type has been selected on the New Model dialog prior to a mesh import being carried 

out then coupled elements will be created during the import process. If a different analysis 

type is specified after the import of mesh data the element types previously used will be 

changed accordingly. 

Local coordinate systems are not imported into newly created mesh-only models so these 

need to be defined as necessary to obtain specific types of results as, for example, to get 

moments around a cylindrical axis. 

Assigning attribute data to mesh objects in mesh-only models 

No import of any attribute data is done when element data is imported, so the mesh objects 

(the elements and their nodes, edges and faces) must be assigned attributes (materials, 

properties and thicknesses, loading and supports), prior to carrying out an analysis within 

LUSAS, in a similar way and as documented for a feature-based geometry model. Rather than 

selecting points, lines, surfaces or volumes to make an attribute assignment, nodes, edges, 
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faces, or elements are selected instead. To assist in the attribute assignment process the 

cursor selection filter can be used to identify specific mesh objects. 

Editing mesh-only models 

When a mesh-only model is being edited any main menu items normally used with feature-

based models that are not valid are removed or shown greyed-out to prevent selection. Mesh-

only menu items (such as Geometry > Element for instance) are added to the main menu. 

Context menus may contain different menu items also. 

Additional elements cannot be added to a mesh-only model. Once imported, the number and 

shapes of the elements are fixed but the type of element may be changed by use of the 

Change Element Type option on the context menu on the element group name. In doing so, 

the number of nodes defining the element topology may be reduced but not increased. For 

instance, an 8-noded brick elements may be defined for use on previously defined 20-noded 

brick elements. 

Restricted / unsupported functionality for mesh-only models 

With reference to the user interface menus for feature-based geometry models the following 

differences exist for mesh-only models: 

 The Utilities > Slice resultants beams and shells menu item is not currently 

supported  

 The Utlities > IMDPlus > Moving load wizard functionality is not currently 

supported 

 The Bridge > Moving load menu item is not currently supported. 

 The Bridge > Prestress Wizard > Tendon profile and Multiple tendon prestress 

menu items are not currently supported. 

 The Bridge > Prestress Wizard > Single Tendon design code options are not 

currently supported.  

 Single tendon definition is only permissible by importing data from a spreadsheet. 

 Reference paths can only be created currently by typing in the coordinates defining 

the path. 

Model Properties 

The Model Properties dialog allows many settings relating to the current model to be defined. 

Model properties may be accessed from the File> Model Properties menu item, by right-

clicking the model name (top level) in the  Treeview and selecting Properties from the 

context menu, or by double-clicking the Model Properties object  in the Analyses  

Treeview.  
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The model properties are defined on the following tabs:  

 General 

 Backups 

 Notes 

 Geometry 

 Meshing 

 Attributes 

 Solution 

 Defaults 

 Solver System Variables 

General 

 Title  Brief description of the current model as entered in the New Model startup 

dialog.  

 Model Units Specifies the consistent set of modelling units to be used. 

 Output feet and inches (only if imperial units are set) ensures that modelling units 

used to define coordinates and lengths are reported in feet and inches, instead of just 

feet or just inches. For example, a length may be output as 5'11.5", rather than 71.5" or 

5.92'. 

 Timescale units dictate how time-based values are displayed on dialogs during 

modelling, and how they are output when processing results. Units can be specified as 

seconds, minutes, hours or days. 

 Precision shown in dialogs Controls the number of significant figures or decimal 

places displayed in the dialogs.  

 Decimal marker specifies how decimal points should be handled. Options are: Follow 

Windows, UK/US decimal point, and European comma formats. 

 Pens  Sets the Pens that are used to draw Points, Lines, Surfaces and Volumes. Click 

on the Choose Pen button to use a different pen, or to modify the Pen Library. 

Changing a Pen allocation can be applied to existing features and/or new features 

using the two check boxes. 

Backups 

Controls where and how many backup versions (revisions)of the model are saved. 

 Auto backup Maintains another (current) copy of the model file in a specified 

location. 

 Older revisions Maintains a specified number of older copies (versions) of the model 

file in the Associated Model Data folder for that model name. Whenever a model is 

saved, the previous revision is saved, and if the number of older revisions stated has 

been exceeded the oldest revision is deleted. 
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Notes 

 Notes relating to a model can be typed in the Notes panel of the Model Properties 

dialog and stored with the model.  

Geometry 

The method by which the geometry is displayed is controlled using the Geometry drawing 

layer. 

 Merge Options 

 Action controls the criteria that must be satisfied before features sharing a 

common definition will be merged. 

 New geometry unmergable sets the merge status of all new features to 

Unmergable rather than the default which is Mergable. 

 Tolerance controls the distance within which Point features must lie before 

they will be considered for merging. Note: The merge tolerance should only be 

changed with extreme caution because changing it from its default value can 

lead to instability of the underlying geometry engine. 

See Merging Features for more details. 

 Default faceting 

The default faceting controls the number of facets used for shading lines and surfaces. 

Increasing the number of facets improves the shaded geometry visualisation but takes 

longer to display. See Facet Density for more details 

 Active Local Coordinate 

Sets the coordinate system as either the Global coordinate or any defined local 

Cartesian, cylindrical or spherical coordinate.  

If a local coordinate is set activate then all subsequent geometry definition is carried 

out in transformed coordinates. 

Advanced Geometric Properties 

 Splitting Defaults 

The state of the splitting defaults may be set from the advanced geometry dialog for 

all operations involving splitting operations. The defaults control the check box state 

and may be overridden during geometry creation. 

 Creation Defaults 

Process objects in selection order forces objects to be processed in selection order 

rather than Modellers best fit. 

Allow hollow volume creation allows hollow volumes to be created. This option is 

automatically set true when IGES files are imported. Once set the create volume 
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button will try to create a closed hollow volume when it is not possible to create a 

solid volume. In addition, extra menu items will appear under the Geometry> 

Volume to enable hollow volumes to be defined. 

 Hole Removal Defaults 

The state of the holes removal defaults may be set from the advanced geometry dialog 

for all operations involving hole removal operations. The defaults control the check 

box state and may be overridden during geometry creation. 

 Merge Defaults 

The state of the merge defaults may be set from the advanced geometry dialog for all 

operations involving merging.  The defaults control the check box state, and may be 

overridden during geometry creation. 

Meshing 

 Equivalence Defines the default nodal equivalence tolerance used in a equivalence 

attribute. If automatic is switched on equivalencing is carried out automatically for all 

nodes in the model and no equivalence attribute assignment is required. See Nodal 

Equivalencing for details. 

 Line Mesh Defaults Sets the default number of mesh divisions on a line and the 

maximum subtended angle per element for an arc or splines. If an element exceeds the 

max subtended angle the number of divisions on the arc or spline will be increased. 

 Irregular tet meshing specifies the number of the passes and attempts to be made by 

the tetrahedral mesh generation when attempting to mesh a volume. 

 Create a group of objects that failed to mesh creates a group named 

$failedToMeshObjects which contains all features which failed to mesh. 

Advanced meshing parameters 

 Draw failed parts of mesh only - draws those parts of the mesh that failed to mesh 

 Linearise element edges  

 Constrain adjacent linear/quadratic edges forces mid-side nodes on lines or 

surfaces to be averaged between the corner/end node positions. This option is turned 

on by default. 

 Element edge collapsing invokes edge collapsing which removes elements/faces with 

short edges and small subtended angles by merging them with neighbouring elements. 

 Script to run after meshing description here 

Attributes 

 General Options 

 Apply concentrated loads in cylindrical coordinates for Fourier elements 
(LUSAS Solver option 202). 
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 Body force given as acceleration This option is turned on by default. Turning 

it off converts body forces to global loads per unit volume. (LUSAS Solver 

option 48). 

 Slideline Options 

 Suppress stringent slave search For simpler geometries, such as flat surfaces 

in contact, a slight reduction in processing time may be achieved by 

suppressing the "stringent" local node search but this is not usually 

recommended. (LUSAS Solver option 184). See the Theory Manual for more 

details. 

 Suppress initial slide-surface stiffness check  Slideline stiffnesses are 

automatically scaled at the beginning of an analysis if the average master/slave 

stiffnesses differ by a factor greater than 100. This is to account for contact 

between bodies that have significantly different material properties. See the 

Theory Manual for more details. 

 Suppress initial penetration check The coordinates of all contact nodes that 

have penetrated prior to the commencement of an analysis, are reset back to 

the closest point on the contacted surface. This option should be set if the node 

resetting is to be suppressed, such as when performing an interference fit 

analysis. See the Theory Manual for more details.  

 Allow modification of LUSAS generated attributes overrides the default behaviour 

of not allowing any changes to be made to Modeller-generated attributes such as 

loading attributes generated as a result of carrying out cable tuning analysis, vehicle 

load optimisation, prestress calculations, and rail track analysis. 

Solution 

Solver options can be specified to be common to all analyses or be set individually for each 

analysis. Element and Draping options apply to all analyses.  

Solver Options   

When the type of solver selected is set to Default the fast multi-frontal solver will be used if 

this option is included in the licence agreement. This may be overridden by selecting the 

solver required. For further information see Selecting a Solver.  

 Optimiser Options  When using the standard frontal solver the frontwidth of the 

problem may be reduced by optimising the order in which the elements are presented 

to the frontal solver. The type of optimiser to be used is selected from an options 

dialog. No optimisation is required when using the fast multi-frontal solver. For 

further information see Selecting a Frontal Optimiser. 
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 The Advanced... button enables a new Modeller option to be specified or particular 

default values or settings to be modified. Advanced settings should generally only be 

modified with the assistance of LUSAS technical support. 

When specified separately, a Solver options object  is added to the Analyses  Treeview 

for each analysis entry. Double-clicking this object provides access to specify the Solver type 

and optimisation options. 

Element Options 

See the Element Reference Manual for details of which elements can be used with these 

options. 

 Assign 6 degrees of freedom to all thick shell element nodes By default this option 

is on. It has the effect of adding a rotational spring stiffness to the drilling rotation of 

the thick shell elements making the analysis more stable. The value of the spring 

stiffness can be adjusted using the system parameter STFINP. For problems in which 

geometric nonlinearity (Option 87) is being used more accurate results may be 

obtained by switching this option off and letting LUSAS automatically establish the 

need for 5 or 6 degrees of freedom at a node. (LUSAS Solver option 278). 

 Axisymmetry about Global X axis When selected, LUSAS considers the line of 

axisymmetry in an analysis to be about the global X axis and not the default, which is 

the global Y axis. (LUSAS Solver option 47). 

 Lumped Mass Matrix Formulate lumped mass matrix instead of consistent mass 

matrix for elements. (LUSAS Solver option 105). 

 Write strains to output file causes element strains to be written to the Solver output 

file. 

 Preserve loading whilst elements deactivated retains the loading assigned to all 

elements in model (activated and deactivated) until a subsequent load case is applied. 

Typical usage would, for example, be when carrying out a staged construction 

analysis. Self weight would be assigned to all elements (activated and deactivated) in 

the loadcase representing stage 1 of the analysis. As stage 2 and subsequent loadcases 

are activated the loading initially applied to elements in stage 1 would automatically 

be applied as the elements become active. Note that when using this option no 

additional loading should be applied to any loadcases following the one that contained 

the load assignments. If done so, the initial applied loading for those loadcases will be 

lost. 

 Integration options 

 Fine integration for stiffness and mass Invokes a finer numerical integration 

rule for elements. (LUSAS Solver option 18). 



  Chapter 2 

    

29 

 Fine integration for mass HX16 and HX20 Formulate mass matrix with fine 

integration. (LUSAS Solver option 91). 

 Coarse integration for semi-loof shells Invokes coarse numerical integration 

rule for semiloof elements. This option under-integrates the semi-loof shell 

element which may have the effect of removing low energy mechanisms when 

the element is very thin and/or pressure loaded. (LUSAS Solver option 19). 

 Newton-Cotes Integration for beam elements  Newton-Cotes is a form of 

numerical integration or quadrature. It is often used for through-thickness 

integrals since sampling points are located at the extremes of the range. 

(LUSAS Solver option 134). 

Element options are accessed via the Model Properties dialog or the Model Properties control 

object  in the Analyses  Treeview. Element options can only be specified to be common 

for all analyses. 

Draping Options 

The draping options control the composite lamina draping process. The draping process 

works by effectively draping a square mesh of pinned bars over the structure. The length of 

the bars is considered to be the drape mesh size. A smaller bar size provides a more accurate 

drape at the expense of computer time and memory usage. Typically the drape mesh size 

should be about half the element size. 

 Drape by mesh size - Desired drape cell size. If the desired drape cell size would 

generate more than the specified maximum number of drape cells then the drape mesh 

size would be adjusted to generate the maximum number of drape cells. Likewise, if 

the desired drape cell size would generate less than the specified minimum number of 

drape cells then the drape mesh size would be adjusted to generate the minimum 

number of drape cells. 

 Drape by number - Desired number of drape cells on draping surface. This must be 

between the maximum and minimum values stated below. 

 Drape by face multiplier - A number that is used to multiply the actual number of 

mesh divisions on a draping surface to arrive at a desired drape cell number. This 

must be between the maximum and minimum values stated below. A default value of 

4 is entered. 

 Maximum number of drape cells - Maximum number of drape cells to be generated. 

 Minimum number of drape cells - Minimum number of drape cells to be generated. 

 Extend drape grid one row - Ensures the edges of the component are fully enclosed 

by the draping grid. Note that the grids for LUSAS draped solids and shells are 

automatically trimmed at Surface boundaries. 
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Draping options can be accessed via the Model Properties or Draping options objects  in 

the Analyses  Treeview. Draping options can only be specified to be common for all 

analyses. 

Defaults 

Sets the defaults for symbols, arrows and text which are used when visualising attributes. 

Actual settings are controlled from the Attribute Visualisation layer for the current window. 

The value and units for Gravity that are currently in use may be checked on this tab of the 

dialog. 

The Advanced... button enables a new Modeller option to be specified or particular default 

values or settings to be modified. Advanced settings should generally only be modified with 

the assistance of LUSAS technical support. 

Solver System Variables 

By default the LUSAS Solver is set up to operate efficiently for a wide range of modelling 

and analysis problems. In some cases it may be occasionally necessary to adjust the Solver 

system variables. Variables that can be modified inside Modeller are accessed via the File> 

Model Properties> Solver System Variables dialog. Making changes to Solver system 

variables should generally be done only after seeking advice from LUSAS Technical 

Support. 

Using Windows 

Each Modeller window can display a unique view of a model. View layers inside each 

window hold model information that can be added or removed from the current window as 

required. Multiple windows can be opened using the Window> New Window menu item. 

Closing the last window will close the model. 

Windows consist of the following components: 

 Drawing Layers  By default the first panel of the tree frame displays each model 

window currently open, and shows the view layers contained in that window. 

 View Properties Double-clicking in a window or right-clicking in a window with no 

selection, will display the view properties of that window. The View Properties can 

be altered as required. 

Saving a View 

A view of a model may be saved with the current settings for future use using the Window> 

Save View menu item. Any new window is based on the default view. Therefore, if a view is 

saved with the name default, all new windows are based on this view. The view name 

Factory default cannot be changed and is the default view when the system is installed. The 

following settings are saved: 

 Rotation The current rotation consists of a vector and an origin as specified on the 

View tab of the View properties 
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 Layers The window layers contained in the  Treeview. 

 Colours The colourmap as used for plotting results contours. 

 Page size & borders The page size and border setting as defined from the File> Page 

Setup menu item. 

 Pen Library The pen library referenced every time a item is drawn. 

All the above settings are saved. The choice of which to apply to a new or current window is 

made when a view is loaded. 

Pen Library 

The choice of colour for various operations is linked to the Pen Library. The Pen Library 

contains twenty pens, each numbered, each with a colour, style and thickness that may be set 

if desired.  

Pens are used in a number of dialogs. Whenever a pen is used a Choose pen button allows 

access to the Pen Library to specify a different pen, or to change the pen colour or style. If a 

particular pen style or colour is changed then this will affect every operation that references 

that pen. 

Loading a View 

A previously saved view may be loaded into a new window, or into the current window using 

the Window> Load View menu item. Any of the saved view settings can be chosen. 

Copying Windows 

A window can be copied by selecting and copying the window name in the  Treeview, 

then pasting the window back into the  Treeview. The window layers and settings are also 

copied. 

Using Layers 

Selective viewing of model and results data is done using separate pre-named layers in the 

Layers  Treeview. Layers can be added to each view window by right-clicking on a blank 

part of that view, or by right-clicking the window name in the Layers  Treeview, or by 

selecting the View> Drawing Layers menu item.  

The following layers can be generally manipulated from the Layers  Treeview: 

General modelling layers 

 Geometry 

 Mesh 

 Attributes 

 Labels 

 Annotation 
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 Utilities 

When an influence analysis has been carried out the following additional entry will be added 

to the Layers  Treeview. This layer cannot be added manually. 

 Influence shape 

Results processing layers 

 Contours 

 Vectors 

 Deformed mesh 

 Diagrams 

 Values 

Manipulation of Layers 

The order in which the layers are drawn to the view window is defined by the order or the 

layers in the Layers  Treeview. The top layer in the Treeview is drawn first. If the display 

of one layer is eclipsed by another layer, (i.e. the mesh is eclipsed by the contours, or the 

annotation is eclipsed by the deformed mesh), the eclipsed layer can be moved down in the 

Layers  Treeview by selecting it, then dragging and dropping it to a new position to cause 

it to be drawn following a particular layer.  

A context menu (accessed by right-clicking on each layer name in the Layers  Treeview) 

provides additional manipulation options: 

 Copy (and Paste) allows a layer (and its corresponding layer settings) to be copied 

and pasted between different view windows of the same model. 

 Delete removes the layer from the view window 

 On/Off controls the display of the layer in the view window. Turning a layer off 

retains the layer in the Layers  Treeview but removes the display of that layer from 

the view window. 

 Reset returns the layer to its default settings 

 Move up / Move down moves the selected layer to be drawn before or after the 

preceding or following layer. 

 Properties Double-clicking on a layer name (whether or not is it On or Off) will 

display a Properties dialog where the style of the viewed layer can be changed. 

Clicking OK will turn On a previously turned Off layer. 

Layer symbols explained 

A symbol adjacent to each layer name in the Layers  Treeview shows the display status of 

each layer:  

 A coloured layer symbol indicates that the display of a layer has been turned 'on'. 

 A greyed-out layer symbol indicates that the layer has been turned 'off'. 
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 A red circle with a line through it indicates that no results are loaded or currently available 

for this layer, or inappropriate settings are currently set. 

 View properties: options and settings 

Selecting Model Features 

Items displayed in the view window may be selected with the cursor by clicking on them 

individually or by rectangular, circular or polygonal area selection. Following selection, items 

may be added or removed from the initial selection by carrying out further selections based 

upon either menu choices or upon particular keystrokes used. 

Items in a current selection may be viewed in the Browse Selection window which can be 

displayed from the View> Browse Selection menu item or using a right-hand mouse click in 

the Selected area of the status bar at the bottom of the graphics area. By means of checkboxes 

the selected items may be individually unselected. 

Cursor-based selections 

 

The standard cursor can be used to select any object, i.e. Points, Lines, Surfaces, 

Volumes, Nodes, Elements, Annotation according to the model type in use. It can 

also be used to make rectangular area selections. 

Greater control over what is selected can be achieved by changing the cursor 

selection filter. The cursor options listed change according to the type of model in 

use. 

 



Modeller Reference Manual   

    

34 

Selection filters for feature-based models 

 The selection cursor will select any object, i.e. Points, 

Lines, Surfaces, Volumes, Nodes, Elements, 

Annotation 

 The selection filters allow only specific objects to be 

selected, i.e. with the Line filter only Lines can be 

selected and with the Surface filter only Surfaces can 

be selected. 

 Selection filters can be activated either from the drop 

buttons to the right of the cursor button, or using 

keyboard shortcuts. To display the drop buttons click 

on the down-arrow to the right of the cursor button. 

 Alternatively hold down the appropriate key whilst 

selecting using the normal cursor as follows: 

  

G – Geometry selection filter 

P – Point selection filter 

L – Line selection filter 

S – Surface selection filter 

V – Volume selection filter 

M – Mesh selection filter 

N – Node selection filter 

E – Element selection filter 

A – Annotation selection filter 

When a specific selection option has been chosen the on-screen cursor will show a 

graphical representation of the chosen option. 
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Selection filters for mesh-only models 

 The selection cursor will select only Nodes, Elements 

or Annotation 

 The selection filters allow only specific objects to be 

selected, i.e. with the Edges filter only edges of 

elements can be selected and with the Faces filter only 

Faces can be selected. 

 Selection filters can be activated either from the drop 

buttons to the right of the cursor button, or using 

keyboard shortcuts. To display the drop buttons click 

on the down-arrow to the right of the cursor button. 

 Alternatively hold down the appropriate key whilst 

selecting using the normal cursor as follows: 

  

M – Mesh selection filter 

N – Node selection filter 

B – Edge selection filter  

F – Face selection filter 

E – Element selection filter 

A – Annotation selection filter 

When a specific selection option has been chosen the on-screen cursor will show a 

graphical representation of the chosen option 

See Appendix C - Model Selection Shortcuts for a complete listing of all the selection keys 

available. 

Area selections 

Regions or areas of the model may be selected as a rectangular, a circle, or a polygon either 

using the appropriate toolbar buttons or the keyboard short cut.  

 

To select a rectangular area click to define one corner, hold the mouse button down, 

and drag the cursor to the opposite diagonal corner. This can also be achieved using 

the standard cursor. 

 

Pick the circle selection tool or hold down the C key then select the centre of the 

circle and drag the edge of the circle to the required radius. 

 

Pick the polygon selection tool or hold down the X key then select each corner of a 

polygon and either double click to close the polygon or select Close Polygon from 

the context menu. It is invalid to define a vertex which would cause two lines on the 

perimeter to cross. Because more than one click is needed to define a polygon, 

individual items may not be selected whilst in polygon select mode. 
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Cursor and Area Selection Modifiers 

Items can be added to, toggled, or removed from a selection by the use of specific keys. The 

default keys used are Windows defaults: 

 Holding down the Shift key whilst selecting items will Add the newly selected items 

to those currently selected. 

 Holding down the Control key while selecting items will enable the selection state of 

the item selected to be Toggled.   

 Holding down the Shift and Control keys while selecting will Remove items found 

from the current selection 

 By default all items completely enclosed in a selected area will be selected. By 

holding down the Alt key, items intersecting the selection perimeter will also be 

selected. The Alt key may be used with, or independently from, the Shift or Ctrl 

keys. The Alt key can also be used with feature selection shortcuts e.g. Alt + Shft + L 

adds lines to the current selection. 

 All visible items can be selected together using the Select All command which can be 

invoked from the Edit> Select All menu item, from the right-click context menu or 

using the Control + A keyboard shortcut.  

Mapping of Keyboard Modifiers for Cursor and Area 

Selection 

The Cursor drop-down menu contains a Keyboard Mapping... menu item which allows the 

default Windows-based cursor and area selection keyboard modifiers to be changed to suit 

those that are generally used with CAD modelling systems or be user-defined.  

 Windows - Uses the defaults stated in the Cursor and Area Selection Keyboard 

Modifiers section. 

 CAD - Uses the defaults shown in the following table. 

Keyboard modifier actions when selecting items using Windows defaults and those generally 

used by CAD systems: 

 

Key type or sequence Windows CAD systems (generally) 

No keys Set Toggle selection 

Ctrl Toggle selection Set 

Shift Add to selection  Remove from selection 

Ctrl+Shift Remove from selection Add to selection 

  

User-defined modification of the keyboard modifiers requires the Intersection key to be 

defined initially, followed by drop-down menu selections for the No keys, Ctrl, Shift, and 
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Ctrl+ Shift key types/sequence, where each has to be uniquely set to be Set, Add, Toggle or 

Remove. 

Selecting coplanar neighbours 

 After selecting a surface or element face the Select Coplanar Neighbours menu item can be 

selected from its context menu. This provides a quick way to select a number of surfaces or 

element faces according to their alignment in relation to the selected surface or element face. 

By specifying an angular tolerance all surfaces or element faces where the angle between the 

normals of adjacent surfaces or element faces lies within that tolerance will be added to the 

selection. This is of particular use when defining a draping surface as used in composites 

analysis. An option to ignore internal faces helps to ensure that when an element has faces 

that both lie within the angular tolerance, only the external face is selected. 

Advanced Selection Filter 

The advanced selection filter accessed via the context menu item Advanced selection... for a 

view window enables geometry, nodes or elements to be selected based on a number of 

different criteria. Items may be selected by number or range or numbers, for example 1T5I2 

(representing 'one to five in increments of 2') will select item 1,3,5). When a results only file 

is loaded the geometric and material attributes reflect the numbers in the solver data file. 

Geometry can by selected according to the connectivity of the feature to surrounding features; 

End Points, Free Lines and External Surfaces can be highlighted in this manner. 

Cycling through the Selection 

When features lie close together or overlap it can be difficult to select the required feature 

first time. In these circumstances, each separate press of the Tab key or click with the mouse 

at the same position selects a different feature. The currently selected feature is displayed in 

the Status Bar at the bottom of the screen.  

Alternatively, click in the Status Bar to cycle the selectable features. Or right-click in the 

Status Bar to display a context menu from which Next, Previous, Closest or Furthest may 

be selected  
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Even closer control over the selection of items at the same cursor location can be attained 

using the Browse Cyclable Items window which is available on the right-click in the status 

bar or from the View> Browse Cyclable Items menu. 

Associate Selection Downwards 

Associate selection downwards is an option to automatically select lower order features 

when selecting objects in the model. For example, selecting a Surface will also select the 

Lines and Points that define the Surface. This option may be invoked from the Edit> 

Associate Selection Downwards menu item. Associate selection downwards is set off by 

default. 

Associate Operations Downwards 

Associate Operations downwards is a option to operate on lower order features when a 

command is issued. For example, deleting a Surface will also delete the Lines and Points 

which define that Surface. This option may be invoked from the Edit> Associate Operations 

Downwards menu item. Associate operations downwards is set on by default. 
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Selection Memory 

Some operations require features to be stored in selection memory prior to other features 

being selected in order to complete an operation. One example of use would include the 

setting of a single point in selection memory prior to the normal selection of a number of 

other points prior to selecting the Geometry> Line> By joining menu item to create a fan of 

lines from the selected point. Another example would be to define the master and slave 

members when making joint material assignments to sets of multiple lines. Here, the set of 

lines representing the master would be set in selection memory and the set of lines 

representing slave items would be selected normally prior to the material being assigned. 

The selection memory commands are available from the Edit> Selection Memory menu item 

or from the context menu enabled by right-clicking in the graphics area. The selection 

memory commands are: 

 Set - clears the selection memory and set the contents to the items in the selection. 

 Add - adds the selected items into selection memory. 

 Remove - removes the selected item from selection memory. (Only available if the 

selected item is already in selection memory) 

 Recall - places all objects in selection memory into the main selection. Objects are not 

removed from selection memory. 

 Clear - clears the selection memory. 

 Browse- displays the Selection Memory browse window. 

Selection Colour 

The Pen used to draw items in the selection or the selection memory may be changed from 

the View properties. To display the View properties double-click (without anything selected) 

in the View window and choose Properties from context menu. 

Groups 

 The Groups  Treeview is used to store selected user-defined collections of objects 

(geometry, nodes or elements) under a collective name. For example, a certain set of 

geometry might be grouped together with the name Nut, whilst another set might be grouped 

and named Bolt.  

LUSAS also automatically creates groups as part of the general modelling process as slice 

sections are created, or as a result of an analysis when slidelines are present in the model. 

With slice sections, groups are created with the group name Slices with each slice section 

having a group name of Slice 1, Slice 2 etc. With slidelines, a group named Slideline Results 

is created containing master and slave group names for each defined slideline. 

Groups are also automatically created when importing data files from other supported third-

party software applications to create mesh-only models. In this case groups are named after 

element or with material references, if present in the data file. 

When using LUSAS HPM software, groups are automatically created to simplify the 

modelling of the composite parts, as well as the interface surface and other items. 
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Uses of Groups 

 Enabling unique components to be identified, manipulated, hidden, or have results 

plotted only on those features. 

 Allowing the assignment of attributes to a group in one step. The appropriate geometry 

features will be used if attributes can not be assigned to all geometry types. 

 Identifying all the features that failed to mesh during any command that invokes 

meshing. See Fixing Meshing Problems 

 When defining slice sections through a model in order to view the internal 

arrangement or to plot results. 

 To allow easy manipulation of master and slave results following a slideline analysis. 

Defining Groups 

First, select the model features to be grouped together and then select either the  icon on 

the main toolbar or use the Geometry> Group> New Group menu item.  

All current group definitions are listed in the Group panel of the  Treeview. Manipulation 

of Groups can be carried out using the context menu of the Group panel, and/or using the sub-

menu entries under the main Geometry> Group menu item.  

Naming Groups 

Groups can be given a meaningful name at the time they are defined. They may later be 

renamed in the  Treeview or from the group properties accessed from the context menu.  

Manipulating Groups 

From a group’s context menu the following commands will 

act on that group in the current window: 

 Visible Makes all members of the group visible.  

 Invisible Makes all members of the group invisible.  

 Set as Only Visible Makes the whole model invisible 

and then sets all the members of the group to be 

visible. 

 Advanced Visibility Enables the visibility of the 

higher and lower order features of the members of a 

group to be manipulated. 

 Results Plots permits results to be selectively plotted for the chosen group. For details 

see plotting results for groups in the results viewing section. 

 Change element type (mesh-only models) permits changing the element type of a 

group of imported elements by description, or by entering a specific known element 

name. 



  Chapter 2 

    

41 

 Current Group Set the group to be the current group. 

 Rename Enables a group to renamed. 

 Delete Deletes the group. The group is deleted but the contents of the group are not. 

 Select Members Adds the members of the group to the current selection. 

 Deselect Members Removes the members of the group from the current selection. 

 Add to Group Adds the currently selected items to the group. 

 Remove from Group Removes the currently selected items from the group. 

 Properties Displays a list of the member items of the group. 

When the group defines a slice section the otherwise generally available Rename, Delete, 

Add to group, and Remove from group options are unavailable but additional slice-related 

options are include on the context menu: 

 Draw axes Draws the local axes for the slice section. Note that options on the 

Contours properties dialog allow for plotting of results on slice sections and at slice 

axis directions. 

 Print Properties Displays information about the slice including cross-sectional area 

of the slice, centroid and section property data. 

 Print Forces Displays force and moment information for the slice. 

Group symbols explained 

By default a symbol adjacent to each group name in the Groups  Treeview shows the 

visibility and status of each group. 

When modelling: 

 A black dot next to a symbol denotes the current group into which all new geometry will 

be added when created.  

 (green tick) All of the objects in this group are visible. 

 (blue tick) Some of the objects in this group are visible. 

 (red cross) None of the objects in this group are visible. 

When a results file is loaded: 

 (green tick, green border) All of the objects in this group are showing results. 

 (blue tick, blue border) Some of the objects in this group are visible and some are 

showing results. 

 (green tick, blue border) All of the objects in this group are visible but only some are 

showing results 
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Group visibility / symbol feedback panel 

The group visibility / symbol 

feedback panel at the bottom of the 

Groups  Treeview reports on 

whether any groups have been made 

invisible, or whether the model is 

fully visible. The visibility / results 

feedback settings control whether the 

group symbols are displayed to show 

the status of the objects in the group, or whether no group visibility symbols are to be used. 

For particular sizes of model, and numbers of objects within a number of groups, it may be 

necessary to turn-off the automatic group feedback option to retain optimum display speeds. 

  

Changing the Visibility of Features 

By default all model geometry is visible (providing the geometry layer is present and turned 

'on' in the Layers  Treeview, and providing it is not hidden by another layer) but as models 

get larger it is convenient to temporarily turn-off the display of parts of the model.  

Features may be made invisible using any of the following methods: 

 By selecting features and choosing Invisible from the context menu activated from the 

view window. 

 By selecting an attribute from the  Treeview  and choosing Invisible from its 

context menu. 

 By creating a group from selected model features and choosing Invisible from the 

group name's context menu to make the members of the group invisible.  

Features may be made visible by using any of the following methods: 

 By choosing All Visible from the context menu activated from the View window 

(used if any features have been made invisible) 

 By choosing Visible from an attribute's context menu to re-display the features 

assigned to the attribute 

 By choosing Visible from a group name's context menu to make the members of the 

group visible again. 

In addition the advanced visibility dialog activated from the View window's context menu 

allows fine control on the visible / invisible items by controlling the visibility of higher order 

and lower order features. i.e. This allows all Lines attached to a Point to made visible or all 

Surfaces connected to a Line to be made invisible. 

Notes: 
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 All visible features will always have their lower order features visible. i.e. If a line is 

visible its defining points will also be visible. 

 When a feature is made visible any associated elements or nodes will also be made 

visible. Use the Advanced Visibility dialog to override this behaviour. 

 An element can only be made invisible if its defining feature is invisible. To make a 

chosen element invisible, select the element and then use the Advanced Visibility 

dialog to make the element invisible by selecting the Also apply to higher order 

option. This makes the selected elements and the defining features invisible without 

making the unselected elements invisible. 

Rotating, Zooming and Panning 

A number of tools are available to manipulate the view of the model. 

 Dynamic rotation is carried out by selecting the dynamic rotate button, or by pressing 

the scroll wheel button and either the left or right mouse button or by holding down 

the R key, while moving the mouse in normal cursor mode. The model will be rotated 

about the centre of the model unless any part of the model is selected in which case the 

model will rotate about the centre of the selection. The model can additionally be 

rotated around any of the screen axes by pressing additional keys. See Rotating the 

Model. 

 Dynamic zoom is carried out by selecting the dynamic zoom button, or by scrolling 

the mouse wheel or by holding down the Z key while moving the cursor in normal 

cursor more. If any part of the model is selected the location of the centre of the 

selection will remain fixed. 

 Dynamic pan (drag) is carried out by selecting the pan button, or by depressing the 

scroll wheel button or holding down the D key while moving the mouse in normal 

cursor mode.  

Notes:  

 Rotation, zoom and pan model manipulations are applicable for all cursor input modes 

including normal cursor selection of features, defining lines by cursor or when section 

slicing.  

 For larger models when the refresh time is significant the model display will reduce to 

an outline view when using rotate, zoom and pan.   

Rotating the Model 

Three methods of rotating the view of the model are available, each one is a button on the 

View toolbar: 
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  Dynamic rotate  Allows the 

model to be rotated dynamically 

using the cursor. The model rotates 

around various multiple axes when 

the cursor is moved. By holding 

down the Control key, the Control 

and Shift keys or the Shift key while 

using the dynamic rotate the model 

can be rotated independently about 

the screen Z, Y and X axis 

respectively. Click on the normal 

cursor to return to selection mode. 

Note also that holding down the Alt key provides a one-key option for rotating about 

the the screen Y axis. 

  

Note. Models are dynamically rotated using the 'model 

ball' method. With this method, a model can be imagined 

to be surrounded by a sphere such that a mouse-click and 

a drag of the cursor on the screen represents clicking on 

the surface of the sphere and dragging to rotate it to a new 

position. In doing so, it is important to note that the model 

rotation is restrained to rotate only around the model's 

vertical axis (as defined on the Vertical Axis dialog) - 

unless any model viewing shortcuts are being used at the 

same time. A benefit of this approach is that, no matter 

where on the screen you click to start the rotation of your 

model, if you return the mouse pointer to the same spot, 

(whilst you are dynamically rotating the model), the model will return to its original position 

and orientation on the screen. 

  

 Incremental rotate Allows the model to be rotated by 

an specified rotation about a chosen global axis. The 

specified rotation may be modified by adjusting the 

rotation increment on the window's properties. 
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 View along axis Views the model along a chosen global 

axis. 

Note that this toolbar button is not provided as part of the 

standard user interface but it can be added by selecting the View 

> Toolbars > Customise > menu item.  

Note that this facility is also available by clicking in the X, Y or 

Z boxes in the Status Bar (holding-down the Shift key, if 

needed, to obtain the views along the negative screen axes.)  

Zooming in or out 

 
Zoom tool This tool works in two ways: 

1. By dragging a box around part of the model the view will zoom into that area.  

2. Clicking on part of the model will zoom in progressively for each click. Hold 

the Control key to zoom out. 

 
Dynamic Zoom is similar to dynamic rotate. Using the cursor the model can be 

visually enlarged or reduced in size. 

Panning (Dragging) the Model 

 
Dynamic Pan allows the model to be dragged into position on the screen. 

Reseting the View 

 
Home Restores the view to a scaled to fit view in the XY plane. 

 
Resize When the resize button is depressed the model will fit into the available screen 

area.  

See Appendix C - Model Viewing Shortcuts for a complete listing of all model viewing 

facilities and keyboard shortcuts available 

Undo/Redo 

 The Undo button allows any number of actions since the last save to be undone. If 

more than the last action is to be undone then the actions to be undone may be selected from 

the undo history list by clicking on the down arrow at the side of the undo button. 
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 Redo is available immediately after choosing an undo event to enable the undone 

action to be reinstated. 

Notes: 

 The undo facility works by replaying the session file from the last save. Because of 

this, it is advisable to save the model frequently to speed-up the undo facility. 

 Undo is only available when a model file is loaded. (i.e. undo is not available when a 

results file is loaded without a corresponding model file) 

Page Layout Mode 

Two viewing modes are available, both accessed from the View menu: 

 Working Mode is useful for model generation. In working mode annotation is scaled 

and moved so it is always visible. 

 Page Layout Mode enables the model to be viewed as it would appear on a printed 

page. This makes annotation easier to position and allows pictures to be created to a 

specified scale. 

Scaling 

In Page Layout Mode the model is scaled and positioned within the margins defined using 

Page Setup> File menu item. This behaviour may be modified by toggling the scale to fit 

window   button.  

If a picture is to be created to a specified scale the page size should first be set using the File> 

Print Setup menu item. The desired scale and position should then be set on the View tab of 

the View Properties accessed from the context menu. In this dialog the scale to fit window 

option should be switched off and the scale and origin position defined. 

Annotating the Model 

The View window may be annotated using the Utilities> Annotation menu item. Annotation 

can be placed by either cursor positioning or by specifying a coordinate location in Frame or 

Model coordinates. Annotation added to the model is displayed in the Annotation layer in the  

 Treeview. 

Cursor positioned annotation 

 Line Single lines may be added in a selection of colours and line styles.  

 Polygon Filled or unfilled polygons may be annotated on the screen in a selection of 

colours. Left click to indicate successive polygon vertices. When at least three vertices 

have been indicated, right click and select Cancel or Close from the context menu.  

 Bitmap Adds a bitmap from a selected file 
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 Banner Adds the LUSAS banner 

 Arrow Defines an annotation arrow of a default size and colour 

Coordinate positioned annotation 

Several types of annotation are available: 

 Text Any number of lines of text may be plotted in a selection of fonts, character 

heights, angles and colours. Requires text setting-out point to be defined. 

 Line Requires start and end points of line to be defined. Single or multiple lines may 

be added in a selection of colours and line styles. 

 Polygon Requires points to be defined for each vertex. 

 Bitmap Adds a bitmap from a selected file at a specified location point 

 Banner Adds the LUSAS banner at a specified location point 

 Arrow Defines an annotation arrow at specified start and finish points in chosen pen 

colour. 

 Symbol A selection of symbols may be plotted in a 

selection of sizes, angles and colours.  

 

Other Annotation 

 Window border Displays an annotated frame around the Window containing the 

LUSAS version number in use with the model name, the date, the model title, and the 

model units.  

 Window summary Window summary annotation is 

added in the form of an automatically assembled text 

block. It displays information about the model such as its 

view scale and orientation, and if a results file is loaded a 

summary of key values for a particular loadcase.  

 Window summary position The location of the summary block of text with reference 

to the left, right, bottom or top of paper. Note that the Window summary can be moved 

easier graphically by selecting it and then dragging it to a new position. 

Notes 

 If the annotation is eclipsed by other model data drag the layer (in the Treeview) to 

the bottom of the stack so that it is drawn last. 
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 An annotation toolbar is available but by default is hidden. It can be displayed from 

the View> Toolbar menu item. From this toolbar coordinate positioned text and 

bitmaps can be defined, and cursor positioned lines, boxes, polygons and arrows 

added. 

Editing Annotation 

After being added to a model window, both cursor positioned and coordinate position 

annotation can be easily moved by selecting it with the cursor and dragging to a new position. 

In addition all defining parameters such as location, style and in some cases content can be 

edited.  

To modify the properties of a piece of annotation select the annotation, right-click, then 

choose Properties from the context menu. The following properties apply to most annotation 

types: 

 Anchor point Annotation can be located with respect to the model (model 

coordinates), or to the window frame (frame coordinates). 

 Visibility The annotation can be made visible on all windows or just the current one. 

 Pen The pen used to draw lines or polygons can be selected from the pen library. Line 

thicknesses can be edited. The font used for text annotation can be modified by 

clicking on the Font button. 

 Name The identifying name of the annotation item. If no name is entered an automatic 

numeric identifier is allocated. 

Notes 

 By default the anchor point of all annotation is positioned in frame coordinates from 

the bottom left corner of the page. This enables the annotation to be positioned 

separately from the model. If negative values are specified for the anchor coordinates 

then the annotation is positioned from the top right corner of the page. 

 Annotation may be tied to the model by specifying the anchor point in model 

coordinates. 

 Annotation positioned in frame coordinates can be moved by selecting the annotation 

in the graphics window and dragging to the required location. 

 Annotation lines are used where 2D graphing results are to be recreated at defined 

locations. See Results on Sections Through a Model 

 Polygons are used when a section through a 3D model is to be recreated at a defined 

location. See Results on Sections Through A Model 
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Saving a Model 

When a model is saved using the File> Save menu item all model properties, views and 

associated values are saved also. If a results file was open when the model was saved this is 

not re-opened automatically when the model is re-opened later. 

Customising the Environment 

Various user-definable settings and facilities allow the interface to be customised. 

 View properties contain options relating to the current window. 

 Startup templates can be used to pre-load the Attributes Treeview of the interface 

with selected attributes for a particular analysis, set default mesh or material types, or 

define preferred colour schemes - to name just a few uses. 

 Toolbars and toolbar buttons can be customised and user-defined toolbar buttons 

can added to the user-interface either to sit on a new toolbar group or alongside 

existing buttons in an existing group. 

View Properties 

The View Properties dialog allows general information relating to how both the model and 

results are viewed for a selected window. 

View properties may be displayed in various ways: by double-clicking inside a window (with 

no features selected); by right-clicking a window name in the Layers  Treeview and then 

selecting Properties from the context menu, or by double-clicking the view properties entry 

for a particular Window in the Layers  Treeview. 

View properties are defined on the following tabs: 

 General Show or hide the screen ruler, selection tolerance, and enables the window 

background and selection colours to be modified. 

 View Shows the view rotation vector and rotation increment. Add or removes a 

window border or window summary. Controls if elements activated in the active 

loadcase are displayed or not. Enables the scale and origin position to be set and 

allows the current view settings to be saved. 

 View axes Controls whether views axes are displayed and at what position. The style 

of axes can also be set. 

 Deformations Specify the amount by which the nodal deformations are scaled. 

General 

 View name is the name of the current window 

 Show Rulers Shows, (or hides), the X,Y,Z axis rulers of the current window. 

 Selection tolerance Sets how close the cursor has to be to a feature to be able to select 

it.  
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LUSAS uses standard Microsoft Windows colours to define the screen colours by default. By 

deselecting the Use Windows colours option the following colours can be changed: 

 Background colour Sets the window background colour. 

 Selection Pen Sets the pen colour used to draw model feature when they are selected. 

 Selection memory Pen Sets the pen colour used to draw model features when they are 

in selection memory. 

View 

 Scale to fit window/page When enabled automatically adjusts the zoom level to fit the 

model to the view window/page. 

 Scale  (with Scale to fit window/page disabled) allows the scale ratio of the view to be 

set manually 

 Origin position Defines the origin of the view. 

 Rotation Vector An equivalent eye position coordinate. Entering (0, 0, 1) views the 

model from the Z axis, and (1, 2, 3) gives a three-dimensional view. 

 Rotation increment Sets the rotation increment used for incremental rotation. 

 Triangle sort Defines the triangular sort algorithm to use when shading (For OpenGL 

with GDI drivers only). 

 Border annotation Displays an annotated frame containing the LUSAS version 

number in use with the model name, date, title, and the model units. 

 Summary annotation An automatically assembled text block that displays 

information about the model such as its view scale and orientation and, if a results file 

is loaded, a summary of key values and settings for a particular loadcase. 

 Location Opens a dialog to allow the location of the summary block of text to be set 

with reference to the left, right, bottom or top of paper. Note that the Window 

summary can be moved more easily graphically by selecting it and then dragging it to 

a new position.  

 Show only activated elements Controls whether only the elements activated in the 

active loadcase are displayed or not. 

 Save View Saves the current view, including the view properties, pen library, colour 

map and window layers. Note that when a view is loaded into a window there is a 

choice of what to reload e.g. colours, layers, etc. 

View Axes 

 Visualise coordinate system Visualises the active coordinate system in the graphics 

area using the position and style specified. The active coordinate system may be set 

from the Geometry tab of the model properties dialog. 

 Anchor point Anchors the coordinate axes position to either a model coordinate, or a 

frame (window) coordinate. 
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 Styles Defines the style used to draw the coordinate axes and optionally sets the font 

used for axes labelling. 

Deformations 

 Specify magnitude Sets the maximum nodal deflection for the mesh as seen on the 

screen (in mm). 

 Specify factor Sets an exaggeration factor for the maximum nodal deflection for the 

mesh. 

Customise Startup Templates 

Startup templates can be used to pre-load the Attributes Treeview with selected attributes for 

a particular analysis, set default mesh or material types, or define preferred colour schemes - 

to name just a few uses. User-defined startup templates are created by recording the setting of 

a variety of selections and then associating the recording with a template name. 

Case Study. Creating a Startup Template 

In this example a startup template will be created to define a material type, set it as the 

default, and also set user-defined display colours for a View window. 

1. Run LUSAS and create a new blank model of any filename. 

2. Select File > Script > Start Recording and enter my_defaults as the filename. 

3. Select Attributes > Material > Material Library, choose Mild Steel and click OK. 

4. In the Attributes Treeview, right-click on Mild Steel Ungraded and select Set 

Default.  

5. In the Graphics Area, right-click and select Properties 

6. Deselect Use Windows colours, select a Black background colour, choose a Yellow 

selection pen and click OK when done. 

7. Select File > Script > Stop Recording 

8. Exit from LUSAS. 

Using the Startup Template 

1. Run LUSAS and on the New Model dialog select the  button adjacent to the 

Startup template drop-down list. 

2. On the Customise Startup Template dialog select the  button adjacent to the 

Script field. Enter My defaults into the Name field. Press the Add button to add the 

script and name to the table. Click OK. 

3. On the New Model dialog, select My defaults from the Startup template drop-down 

list and click OK. 

4. The startup template script will run setting all values to those previously chosen. 
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Toolbars and Toolbar buttons 

The toolbars used on the Modeller user interface can be adjusted by using the View > 

Toolbars menu item. Toolbar groups can be turned on or off, new toolbar groups can be 

defined, customised toolbar groups can be created and user-defined toolbar buttons can added 

to the user-interface either to sit on a new toolbar group or to sit alongside existing buttons in 

an existing group. Toolbar manipulation is provided by a third-party and incorporated into 

LUSAS Modeller for general use.  

Turning toolbar groups on and off 

Toolbar groups are listed in the Toolbars dialog and may be turned on or off by checking each 

item in the list. The following options are also available: 

 Show Tooltips shows a temporary description of the toolbar button when the cursor is 

moved over the button. 

 Cool Look removes the raised button style to leave a 'flat' button. 

 Large Buttons are not implemented in LUSAS modeller 

Creating a new toolbar group 

Favourite toolbar buttons (and any user-defined toolbar buttons) can be grouped together into 

a new toolbar group.  

 Use the New button on the Toolbars dialog to create a new, named toolbar group such 

as 'Personal'. An empty 'Personal' button group will be added to the Modeller user 

interface. 

Customising toolbar groups 

Toolbar buttons can be added to exiting toolbar groups or placed on new toolbar button 

groups. 

 Use the Customise tab to select a toolbar category and then, from the arrangement of 

buttons shown for that category, drag and drop a toolbar button into an empty part of 

the user interface. This can be repeated for as many buttons are necessary. As each 

button is added the button group will enlarge to accommodate it. Button groups can be 

'docked ' alongside other button groups on the user interface by dragging and dropping 

into place. 

 Buttons may be removed from toolbar groups by holding down the Alt key and then 

dragging the button into the View window. 

Creating user-defined toolbar button actions 

Nine user-definable toolbar buttons are provided for linking to a specified action. With the 

Customise tab selected these can be seen if the User entry is selected in the Categories list. 
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Scripts can be recorded and specified to be played when a particular user-defined toolbar 

button is selected. 

 In Modeller, use File > Script > Start Recording to record an action to be taken 

(such as the adding a Contours layer to the Treeview and the selecting a particular 

entity such as Force / Moment, and a component such as Mz, for example). Then use 

File > Script Stop Recording to save the script with a name such as Bending.vbs to a 

folder. 

 Then use the User tab to define the action that a particular user-defined toolbar button 

should take when pressed. This involves inserting a text string to reference the script 

that was recorded. A typical entry would read: Fileopen 

"C:\LUSAS150\Projects\Bending.vbs" 

  

  

Changing the user-defined toolbar button images 

The default numbered user button images as supplied are held on a single bitmap image that 

is144 pixels wide and 15 pixels high. Each toolbar button image is created in sequence and 

occupies a region that is 16 pixels wide and 15 pixels high. The bitmap is named 

userToolbar.bmp (case-sensitive) and can be found in <LUSAS Installation 

Folder>\Programs\Config folder.  

  

  

User toolbar button bitmap image as supplied 

  

Example of user-defined toolbar button bitmap image 

It is recommended that the supplied file is copied and renamed to userToolbar_supplied.bmp 

prior to making any changes to this supplied file. Changes made to the button images will be 

seen when LUSAS Modeller is next run. 
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Chapter 3 : File 

Types 

  

LUSAS File Types 

LUSAS can create or use a significant number of different file types. The main file types are 

summarised below.  

 Model Files (.mdl) are created by LUSAS Modeller and are used to store all model 

definition information. 

 Solver (Analysis) Data Files (.dat) are created by LUSAS Modeller during the 

tabulation phase. They contain the data required by LUSAS Solver to perform an 

analysis. 

 Solver Output Files (.out) are text files which are created by LUSAS Solver. They 

contain an echo of the input data, details of any errors or warnings which have 

occurred during the analysis and tabulated results if requested.  

 Solver Results Files (.mys) are created by LUSAS Solver and contain all of the 

analysis results for access by LUSAS Modeller. Results files are also occasionally 

referred to as plot files. 

 Solver Restart Files (.rst) enable a nonlinear, dynamic, transient or viscous problem 

to be restarted after it has been chosen to stop an analysis during a solve. 

 Modeller Results Files (.mrs) are created by LUSAS Modeller and are used to store 

the results cache when the model is saved. These files save assembled results and 

speed up the results processing of combinations. If necessary mrs files may be deleted 

to save disk space. 

 History Files (.his) are created by LUSAS Solver and contain specified analysis 

results for access by LUSAS Modeller. 

 Script Files (.vbs) contain a collection of LUSAS Modeller commands so that, when 

they are replayed, a sequence of operations may be carried out automatically. Script 

files can be recorded by LUSAS Modeller or edited directly using a text editor. 

 Session Files (.ses) are created automatically every time LUSAS Modeller is run. 

They contain a record of all commands issued during a session. 
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 Interface Files (.dxf, .igs, .stp, .stl, .def, .nf) allow graphical structural information to 

be exchanged between LUSAS Modeller and external packages. 

 Command Files (*.cmd) are used to import and export models from and to version 13 

of LUSAS Modeller where only geometry features supported by version 13 Modeller 

will be exported. 

 Library files (.csv) are created by LUSAS Modeller to store user-defined cross-

sections. In addition to this library files, LUSAS Modeller also uses supplied libraries 

of pre-defined materials and section properties that cannot be edited by users. Another 

library file (with a .lmd extension) allows users to store and transfer attribute data 

(such as mesh, geometric, material, loading, and supports) and associated utilities data 

between models. See Transferring Data Between Models for details. 

 Picture Files (.pic, .bmp, .jpg, .wmf) allow the contents of the Graphics Area to be 

saved in a standard file format. Picture files are used to subsequently display the 

information or, in conjunction with the LUSAS Expose program, to create files which 

may be printed or plotted. In addition to proprietary LUSAS picture files, screen 

content can be saved in BMP, JPG or WMF file formats. 

All file types assume the default extensions that are given in brackets. When specifying 

filenames it is good practice to simply supply the filename without the file extension. LUSAS 

will then supply the correct extension for the file type being written which will ensure that 

existing files are not inadvertently overwritten by specification of the wrong file type. 

Model Files 

Model files contain all the information relating to the model, its current database and settings. 

The information is stored in an binary form and may only be accessed using LUSAS 

Modeller. A model file is not saved automatically, but LUSAS Modeller prompts on exit as a 

reminder to save changes to a model file. The following are accessed from the File menu: 

 New Prompts to close an existing model file, and creates a new model file. 

 Open Opens previously saved models. Modeller will prompt for confirmation before 

the currently loaded model is closed. See notes for opening models created prior to 

Version 15.0 

 Close Closes the currently open model file. 

 Save Saves the current model to disk at any time. See Model file locations for more 

details 

 Save As Allows specification of an alternative filename. Selecting Save as for an 

existing model with results will create a new model file and, if necessary, a new folder 

but the existing results (and other intermediate files) will not be copied.  

Opening a LUSAS model will automatically offer to open available results files, if found and 

if listed in the Manage Results Files dialog. 
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Opening pre-version 15.0 model files 

Opening models created prior to version 15.0 which reference more than one results file will 

result in a different File Open dialog being presented from that displayed for models with one 

(or no) results file referenced.  

See Opening pre-Version 15.0 models that do not reference multiple results files and 

Opening pre-Version 15.0 models that reference multiple results files for more details. 

Notes 

 When using Version 14 releases of Modeller, old Version 13 models can be opened if 

Version 13 is installed but this may take longer than usual as the files require 

conversion to the Version 14 format. 

 When saving a model, disk space may be saved by deleting the mesh and faceting data 

using the Advanced button on the File> Save As menu item. This data will be 

regenerated when the model is reloaded. 

  Section property data, that may be referenced in a model is saved in a section 

property library that may have a different folder location. 

Opening pre-Version 15.0 models that do not reference 

multiple results files 

 In Version 15.0 the locations of all files referenced by a model are saved by specifying 

model file locations.  

Opening models created prior to Version 15.0 (that do not reference multiple results files) 

will result in this dialog being displayed: 

 

On the File open dialog displayed: 

 Open model and convert to new format updates the model to the latest format. As a 

result, when it is saved older versions of LUSAS will no longer be able to read it. The 

filenames of the results files are updated to include a reference to the analysis name, 

and all results and associated model data files are saved according to settings made on 

the Modeller settings page of the LUSAS Configuration Utility. 

 Open model read-only keeps the model available for viewing / editing in older 

versions of LUSAS. Filenames of the results files are unchanged. 
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 Open results too opens all associated results files for the model. Results files for 

models created prior to Version 15.0 will be listed in the Analyses  Treeview 

beneath the Analysis 1 entry.  

Opening pre-Version 15.0 models that reference multiple 

results files 

In Version 15.0 the locations of all files referenced by a model are saved either with, or 

beneath the model folder by specifying model file locations.  

Models created prior to Version 15.0 allowed combinations and envelopes to be created that 

referenced loadcases from more than one results file. Combination and envelope data was 

saved if the model file was saved. On re-opening such a model, the results files used in the 

combinations or envelopes had to be loaded on top of the model, in the order that they were 

first loaded, for the combinations and envelopes to be valid. This was because within the 

combination or envelope itself the results file was referenced by a file number (File: 1, File 2 

etc) rather than by its name. 

When opening pre-Version 15.0 models the path and filename of all results filenames 

associated with the model need to be specified if the files are to be automatically accessed by 

LUSAS Modeller each time the model is opened. To not specify a filename for the associated 

results files listed may invalidate the results obtained from a combination or envelope 

depending upon the loadcases included in them. 

Opening a model created prior to Version 15.0, that contains combinations and envelopes 

that, between them, refer to more than one results file, will result in this dialog being 

displayed: 

 

On this example dialog the model opened has three results files associated with it: results file 

ID 1, 2 and 3. The location of results file 1 is assumed to be the same folder as the model file 

location because prior to Version 15.0 a results file was (by default) written to the same folder 

and with the same name as the model filename. Results files 2 and 3 are automatically 

assigned to Analysis 1 so that they will be saved with that analysis when the model is saved. 

However, the location of any of the results files referenced by a combination or envelope 

saved in the model is, for historical reasons, unknown, hence the empty path for results files 2 

and 3 in the Filename column. To ensure that any combinations and envelopes defined using 

these files remain valid in Version 15.0 and above, the location and filename of these 
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'unknown' results files need to be stated. To do this requires a knowledge or a record of the 

filenames and the order in which the results files were loaded in earlier versions.  

So in summary: 

 ID is the identification number of a results file that is referenced in an envelope or 

combination. 

 Analysis The drop-down list selection made here determines whether a results file 

entry (that is added to the Analyses  Treeview) is saved in that treeview when the 

model is saved.  

 Choosing Analysis 1 (the default option) saves the results file entry in the 

Analyses  Treeview when the model is saved.  

 Choosing None does not save the results file entry in the Analyses  

Treeview when the model is saved. These results files will have to be re-

attached each time the model is read. 

 Filename defines the location and filename of a referenced results file. 

 The  button can be used to correct any filename assumptions made by Modeller 

and to specify the location and filename of any results files that do not have a path 

specified. 

 The Open check box (when checked) indicates that the results file is to be opened 

when the OK button is pressed. 

 WARNING: The  button will remove the results file ID, Analysis and 

filename entries for that row from the grid and break the link to the results file in all 

combinations and envelopes that make use of that results file ID. All loadcase entries 

for the results file will be removed from all combinations or envelopes that refer to 

them. 

The Folder for files whose location is not specified is set to be that of the created 

Associated Model Data folder for the model. The entering of relative paths and model names 

in the empty cells in the Filename column (as opposed to using the  button which 

specifies full paths) mean each entry is evaluated with respect to this folder location. 

Once links are established they are retained within Modeller and can be accessed and 

modified via the File > Manage Results files menu item which provides the same 

functionality. 

Notes 

 Results files added to the grid but not connected to any particular analysis (those 

assigned 'None' in the Analysis column of the grid) will be listed in the Analyses  

Treeview in sequence beneath the other analysis entries. This effectively provides the 

Version 14.7 working environment for old models within the new multiple analysis 

capability of Version 15.0, but means that the results files included in the Analyses  

Treeview can only be updated by opening and solving each relevant model (as was the 

case in pre-Version 15 releases). 
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Model file locations 

The LUSAS Configuration Utility controls where files relating to a model (such as results 

files and intermediate files) are saved. 

For each model the location of files that are created in the course of a building it and running 

the various analyses associated with it can be specified as being: 

 Within a folder for each model, within a folder called "Associated Model Data" 
This is the default setting. Note that the model file itself does not reside within the 

folder created. 

 Within a folder with the same name as the model Note that the model file itself 

does not reside within the folder created. 

 Within the same folder as the model (This is Version 14.7 behaviour) 

 To a specified folder where the location can be defined by internal LUSAS tokens 

and ordinary text. For example, the token%ModelLocn% is substituted with the 

working current folder for the model; and %ModelName% is substituted with the 

model's file name. Relative links (e.g. ..\ to use the parent folder) can alternatively be 

specified. 

Model Folders explained 

 Associated Model Data is the default folder name and container for all files (apart 

from temporary files) that are created by LUSAS in the course of modelling or solving 

an analysis. This will include results files (.mys), solver output files (.out) and solver 

data files (.dat) for instance. Within this folder two additional subdirectories are 

created called 'Backups' and 'Sessions': 

 Backups A copy of the original model is preserved in this folder when the 

model is loaded for editing. The number of revisions of a model that can be 

saved to this folder can be set on the Backups tab of the Modeller Properties 

dialog. The default number of revisions saved is two, but this can be modified. 

Whenever the model is saved, the previous revision is saved here and 

(assuming the number of revisions has been reached ) the oldest revision is 

deleted. 

 Sessions All session files (.ses) are stored in this subfolder. The model 

recovery file (.rcv) is also stored here. 

Notes 

 In addition to the backup file locations stated it is also possible to maintain another 

(current) copy of the model file in another location. See the Backups tab on the 

Modeller Properties dialog. 

 The folder location of temporary files, created in the course of modelling with 

LUSAS, is specified on the Temporary Files page of the LUSAS Configuration 

Utility. 
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 The Windows operating system limits the length of a path to a file to 260 characters. 

See File and folder naming in LUSAS. 

File and folder naming in LUSAS 

The Windows operating system limits the length of a path to a file to 260 characters. For most 

modelling situations this should not prove to be a problem but for some modelling and 

analysis applications within LUSAS, notably when carrying out vehicle load optimisation 

(VLO) analysis, this limit may conceivably be met. This will typically occur if very long 

model names are used in conjunction with the use of very long names for attributes and 

analysis runs that are used in VLO analysis.  

In the most extreme case files relating to a model can be saved beneath a model folder in a 

folder named 'Associated Model Data' (see Model File Locations for details), in a folder 

named after the model name. VLO folder and filenames based upon user-defined file names 

are then created beneath that folder. This adds a VLO output folder (based upon the model 

name), and a concatenation of the VLO run name, the influence attribute name, and the 

coordinate value of the position on the model to which the influence attribute has been 

assigned, to make up the full path to a particular file. 

A typical 'longest' path name for a file would therefore be constructed from: 

<userspath> / Associated Model Data / <usersmodelname> / <usersmodelname>_VLOoutput 

/ <usersVLORunname> _ <usersInfluenceName> - (0.00000, 0.00000, 0.00000) - (element 

99999, element 99999).dsp 

Allowing for those parts of a path that are fixed in nature (such as the predefined named 

folder structure and the coordinates and element name) leaves approximately 150 characters 

with which to define a model name (noting that the model name appears twice in the path), a 

VLO analysis run name, and an influence attribute name. 

Solver Data Files 

Solver data files contain the data required by LUSAS Solver to perform an analysis. Solver 

data files (.DAT) are automatically created by LUSAS Modeller during the tabulation phase 

which is triggered either by pressing the Solve  button, or by selecting any of the other 

Solve or Solve now options available for the analysis entries in the Analyses Treeview. 

A Solver Data file can also be created manually by using the File> Export Solve datafile... 

menu item.  

All methods produce a data file in readable ASCII text format and the file may, if necessary, 

be modified with a standard text editor. The format of the analysis data file is described fully 

in the Solver Reference Manual 

Solver Output Files 

When an analysis is performed by LUSAS Solver it creates a text output file which has an 

echo of the input data, details of all errors diagnostics and warnings and tabulated results. 
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Solver Restart Files 

When an analysis is performed by LUSAS Solver, data can be written to a restart file to 

enable a nonlinear, dynamic, transient or viscous problem to be restarted after it has been 

chosen to stop an analysis during a solve. 

Solver restart file generation needs to be specified in Modeller prior to running an analysis by 

choosing the File> Export Solver datafile... menu item, accessing the Advanced Solution 

Options dialog and selecting Generate restart file. 

 The restart output facility enables failed or terminated analyses to be restarted from the last 

saved restart output dump. This is particularly useful for a number of situations: 

 When the termination of the analysis was due to a failure of the solution process rather 

than a problem with the modelling of the structure the solution may be restarted from 

the last converged increment with a different or modified solution strategy. For 

example, a failed increment may be restarted under either constant load or arc-length 

control.  

 To break up larger, longer runs of 100s or 1000s of increments or time steps into 

several sequential runs to reduce the size of each results file created. This may also be 

done simply to safeguard against any potential interruption to the solve that may 

otherwise mean starting the analysis again right from the beginning. 

 To solve to a certain point or stage in an analysis, and then continue from this point 

with several different further loading configurations that each be considered in 

separate parallel restart runs. 

Restarts are not currently supported by LUSAS Modeller and hence must be defined directly 

in a LUSAS Solver data file. See the Solver Manual for more details. 

Solver Results Files 

Results files When the Solve button is pressed in LUSAS Modeller one or more analyses are 

carried out by LUSAS Solver and a results file will be produced in a specified Model folder. 

LUSAS results files, or plot files as theyare sometimes referred to, have a .mys extension. 

The information in a Solver results file is stored in a binary format and may only be accessed 

using LUSAS Modeller. The results file will contain the results of the analysis and sufficient 

model information to process the results. Full details of the finite element mesh (nodes and 

elements), material and geometric property numbers, support positions and equivalent nodal 

loads are stored in the results file so that results processing can be carried out without a model 

file if desired. 

Opening available results files for a model   

When a model is opened, Modeller will attempt to open all available associated results files 

for that model. The File > Open Available Results Files menu item also exists for the same 

purpose. Results files are loaded on top of the current model and results loadcases are added 

to the relevant Analysis entries in the Analyses  Treeview. 
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Results files that are associated with a model can be seen by selecting the File > Manage 

Results files menu item. 

Opening a results file without a model being open 

A results file can be opened in isolation from a model by using the File menu: 

 Open By changing the Files of type drop-down list, results files (.mys) can be 

selected. This opens a results file in isolation from a model. Modeller will prompt for 

confirmation before the currently loaded model is closed.  

 Close Closes the currently open results file. 

Opening a results file in isolation from a model does not provide access to any generated post 

processing loadcases such as envelopes, combinations etc that are saved with the model file. 

Closing results files 

 All open results files can be closed at the same time using the File > Close All 

Results Files menu item. 

 Results files can also be closed individually by right-clicking on a loadcase name in 

the Analyses  Treeview and selecting the Close file menu item. 

Notes 

 If a model has been re-meshed since the results file for that model was created the 

cannot be loaded. Instead the model must be re-solved to create and automatically 

open the results file. 

 If a model has been modified in same other way (than just being re-meshed) an option 

to load or not load the results is made available. 

 For transient and nonlinear analyses the frequency that LUSAS Solver writes results 

to the results file is specified when defining the analysis control. If this is not 

specified results are saved in the results file on every time step or load increment. 

Manage Results Files 

 In Version 15.0 of LUSAS the locations of all intermediate and results files created during 

the building and solving of a model can be specified to be created either within a folder for 

each model, in the same folder as the model, or a specific location dependent upon the Model 

File Location used. 

The File > Manage Results Files menu item displays a grid that lists all results files that are 

associated with the open model.  
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It is recommended to always let LUSAS manage results files.  

The Folder for files whose location is not specified is set to be that of the created 

Associated Model Data folder for the model. The entering of relative paths and model names 

in the empty cells in the Filename column (as opposed to using the  button which 

specifies full paths) mean each entry is evaluated with respect to this folder location. 

In the results file grid: 

 ID is the identification number of a results file. 

 Analysis This column shows the name of the analysis for which the results file is 

applicable. The drop-down list of analyses is populated according to the analysis types 

present in the model.  

 Changing an analysis name associates the results file with a particular 

analysis in the Analyses  Treeview. It is not recommended to do this. 

 Choosing None does not save the results file entry in the Analyses  

Treeview when the model is saved.  

 Filename defines the location and filename of a referenced results file. 

 The  button can be used to correct any filename assumptions made by Modeller 

and to specify the location and filename of any results files that do not have a path 

specified. 

 The Open check box (when checked) indicates that the results file is to be opened 

when the OK button is pressed. 

 WARNING: The  button will remove the results file ID, Analysis and 

filename entries for that row from the grid and break the link to the results file in all 

combinations and envelopes that make use that results file ID. All loadcase entries for 

the results file will be removed from all combinations or envelopes that refer to them. 

If a results file is to be added to the grid the Let LUSAS manage results files check box 

should be unchecked and the Add file button used to add an extra row to the grid to enable an 

Analysis reference, file location and other settings to be made. 

Notes 

 Results files added to the grid but not connected to any particular analysis (those 

assigned 'None' in the Analysis column of the grid) will be listed in the Analyses  
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Treeview in sequence beneath the other analysis entries. This effectively provides the 

Version 14.7 working environment for old models within the new multiple analysis 

capability of Version 15.0, but means that the results files included in the Analyses  

Treeview can only be updated by opening and solving each relevant model (as was the 

case in pre-Version 15 releases). 

Modeller Results Files 

 Modeller results files have a .mrs extension and are saved whenever the model is saved. 

Modeller results files contain loadcase combination and envelope component results that are 

calculated by LUSAS Modeller.  

A Modeller results file speeds-up the assembly of the selected results within LUSAS 

Modeller since the component results are only calculated once for the selected combination 

and envelope results components. This means that when setting each combination or envelope 

active for viewing results the software does not have to re-calculate the results for that results 

component. However, selecting a combination or envelope result component that is not pre-

calculated will cause the results for all envelopes of envelopes and combinations to be re-

calculated.  

The information in a Modeller results file is stored in a compressed binary format and may 

only be accessed using LUSAS Modeller.  

History Files 

History files are used to output the named variables, and selected node and element results 

from LUSAS Solver in an ASCII format. Specification of the node and element numbers to 

be output to this file is defined from the File> Export Solver datafile... menu item. The 

output frequency for incremental analyses is controlled using analysis control. The results 

stored in the time history file can be accessed for graphing. 

The history file format consists of a header section with a title, list of named variables, type of 

nodal results and type of element results, followed by the results for each time/increment 

number. The format is shown below. Note. Due to space limitations, the number format has 

been adjusted. Standard history files will contain accuracy to machine precision. 

The named variables, selected nodal results and selected element Gauss point results will be 

output for each time step or increment as specified in the analysis control. 

Script Files 

Script file may be created and used to store a sequence of commands for later playback. 

Script files are created in Visual Basic Script (.VBS) format and are particularly useful for 

storing combinations of commands which are used frequently. Uses include consistent 

reproduction of screen images for use in reports and use with startup templates to pre-load 

the Attributes Treeview with selected attributes for a particular analysis, set default mesh or 

material types, or define preferred colour schemes.  

Scripts are normally run by opening the file in a file browser but user-defined toolbar 

buttons can be set-up to run scripts. 
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Script file manipulation is controlled from the Files> Script menu item. The following 

functionality is available: 

 Run Script An existing script file is replayed by choosing it from the Open 

dialog. 

 Start Recording creates a script file. If a non-default file extension is specified or if 

the file already exists you will be prompted for confirmation before proceeding. 

Existing script files can be appended to if required. While recording all attempted 

commands are logged to the script file using the LUSAS scripting language. 

 Stop Recording closes the script file. 

Session and Recovery Files 

Each time Modeller is run or the model is saved a new recovery file is created in the current 

working folder. This recovery file is named after the model name with the .rcv extension. 

Every attempted command, whether entered from the user interface or via the command line, 

is logged in this file using the scripting language. When the model is saved or the user exits 

Modeller the recovery file is renamed to a session file with an incrementing version number.  

Picture Files 

About Picture Files 

LUSAS picture files may be used for storing graphical information for subsequent conversion 

to an alternative file format using the LUSAS picture file utility program, Expose.  

LUSAS picture files are stored in readable ASCII text format. The individual picture file 

records use the following general format: 

code, r1, r2, r3, r4, i1, i2, i3 

The information is stored in packets of data as defined in the following table. 
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Code 
   

Function 
   

Parameters 
   

Description 

1 
  

Move 
  

r1, r2 
  

Moves to the drawing location specified by the x (r1) and y (r2) 
coordinate (mm). 

2 
  

Draw 
  

r1, r2 
  

Draws a line from the current position to the drawing location 
specified by the x (r1) and y (r2) coordinate (mm). 

3 
  

Symbol 
  

r1, r2, r3, r4, 
i1 

  
Plots a LUSAS built-in symbol at a specified screen position. (0-
Square,1- Circle, 2-Triangle, 3-Double Triangle, 4-Diamond, 5-
Cross, 6-Boxed Cross, 7-Asterisk, 8-Horizontal Arrow (origin at 
apex), 9-Horizontal Arrow (origin at base), 10-Vertical Arrow, 11-
Vertical Line, 12-X, 13-Y, 14-Z, 15-Barred X  

4 
  

Character 
  

r1, r2, r3, r4, 
i1 

  
Plots an ASCII character at a specified screen position with: x 
coordinate (r1), y coordinate (r2), rotation angle in degrees (r3), 
character height in mm (r4) and ASCII character code (i1). 

5 
  

Colour 
  

r1, r2, r3 
  

Percentage colour content with: red % (r1), green % (r2) and blue % 
(r3). 

9 
  

  
  

r1, r2, r3, r4, 
i1 

  
Starts a colour-filled multi-sided polygon with: number of vertices 
(i1). Real numbers (r1-r4) are not used. 

0 
  

  
  

r1, r2 
  

Creates a polygon vertex with: x and y coordinate (r1-r2). Must be 
used in conjunction with and appear immediately after code 8 or 9 
above. 

10 
  

Clipping 
Rectangle 

  
r1, r2, r3, r4 

  
Sets current clipping rectangle x1-r1, y1-r2, x2-r3, y2-r4 

20 
  

Multi-Line 
Text 

  
r1, r2, r3 ,r4 
,i1 ,i2 

  
Defines mutli-line text located at x-r1, y-r2, rotation-r3 (degrees), 
size-r4 (mm), alignment-i1 (0-top left, 2-top right, 6-top centre, 8-
bottom left, 10-bottom right, 14-bottom centre, 16-middle left, 18-
middle right, 22-middle centre, 24-baseline left, 26-baseline right, 30-
baseline centre), nLines-i2 (number of subsequent lines of text) 

Saving Picture Files 

 Pictures may be saved using the File> Picture Save menu item. 

 Note that views of a LUSAS model can also be saved for use in other applications as 

BMP, JPEG, or WMF files using the File> Picture Save menu item. For more 

information see Printing and Saving Pictures 

Print Files 

When using the print result wizard the output may be re-directed to a Print File. A print file 

has a .prn extension. The opening and closing of print files is controlled using the Files> 

Print File menu item. The following facilities are available: 

 File> Print File> Open The print file is opened by specifying a valid filename. 

LUSAS will prompt for confirmation to proceed if the specified file already exists or if 

a non-default file extension is used.  
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 File> Print File> Close The print file may be closed at any time. With no print file 

open, printed output will be directed to a text output display window. 

Notes 

 Output to the text window can be directed to a log file. See Text Window for more 

details. 

Interface Files 

Interface files are used to transfer external modelling or material data into and out of LUSAS 

Modeller. The full model or a selected portion of a model can, dependent upon the file format 

chosen, be exported to a chosen interface file. 

The currently supported list of interface file formats is: 

 CMD (.cmd) Format for import of LUSAS Modeller model files saved as command 

(CMD) files in previous versions of LUSAS. 

 Solver Data Files (.dat) LUSAS Solver data files (used to import or node and element 

data) 

 DXF (.dxf) AutoCAD Drawing eXchange Format.  

 IGES (.igs) Initial Graphics Exchange Specification. Format for import and export of 

geometry data. 

 LMS CADA-X  (.nf) Model description and modal data exported to a file that can be 

read by the LMS software. 

 NASTRAN Bulk Data files (.bdf, .dat) (used to import node and element data) 

 ANSYS cdb files (.cdb) (used to import node and element data) 

 Abaqus input files (.inp) (used to import node and element data) 

 PATRAN (.def) Neutral file format for inputting phase I geometry information and 

outputting phase II mesh information 

 STEP (.stp) STandard for the Exchange of Product data. 

 STL (.stl) Stereolithography data files. 

In addition to these interface files, search area topology files (.inf) can be imported into 

LUSAS for graphical cross-checking. These files, which contain details of search areas used 

by Autoloader, are converted into geometric line and surface data in LUSAS 

 Search area topography (.inf) Autoloader generated search areas. 
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Summary of Interface File Import / Export Capability 

Interface file name and extension Import file into LUSAS? Export file from LUSAS? 

CMD (.cmd) YES YES 

SOLVER Data File (.dat) YES NO 

DXF (.dxf) YES YES 

IGES (.igs) YES YES 

LMS CADA-X (.nf) YES YES 

NASTRAN Bulk Data Files (.bdf, .dat) YES NO 

ANSYS (cdb) YES NO 

ABAQUS (.input) YES NO 

PATRAN (.def) YES NO 

STEP (.step, .stp) YES YES 

STL (.stl) YES YES 

Notes 

 See Importing Geometry Data for details of how to import interface files. 

 See Importing Mesh Data for details of how to import finite element data files 

created either by the prior running of an analysis in LUSAS or by importing interface 

files from other supported third-party software applications 

 DXF, IGES and STEP files often contain much more detailed information than is 

required to create a finite element model, so a certain amount of model tidying should 

be expected after carrying out an import.  

Transferring Data Between Models 

The library browser allows users to transfer attribute data (such as mesh, geometric, material, 

loading, and supports) and associated utilities and report data between models. Selected data 

is saved to a LUSAS Model Data file (*.lmd). The browser is accessed using the File > 

Import/Export Model data menu item. Any number of library model data files may be 

created. 

Transferring data 

The library browser displays a list of the attributes and utilities for the currently open model, 

alongside a list of attributes and utilities that have been saved in the selected LUSAS model 

data library file.  
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 Selected data can be transferred from the model to the library by using the check 

boxes on the Model side of the dialog to select the attributes for transfer and then 

pressing the Export from model to library radio button. 

 Selected data can be transferred from the library to the model by using the check 

boxes on the Library side of the dialog to select the attributes for transfer and then 

pressing the Import from library to model library radio button. 

Clash detection when transferring 

 Name clash detection checks are carried out to ensure that data is not unknowingly over-

written.  

Clashes will occur when the same attribute or utility name (with the values or settings) is used 

in the model as in the library file. If clashes occur during the transfer process the attribute 

name or utility in the library file can either be overwritten or the offending attribute(s) can be 

renamed in the Attributes  Treeview panels of the model prior to a subsequent re-transfer 

to the library being attempted.  

When transferring data from a model data library to the model, clashes will occur when the 

same attribute or utility name (with the values or settings) is used in the library as in the 

model file. If a clash is detected the following name clash resolution options are provided: 

 Overwrite model item with the one from the library 

 Do not import this item keeps model and library items as they were 

 Append unique name extension appends a user-defined extension to the attribute 

name 

 Prepend unique name prefix gives the attribute name a user-defined prefix 

 Use this choice for all other name clashes applies one of the previous selections to 

all other clashes of names. 

Deleting items  

 If any model attributes, utilities or reports are selected using the check boxes available 

pressing either the Delete from model button or the Delete from library button will delete 

those items from their respective sources. As a result, the Library Browser dialog also 

provides the means to carry out multiple deletions of attribute/utilities data from a model 

(something not possible currently via the main Attributes  and Utilities  Treeviews).  

Notes 

 Note that whilst the Attributes  and Utilities  Treeview panels may show data 

sorted by id number (default) or by name (optional) the listing of entries in the File 

Library browser is always by name. If necessary, model treeview contents can be 

sorted to match by selecting the menu item Sort by name from the context menu for a 

Treeview tab. 
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 If one attribute (such as a composite definition) relies upon another attribute (such as a 

set of material properties) it is not possible to transfer one without the other(s). 

 If variations have been used in the definition of an attribute then transferring that 

attribute from the model to the library (and vice-versa) will also transfer the relevant 

utilities datasets describing the variations used. 

  Attributes should not be edited in the library file. 

Importing Interface File Data 

Geometry and mesh data from supported interface files can be imported using the File> 

Import... menu item. When a file is selected the Advanced button can be used to specify 

import parameters. After all feature entities have been imported, a feature merge will be 

carried out according to the merge setting defined under Model properties.  

File Import Options (Advanced) 

Only those options applicable to the file being imported will be available for selection. 

Option Description Default 

Translate annotation 
type geometry 
entities 

Include entities marked as annotation. 
  

False 

Translate blanked 
entities 

Include entities marked as blank. 
  

False 

Merge trimming lines Attempts to merge the trimming lines of trimmed 
surface entities. 

False 

Delete dependent 
geometry 

Will delete geometry objects created from entities 
marked as dependent. 

True 

Delete points not 
defining lines 

All points not connected to a line are removed. True 

Delete lines not 
defining surfaces  

All lines not connected to a surface are removed. True 

Delete unconnected 
lines 

Deletes unconnected lines that do not define any 
surfaces. 

True 

Use domain space 
trimming curves 

Use domain space trimming curves in preference to 
model spacing trimming curves. 

False 

Lock the mesh post 
import 

Locks the mesh following import to ensure it is not 
changed unintentionally. 

False 

Model is solid 
volumes 

If selected, fills in any missing data to create a solid 
volume. 

False 

Coalesce surfaces Removes similar lines from adjoining surfaces to 
simplify the model. 

False 
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Option Description Default 

Coalese volumes Removes similar surfaces from adjoining volumes to 
simplify the model. 

True 

Create material 
groups 

Create named groups for features in the data file 
having the same material property 

False 

Maximum number of 
groups 

Maximum number of groups permitted to be created 
from material property types 

500 

Merge geometry post 
import 

Merges geometry within the general specified merge 
tolerance. 

True 

Minimum line length Facets containing lines of less than this specified 
length will be ignored. 

False 

Minimum angle 
degrees 

Facets containing lines of less than this specified 
length will be ignored. 

False 

Pre-translation scale Scaling factor applied to all entities before translation. 1.0 

Radius of curvature 
to length ratio 

Minimum allowable radius of curvature to line length 
ratio in surface trimming. 

1% 

Parsing error limit Import terminate after specified number of error (0 
indicates no limit). 

2 

Entity types to 
exclude 

List of entity type numbers to ignore (if checked), 
entities of these type numbers will not be translated 
unless they define entities that are to be translated.  

Ignore 106 (copious 
data) and 108 
(plane surface)  

Drawing layers to 
process 

Allows selection of named layers when importing 
DXF or IGES data. 

None 

 Importing Solver datafile data 

Geometry and Mesh data that has been written to a Solver data file may be imported into 

Modeller for particular types of analysis. 

 Point, Line, Surface and Volume geometry data can be imported to create a feature-

based geometry model using the File> Import... menu item.  

 Element data can be imported to create a mesh-only model by using the File> Import 

menu item. When a file is selected the Advanced button can be used to specify import 

parameters. See Model Types for more information. 

Geometry and mesh data from supported interface files can be imported using the File> 

Import... menu item. When a file is selected the Advanced button can be used to specify 

import parameters. After all feature entities have been imported, a feature merge will be 

carried out according to the merge setting defined under Model properties.  

Importing Mesh Data 

Mesh-only models can be created by importing finite element data files created either by the 

prior running of an analysis in LUSAS or, more usually, by importing data files from other 

supported third-party software applications.  
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During the mesh import process, Modeller creates separate Groups for each element type 

encountered. For models created from LUSAS data file these will be familiar LUSAS 

element names. For models created from other software they will be the names used within 

that system, whatever they may be. See Mesh-only models for more information. 

After import the vertical axis for the model may need to be defined to ensure correct 

isometric viewing and loading of the model. 

File Import (Advanced option) 

Only those options applicable to the file being imported will be available for selection. 

Option Description Default 

Create 
material 
groups 

Create named groups for elements in the data file having the same material 
property. A maximum number of groups can be specified and if more groups 
are created the number specified only the most common element groups in 
the model will be created. This option is for use with LUSAS Solver data files 
and Nastran bulk data files only. 
  

False 

Exporting Model Data 

Model data can be exported to a chosen interface file format by using the File> Export menu 

item.  

Export options 

Depending upon the export file format chosen all, or some of the following export options 

will be available for a selected analysis: 

 Current window 

 All 

 Visible  

For exporting to a LUSAS V13 CMD file an analysis entry must additionally be chosen.  

And the following features may be exported: 

 Geometry and Mesh (excluding volumes) 

 Geometry and Mesh (including volumes) 

 Geometry Only 

 Mesh only (excluding volumes) 

 Mesh only (including volumes) 

 Nodes Only 

 Deformed mesh factor (only accessible when a results file is loaded) The mesh may 

be tabulated with node coordinates computed from the deformations in the active 

loadcase multiplied by a specified factor. This is useful when the deformed mesh 

caused by one analysis is to be used as the starting point for a further analysis. 
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DXF Interface Files 

The AutoCAD Drawing eXchange Format or DXF file, as it is more commonly known, can 

be used to import and export data to and from LUSAS. 

DXF Import 

DXF files are imported using the File> Import...  menu item. 

DXF entities supported by the LUSAS DXF import facility are listed in the table below. 

DXF Entity 
   

Imported as LUSAS Feature 

POINT 
  

Point. 

LINE 
  

Straight Line. 

3DLINE 
  

Straight Line. 

ARC 
  

Arc Line. 

CIRCLE 
  

Two arc Lines. 

POLYLINE 
  

Spline Line. 

SOLID 
  

Straight-edged Surface. 

3DFACE 
  

Straight-edged Surface. 

TRACE 
  

Straight-edged Surface. 

POLYGON MESH 
  

Multiple straight-edged Surface. 

POLYFACE MESH 
  

Bicubic Surface. 

EXTENDED ENTITIES 

  
  

Not supported. 

Tip. Units and entity orientation can be modified by defining a local coordinate and making 

this active before importing. For example, the units may be changed from mm to m during 

conversion by defining a scale local coordinate with X, Y and Z scale factors of 1e-3. The 

entity orientation may be changed from landscape to portrait with the aid of an XY rotation 

local coordinate with an angle of 90 degrees. 

Notes 

 The amount of information which may be transferred via the DXF file is limited due 

to limitations in the DXF file format (for example, a volume cannot be expressed in 

standard DXF data). 
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 AutoCAD version 13 uses DXF extended entities for some items. LUSAS does not 

support import of extended entities and will warn to this effect if an AutoCAD version 

13 DXF file is detected. 

DXF Export 

A DXF interface file may be created from LUSAS for use in an external program using the 

File> Export... menu item. 

 LUSAS attributes are converted into their equivalent DXF entity. Control over the amount of 

information exported is provided, i.e. All or Visible features and/or mesh may be specified. 

This is valid for both pre-processing model files and results files. The following parameter is 

available on the export dialog to control creation of DXF files: 

 Level Indicator indicates whether Geometry Only, Mesh Only or 

Geometry and Mesh are to be exported. The level indicator is only required when a 

model file is open and features are active. When no model is loaded, such as during 

post-processing, only the mesh is exported. Additional options are available to include 

Volume mesh entities in the export process. Only element faces are exported when 

exporting Volume feature mesh records. 

LUSAS feature types supported by the DXF export facility are listed in the table below: 

 

LUSAS Feature/Mesh 
   

Exported as DXF Entity 

Feature LINE (straight) 
  

3DLINE 

Feature LINE (arc) 
  

ARC 

Feature LINE (spline) 
  

POLYLINE 

Feature SURFACE (straight-edged) 
  

3DFACE 

Feature SURFACE (general curved) 
  

3DLINE/ARC/POLYLINE 

Mesh LINE (linear or quadratic edge) 
  

3DLINE 

Mesh SURFACE (linear or quadratic face) 
  

POLYFACE MESH 

Mesh VOLUME (linear or quadratic face) 
  

PLOYFACE MESH 

Notes 

 The exporting of models generates DXF files containing structural information only. 

This facility is not intended for exchanging graphical information, for this purpose 

picture files should be used. 
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 Only the element faces are exported when exporting volume feature mesh records 

 For further information on the DXF file format, users are referred to the AutoCAD © 

Reference Manual. 

IGES Import / Export 

IGES files are imported from the File> Import... menu item. When a file is selected the 

import process may be controlled from the Advanced button by specifying import 

parameters.  

LUSAS Model geometry may be exported to IGES using the File> Export... menu item. 

Notes: 

 IGES data is made up of a number of discrete surfaces. These need to be merged 

together to create volumes which can then be meshed. 

 When IGES import is used the option to crate hollow volumes is automatically 

invoked. 

 Any active local coordinates will be ignored.  

 All IGES annotation lines and font data is ignored.  

 The IGES interface only supports fixed length ASCII IGES files.  

 All curve and surface geometric type entities are translated into LUSAS Modeller.  
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Supported IGES Entities: 

Entity Description 

100 circular arc 

102 composite curve 

104  conic arc 

106 copious data 

108 plane surface 

110 straight line 

112 parametric spline curve 

114 parametric spline surface 

116  point 

118  ruled surface 

120  surface of revolution 

122 tabulated cylinder 

124 transformation matrix 

126  rational B-spline curve 

128  rational B-spline surface 

130  offset curve 

140  offset surface 

141  trimming line of bounded surface 

142  trimming line of parametric surface 

143 trimmed bounded surface  

144  trimmed parametric surface 

186 B-rep volume 

502 Manifold Brep vertex list 

504  Manifold Brep edge list 

508 Manifold Brep loop 

510  Manifold Brep face 

514 Manifold Brep shell 

Note. Only those found in the selected IGES file are displayed in the exclusions list. 

LMS CADA-X Files 

This data format is used to export data from LUSAS Modeller to the LMS Modal Analysis 

Suite of Software. 
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 When exporting modal data or element matrices, a check for a results file is made. If 

no results are available, the moddat parameter is deselected. The modes for export 

dialog is only displayed if modal data is requested. 

 The mode shapes input dialog will expect the mode shape numbers to be entered in the 

same manner as the SET MODAL MODES command.  

The format is: resultfileID:mode1;mode2;mode-aTmode-bIincrement ... etc. 

 Additional system parameters are required to deal with problems encountered when 

reading the neutral file into LMS. These variables should be set as shown below in the 

Modeller start-up file. The variables are defined as follows: 

 LMSTKV when set forces the THICKV element property keyword to accept the 

#NO_DEF purpose code to describe the property type instead of MEMBRANE, 

PLANESTRAIN, SHELL, PLATE and SHEAR. This is due to an error in the LMS 

parser. 

LMSTKV should be set to 1 to have #NO_DEF output to the neutral file. 

LMSTKV should be unset to have normal codes output to the neutral file. 

The default setting is 0. 

 LMSDMP forces the export routines to only output SPRING and MASS elements and 

properties for joints instead of SPRING, MASS and DAMPER elements and 

properties. This is to work around a limitation in the LMS parser which will not 

interpret the DAMP or DAMPER keywords. 

LMSDMP should be set to 3 to have 3 properties/elements per joint output. 

LMSDMP should not be set to have 2 properties/elements per joint output. 

The default setting of LMSDMP is 2 (2 properties/elements per joint). 

 LMSPRC allows the user to specify single or double precision real number output in 

the neutral file. Using this parameter can reduce the size of the neutral file. The 

differences between the two types of precision is as follows: 

Single precision: +n.nnnnnnE+ee 

Double precision: +n.nnnnnnnnnnnnnE+ee 

Currently LMSPRC can take the following values: 

LMSPRC = 1 Single precision format (default) 

LMSPRC = 2 Double precision format 

LMSPRC = 3 Double precision format on a single precision machine. 

LMS Export 

 Option 290 must be set before tabulating a model to ensure element matrices are 

transferred from LUSAS. 

 Option 290 allows you to instruct LUSAS to output the element STIFFNESS and 

MASS matrices to the .mys plot file. The volume of data transferred can be substantial 

so this option is turned off by default.  

 Nodal Freedoms LMS supports only six degrees of freedom: X, Y, Z, Rx, Ry and Rz. 

If unsupported freedoms are encountered a warning message is issued. If this section is 

not present it will not affect the translation of the neutral file into LMS as long as no 

node statement contains a reference to a #Frnnn freedom label. 
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 Node Coordinates The node co-ordinates are written with the co-ordinate system 

omitted implying the use of the global co-ordinate system. The Modeller node 

labelling scheme is preserved during the export process. 

 Material Properties (mdl file) Isotropic, 2D Anisotropic and 2D Orthotropic 

materials are supported. 3D material properties are exported as ANISO3D, however 

the values are read but not used by LMS. Joint properties are output in the element 

property section of the neutral file. 

 Material Properties (mys file) Material properties are transferred from LUSAS to 

Modeller. If no material properties are detected in the LUSAS mys file, then dummy 

material properties are set-up and a warning is issued. Materials can be used in LMS to 

group common elements together. The dummy properties allow the other model 

description entities (element topology) to be read by the LMS parser. 

 Element Properties (mdl file) The LMS element properties supported are PBAR, 

STIFF, PMASS, BEAMG and THICKV. The corresponding Modeller geometric 

properties are mapped into the expected LMS format. Supported Modeller property 

types are as follows: Bar/Link, Beam, Membrane/Plate/Shell. Beam and joint 

eccentricities are ignored. Checks for unsupported element properties are made and a 

warning is issued if any are found. Unsupported element properties are not output. 

 Element Properties (mys file) Modeller geometric properties from the mys file are 

transferred and output into the LMS neutral file. The same constraints as for the mdl 

file apply. 

 Element Topology Elements are output in element type order. Material properties 

must be specified for all elements, but LMS element properties for solid elements are 

optional. Checks for unsupported elements are made and a warning is issued with the 

unsupported elements not written to the neutral file. Beam elements which have end 

freedoms released are output to the neutral file, but the node freedoms are not 

transferred as they may not be valid for all connections to a node. Supported elements 

are shown in the table below. 

 Eigenvectors and Frequencies Node displacements for all nodes specified in the 

model description are output to the neutral file in the global co-ordinate system. When 

mode shapes are read by LMS, the mode shape numbers will not necessarily be the 

same unless all eigenvectors are exported. Modeller mode shape numbers are 

preserved during an export, but are not preserved when read into the LMS software. 

 Element Matrices The element matrices (stiffness and mass) are output in element 

type order. There are three sections required to define a matrix. These are MATSHP, 

MATVAL and MATDEF.  

By definition elements of the same type have the same matrix shape, therefore for each 

element type there is only one MATSHP keyword. However, each element matrix contains 

different values and hence gives rise to one MATVAL and MATDEF statement per element 

matrix. To reduce the amount of matrix data output to the neutral file, and to keep its size to a 

minimum, only the non-zero (active) columns of the element matrices are processed. 
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Supported Elements 

The following elements are supported by LMS. 

Bars Beams Plates, Shells, Membranes Solids Joints 

    Triangular Quadrilateral Tetra Penta Hexa   

BAR2 BEAM TPM3 QPM4 TH4 PN6 HX8 JF3 

BAR3 BMS3 TPM6 QPM4M TH4E PN6E HX8M JPH3 

BRS2 BRP2 TPM3E QPM4E TH15 PN15 HX20 JRP3 

BRS3 GRIL   QM8       JNT3 

    TF3 QF4       JNT4 

    TTF6 QSC4         

    TRP3 QTF8         

      RPI4         

    TS3 QSI4         

    TTS3 QTS4         

    TTS6 QTS8         

    TSM3 SMI4         

NASTRAN BDF and DAT Import 

Data from NASTRAN Bulk Data Files (.BDF) or DAT (,dat) files can be imported to create a 

feature-based geometry model using the File> Import... menu item or a mesh-only model by 

using the File > Import Mesh menu item. When a file is selected the Advanced button can 

be used to specify import parameters. See Model Types for more information. 

ABAQUS Input File Import 

Data from Abaqus Input Files (.inp) can be imported to create a feature-based geometry 

model using the File> Import... menu item or a mesh-only model by using the File > Import 

Mesh menu item. When a file is selected the Advanced button can be used to specify import 

parameters. See Model Types for more information. 

ANSYS CDB File Import 

Data from ANSYS CDB Files (.CDB) can be imported to create a feature-based geometry 

model using the File> Import... menu item or a mesh-only model by using the File> Import 

Mesh menu item. When a file is selected the Advanced button can be used to specify import 

parameters. See Model Types for more information. 
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PATRAN Interface Files 

About PATRAN 

The PATRAN neutral file contains the full finite element model information. The Neutral file 

is split into two data categories: Phase I contains the definition of the geometric entities, and 

Phase II contains all of the finite element (node and element) information. 

PATRAN Import 

PATRAN files are imported using the File> Import... menu item.  

Phase I data (geometric entities) is read from the PATRAN neutral file. Phase II data is 

ignored. The following table shows the supported Neutral file packet types for import into 

LUSAS: 

Packet 
   

Title 
   

LUSAS Equivalent 

25   Title   Used for information purposes only. 

26   Time/Date/Version   Used for information purposes only. 

31   grid   Point. 

32   line   Spline Line defined by 2 Points. 

33   patch   Bicubic Surface defined by 4 spline Lines. 

34   hyperpatch   Volume. 

47   trimmed surface   Bicubic Surface and spline Lines defining the trimmed regions. 

Tip. Imported PATRAN data is particularly suited to tidying, since all defined geometry is 

spline data. See Tidying Imported Lines and Surfaces for more details. 

PATRAN Export 

Export of LUSAS data to PATRAN was last supported in LUSAS V14.3 

Exporting a Solver data file 

The File> Export Solver datafile... menu item is intended to export Solver datafiles for 

solution on another computer. It provides the means to select which analyses and loadcases 

are written to a solver data file for all or only visible elements, without any solving taking 

place.  

 The data written to a Solver data file can be controlled according to the following: 

 Analysis Choose the Analysis type to be tabulated. 

 Loadcases / Influences Choose All loadcases or selected Specified loadcases for 

tabulation 

 Elements Choose All elements, Selected elements or only those Visible elements for 

tabulation 
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Controlling the content of a LUSAS Solver Output File 

Advanced export (solution) options are accessed from the Advanced button on the Export 

Solver datafile dialog. 

By default no results are written to the LUSAS output file. Results can however be written to 

the output file for All elements and nodes, or for those in the current Selection or Selection 

Memory. The following options allow the results written to the output file to be specified. 

 Element results such as stress and strain (as controlled by the LUSAS Solver options 

set from the File> Model Properties menu item) can be written to the output file at 

Node and/or Gauss points and also written to a history file if required. 

 Node displacements and reactions can be written to the output file and a history file 

can also be written if required. 

 Generate plot file If selected configures the LUSAS Solver data file to create a plot 

file (mys). (default) 

 Generate restart file If selected configures the LUSAS Solver data file to create a 

restart file (rst). 

Notes 

 Prior to Version 15.0 this menu item was named File> LUSAS Datafile 

 During the tabulation process progress will be reported to the Text Window. If 

problems are encountered warnings and/or error messages will be displayed in the 

same window. Such warnings and errors can be caused by inconsistencies in the 

model data which may produce erroneous analysis data files. These errors should be 

acted on before continuing with an analysis. 

 LUSAS is configured to run the majority of analyses without the need to adjust the 

system parameters. In some circumstances however it may be necessary to adjust one 

or more of these parameters. System parameters may be modified from within the 

File> Model Properties using the Defaults tab. Modified parameters will be 

tabulated in a SYSTEM chapter at the start of the LUSAS Solver data file. 

STEP Import / Export 

STandard for the Exchange of Product data (STEP) files are imported according to Part 42 of 

the Geometric and Topological Representation by using the File> Import... menu item. 

When a file is selected the import process may be controlled by clicking the Advanced button 

and specifying appropriate parameters.  

LUSAS model geometry cannot currently be exported to a STEP file. 

STL Import / Export 

STL files are used by Stereolithography software. They hold information needed to produce 

3D models on Stereolithography machines. 
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STL files are imported using the File> Import... menu item. When a file is selected the 

import process may be controlled from the Advanced button by specify the parameters.  

LUSAS Model geometry may be exported to STL format from the File> Export... menu 

item. 

Notes: 

 STL data defines vertices of triangles that define the shape of a surface. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Modeller Reference Manual   

    

84 

 

 

 

 

 

 

 

 

 

 



  Chapter 4 

    

85 

Chapter 4 : Model 

Geometry 

  

Introduction 

There are four geometric feature types in LUSAS to which attributes such as a mesh type, 

geometric properties, material, supports and loading can be assigned: 

 Points define the vertices of the finite element model. 

 Lines define the edges of the finite element model. (Combined Lines define edges 

built from a series of continuous lines). 

 Surfaces define external faces or internal construction surfaces of a model. 

 Volumes define simple solid components of a model. 

Features are defined hierarchically , i.e. Points define Lines, Lines define Surfaces, Surfaces 

define Volumes. 

If higher order features are created using techniques which do not involve lower order 

features, for example, by specifying coordinates, Modeller will automatically generate the 

lower order features from which to define them. Furthermore, due to feature associativity, 

when a lower order feature, for example a point, is moved, the higher order features defined 

by it, for example a line, is also moved. 

Features may be deleted from the model provided they are not referenced by a higher order 

feature. For example, a Line may not be deleted if it is used in a Surface definition. 

Geometry creation 

Geometry can be created by using a relevant Geometry menu item for each geometric feature 

type, or be imported from other systems. See Importing Geometry Data. 

Notes 

 Attributes are assigned on a feature basis, therefore the positions of geometric and 

material discontinuities, supports and loads must be carefully considered when 

defining the features. 
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 By default, coordinates are expressed in terms of a global Cartesian axis system. Local 

coordinates may be used by setting a pre-defined local coordinate active. This is 

achieved by defining a local coordinate and choosing the Set Active command on the 

context menu. See Local Coordinate Systems. 

 Modelling units used to define coordinates and lengths can be input and reported in 

feet and inches, instead of just feet or just inches. For example, a distance can be input 

and output as 5'11.5", whereas in previous versions it had to be either 71.5" or 5.92'. 

On dialogs with grid cells expecting dimensional input, the units expected are 

displayed as a data tip when the cursor is hovered over the input cell. 

Visualising Geometry 

There are a number of ways to visualise geometry all of which are controlled from the 

Geometry  layer properties activated from the Geometry layer context menu. The 

Geometry layer controls the display of all geometry. If the Geometry layer does not exist or is 

hidden by another layer the geometry will not be drawn.  

Show Geometry 

The Geometry layer properties may be set to not show certain geometry types. To aid 

visualisation Points, Lines, Combined Lines, Surfaces and Volumes can all be independently 

not shown as required.  

Note. Not showing a geometry type is not the same as making all items of that type invisible 

as the presence of that geometry will affect the visibility of lower order features. (i.e. A Line 

can not be made invisible if a Surface using that line is not shown (visible but not drawn) 

because the drawing of Surfaces has been suppressed in the Geometry layer properties). 

Display Style 

Geometry can be displayed in a number of styles. By default Geometry is viewed in 

wireframe mode with hidden parts shown but a wide variety of styles can be obtained by 

mixing the options for wireframe with and without hidden line and solid plots. Some 

examples follow: 
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Default wireframe geometry visualisation Wireframe with hidden Parts removed 

 
Wireframe with hidden parts draw dashed 

 

Solid fill with wireframe and hidden parts removed 

 
Solid fill with wireframe (hidden parts removed) and Points hidden 

Facet Density 

By default lines and surfaces are assigned a facet density which is used in visualisation. Facet 

density effectively controls how smooth a line or surface will look when drawn to the screen. 

Straight lines, arcs and splines are all drawn using facets of a particular line length. Surfaces 

are drawn using facets that are triangular. The default facet density may be changed prior to 

geometry definition from the Geometry tab of the Model Properties dialog or after 

geometry definition by selecting the appropriate Lines and Surfaces and modifying the facet 

density from the  Geometry> Surface> Facet density or Geometry> Line> Facet density 

menu items. 
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The facet density may be specified either as: 

 Maximum facet length (in model units). 

 Maximum deviation d (in model units). 

or for Lines as: 

 Minimum adjacent angle (in degrees). 

 Minimum number of facets for straight line, full arc line and 

spline line. 

or for Surfaces as 

 Minimum number of facets for planar surface, surface with 

seam and other surfaces. 

 

Note that facet density only affects the display of the geometric feature and not the actual 

geometric accuracy of the model. 

Notes  

 The display speed is inversely proportion to the number of facets used to define the 

geometry. 

 The facet density can be visualised by selecting the Facet option on the Geometry 

Layer properties dialog. The facet density display can be restricted to only selected 

Lines and Surfaces using the Facet only if selected option. 

Using Colour For Geometry 

The colour in which geometry is drawn may be specified in many ways.  

From the Geometry layer properties specify Colour by: 

 Own colour An individual feature may be drawn in a pen different from the default 

geometry type pen. The pen is specified on the properties dialog. Select the single 

feature and right click then choose Properties to display the feature properties. Until a 

pen is set for an individual feature, that feature will be drawn using the default pen. 

 Normals Surfaces are coloured according to whether they are orientated showing the 

top or bottom of the surface. 

 Assignment Features are coloured according to which attribute is assigned to them. 

Features with no attribute assigned are drawn in grey. The picture below shows an 

example of this 

 Group Features are coloured according to which group they are in. Features not in a 

group are drawn in grey 

 Type Each geometry type has a default pen, associated with it. This option causes all 

geometry to be drawn in that pen. The colours may be set from the Model Properties. 
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By default the settings are red for Points, magenta for Lines, orange for Combined 

lines, green for Surfaces, blue for Volumes. 

 Line / Surface Connectivity Features are drawn in colours according to the number of 

higher order features connected to them and areas of the model that have not been 

merged together correctly after import are highlighted by being drawn in a different 

colour. One example of use is for checking models created from the import of 

3D CAD data where the use of this option would enable any surfaces that were not 

correctly forming volumes to be seen. Use of the merge facility would correct any 

unmerged and isolated features. 

 

Orientation Axes 

Orientation axes may be viewed as a local axis set for Lines, Surfaces and Volumes . The 

local x, y and z axes are shown, with a double arrowhead on the x axis and a single arrowhead 

on the y axis and no arrow head on the z axis.  

When features are meshed, the orientation of the feature determines the orientation and 

spacing of the elements. Therefore the orientation of Lines, Surfaces and Volumes can be 

changed by reversing or cycling the features. See Changing Geometry Orientation for more 

details. 

In all of the following illustrations the local axes are orthogonal. 

 Line directions can be drawn to indicate the local x 

direction of Line or axes can be displayed.  
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 Surface axes or surface normals can be displayed. 

Axes are positioned adjacent to the first Line in the 

Surface definition. In the example shown the axes 

are orthogonal but viewed from an angle to show 

the z axis orientation. 

 

 Volume axes can be displayed. The origin or the 

axis is closest to the first point in the first Surface 

of the Volume definition. 

 

Tip: To aid axes visualisation on larger models choose the Orientations only if selected 

option. This will display axes only on selected features. 

Labels 

Labels can be added to the view of a model from the View> Insert Layer> Labels menu 

item, or from the window context menu. The label options are controlled from the labels 

property dialog. 

Labels may be added to geometry features as follows: 

 Name 

 Position 

 Mesh 

 Geometry 

 Material 

 Supports 

 Loading 

 Transformed freedoms 

 Composite 

 Slideline 

 Constraints 

 Thermal surfaces 

 Retained freedoms 

 Damping  

 Activate 

 Deactivate 

 Equivalence 

 Search area 

 Influence 

 Age 

 Tendon 

Node, element and Gauss point labels may also be displayed. 
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Notes 

 Line labels for standard Lines are drawn at 3/4 distance from the start of the line. This 

can be a useful indication of the line orientation.  

 If a Line is used as part of a Combined Line definition, the Line label is located at 

8/10 distance and the corresponding Combined Line label is located at 6/10 distance 

along the Line segment. This is to avoid the labels overwriting each other. 

 For complex models labels may be displayed only on selected features by choosing 

the Label selected items only option on the label properties dialog. 

Points 

Points define the vertices of a model and are used in the definition of lines. Point geometry is 

defined from the Geometry> Point menu item, or by the use of the New Point toolbar icons. 

Line types available are:. 

 Coordinates Defines a Point by entering the X, Y and Z coordinates (Z is optional). If 

a non-Cartesian local coordinate system is in use the coordinates are specified in the 

coordinate system of that local coordinate set. The dialog box labels will be updated to 

reflect the required coordinate input. 

 Cursor Allows definition of a series of Points on the screen with the cursor. The 

Points can snap to a grid in the XY, YZ or XZ plane. The out of plane ordinate can be 

specified as non-zero if desired. This facility is useful for positioning Points on Lines 

or Surfaces which will be used for splitting that feature later. 

 From Mesh Defines a Point at the position of every node of the selected mesh.  See 

Geometry From Mesh. This is useful for defining a Point feature to which loads or 

supports can be subsequently assigned. The Point must be equivalenced with the 

underlying meshed feature in order for the Point's assigned attributes to be transferred 

to the underlying nodes. Subsequent re-meshing of the structure with different mesh 

spacing characteristics may result in movement of the 

underlying nodal positions.  

 By Intersection Defines a Point or a number of Points at the 

intersections of two or more selected Lines. When the Lines 

selected do not physically intersect Points may be created at 

the nearest intersections. These nearest intersections are 

controlled by the following options.  

 All point pairs creates Points at all possible 

intersections. 

 Nearest point pair only creates a Point on each line where the projection of 

the Lines is at its nearest. 

 Nearest pair to reference position defines Points on each line at the 

intersection nearest to the defined reference Point. 
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 Limit distance between points only creates Points at intersections that are 

within a specified distance 

 Allow extended lines will create Points at the intersection of the extension of 

the selected Lines. 

 By Projection Defines a Point at the (perpendicular) 

projection of a selected Point onto a selected Line or 

Surface. 

 By Extension Defines a point at the extension of a selected 

Line. The extension may be defined as a parametric or actual 

length. 

 Make Planar moves the selected points onto a plane defined 

either as an offset from an orthogonal plane, or onto a plane 

defined by 3 coordinates, or as a best fit to the selected points. A local coordinate may 

be used to define the orthogonal axes if required. 

  

Case Study. Editing Point Properties 

By selecting a single Point, then right-clicking to display the context menu, properties 

relating to that Point can be displayed. From an individual Point’s properties the 

coordinates can be altered, and attribute assignments may be manipulated.  

  

Lines 

Lines connect point features and are used in the definition of surfaces. Line geometry is 

defined from the Geometry> Line menu item, or by the use of the New Line toolbar icons. 

Line types available are: 

 Line defined by two Points. 

 Arc/Circle defined by two Points and a Line map ( a means of selecting the meaning 

of a third definition point) 

 Spline defined by two or more Points. 

 Lines may also be created by Splitting lines, and Intersecting with other lines 

Additionally, these other lines may, during the modelling process, be created as a result of 

editing the geometry: 

 Elliptical Arc/Ellipse 

 Composition Line defined by a Line and Surface map. 

 Intersection defined by two Surface maps. 

 Isoparametric 

Line geometry is defined from the Geometry> Line menu item. 
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General Line Definition 

 Coordinates Defines a Line by entering the X, Y and Z coordinates. Entering more 

than two coordinates will define linked Lines. If a non-Cartesian local coordinate 

system is in use the coordinates are specified in the coordinate system of that local 

coordinate. 

 Cursor Allows definition of a series of straight Lines on the screen with the cursor. 

The Lines can snap to a grid in the XY, YZ or XZ plane. The out of plane ordinate can 

be specified as non-zero if desired. 

 PointsDefines a Line from selected Points. A dialog is displayed to specify the Line 

type as either Straight Line(s), Arc, or Spline. 

 Tangent > Point to Line Defines a Line between 

a selected Point and the tangent to a selected Arc. 

An error will occur if no tangent is possible. In this 

example Line 2 is created by specifying Line 1 and 

Point 4. Point 5 is automatically created. 
 

 Tangent > Line between Arcs Defines a Line 

which is tangent to two coplanar Arcs. The new 

Line can be defined as an inside or outside tangent. 

Options are available to split the Arcs at the new 

Points, and then delete the original Arcs. 
 

 By Sweeping Defines a Line by sweeping a Point 

through a transformation (translation, rotation, 

mirror or scale). In this example Line 1 is created 

by sweeping Point 1 through a translation in X 

and Y. 

 

 By Offsetting Defines a Line or series of Lines 

offset from a selected Line or series of Lines. If 

multiple Lines are selected a new set of Lines can 

be offset in one operation. The direction of the 

generated lines can be controlled by selecting a 

point in the direction of the new lines required, 

prior to selecting the lines to be used for 

offsetting.. If multiple Lines are selected the 

outside fillets may be created with arcs or straight 

Lines. 
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 By Joining Defines a number of Lines by joining 

two sets of Points. Points put in selection memory 

define the start of each Line, and Points selected in 

a subsequent 'normal' selection define the end of 

each Line. The Points must pair up equally. Lines 

are joined according to the order in which the 

Points were selected, (or Point number when 

boxing a selection), i.e. first point in selection 

memory joins to first point in the selection, etc. In 

this example Lines 1 to 3 were defined, by first 

adding Points 1 to 3 to selection memory, then 

selecting Points 4 to 6, and then using this 

command. 

 

Note also that a fan of lines from one point to 

many others can be created by setting one point 

only in selection memory prior to selecting the 

other set of points in a 'normal' selection. This is 

useful for creating lines to represent the cables 

radiating from the top of a tower to the deck on a 

cable stayed bridge for example.  

 

    

 By Intersection Lines may be defined by 

intersecting two or more Surfaces. Intersects all 

Surfaces within a single selection with all other 

Surfaces within that selection. If no intersection is 

found a warning will be issued. 

 

 By Manifolding (via projection) Existing Lines 

may be projected or laid onto an existing Surface. 

A Surface to be projected onto is selected, 

followed by the Line to be projected and the 

Geometry> Line> By Manifolding menu item is 

used to create the new manifolded Line. The new 

Line is created in the plane of the surface.  

  

 By Manifolding (via Point creation) Lines can 

also be created directly onto a Surface by creating 

points lying on a surface (use the Geometry> 

Point> Cursor menu item to snap points, as for 

instance to a curved surface as in the example 

shown) prior to using the Geometry> Line> By 

Manifolding  menu item to create the manifolded 

line. Points created prior to choosing the command 
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can be, but do not have to be, on the boundary of 

the Surface. In this example Points 7 and 8 lie 

within the Surface boundary, while Points 13 and 

14 lie on the boundary. 

 From Mesh Defines a Line based upon points at 

the position of every node of the selected mesh 

elements.  See Geometry From Mesh.  

  

Arc and Circle Definition 

Arcs and circles are defined from the Geometry> Line> Arc/Circle menu item. 

  From Coords/Points Coordinates can be entered manually or taken from selected 

Points. The coordinates define the arc in one of three ways: 

 Start Point, Bulge Point and End Point 
Defines an Arc or  Circle which passes 

through three coordinate points. In this 

example Line 1 is defined by selecting 

Points 1, 2, 3 and specifying Point 2 as the 

‘bulge’ point. Line 2 is defined by 

selecting P4 and P5, then entering the 

coordinates to define a ‘bulge’ Point, P6 

(which is not actually created) 

 

 Start Point, Directional Point, End 

Point, and Radius Defines an Arc or 

Circle between two coordinate points, to a 

specified radius. A third coordinate point 

is required to indicate the direction in 

which the arc or circle bulges. In this 

example arcs are created from Point 1 to 

Point 2 with a radius of R, using Direction 

Point 3. Choosing Minor Arc creates Line 

1, while choosing Major Arc creates Line 

2. A Major Arc subtends an angle greater 

than 180 degrees at the arc centre, while a 

Minor Arc subtends an angle less than 180 

degrees. 
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 Start Point, Centre Point and End Point 
Defines an Arc or Circle between two 

coordinates, with a third coordinate 

defining the centre of the arc or circle. The 

centre must be equidistant from the start 

and end points. In this example arcs are 

created by selecting Points 2, 3, 4 with 

Point 3 as the arc centre. Choosing Minor 

Arc defines Line 1. Choosing Major Arc 

defines Line 2 (dotted line for clarity). 

Note that the centre point is not linked to 

the line, so the geometry will not update if 

it is moved. 

 

 Tangent to Lines Inserts an Arc or Circle with a 

specified radius, tangent to two selected Lines. 

The selected lines must be straight Lines or Arcs. 

In this example Line 3 is created by selecting 

Lines 1 and 2, then specifying a radius and Minor 

Arc. Alternatively, Line 4 is created by selecting 

Lines 1 and 2, then specifying a different radius 

and Major Arc. 

 

 By Sweeping Points Defines Arcs by sweeping 

selected Points through a specified rotation. In this 

example Point 1 is swept into Line 1 using a 

rotational transformation and choosing the Minor 

Arc option. 

 

Spline Definition 

Spline Lines are defined from the Geometry> Line> Spline menu item. 

Note that the inetrmediate points used to create a spline are not linked to the spline, so the 

geometry will not update if these points are moved. 

 By Points Defines a spline from three or more selected Points. 
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 Points and End Tangents Defines a Spline 

passing through two or more selected Points. The 

end directions are defined by entering end tangent 

vectors. In this example Line 1 is defined by 

specifying Points 1;2 and inputting start and end 

tangents by vectors (1, 0, 0) and (0, -1, 0) 

respectively. Both the direction and length of the 

end tangents control the spline shape. In this 

example, a different shape of spline would be 

defined, passing through the same Points, if the 

end tangents were changed to (3, 0, 0) and (0, -0.5, 

0) respectively. 

 

 Tangent to Lines Defines a Spline passing 

through two or more selected Points. The Spline 

end vectors are taken from the directions of two 

selected Lines. The tangent Lines do not have to 

connect with the Spline. In this example Line 3 is 

defined by selecting Points 2, 3, 4, 5 to define the 

path, and Lines 1 and 2 as end tangents. 
 

Splitting Lines 

Lines may be split at a Point, or split into a number of equal or unequal divisions to form new 

Lines. The splitting Lines dialogs contain options to automatically split and delete the original 

Lines, and to replace the split Lines with Combined Lines. Note that when splitting Lines the 

original Line can only be deleted if it did not define any Surfaces, or if the 'Use in dependent 

Surfaces' option is selected. As a further option a combined line may be created. This is 

useful if a regular mesh is required. 

Any attributes assigned to a feature that is split will be automatically assigned to the new 

features created. 

Line splitting commands are accessed from the Geometry> Line> By Splitting menu item. 

 At a Point Splits an existing Line into 

two new Lines at a selected Point on 

the Line, Spline or Arc. A splitting 

tolerance can be set to increase the 

allowable distance between a Point 

and the Line being split. In the 

example here Line 3 is split at Point 5 

into 2 new component Lines defining 

Combined Line 5. Line 3 is also 

replaced in the definition of Surface 1. 
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 In Equal Divisions Splits an existing 

Line into a specified number of equal 

divisions. A new Line is defined at 

each division. In the example shown 

Line 1 is split into 4 new Lines of 

equal length, and the original Line is 

deleted. 
 

 Parametric or Actual Distance Splits 

an existing Line into a number of 

divisions based on specification of 

parametric distance values along the 

Line. The direction of the existing line 

is used to calculate the splitting 

positions. A new line is created at 

each division. In this example Line 1 

is split at a parametric distance of 

0.75. Line 2 is created at 3/4 of the 

original length and Line 3 at 1/4. 

Specification of a parametric divisions 

list as 0.1;0.5;0.75 will split a line at 

1/10, 1/2 and 3/4 distance into 4 new 

lines. 

 

Combined Lines 

A Combined Line is a Line which is composed of several continuous individual Lines. 

Combined Lines may be used in exactly the same was as other Lines to allow Surfaces, to be 

meshed using regular mesh patterns. This is especially useful for meshing surfaces defined by 

more than four Lines. 

Combined Lines are defined from the Geometry> Line> Combined Line menu item.  

 Lines Defines a Combined Line 

from two or more selected Lines that 

are continuous but do not form a 

closed loop. Any number and type 

of existing Lines can be used to 

define a Combined Line. In the 

example here Lines 3 and 4 are used 

to define Combined Line 6. Lines 3 

and 4 are replaced in the definition 

of Surface 1. 
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Notes  

 Automatic numbering uses the next highest available number for Lines or Combined 

Lines. 

 Mesh attributes may not be assigned to Combined Lines, but must be assigned to the 

Lines defining the Combined Line. 

 Using Combined Lines in the definition of Surfaces provides an additional means of 

producing transition meshes. 

 

Case Study. Using Combined Lines 

Combined lines may be used in a surface definition in order to use a regular mesh. 

1. Define a Surface using the New Surface button , and enter the coordinates (0,0,0), 

(100,0,0), (120,20,0),  (100,100,0) and (0,100,0). 

2. Define a Line mesh attribute (using Attributes> Mesh> Line) with of element type 

None with mesh divisions of 1 and assign it to the shorter Line on the left hand side of 

the surface. 

3. Define a Line mesh attribute (using Attributes> Mesh> Line) with of element type 

None with mesh divisions of 3 and assign it to the longer Line on the left hand side of 

the surface. 

4. Define a Surface mesh attribute using (using Attributes> Mesh> Surface)  with 

Plane Stress, Quadrilateral, Linear elements and assign it to the surface. This will 

automatically select an irregular mesh for a five-sided Surface as shown below.  

5. Now define a Combined Line by selecting the Lines on the left hand side of the model 

and press the  button from the Line menu item. 

6. Since the Surface definition has been altered the Surface will be remeshed. A regular 

mesh will now be adopted because the line divisions on the Combined Line match 

those on the opposite Line.  

Irregular Mesh 

A regular Surface mesh using Plane Stress, 

Quadrilateral, Linear elements is assigned 

to the Surface with the resulting mesh 

shown. (An irregular mesh is used as 

surface does not have 3 or 4 sides). 

Regular Mesh Using Combined Lines 

The lines on the right hand side are used to 

define a Combined Line. A remesh occurs 

because the surface has been redefined and a 

regular mesh is generated because the surface 

is now defined with 3 Lines and 1 Combined 

Line. 
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Surfaces 

Surfaces define the faces of a model and are used in the definition of volumes. Surface 

definition commands are found under the Geometry> Surface menu item. Surface types are: 

 Regular defined by 3 or 4 Lines. 

 Irregular defined by 5 or more Lines. 

Note. For meshing purposes an irregular surface can be considered to be a regular surface 

using Combined Lines. 

Surface Definition Commands 

The following commands are for defining Surfaces directly: 

 By Coordinates Defines a Surface by entering a list of X, Y and Z coordinates (Z is 

optional). If a non-Cartesian local coordinate system is in use the coordinates are 

specified in the coordinate system of that local coordinate. Coordinates can be entered 

using global (default) or local coordinate systems. 

 By Cursor Allows definition of a series of flat rectangular Surfaces on the screen with 

the cursor. The Surfaces can snap to a grid in the XY, YZ or XZ plane. The out of 

plane ordinate can be specified as non-zero if desired. 

 By Points Defines a Surface from three or more selected Points. A Surface can be 

defined from any number of Points. 

 By Lines Defines a Surface from the selected Lines. When defining Surfaces in this 

way, any number of Lines may be specified in any order and a Surface will be formed 

from the greatest number of lines that form a closed loop. If a number of disconnected 

Lines are selected a Lofted Surface will be created. A lofted Surface is defined as 

Surface with a smooth transition between 2 or more Lines. 

 From Mesh Defines a Surface based upon lines and points at the position of every 

node of the selected mesh.  See Geometry From Mesh.  
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Surfaces generated from selected Lines 

 

 

Lofted Surface generated from selected Lines 

Note: The direction in which the Surface is defined is used to define the Surface orientation, 

The surface orientation is used at a later stage to define element normals and local loading 

directions. 

Coalescing Surfaces  

Two or more surfaces can be reduced to one surface defined by lines or combined lines if the 

surfaces share a common line. 

Creating Holes in Surfaces 

Geometry> Surface> Create Holes 

 Create Defines a hole or number or holes in a Surface. Closed loop(s) of Lines or the 

Surface(s) representing the hole(s) and the Surface to be holed should be selected prior 

to choosing this menu option. 

 Move Moves or modifies selected hole(s) within a Surface. To move a hole select the 

Lines and/or Points forming the perimeter of the hole. If only some Lines or Points are 

selected the hole will be stretched by only moving the selected features. Note. Moving 

a hole actually deletes the original hole and recreates a new hole. This means the 

feature numbers of the Points and Lines will not be maintained. 

 Copy Creates multiple holes within a Surface. 
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 Delete Deletes the selected hole(s). The hole boundary lines may be deleted, retained 

as Lines or used to create new Surfaces. 

 Delete All Deletes all holes from a selected Surface. The hole boundary lines may be 

deleted, retained as Lines or used to create new Surfaces. 

  

Case Study. Creating a Surface with Holes 

It is often convenient to create a Surface with embedded holes rather than create a number 

of Surfaces around a hole. To create a single Surface with a number of holes carry out the 

following: 

1. Create the outer Surface and a defined a separate 'inner' Surface for each hole. 

2. Select all Surfaces. 

3. Use the Geometry> Surface> Holes> Create menu item to create a single 

Surface with holes. Ensure that the Delete geometry defining holes option is 

chosen to remove the original 'inner' Surfaces defining the holes. The lower-order 

points and lines of those surfaces will be re-created because they are required 

define the inner boundaries of the enclosing surface. 

 

Redefine Perimeter 

A Surface perimeter may be modified by selecting the Surface and the new boundary Lines. 

The new Surface perimeter will be created from a closed loop of Lines formed from the old 

Surface perimeter and the new boundary Lines. The perimeter of the Surface will be defined 

from the closed loop of Lines with the maximum number of segments. If two possible loops 

of Lines have the same number of segments a additional Line from the existing Surface 

boundary should be selected to resolve the ambiguity.  

  

Case Study. Redefine Surface Perimeter 

To redefine the perimeter of a Surface use the following 

steps. 

1. Create a Rectangular Surface. 

2. Define the new perimeter with Lines which start 

and finish at existing Points on the Surface. 

3. Select the Surface and the new perimeter Lines.  

4. Use the Geometry> Surface> Redefine 

Perimeter>Redefine menu item to define the new 

Surface perimeter.  
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Sweeping Surfaces 

 By Sweeping Defines a Surface by sweeping a selected Line through a transformation 

(translation, rotation, mirror or scale). 

Line 1 is swept using an X and Y translation to 

create Surface 1: 

A cylindrical Surface is defined by sweeping 

Line 1 through a rotation: 

 

  

 

Offsetting 

 By Offsetting Defines a Surface at a 

specified distance normal to a selected 

Surface. The positive offset direction is 

defined by the Surface normal unless an 

additional Point is selected. 

 

Splitting Surfaces 

Surfaces may be defined by splitting an existing surface in a number of ways using the menu 

items under Geometry> Surface> Splitting. Surface splitting commands contain an option to 

automatically delete the old Surfaces and Lines which have been split. Attributes assigned to 

the split feature will automatically be assigned to features of the same type created during the 

split process. The following splitting methods are supported. 
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 By Line Splits a selected Surface at an existing Line. The 

end Points of the Line must lie on different boundary 

Lines of the Surface. It is advisable to split curved 

Surfaces using Lines that are manifolded over the 

Surface. In the example shown here, the original Surface 

is split at Line 5. Points 5 and 6, defining Line 5, must lie 

on the original Surface boundary Lines. 
 

 By Points Splits a selected Surface at two boundary 

positions indicated by Points. A new Line will be 

manifolded onto the existing Surface and the Surface will 

be split at this Line. In the example shown, Surfaces 2 and 

3 are created in the parametric space of the original 

Surface using the Points on the boundary. The new Line 

is manifolded onto the original Surface. 
 

 At a Point Splits a selected Surface at a single Point 

defined on the surface inside the boundary. Four new 

Surfaces are created by manifolding straight Lines or arcs 

onto the existing Surface using the relative position of the 

splitting Point. In this example, the original Surface is 

split at Point 5. The resulting Surfaces (2-5), use 

parametric space to calculate boundary Point positions.  

 In Equal Divisions Splits a selected Surface into separate 

Surfaces at a specified number of equal divisions. The 

direction of the split is expressed using local Surface 

axes. In the example shown here, the original Surface is 

split in its local x direction into equal divisions forming 3 

new Surfaces. 

 

 At Parametric Distances Splits a selected Surface into 

separate Surfaces at specified parametric divisions. For 

example, specifying the parametric distances as 0.25 and 

0.75 will split a Surface at the 1/4 and 3/4 position in 

parametric space in the specified local direction. In this 

example, the original Surface is split in its local y 

direction at parametric divisions 0.25;0.75. 
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Joining 

 By Joining Defines a number of Surfaces by 

joining two sets of selected Points or Lines. 

The first set of Lines should be added to 

selection memory, the second set should be 

selected. The Lines should pair up equally. 

Surfaces are joined according to the order in 

which the Lines were selected, i.e. first Line in 

selection memory joins to first Line in 

selection, etc.  

 

In the example shown Surfaces 1 and 2 are 

defined by first selecting Lines 1 and 2, then adding them to selection memory, then 

selecting Lines 3 and 4 and using the Surface by joining command. 

Other surface joining examples 

 A single line can be put in selection memory and a set of lines selected in a normal 

selection and surfaces created .  

 A single point in selection memory and a set of lines in normal selection can be used 

to created a pyramid shape of triangular surfaces. 

Intersection 

 By Intersection Defines a Surface at the intersection of two selected Volumes. 

Manifolding 

Manifolding is the process of creating geometry which lies on the surface map of an existing 

Surface. 

 By Manifolding Existing Surfaces may be projected or laid onto an existing Surface. 

A Surface to be projected onto is placed into Selection Memory and the Surface to be 

projected is then selected prior to choosing the Geometry> Surface > By 

Manifolding menu item. The new Surface is created normal to the selected item (in 

selection memory) and will lie on the map of the underlying Surface. 

 Manifold by Lines Defines a Surface 

positioned on an existing underlying 

Surface with its boundary specified by 

edges or vertices. In this example a 

Surface is created by Joining any 

combination of the Points and Lines 

shown. Any new Lines created will 

automatically be manifolded onto the 
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underlying Surface. 

Extrusion 

 By Extrusion Defines Surface by 

extruding selected Lines a specified 

distance. The positive direction may 

be defined by an additional Point if 

selected. For Arcs the default 

direction is assumed to lie in the plane 

of the Arc. 
 

Volumes 

About Volume Features 

Volumes define the solid geometry of the model and come in two forms.  

 Solid Volumes are defined by a number of connected Surfaces. These are recognised 

by the geometry engine which allows Boolean operations to be performed. Solid 

Volumes are the default form of Volume and are created when geometry is defined in 

Modeller.  

 Hollow Volumes are defined by a number of disconnected Surfaces. These are not 

recognised by the geometry engine. Hollow Volumes are usually only of use when the 

geometry has been imported from CAD. 

For meshing purposes volumes may be split into the following categories. 

 Regular volumes may be defined as Tetrahedral (4 sided volume with all faces 

defined by triangular surfaces), Pentahedral (5 sided prism with top and bottom faces 

defined by triangular surfaces and side faces defined by quadrilateral surfaces), 

Hexahedral (6 sided cuboid with all faces defined by quadrilateral surfaces). 

 Swept Irregular are defined by 2 identical irregular Surfaces joined at equivalent 

positions on the boundaries by quadrilateral Surfaces. The Lines joining the two 

irregular Surfaces must be either straight Lines or arcs with a common centre. 

 Irregular are defined by any number and type of surface but can only be meshed with 

tetrahedral elements. 

Defining Volumes 

The following commands are for defining Volumes directly: 

 By using the Shape Wizard to create regular volumes. 

 By selecting Surfaces to define a Volume from four or more selected connected 

Surfaces. The Surfaces may be entered in any order. When defining Volumes in this 

way any number of Surfaces may be selected to define a Volume. Duplicate and 

unconnected Surfaces will be filtered out.  
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 By Sweeping to define a Volume by sweeping a selected Surface through a 

transformation (translation, rotation, mirror or scale).  

  

A Surface is swept through a translation to create a 

Hexahedral: 

A Surface is swept through a rotation to create a 

Volume: 

 By Splitting Splits a selected Volume by a selected Surface. 

 By Joining Joins two selected features to form a Volume, either a Point to a Surface, 

or a Line to a Surface, or two Surfaces. The features are joined by straight lines. 

   

Surface 1 is joined to Point 4 to 

form a pentahedral.  

Surface 1 joined to Line 5.  Surface 1 is joined to Surface 2 

to form a hexahedral. Two 

triangular Surfaces joined this 

way would form a pentahedral. 

Groups of Volumes may be defined by joining two sets of selected Surfaces. The first set of 

Surfaces should be added to selection memory and the second set of surfaces should be 

selected. The Surfaces will pair up equally. i.e. Volumes will be joined according to the order 

in which the Surfaces were selected. The first set of Surfaces in selection memory joins to the 

first set of  Surfaces in selection etc. 

 By Extrusion Enables a Volume to be defined 

by extruding a specified distance normal to a 

selected Surface. The positive direction is 

defined by the Surface normal unless an 

additional Point is selected. Extrusion can be 

towards or away from the specified reference 

Point. 
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Coalescing Volumes 

The internal Surfaces from a Volume model may be removed by coalescing Volumes. This 

will result in a model with fewer Volumes which may be meshed using Tetrahedral elements.  

From Mesh Defines a Volume based upon the position of every node of the selected mesh. 

 See Geometry From Mesh.  

  

Case Study. Coalesce Volumes 

Sometimes a results file exists without a corresponding model file. The coalesce Volumes 

feature allows the results mesh to be converted to a Volume model so it can be modified and 

used in a subsequent analysis. 

1. Open results file and use the File> Save As menu item to save it as .mdl file. 

2. Use Control-A to select the mesh and convert it to Volumes using the Geometry> 

Volume> From Mesh menu item and select the Coalesce Volumes option. 

3. Create a loadcase. 

Delete Holes 

When geometry is imported from CAD it may have small holes defined which are of no 

significance in the analysis. These holes may be removed using the Geometry> Volume> 

Delete Holes menu item. 

Delete Voids 

Voids are cavities in a Volume which do not penetrate the defining surfaces. Voids are 

removed using the Geometry> Volume> Delete Voids menu item. 

Orientating Volume Axes 

In some analysis types the Volume axes is used to define the material direction. The Volume 

axis may be orientated by the following methods: 

 Axis to Surface  

 Cycle Axes  

 Cycle Relative 

See Changing Geometry / Element Orientation for details. 

Hollow Volumes 

Hollow volumes, just like normal solid volumes, are defined by a set of surfaces. However, 

unlike normal solid volumes, the defining lines and points of those surfaces do not need to be 

perfectly merged together. Hollow volumes are mainly used when geometry has been 

imported from CAD systems, when such merging may be difficult or impossible. Once 
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defined, hollow volumes behave in almost exactly the same way as normal solid volumes. For 

example, they may be meshed and have attributes assigned and deassigned in the usual way. 

The main difference is that in a geometric Boolean operation a hollow volume will behave 

like a set of surfaces, hence the name.  

Hollow volumes may be open or closed. To understand the 

difference consider just one defining edge of the volume between 

two defining surfaces. If that edge consists of exactly one line, or 

exactly two lines of very similar length and shape, then those lines 

can be considered a matching pair. If all the defining edges of the 

volume can be matched in this way, the volume is said to be closed. 

However, if one or more edges of the volume cannot be matched in 

this way then the volume is said to be open.  

For the example shown most of the lines form matching pairs. However, one of the defining 

surfaces has an edge that is defined by two lines, with a point in the middle. This pair of lines 

cannot be matched to the corresponding single line on the adjacent surface, and so this 

volume is open. 

The distinction between open and closed hollow volumes is only important when it comes to 

meshing. A closed hollow volume can be meshed in exactly the same way as a normal solid 

volume. However, a regular mesh cannot be assigned to an open hollow volume, and so these 

must be meshed using an irregular mesh. 

The user interface to enable the creation of hollow volumes may be invoked from the 

Advanced Dialog of the Geometry Properties dialog. This option is automatically invoked 

when geometry is imported from CAD. When this option is chosen the volume definition 

tools will try to automatically create a solid volume as normal. However, if this process fails, 

a further attempt will be made to create a closed hollow volume from the selected surfaces 

using the defined closure tolerance. 

Open hollow Volumes can only be created via the Geometry> Volume> Hollow Volume> 

Create menu item. Surfaces may be added or removed from an open hollow volume 

definition using the Geometry> Volume> Hollow Volume> Add and Geometry> Volume> 

Hollow Volume> Remove menu items. 

Once a hollow volume has been defined its status (open or closed) can be determined from its 

properties dialog. In some cases an open hollow volume may be changed to a closed hollow 

volume by simply increasing the closure tolerance on the volume properties dialog. When 

meshing a closed hollow volume, any nodes closer together than the volume’s node merge 

tolerance (defined on the volume properties dialog) are merged. For closed hollow volumes 

this defaults to the volume closure tolerance. 

Shape Wizard 

The shape wizard defines analytical shapes which may orientated with a local coordinate 

system and positioned by a user defined origin. If a point is selected the selected shape's 

origin will default to the coordinates of the selected point. Shapes may be defined using 

Lines, Surfaces or Volumes. 
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The following shapes are supported; cube, cuboid, cylinder, and cone. The origin of each 

shape is indicated by the axes. 

 

Notes.  

 Specifying a negative length or height results in that dimension being defined along 

the negative axis direction. 

 For the cylindrical shape there is an option to create the cylinder with a seam which 

effectively creates a cylinder using only one surface rather than the default two 

surfaces. 

Boolean Geometry Construction 

Boolean operations allow complex geometry to be defined by combining, subtracting or 

intersecting existing Surfaces or Volumes. 

  

 Union (with simplify internal geometry) enables a Surface 

or Volume to be defined by union of any number of selected 

Surfaces or Volumes. 

 Union (without simplify internal geometry) enables a 

number of Surfaces or Volumes to be defined by union of any 

number of selected Surfaces or Volumes. 

 Subtraction enables a Surface or Volume to be defined by 

subtracting one Surface or Volume from another Surface or 

Volume. 

 Intersection enables a Surface or Volume to be defined as 

the intersection of two selected Surfaces or Volumes. 

 Slice Enables a selected Volume to be sliced by a plane and 

the resulting geometry to be deleted either side of the slice if 

required. The slice plane may be defined in any global or 

local plane which may be visualised prior to the slice 

 

Separate (unconnected) 

cube and cylinder =  
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operation. A Surface of any shape may be used to slice a 

Volume by Subtracting the Surface from the Volume. 

2 volumes 

 

    

Union of cube and cylinder 

(simplify internal geometry) 

=  

1 volume 

Union of cube and cylinder 

(no simplify internal 

geometry) =  

4 volumes 

Subtraction of cylinder 

from cube =  

1 volume 

Intersection of 

cube and 

cylinder =  

1 volume 

Geometry From Mesh 

An existing finite element mesh defined in a Solver results model file (.mys) file can be 

converted into features such that each element is converted into a single feature. Use of this 

facility will produce a similar model to that created by the use of the File > Import menu 

item which permits the import of a Solver data file(.dat) to create a model.  

In using the Geometry from Mesh facilities, lower order features are automatically created, 

and the command describes the highest order of feature type that is to be created. For 

example, if a Line convert command is used on a single HX8 solid element mesh, then 8 

Points would be defined at the node positions and 12 Lines would be defined from the edges 

of the HX8. As a result, be warned that very large models can be produced . 

The currently selected elements are converted using the following menu items: 

 Geometry> Point > From Mesh creates Points from nodes. 

 Geometry> Line > From Mesh creates Points from nodes and Lines from beam 

elements, surface and volume element edges.  

 Geometry> Surface > From Mesh creates Points from nodes, Lines from beam 

elements and Surfaces from surface elements and volume element faces.  

 Geometry> Volume > From Mesh creates Points from nodes, Lines from beam 

elements, Surfaces from surface elements and Volumes from volume elements. 
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To convert from mesh the results database must be saved as a model file with access for 

writing prior to conversion. Firstly open the .mys using the menu item File> Open, then save 

as a model file using File> Save As. Select the elements you wish to convert to geometry and 

pick the appropriate From Mesh menu item. 

Deformed mesh factor 

The coordinates of all nodes in the mesh (used to define points) can be adjusted based upon a 

specified deformed mesh factor.  

Notes 

 No attributes will be converted. 

 When converting to Volumes to resulting Volumes may be coalesced by removing the 

internal Surfaces. 

 The conversion commands always create new features and cannot be used to edit 

existing features. 

 Quadratic element edges with 3 nodes are converted to spline Lines with an exact 

match using the end node positions. A Point is defined at the mid-side node position 

but is not used in the Line definition. 

Importing Mesh Data 

Moving, Copying and Sweeping Geometry 

Geometry may be moved or copied to new positions, or 'swept' to create higher order 

geometry from lower-order features using transformations. Compound transformations may 

be used in which a series of transformations are carried out in a specified order. When a 

feature is moved or copied, features will be merged as defined by the current merge status. 

See Merging and Unmerging Features. 

  

 Move When a feature is moved to a 

new location its lower order features 

will also be moved and its higher order 

features will be updated.. In the 

example shown here, Point 3 is moved 

using an X and Y translation. Due to 

feature associativity the definition of 

Lines 2 and 3 and of Surface 1 is 

automatically updated. Moving can be 

used to separate features on a 

temporary basis to assist in the 

manipulation of features, for example 
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when defining slidelines or joints.  

Note: When moving holes the Surface is 

actually deleted and recreated so the feature 

numbers will not be maintained. 

  

 Copy Features may be copied any 

number of times. When a feature is 

copied its lower order features will also 

be copied using the same 

transformations. Copied features will 

inherit the same attribute assignments 

as the original features. In the example 

shown here the Line at the bottom is 

copied 4 times using a transformation 

in the X and Y direction. 

 

 Sweeping Geometry New geometry can be created by sweeping existing lower order 

geometry into higher order geometry using a transformation, as for example, by 

sweeping a Point to create a Line, or a Line to create a Surface, or a Surface to create a 

Volume. To do so a transformation or sweep type needs to be specified. 

Transformations 

Transformations are used in two ways: 

 When moving, copying or sweeping geometry a transformation is specified, and may 

be saved if required. 

 For special applications such as to orient discrete point and patch loads, or to define a 

reflective mirror plane for thermal analyses. 

Transformation attributes are defined using the Utilities> Transformation menu item, as 

well as from a move, copy or sweep dialog. Certain transformations can be defined by adding 

two or three geometric Points to selection memory before initiating the transformation 

command.  

 

The following transformation types are available: 

 Translation Linear translation along a 

specified vector coordinate. The vector 

coordinate will use the active coordinate 

set (See notes for an exception for 

cylindrical and spherical coordinate sets). 

Two Points added to selection memory can 

be used to define the vector coordinates. In 

this example, the translation is defined using 

Points 1 and 2, which stores a translation of 

X and Y. This is then used to copy the 
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Surface shown. 

 Rotation (in a global plane) A specified 

angular rotation in either the XY, YZ, or ZX 

global plane at a specified origin. 

 

In this example Surface 1 is copied about the 

global origin through positive 90 degrees. A 

right hand corkscrew rule is used for 

rotations. Local coordinate systems can be 

used to rotate about non-global axes.  

 Mirror A mirror plane may be defined by 

specifying three points in space to define an 

arbitrary plane, or two points to define a 

plane parallel to either the Z, Y, or X axis. 

Three Points added to selection memory can 

be used to define an arbitrary mirror plane, 

and two Points added to selection memory 

can be used to define a mirror line in the XY 

plane (not the YZ or ZX planes) 

 

Note:.Care should be taken when mirroring 

Lines and Surfaces as their orientations may 

be reversed so some Surfaces may 

effectively be turned upside down. Lines 

may also point in the opposite direction. See 

Changing Geometry Orientation to 

resolve any problems. 

 

 Scale A scale factor and the origin point of 

the scale is specified . 
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 Matrix rotation A direction cosine either 

specified directly, or using two or three 

Points added to selection memory. Points in 

selection memory define a plane, the 

rotation of the global XY plane to this new 

plane defines the transformation. Note. If the 

determinant of the matrix is not unity then 

the effects may not be as desired. 

 

This example defines a rotation by defining 

a plane relative to the global Cartesian axis 

set by indicating three Points: at the origin 

(P1), along the local x axis (P2) and defining 

the local xy plane (P3). The resulting 

transformation is a rotation of 90 degrees 

about the global axes. 

 

Notes 

 In a transformation dialog, (including the move, copy, or sweep commands), click on 

the Use button to use a transformation defined from Points in selection memory.  

 A transformation is not updated when the points defining it are changed. 

 When a cylindrical or spherical coordinate set is active only X,Y and Z transformation 

input is supported. 

Compound Transformations 

Saved transformations may be used together to create a compound transformation, i.e. two or 

more transformations can be performed on selected geometry at once. To carry out a 

compound transformation (firstly from the Utilities> Transformation menu item) define the 

required transformations and save them with suitable names. Then when copying, moving or 

sweeping select the Compound option and specify which transformations to use by adding 

them to the right side box. Single transformations may be used more than once if required. 

The order in which the transformation is performed is significant, therefore click the up and 

down buttons to get the correct order, starting from the top. 

Merging and Unmerging Features 

When a new feature is generated, if its position coincides with an identical feature then by 

default the two features will be merged (removing one of the features) provided the merge 

characteristics are satisfied. 

In addition to the automatic merging carried out during feature generation, any combination 

of features can be merged at any time. Care should be taken to merge from the lower order 
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features upwards, as higher order features can only merge if defined by the same lower order 

features. 

Merge/Unmerge Commands 

The following merge/unmerge commands are available from the Geometry menu, under each 

feature type. 

 Merge Merges all mergable features currently selected subject to the current merge 

characteristics and tolerance. Lower order features must be merged first. for example 

two Lines cannot be merged until the Points defining the Lines are themselves merged. 

When selected at the same time, LUSAS merges lower order features before higher 

order features. 

 Make Mergable/Unmergable Sets the merge status of selected features. Merging can 

happen unintentionally in the normal course of events when additional features are 

defined in the same position as existing features. Using this command, it is possible to 

prevent two coincident features being merged by making one of the features 

unmergable. The merge status of an individual feature may be viewed, and altered, by 

displaying the properties of the selected feature, (right-click button), on the Hierarchy 

tab. 

 Unmerge Duplicates or retracts selected features into higher order features which 

reference them in their definition. When a feature is unmerged from its higher order 

features, any new features defined are automatically set to be unmergable.  

Merge Options 

Several merge settings can be set from the Geometry tab on the Model Properties dialog. 

 Ask for Confirmation Configures Modeller to prompt for confirmation before 

selected features are merged. (Confirmation tab). 

 Merge Tolerance Controls the distance within which Point features must lie before 

they will be considered for merging. (Geometry tab). 

 Make New Features Unmergable Sets the merge status of all new features to 

Unmergable. (Geometry tab). 

 Merge Characteristics Controls the criteria that must be satisfied before features 

sharing a common definition will be merged. (Geometry tab). See below. 

Merge Characteristics 

Features will be merged only if they share common lower order features, in addition feature 

merging is dependent upon attribute assignments. By default, identical assignments must be 

found on two features, for those features to be merged. The merge type parameter controls 

how LUSAS handles feature merging. The following merge types are supported: 

 Off where no merging is carried out. 

 Exact where features are merged only if all assignments are identical. This is the 

default. 
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 Wild where features are merged if feature assignments of the same type for both 

features match. The assignments of both features are retained where the assignment 

type is unique to one feature. 

 Ignore Assignments ignores the assignments when deciding if two objects should 

merge (this is the opposite of "Exact" where the two objects must have the same 

assignments to merge). The assignments of the feature merged out will be transferred 

to the feature retained unless the retained feature already has that particular 

assignment. 

Notes 

 If several features are merged with merge status set to ignore assignments and the 

assignments are indeed different, the remaining feature will inherit the assignment of 

the lowest numbered deleted feature. 

 If two coincident features are not merged, two sets of coincident nodes will be 

generated when they are meshed and the finite element mesh will be unconnected at 

the feature discontinuity. This may be corrected at the meshing stage by merging the 

nodes using the equivalence facility. 

Using the Merge (and Unmerge) Commands 

 Merge Point Coordinates of Points to be 

merged must lie within the merge tolerance. 

By default assignments must be exactly the 

same for a Point to be merged. 

 

  
 

 Merge Line Lower order features must be 

common for merging to take place. By 

default assignments must be exactly the 

same for a Line to be merged. 
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 Merge Surface Lower order features must 

be common for merging to take place. By 

default assignments must be exactly the 

same for a Surface to be merged. 

 

 

Merge Case Study 1 

Merging Lines with different non-zero assignments. Wild and Ignore Assignments will merge 

Lines successfully. 
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Merge Case Study 2 

Merging Lines with additional material assignment on Line 2. Material assignments differ, 

therefore only Ignore assignments will merge successfully. 

 

Using the Unmerge Commands 

  

To unmerge a feature from a higher order feature (i.e. a point from a line) select both the 

feature to be unmerged and the higher order feature from which to unmerge it. In the 

following examples red represents "New" and green "Modified" geometry. 

  

 Unmerge Point in LineUnmerge Point 

2 in Line 2. A new Point 4 is copied 

from Point 2 and Line 2 is redefined 

using Point 4. Points 2 and 4 are 

coincident. Point 4 is unmergable. 
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 Unmerge Point in SurfaceUnmerge 

Point 5 in Surface 2. A new Point 8 is 

copied from Point 5, a new Line 9 is 

defined and Line 6 is redefined using 

Point 8. New features are set to be 

unmergable. Point 5 and Point 8 are 

coincident. 

 

 Unmerge Point in VolumeUnmerge 

Point 1 in Volume 1. A new Point, 2 

new Lines and a new Surface are 

defined and affected Surfaces and the 

Volume are redefined. The new Point 

is coincident with Point 1. 
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 Unmerge Line in SurfaceUnmerge 

Line 5 in Surface 2. A copy of Line 5 is 

defined which replaces Line 5 in the 

definition of Surface 2. Points are 

unaffected. 

 

 Unmerge Line in VolumeUnmerge 

Line 1 in Volume 2. A copy of Line 1 

is defined joining the same end Points 

The new Line replaces Line 1 in the 

definition of the affected Surfaces in 

Volume 2 
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 Unmerge Surface in VolumeUnmerge 

Surface 1 in Volume 2. A copy of 

Surface 1 is defined which replaces 

Surface 1 in the definition of Volume 

2. 

 

  

Case Study. Forcing Features to Merge 

Sometimes when creating the geometry duplicate features are created. If these have different 

assignments the default merge setting will prevent coincident features from merging. In this 

case it is useful to request the merge settings to ignore assignments. LUSAS can be forced to 

merge duplicate features in the following way: 

1. Set the merge status to ignore assignments by choosing the File> Model Properties 

dialog box, Geometry tab and pick Ignore assignments for the Merge action. 

2. Select the whole model using Edit> Select All. Then merge the model features using 

the Merge Features button  on the Advanced Define toolbar and pick the option to 

merge defining geometry. 

3. Reset the merge status to Exact. 

Note: If some features have been previously unmerged these must first have their merge 

status reset to Mergable using Geometry> Feature type> Make Mergable. 
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Changing Geometry / Element Orientation 

For feature-based models the orientation of the Geometry is generally used to define the local 

axes of the elements. For mesh-only models the local axes of the elements will be the same 

initially as those defined in the data file that was used to create the model.  

Selecting features for re-orientation 

The following commands enable the local axes of Lines (where stated), Surfaces and 

Volumes (and Elements for a mesh-only model) to be re-oriented. First, the feature or 

element to be used as a basis for the re-orientation to be carried out must be selected 

(followed by the selection of any additional features to which the re-orientation of the first 

feature or element should apply) and then a menu item based upon Geometry > (Feature) > 

(Command) should be chosen. 

 Reverse Lines, Combined Lines and Surfaces can have their direction reversed. 

This example shows the effect of a 

Line reversal. The local x axes of all 

elements on this Line will be reversed. 

 

In the Surface example the local x axis 

remains along the first Line in the 

Surface definition, but the Surface 

normal is reversed. Elements meshed 

on this Surface will be inverted. 
 

 Axes to Surface This command reorders the Surfaces that define a Volume such that 

the selected Surface becomes the first Surface in the volume definition. The z axis of 

the Volume is orientated normal to the first Surface, and pointing from that Surface 

towards the middle of the Volume. When the z axis of the Surface and the z axis of the 

selected Volume are the same their x, y and z axes will align. But if the z axis of the 

selected Surface and z axis of the selected Volume are in opposite directions (as may 

occur when Surfaces are shared between Volumes), the x axis of the Surface is used as 

the x axis of the Volume and the y axis of the Volume will be re-orientated 

accordingly. If required, the local x and y axes of the selected Volume(s) may be 

additionally changed using the Cycle Surface command. 
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 Cycle Surfaces (or surface/solid elements in a mesh-only model) may have their 

definition order cycled, and Volumes may have the definition of the first Surface in the 

Volume definition cycled (and for mesh-only models, Elements may have the 

definition of the first Face in the Element definition cycled). In this example, the 

original Surface defined by Lines 1, 2, 3 and 4 is shown in grey. Cycling by changes 

Surface definition to Lines 2, 3, 4, 1. Cycling again defines the Surface as Lines 3, 4, 

1, 2 . Surface normal directions remain consistent throughout. 

 

 Cycle Relative Cycles the definition order relative to the first feature of the same type 

in the current selection. Lines may have their axes aligned to a chosen Line, and 

Surfaces and Volumes (or surface/solid elements in a mesh-only model) may be 

reoriented in this way. In this example Surfaces 2, 3 and 4 are cycled using Surface 1 

(shown greyed) as the reference orientation. 

 

 Cycle to Neighbours (Mesh-only models) Cycles the element axes of all neighbouring 

and selected elements relative to the first element in the current selection. Whilst 
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similar in effect to the Cycle Relative option for the example shown above (which 

would obtain the same result for that particular example), it caters for the case where, 

for certain orientations of elements, the cycle relative option would not be applicable. 

The example below shows one such example. 

  

 
Cycle to Neighbours (correctly aligns element axes of the selected elements with initially selected neighbouring element) 

  

 
Cycle Relative (only aligns element axes of the selected elements to best angle with respect to initially selected 

neighbouring element) 

  

 Cycle to Faces (Mesh-only models) Solid elements may have their local z direction 

set from a selected Face. Element axes are defined by the direction of the axes on the 

first Face in their definition. This command reorders the Faces defining the Element 

such that the first Face in the definition is the selected Face. The local x and y axes of 

the element itself may then be changed using the Cycle command. 

Notes 

 When cycling Surfaces it is not the Lines that change, but the order of the Lines in the 

Surface definition. Since the Surface local x axis lies along the first Line in the 

Surface definition the orientation of the Surface changes.  
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 When cycling Volumes the cycle command only changes the order of Surfaces in the 

Volume definition. Since the Volume axes are determined by the orientation of the 

Lines that define the first Surface in the Volume, the orientation of the Volume 

changes. 

Case Study. Changing Element Orientation For a Feature-based 

Model 

When it is necessary for the local axes of Lines and Surfaces to be consistent this can be 

achieved by reversing and cycling the features. Consistent axes for underlying Lines, 

Surfaces and Volumes ensure that their elements also have consistent axes. 

1. Draw the orientation axes for the features which are required to be consistent 

(Geometry Layer Properties). It may be useful to draw just Surface normals. 

2. In the case of lines, reverse any lines whose orientation is to be changed. 

3. In the case of Surfaces, reverse Surface normals (local z axis) and cycle Surfaces xy 

axes until all axes are consistent. Surfaces can be cycled relative to a reference 

Surface if required. 

4. In the case of Volumes, set up the Volume local z axis and cycle xy axes by cycling 

the first Surface in the Volume definition until all axes are consistent. Volumes can be 

cycled relative to a reference Volume. 

CAD Interfacing 

CAD interfacing is the process of importing or exporting the geometry and other data from 

and to a CAD package.  

When importing from CAD, only the relevant data should be exchanged. Annotation and 

construction lines should not be included as these will then be converted into LUSAS 

geometry. Control over the data imported into LUSAS is achieved using the Advanced 

button accessed from the File> Import Geometry menu item. Similarly, control over what is 

exported is achieved by options on the Export dialog accessed from the File> Export menu 

item. For more information see Interface Files 
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Chapter 5 : Model 

Attributes 

  

Attributes 

Attributes are used to describe the properties of the model. They are defined by using the 

Attributes> menu item. Once defined, attributes are assigned to geometry features (or to 

mesh objects in a mesh-only model) and are not lost if the geometry is edited, or if the model 

is re-meshed. Some attributes, such as material, geometric, and constraint attributes are 

always assigned on a per-analysis basis. Some attributes, such as activate, deactivate, support 

and loading attributes (usually) are assigned on a per-loadcase basis. Attribute assignments 

are inherited when geometry features are copied and are retained when geometry features are 

moved.  

The attribute types are: 

General Attributes 

 Mesh describes the element type and discretisation on the geometry. 

 Geometric specifies any relevant geometrical information that is not inherent in the 

feature geometry, for example section properties or thickness. 

 Material defines the behaviour of the element material, including linear, plasticity, 

creep and damage effects. 

 Support specifies how the structure is restrained. Applicable to structural, pore water 

and thermal analyses. 

 Loading specifies how the structure is loaded. 

Specific Attributes 

 Local Coordinate provides a transformation for loads and supports, and an alternative 

to the global coordinate system. 

 Composite defines the lay-up properties of composite materials in the model. 

 Slideline slidelines control the interaction between disconnected meshes. 

 Constraint Equation provides the ability to constrain the mesh to deform in certain 

pre-defined ways. 
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 Thermal Surface defines thermal surfaces, which are required for modelling thermal 

effects. 

 Retained Freedom specifies the master nodes used in a Guyan reduction or 

superelement analysis. 

 Damping defines the damping properties for use in dynamic analyses. 

 Birth and Death allows elements to be added (birth) and removed (death) throughout 

an analysis, e.g. in a tunnelling process or a staged construction. 

 Equivalence allows nodes which are close to each other but on different features to be 

merged into one according to defined tolerances. 

 Influence attributes define the type of behaviour of the structure at and around an 

influence point 

 Age defines the time between creation and activation of features in the model.  

 Search Area restricts discrete (point and patch) loads to only apply over certain areas 

of the model. 

 Crack tip define a crack tip attribute to allow a crack tip location to be defined at a 

point or line in a model. 

 Design strength define strength data for use in conjunction with Design Factor Plots 

Defining and Assigning Attributes 

Attributes are defined from the Attributes menu. Defined attributes are shown in the 

Attributes  Treeview and can be assigned to selected geometry features (or to mesh 

objects in a mesh-only model) by dragging and dropping them onto selected features of the 

model or assigning them from their context menu.  

Attribute symbols explained 

A symbol adjacent to each attribute name in the Attributes  Treeview shows the status of 

each attribute present. 

  A coloured attribute icon shows an attribute has been assigned to the model or used in the 

definition of another attribute. 

 A greyed-out attribute icon shows an attribute has yet to be assigned to the model or used 

in the definition of another attribute. 

 A coloured or greyed-out attribute icon with a surrounding red box indicates an attribute 

that has been set as default, meaning it will automatically be assigned to features of the model 

as they are generated. 

 If any attributes that were previously created by a Prestress Wizard are edited outside of 

the prestress wizard they will be marked with a warning symbol to show that the Prestress 

Wizard must be re-run to recalculate new values. 
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Attribute manipulation 

Attributes are manipulated using the context menu in the Attributes  Treeview (accessed 

by clicking the right mouse button on the attribute), with the following commands: 

 Edit Definition Allows the properties that were originally defined to be modified on 

the dialog that was used to create them. 

 Edit Attribute Allows the properties of the attribute to be modified.  

 Copy Enables the attribute to be copied and assigned to a selected group, or view 

window, in the current model using paste. 

 Rename Attributes can be given meaningful names, for example 'Steel' to describe a 

material, or 'Beam - Four Divisions' to describe a Line mesh. 

 Delete Deletes the selected attribute. 

 Visible Makes visible all features to which the selected attribute is assigned. 

 Invisible Makes invisible all features to which the selected attribute is assigned. 

 Set As Only Visible Sets the whole model invisible and then makes visible only those 

features to which the selected attribute is assigned. 
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 Advanced Visibility Provides fine control over the visibility of features to which the 

selected attribute is assigned. 

 Results Plots permits results for selected attributes to be selectively plotted. 

 Select Assignments Selects the features that have the selected attribute assignment.  

 Deselect Assignments Deselects the features that have the selected attribute 

assignment.  

 Visualise Assignments Switches on and off the visualisation of features that have the 

selected attribute assignment. Note this is not an action but a change of state. 

 View Assignments Shows loadcases and analyses to which attributes such as 

materials, supports and loadings etc. have been assigned. 

 Assign Assigns the selected attribute to the selected features. The attribute will only be 

assigned to features where the assignment would be valid. Some attributes require 

further information in order to be assigned and in these cases a dialog is displayed. For 

attributes that can only be assigned once to a feature, assigning another attribute will 

overwrite any previous assignment of that attribute type. 

 Assign to all Assigns the selected attribute to all currently defined geometric features 

(or mesh objects in a mesh-only model) and to all new geometric features as they are 

created. Some attributes require further information in order to be assigned and in 

these cases a dialog is displayed. A tick is displayed in the attribute context menu 

when Assign to all is switched on, selecting the Assign to all menu item again 

deassigns the attribute from all and removes the tick.  

 Deassign Deassigns the selected attribute. Choose From All or From Selection. 

 Set Default Automatically assigns the selected attribute to all new features as they are 

created.  

Clarifying where attributes have been assigned 

When Modeller is unable to automatically carry out an operation such as 'Set As Only 

Visible" or 'Select Assignments' on a set of objects to which an attribute is assigned, 

clarification will be sought, requesting the user to identify an analysis or loadcase from those 

that include the chosen attribute. 

Visualising Attribute Assignments 

Attribute assignments can be visualised using: 

 Attributes layer The Attributes layer is a window layer in the Layers  Treeview 

that is normally added during the initial start-up of Modeller. The Attributes layer 

properties define the styles by which assigned attributes are visualised. The attributes 

layer properties may be edited directly by double clicking the layer name in the Layers 

 Treeview. Assigned attributes can also be visualised individually by selecting an 

attribute name in the Attributes  Treeview and clicking the right mouse button to 

choose Select Assignments from the context menu. This is the easiest way to 

interrogate the assignment of a single attribute. Note that the option Visualise 
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Assignments is not an action but a change of state. It sets the visualisation of 

assignments to 'on' or 'off', such that any assignments will be drawn or not drawn for 

that attribute. 

 Contour layer (materials/geometry/loading attributes only) Allows the model to be 

contoured with a specified value obtained from the material, geometric or loading 

attribute assignments. This is especially useful when an attribute value changes across 

the model. e.g. when defined using a variation. To use this feature click the right 

mouse button in the view window (with nothing selected), choose Contours from the 

context menu, then select either Loading (model), Geometry (model) or Materials 

(model). 

 Colour by attribute (Accessed from the properties dialog of the Geometry layer) 

colours the geometry according to which attributes are assigned to which features. A 

key is generated to identify the colours. 

 The options Combine assignments using loadcase history and Show only 

assignments in the active loadcase (accessed from the properties dialog of the 

Attribute layer for supports/activate attributes only) allows load dependent attributes to 

be visualised from the accumulated load history or from only those attributes assigned 

to the active loadcase.  

In addition to the above, toolbar buttons for Supports  and Loading  can be used to 

turn-on and turn-off the display of any supports or loadings that are assigned to a particular 

loadcase. 

 See Geometric Properties for the visualisation of beam cross sections and surface 

thickness (fleshing). 

 See Composites for visualising composites materials. 

Deassigning Attributes 

Attributes may be deassigned from all or selected features by selecting the attribute in the 

Attributes  Treeview  with the right hand mouse button and picking the Deassign entry 

from the context menu. The menu item entries From Selection or From All may then be 

chosen to deassign from the items in the current selection or from all the features in the 

model. Unassigned attributes will be denoted with a greyed-out bitmap . 

Attributes may also be deassigned by selecting View Assignments from the context menu for 

the attribute and unchecking the relevant loadcase. 

Copying attributes between models 

Attributes can be copied between models by using the Library Browser. See Transferring 

Data Between Models for details. 
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Deleting attributes from the Treeview 

Attributes can be deleted from the Attributes  Treeview individually by selecting the 

attribute name and pressing the Delete key, or choosing 'Delete attribute' from its context 

menu. Attributes can also be deleted en-mass by attribute type (e.g. Mesh, Geometric, 

Supports, Loading etc), by selecting an attribute folder name and selecting Delete all from its 

context menu. Deletion of selected attribute data can be carried out in one go using the 

Library Browser. See Transferring Data Between Models for details. 

Drawing Attribute Labels 

Labels are a layer in the Layers  Treeview. To display attribute labels:  

1. With nothing selected, click the right mouse button in the graphics area and choose 

Labels from the context menu.  

2. Switch on labels for the chosen attribute type. 

Set Default Assignment 

Certain attributes, (mesh, geometric, material, composite), can be assigned automatically to 

all newly created features. Default attributes are set by right-clicking the attribute in the 

Attributes  Treeview , then choosing the Set Default entry from the context menu. This is 

useful for models with constant materials or thickness throughout, or where the same element 

is to be applied to all features. Attributes that are set as default are displayed with a red box 

around them  in the Attributes  Treeview. 

Attribute dependency across analyses / loadcases 

See Base Analyses for a table that summarises how attributes assigned in a base analysis are 

inherited in other dependent analyses. 

About Meshing 

Feature-based models are defined in terms of geometry features which are sub-divided into 

finite elements for analysis. This process is called meshing. Mesh attributes contain 

information about: 

 Element Type Specifies the element type to be used in a Line, Surface or Volume 

mesh attributes may be selected either by describing the generic element type, or 

naming the specific element. See Element Selection. 

 Element Discretisation Controls the density of the mesh, by specifying the element 

length or the number of mesh divisions, spacing values and ratios. 

 Mesh Type Controls the mesh type e.g. regular, transition or irregular. 

 For feature-based geometry models, mesh attributes are defined from the Attributes> Mesh 

menu item for a particular feature type i.e. Point, Line, Surface or Volume. The mesh 

attributes are then assigned to the required features. The orientation of the model Geometry is 
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used to define the local axes of the elements. See Changing Geometry / Element 

Orientation if element axes need to be changed. Assigned mesh attributes apply to all 

analyses defined for that model. 

When modelling 2D frame problems it is recommended to use the relevant family of 

3D beam elements (rather than 2D elements) if, at a later date, it is intended to convert the 

2D model into a full 3D model. 

Mesh-only models 

Mesh-only models are comprised of nodes and elements and do not contain any geometric 

feature types, or indeed any geometric data at all. The number and shapes of the elements of a 

mesh-only model are fixed. The type of element may be changed and this is done by use of 

the Change Element Type option on the context menu on the element group name. In doing 

so, the number of nodes defining the element topology may be reduced but not increased. For 

instance, an 8-noded brick elements may be defined for use on previously defined 20-noded 

brick elements. See Changing Geometry / Element Orientation if element axes need to be 

changed.  

Mesh Types 

Various mesh patterns can be generated: 

 Regular Only used on regular Surfaces and Volumes. Any element shape may be 

selected for regular meshing. Options exist to automatically allow transition or 

irregular meshes to be generated when regular meshing is not possible. 

 Irregular Used for Surfaces and Volumes. An irregular Surface mesh may consist of 

triangular or quadrilateral elements. A irregular Volume mesh must consist of 

tetrahedral elements. Irregular Volume meshes will only be generated if specified as 

acceptable in the mesh attribute. 

 Interface Meshes Only applicable to joint and interface elements. 

Mesh Visualisation 

The Mesh layer properties control how the mesh is displayed in the current Window. The 

same controls are available for the undeformed mesh and the deformed mesh, but since they 

are different layers in the  Treeview, different properties can be applied to each layer.  

Mesh settings 

 Wireframe Displays the element mesh as a wireframe using the pen specified. Only 

the visible mesh lines are drawn. 

 Solid Displays the mesh as solid panels using the colour specified. Click on the 

coloured square to change the colour used. 

 Maximum shade Controls (using a percentage value) the darkness of any specified 

solid mesh colour.  
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 Outline only Displays only the outline of the mesh for each assigned feature. This is 

also useful for spotting cracks or discontinuities in the mesh due to features not being 

merged or equivalenced correctly. 

 Show nodes Draws the mesh nodes. Nodes define the vertices of elements. 

 Hidden parts Displays all elements and not just the visible element faces. Dotted 

displays the hidden edges in a dotted line. 

 Show normals Displays the element normal for Surface elements. 

 Show element axes  Displays the element axes as a local axis set.  

 Orientations only if selected Displays the surface normal or element axes only if the 

element is selected. 

 % of elements remaining Shrinks the elements to the percentage specified. 

 Colour by Enables the mesh colour to be changed. 

 Mesh colour - colours elements in default mesh colour. 

 Group - colours elements by group. 

 Connectivity - colours element edges by number of neighbours. 

 Element Type - colours elements by element type. 

 Normals - colours elements by surface normal direction. 

Note. The arrow sizes used for element axes and normals are defined on the Default tab of 

the Model Properties. 

Visualise settings 

 Joint elements Marks any joint elements in the model with a symbol. 

 Active mesh Marks the active elements with a symbol. 

 Beam end releases Draws the beam end release for elements that use end releases. 

Meshing Points  

Point mesh attributes are used to assign non-structural point mass elements, joint elements 

and mesh spacing parameters to the model. Point mass and spacing attributes are assigned to 

a single Point whereas joint attributes are assigned to pairs of Points. The first Point is 

referred to as the Master, the second is the Slave. Joint property assignments should be made 

to the Master Point. 

Meshing Lines 

Line meshing is carried out by defining a Line mesh attribute and assigning this to a selected 

Line. Line mesh attributes are defined from the Attributes> Mesh> Line menu item. The 

number of elements can be specified using either element length or number of divisions.  
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Note that when modelling varying cross sections with constant section beam elements care 

should be taken to ensure that sufficient elements have been assigned. Greater than 8 

elements should be used for small variations in cross section along the length of the geometry 

to which the section has been assigned, and considerably more elements should be used for 

larger variations. 

Line Mesh Spacing 

By default elements are evenly spaced but this can be user defined. Non-uniform spacing is 

specified by clicking on the Spacing button from the Line mesh dialog then using one of the 

following methods: 

 Uniform Spacing 
 

 Uniform Transition Specify a ratio of the first to 

last mesh division length. The spacing ratios are 

assigned in the direction of the line to which they are 

applied. This example uses a ratio of 4 which is the 

ratio of the length of the first element to the last. To 

reverse the mesh spacing the ratio could be specified 

as 0.25 (or the Line could be reversed). 

 

 General Spacing Enter a grid of numbers which 

defines the individual segment length ratios 

explicitly. They are specified in the form: 

 Number Defines the number of elements at 

this ratio, (from the start of the line as 

defined by the line direction). The numbers 

must add up to the number of divisions 

specified, e.g. for the example below 2+2 = 4 

divisions. 

 Ratio Defines the spacing ratio of the 

elements in the 1st column to the total 

number of elements.  

This example uses general spacing 2@2, 2@4 

(spacing ratios are applied in the direction of the 

Line). 

 

When specifying spacing the Line direction is important as the spacing is defined from the 

start to the end of the line. If the spacing appears to be in the incorrect direction the line may 

be reversed by selecting the Line and using the Geometry> Line> Reverse menu item.  

If desired, the element spacing can also be defined using a background grid mesh. The use 

of a background mesh is specified when the mesh attribute is assigned to the Line. 
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Line Element Axis Orientation 

The element x axis always runs along the Line. Orientation of the local y and z axes of 3D 

beam elements may be defined using a beta angle or a local coordinate when the Line mesh 

attribute is assigned to the Line. By default the element z axis coincides with the global Z axis 

and the element y axis forms a right hand set. Elements may also be orientated using a local 

coordinate which is assigned to the geometry. 

End Releases for Beam Elements 

Freedoms at the ends of a Line can be freed to rotate or translate 

using an element with end releases. See the Element Library for 

more information on these element types. When defining a Line 

mesh attribute, with a valid element selected, click on the End 

Release button. Releasing beam element end freedoms can be used 

as an alternative to using a joint element, for example when defining 

a pin between two beams. 
 

Meshing Surfaces 

Regular Surface Meshing 

Regular meshing is used to generate a set pattern of elements on Surfaces and Volumes. Only 

surfaces which are regular (defined by 3 or 4 lines) can be meshed using a regular mesh 

pattern. 

 In order to generate a regular grid mesh 

pattern the number of mesh divisions on 

opposite sides of the Surface must match. 

If they do not match transition patterns 

will be used (if allowed in the mesh attribute definition). The examples shown here 

mesh triangular and quadrilateral Surfaces using both triangular and quadrilateral 

elements.  

  

 The Surface mesh may be graded using 

mesh spacing parameters in 'None' 

element Line meshes assigned to the 

boundary Lines. In the examples shown 

here mesh spacing has been used to bias the elements into the apex of the triangle or 

one corner of the rectangle. 

Irregular Surface Meshing 

Irregular meshing is used to generate elements on any arbitrary Surface. 

 Element Size specifying the required approximate element edge length. 
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Meshing Volumes 

Volumes are meshed using regular mesh patterns, transition mesh patterns, or irregular 

tetrahedral meshing.  

Tetrahedral Volumes 

Tetrahedral Elements Pentahedral/Tetrahedral Elements  

  

Pentahedral Volumes 

  

Pentahedral Elements Hexahedral/Pentahedral Elements 

 
 

 

Hexahedral Volumes 

Pentahedral Elements Hexahedral Elements Hexahedral/Pentahedral Elements 

   

The mesh density for volumes is taken from the boundary surface mesh density. 
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Regular Volume Meshing 

In order to generate a regular mesh pattern the number of mesh divisions on opposite faces of 

the volume must match. If they do not match then transition patterns will be used. 

Pentahedral/tetrahedral elements will automatically be inserted in the appropriate positions of 

a transition mesh. 

Extruded Irregular Mesh 

Volumes defined by sweeping an irregular Surface may be 

meshed with a regular Volume mesh attribute. The 

interconnecting Lines between the irregular end Surfaces must 

all be straight, or all minor or major arcs with a common axis of 

rotation. The side Surfaces must all be defined by four Lines so 

they can be meshed with a regular grid of quadrilateral faces. 

The irregular opposite Surfaces must not share any common 

boundary lines therefore wedge-shaped Volumes cannot be 

meshed as extruded irregular Volumes. 
 

  

Case Study: Meshing Volumes by Extruding Irregular Surfaces 

It is possible to mesh an irregular volume with hexahedral or pentahedral elements if the 

volume has been formed by sweeping an irregular surface. 

1. Define an irregular Surface with more than 4 sides. 

2. Define a Volume by sweeping the irregular surface. 

3. Define a Volume mesh attribute with Hexahedral or Pentahedral elements, use a 

regular mesh with automatic divisions to ensure an equal number of divisions on the 

swept edges. 

4. Assign the Volume mesh attribute to the Volume. 
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Irregular Tetrahedral Meshing 

Arbitrary shaped irregular Volumes defined by 

any number of Surfaces may be meshed with 

tetrahedral elements. The element size may be 

specified on the mesh attribute, taken from the 

defining geometry or interpolated from a 

background grid. The mesh may be refined 

around small features and stress concentration 

using 'None' Surface and Line mesh attributes. 

By default the maximum angle around an arc 

subtended by a single element is 90 degrees. 

This may be adjusted on the Meshing tab of the 

Model Properties dialog.  
 

Notes 

 A good initial mesh is usually obtained by specifying the element size as 

approximately1/50th of the diagonal model size. Specifying too small an element size 

will cause too many elements to be generated and may result in LUSAS using up all 

the available memory. Specifying too large an element size will cause the meshing 

algorithm to fail. 

 The success of tetrahedral meshing is dependent on the quality of the Surface mesh. If 

the meshing algorithm fails, invoke edge collapsing or set the Volume mesh to "From 

defining geometry" and adjust the element size using Line and Surfaces mesh 

attributes of type None. If the meshing still fails try breaking the Volume into a 

number of smaller Volumes. 

Edge Collapsing 

The quality of the mesh may be improved using edge collapsing. Edge collapsing removes 

elements with very short sides or acute angles by merging them with neighbouring elements. 

This is particularly useful when generating tetrahedral elements on imported CAD models 

where very short lines are present. Edge collapsing is invoked from the Advanced button on 

the Meshing tab of the Model Properties dialog. 
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Mesh before edge collapsing Mesh after edge collapsing  

(short edge removed) 

  

Mesh before edge collapsing Mesh after edge collapsing  

(Elements with small subtended angles removed) 

Controlling the Mesh Density  

The simplest way to define the mesh density is to define the number of divisions to be used in 

the mesh attribute. This method should only be used for simple models because changing the 

mesh density when multiple mesh attributes have been defined is both time consuming and 

prone to error. For most model the mesh density should be controlled using boundary 

discretisation. 

Boundary Discretisation 

In the case of Surface or Volume meshing, the number of mesh divisions may either be 

specified directly in the Surface or Volume mesh attribute, or using Line or Surface mesh 

attributes of element type ‘None’. In many realistic problems, where several Surfaces or 

Volumes exist, using attributes with an elements of type 'None' is the most convenient way to 

define the mesh density. For Lines the spacing is specified using either element length or 

number of divisions and for Surfaces the mesh size is specified as the element edge length.  
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Notes  

 If the element size is specified differently in the Line and Surface mesh attribute the 

Line element size will be used. 

 If the element size has not been specified the default number of mesh divisions will 

be used. 

  

 Regular Surface Meshing The applied boundary discretisation (left) produces the 

irregular mesh pattern on the Surface (right). 

 

  

 Irregular Surface Meshing The applied boundary discretisation (top) produces the 

irregular mesh pattern on the Surface (bottom). 
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Default Number of Mesh Divisions  

If the discretisation has not been specified in the mesh attribute, or by using a Line mesh of 

element type ‘None’ the Line will be sub-divided according to the default number of mesh 

divisions. This is specified on Meshing tab of the File> Model Properties dialog. 

Background Grid Meshing 

Background grid meshing is a method of controlling the size of elements generated during 

automatic meshing. It is generally only used when specification of spacing and stretching 

parameters at Points is required to grade the mesh pattern locally when irregular surface 

meshing. 

A background grid is a collection of triangular or tetrahedral shapes which completely 

encompasses the features to be meshed. A Line, Surface or Volume mesh is used to define the 

element type in the usual way and point meshes assigned to the points of the background grid 

are used to control the element size in the vicinity of each point. Finer control is achieved by 

using more Points in the background grid definition or by using Line mesh assignments to 

override the mesh size on specific edges. 

The background grid may be specified explicitly from Points at each vertex or generated 

automatically. Any mesh distortion required may be entered using the point mesh stretching 

parameters. If generated automatically, tetrahedral shapes will always be used.  
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Constant Mesh Spacing 

Same spacing parameters (Point meshes) are 

assigned to all Points in background grid. 

   
Varied Mesh Spacing 

Different spacing parameters (Point meshes) 

are assigned to the top Points (spacing=7) and 

the bottom Points (spacing=1) in the 

background grid. 

 

  

 

Notes 

 Background grid meshing requires all Points defining the background grid to have a 

point mesh assignment. 

 To remove a background grid delete the Background Grid from the  Treeview. 
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Case Study. Using Background Grid Meshing 

1. With a Surface or Volume already drawn and selected, define a background grid by 

selecting the Utilities> Background Grids menu item and choosing Enclose 

Selection. Define one element in each direction and give the background grid a name. 

2. Define Point mesh attributes from the Attributes> Mesh> Point menu item with the 

desired element sizes for use at assigned points on the background grid. For example 

Point mesh spacing attributes of 0.5 and 2.5 might be used for opposing corners of the 

grid, and a spacing of 2.0 might be used for the remaining points. 

3. Assign the Point mesh attributes to the appropriate Points on the Background Grid. 

All points must be assigned a point mesh attribute. 

4. Define a Surface or Volume mesh attribute with an Irregular mesh type, leaving the 

element size blank. 

5. Select the Surface or Volume and assign the Surface or Volume mesh attribute to the 

model selecting the From background grid in the mesh assignment dialog. The mesh 

generated will be based upon the governing point mesh values defined for the 

background grid. 

 

  

Composite Material Assignment 

When a Volume feature with a composite material assignment is meshed  the nodes are 

moved onto the composite layer boundaries. This ensures an exact number of layers in each 

element. 
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Connecting Beam and Shells 

Beam Shell Connectivity 

Extend the beams along the edge of the 

shell indicated by thick lines. 

   
Beam Solid Connectivity 

Extend the beams along the edge of the solid 

elements indicated by thick lines. Torsion is 

restrained using out of plane beams. 
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Shell Solid Connectivity 

Extend the shells over a portion of the 

solids indicated by the dark shaded area. 

  
  

 

  
  

  

Case Study: Connecting Shells and Solids 

Solid and shell elements may be connected but the procedure is not as straightforward as it 

first may appear. Solids and shells have different sets of nodal freedoms and the rotational 

freedom present in the shells can only be passed through to the solid elements by extending 

the shell around the side of the solid, thus passing through the rotation via combined 

translation effects. This form of connection stops rotation relative to a solid which only has 

translational degrees of freedom. 

The following procedure outlines the general method of fixing shells to solids: 

1. Define the Surfaces and Volumes. 

2. Define suitable mesh attributes, for example define linear hexahedral elements and 

linear quadrilateral shell elements and assign these to the Volume and Surface parts of 

the model. 

3. Now assign the surface mesh attribute to a surface that forms part of the solid 

elements and which shares a common edge with the shell Surface that is being fixed to 

the solid part of the model. Do not forget to assign material and geometric attributes to 

the surface attached to the solid.  

Note: It is advisable to make a connection such as this reasonably distant from the main area 

of interest as it may affect the quality of the results locally. 
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Fixing Mesh Problems 

When meshing, any features which failed to mesh are noted in the text window. These can be 

identified using the Identify Object dialog invoked by double clicking on the error message in 

the text window. Alternatively, a group can be created containing all the features that failed 

to mesh. Only features that are not part of meshed higher order features will be added to the 

group. To activate this facility choose the check box Create a group of features that failed 

to mesh invoked from the Advanced button on the Meshing tab of the Model Properties 

dialog.  

When importing CAD models meshing errors can sometimes occur due to very short lines 

and small surface slivers in the model. These problems can be alleviated in the meshing 

process by using edge collapsing. 

When meshing open hollow volumes with tetrahedral elements the edges with nodes which 

have failed to merge are displayed automatically. 

  

Unmerged nodes on volumes which failed to mesh. Mesh with nodes merged by adjusting node merge 

tolerance 

Notes 

 Unmerged nodes are most easily seen when meshed using solid fill. 

 Nodes which have failed to merge may be forced to merge by adjusting the node 

merge tolerance on the volume properties dialog or by assigning a suitable line mesh 

of type None to the lines. 

Mesh Utilities  

Mesh utilities provide the means to query distances between nodes; to control the meshing 

and re-meshing of all or parts of a model and to use a defromed mesh as a starting point for a 

further analysis. Mesh utilities are accessed from the Utility > Mesh menu item 

 Distance Between Nodes - displays in the Text Output window the relative distance 

between any selected nodes. 
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 Show Closest Nodes - displays in the Text Output window the distance between the 

closest nodes of any of those selected. 

To control changes being made to a mesh the following menu items can be used in various 

inter-related ways. 

 Mesh Lock - Disables automatic remeshing of a model and prevents any changes to a 

mesh being made. LUSAS automatically locks the mesh on a model when a results file 

is loaded because any subsequent mesh changes may lead to the assembly of results in 

a misleading fashion. Mesh changes involve renumbering or reorientation of elements 

and results are associated with node and element numbers.. Therefore results requested 

after a remesh (without the mesh being locked) may appear in the wrong location and 

in the wrong order in the structure.You can unlock the mesh using the menu item 

Utilities > Mesh > (uncheck) Mesh Lock and Utilities > Mesh > Mesh reset 

 Mesh Reset - Deletes the current mesh and forces a complete re-mesh of the whole 

model using the assigned mesh attributes. If Mesh Lock is 'on' this will not occur. 

 Mesh Now - meshes the whole model regardless of any Mesh Lock being set. 

 Mesh Selected Items - meshes only those features selected. 

 Use Deformations - uses the deformed mesh caused by one analysis to be used as the 

starting point for a further analysis. The mesh may be tabulated with node coordinates 

computed from the deformations in the active loadcase multiplied by a specified 

factor. To do so, a model file and its results file must be loaded with the required 

results loadcase set active.  

Checking mesh refinement in a model 

Checking the mesh refinement in a model is an essential part of any finite element analysis. 

By nature, all finite element analysis is an approximation, a "model" of a real (or potentially 

real) object. The results will only be accurate if the mesh is defined in such a way as to 

simulate the change in load effects across the structure effectively. 

The appropriate degree of mesh refinement can only really be discovered by experimentation: 

increasing the refinement and observing changes in the results. When refinement produces a 

negligible change in key results, the level of refinement required has been exceeded. A 

"negligible" change in results might be where the inaccuracy derived from the FE analysis 

may be considered small by comparison to other assumptions inherent in the design 

calculations. There is no hard rule because the load effects vary across "real" structures 

according to the structural form and loading conditions. 

It is normal to find that a higher level of refinement is needed in certain parts of the structure 

compared to other areas. Changing between linear and quadratic order elements can help 

identify the behaviour of the structure and the refinement considerations. 

Joint and Interface Elements 

 Joint elements are used to connect two or more nodes with springs having 

translational and rotational stiffness. They may have initial gaps, contact properties, an 

associated mass and damping, and other nonlinear behaviour.  
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 Interface elements are used for modelling interface delamination in composite 

materials. 

Both joint and interface elements may be inserted between pairs of corresponding nodes and 

features. Joint elements can be inserted between points, lines and surfaces. Interface elements 

can only be inserted between lines and surfaces. 

Defining and Assigning Joints / Interface Elements 

A Joint element is defined as a Point, Line or Surface mesh attribute using the Attributes > 

Mesh menu and specifying the structural element type to be used. Once defined, it is assigned 

to the model in one of two ways: 

 To a single pair of features This requires two points (joints only) or two lines or 

surfaces to be selected. The first selected feature becomes the master. The second 

selected feature becomes the slave.  

 To multiple pairs of features This uses selection memory to define a set of slave 

features prior to selecting a set of master features. 

Defining and Assigning a Joint / Interface Element Mesh 

to a Single Pair of Features 

To model a single joint element between a pair of features (two points, two lines or two 

surfaces, when applicable): 

1. Define a Joint mesh attribute with the chosen joint element. 

2. Select the first (master) feature. 

3. Add the second (slave) feature to the selection. 

4. Assign the Joint mesh to the two features. Options exist to allow definition of the local 

axes of the joint element. 

Defining and Assigning a Joint / Interface Element Mesh 

to Multiple Pairs of Features 

To define joint elements between multiple pairs of features (two or more sets of points, lines 

or surfaces, when applicable): 

1. Define a Point, Line or Surface mesh attribute with the chosen joint element. 

2. Select the slave features and add them to selection memory. 

3. Select the master features. 

4. Assign the joint mesh. 
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In making multiple selections of points, lines or surfaces it is important to select the separate 

slave and master features in the same order to ensure that the joints / interface element mesh 

created map to the correct features. 

As the same joint mesh attribute is assigned to both master and slave features, a mesh pattern 

is created between the two features, with the mesh definition for the feature determining the 

number of joints generated in the joint interface mesh (see Examples of Assigned Joints that 

follow). When using interface meshing the joint elements are automatically created, joining 

all nodes on the master and slave features, and each joint stiffness is automatically computed 

from the representative length or area of the elements on the master/slave features.  

Notes.   

 Joint meshes require Joint material properties to be assigned to them. 

 For joints with rotational degrees of freedom an eccentricity must be specified. An 

eccentricity of zero may be specified. 

 The Joint symbol is drawn at the quarter-point along the joint nearest to the first 

master feature defining the joint element. 

 Joint properties should be defined per unit length when assigned to Lines and per unit 

area when assigned to Surfaces. 

 Master features hold the mesh assignment data. A point can only hold one joint 

assignment so if multiple joints are to be assigned to a single point that point must be 

designated the Slave by ensuring it is the second point in the selection. 

 Joints defining spring supports act relative to the initial, unstressed configuration 

rather than that on any previous loadcase. This means that to introduce a stiffness to a 

support in a loadcase during a staged nonlinear analysis, relative to the stressed state 

on the previous analysis, you will need to use joints and activate them on this 

loadcase. 

Examples of Assigned Joints/Interface Element 

   
Joint between  

two points 

(Lower point is the master) 

Joint / Interface mesh  

between two lines 

(Lower line is the master, four line 

 mesh divisions are assigned to line) 

Joint / Interface mesh  

between two surfaces 

(Lower surface is the master, four 

 line mesh divisions are assigned 

 to each line) 
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Joint Local Axis Direction 

The joint local axis direction is defined when the mesh is assigned. Three options are 

available: 

 Follow point axes (Default selection) Adopt the axes assigned from the Local 

Coordinate (if any) assigned to the point. Any Local Coordinate that has been assigned 

to a feature can, additionally, be chosen to be ignored as a separate option. 

 By point in selection memory A Point previously added to selection memory is used 

together with the points defining the master and slave features to define the xy-plane 

of the local axis direction. 

 By specified local coordinates The element axes are defined using a previously 

defined Local Coordinate. 

For Joint element assignments only, the order of the features selected determines the Master 

and Slave. The master assignment of a joint is always the first of the two selected features 

that the joint is assigned to. For assignment to multiple pairs of features selected, those 

features in selection memory will become the slave assignments. Joint elements are orientated 

from the Master to the Slave by default. To reverse the joint orientation to be from Slave to 

Master, deselect the Mesh from Master to Slave option. 

  

Case Study. Joint/Interface Mesh 

(2D) 

In this example Line 2 is placed in selection 

memory (Slave) and a Line joint mesh attribute 

with 6 divisions is assigned to Line 1 (Master). 

Joints are created automatically to tie the Lines 

together with an interface joint mesh. 

Note. The unmerge facility allows coincident features to be created from a single feature and 

also allows a feature to be set as Unmergable, so it will not be accidentally merged back with 

another coincident feature. See Merging and Unmerging for more details. 
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Case Study. Cylindrical 

Joint/Interface Mesh (3D) 

In this example, a Surface joint mesh is assigned 

to Surfaces between two concentric cylinders. 

Cylindrical axes are defined for the joint 

properties using a local coordinate. Joint local x 

axes will then coincide with the cylinder radial 

direction. 

Joint Material and Geometric Properties 

Joint material and geometric properties are assigned to the master feature. 

 Joint Material Properties Joint meshes require joint properties to be assigned to 

them. These are defined from the Attributes> Material> Joint menu item.  

 Joint Geometric Properties For joints with rotational degrees of freedom an 

eccentricity must be specified using the Attributes> Geometric> Joint menu item. 

Non-Structural Mass Elements 

Non-structural mass elements are used to define a lumped mass at a Point, or a distributed 

mass along a Line or over a Surface. Variations may be used to vary the mass along the Line 

or over the Surface.  

Defining and Assigning Non-Structural Mass Elements 

A non-structural mass element is defined as a mesh attribute using the Attributes> Mesh 

menu item and specifying the structural element type to be used. Once defined it is assigned 

to selected features using the standard drag and drop technique.  

Non-structural mass elements also require material properties to be assigned to them. Use the 

Attributes> Material menu item to create the required mass for assignment. 

Note. Mass properties should be defined per unit length when assigned to Lines and per unit 

area when assigned to Surfaces. 

Examples of Assigned Non-Structural Mass Elements 
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Lumped mass at a point Distributed mass along a line Distributed mass over a surface 

Non-Structural Mass Local Axis Direction 

Since the mass can be used to model hydrodynamic effects it is defined in local directions. In 

the case of a line, the direction may need to be normal to the line or in the case of a surface, 

normal to that surface. When carrying out large deformation analyses these directions are 

continually updated as the solution progresses. The element axis direction can be defined 

when the mesh is assigned. Three axis orientation options are available: 

 Follow point axes (Default selection) Adopt the axes assigned from the Local 

Coordinate (if any) assigned to the point. Any Local Coordinate that has been assigned 

to a feature can, additionally, be chosen to be ignored as a separate option. 

 By point in selection memory - A Point previously added to selection memory is 

used to define the xy-plane.  

 By specified local coordinates The element axes are defined using a previously 

defined Local Coordinate. 

Delamination Interface Elements 

Interface elements may be used at planes of potential delamination to model inter laminar 

failure, and crack initiation and propagation. 

If the strength exceeds the strength threshold value in the opening or shearing directions the 

material properties of the interface element are reduced linearly as defined by the material 

parameters and complete failure is assumed to have occurred when the fracture energy is 

exceeded. No initial crack is inserted so the interface elements can be placed in the model at 

potential delamination areas where they lie dormant until failure occurs. 

Fracture Modes 

Three fracture modes exist: open, shear, and tear (orthogonal shear for 3D models). The 

number of fracture modes corresponds to the number of dimensions of the model. The 

diagram below illustrates the three modes. 
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 Mode 1 - Open 

  
 
 Mode 2 - Shear 

  
Mode 3 - Tear  
 (orthogonal shear to mode 2) 

 

 

  
 

 

  
 

 

The interface elements are used to model delamination in an incremental nonlinear analysis. 

These elements have no geometric properties and are assumed to have no thickness. 

Interface elements are defined as Line or Surface mesh attributes using the Attribute> Mesh 

menu item.  

Interface Material Properties 

The interface material properties are defined from the Attribute> Material> Specialised 

menu item and then assigned to the same geometry as the interface mesh. 

 

Material Parameters 

 Fracture energy Measured values for each fracture mode depending on the material 

being used, e.g. carbon fibre, glass fibre. 

 Initiation Stress The tension threshold /interface strength is the stress at which 

delamination is initiated. This should be a good estimate of the actual delamination 

tensile strength but, for many problems, the precise value has little effect on the 
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computed response. If convergence difficulties arise it may be necessary to reduce the 

threshold values to obtain a solution. 

 Relative displacement The maximum relative displacement is used to define the 

stiffness of the interface before failure. Provided it is sufficiently small to simulate an 

initially very stiff interface it will have little effect. 

Coupling Model 

 Coupled/mixed interface damage - Recommended method. 

 Uncoupled /reversible - Unloading is reversible along the loading path. 

 Uncoupled /origin - Unloading is directly towards the origin ignoring the loading 

path. 

Notes 

 It is recommended that automatic nonlinear incrementation is used with the arc length 

procedure option set to root with the lowest residual norm, when defining loadcase 

control. 

 It is recommended that fine integration is selected for the parent elements from the 

Solution tab of the Model Properties dialog. 

 The nonlinear convergence criteria should be set to converge on the residual norm. 

 Choose Continue solution if more than one negative pivot occurs from the Model 

properties, Solution tab, Nonlinear options dialog and set option 252 to suppress pivot 

warning messages from the solution process. 

 The non symmetric solver is run automatically when mixed mode delamination is 

specified. 

 Although the solution is largely independent of the mesh discretisation, to avoid 

convergence difficulties it is recommended that a least two elements are placed in the 

process zone. 

Element Selection 

About LUSAS Elements 

Elements are classified into groups according to their function. The main element groups are 

listed below.  

 See also Joint Element Meshes, and Interface Elements (for composite 

delamination). 

 For full details of all elements refer to the Element Reference Manual. 
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 For full details of the element formulations refer to the LUSAS Theory Manual. 

Point Element Selection 

Non structural mass and Joint elements are defined at or between points.  

Elements in plain text are available Standard product versions of LUSAS software. Elements 

in bold text are in Plus versions. 

 

Generic Element Types 2D 3D 

Non structural mass PM2 PM3 

Joint (no rotational stiffness)  JNT3 JNT4 

Joint (for beams) JPH3 JSH4 

Joint (for grillages) JF3  

Joint (for axisymmetric solids) JAX3  

Joint (for axisymmetric shells) JXS3  

  

Line Element Selection 

The following table lists the elements available for Line meshing by type and by name. The 

first column matches the option list in the Line mesh dialog box.  

Elements marked with (LT) are in Lite versions of LUSAS software. Elements in plain text 

are available in Standard product versions. Elements in bold text are in Plus versions. 

 

Generic  
Element Types 

2D  
2 noded 

2D  
3 noded 

3D  
2 noded 

3D  
3 noded 

’None’  - - - - 

Bar  BAR2 (LT) BAR3 BRS2 (LT) BRS3 

Thin beam  - BM3 - BS3, BS4 

Thick beam BEAM (LT) - BMS3 (LT), BTS3 BMI21 (LT), BMI22, 
BMX22, BMI31, BMX31, 
BMI33, BMX33 

Thick beam (nonlinear) - - - - 

Engineering grillage  GRIL (LT)  - - 

Cross-section beam - BMX3 - BSX4 

Semiloof beam  - - - BSL4 

Axisymmetric membrane  BXM2 BXM3 JNT4 - 
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Generic  
Element Types 

2D  
2 noded 

2D  
3 noded 

3D  
2 noded 

3D  
3 noded 

Joint (no rotational stiffness) JNT3 - JSH4 - 

Joint (for beams) JPH3 - - - 

Joint (for grillages) JF3 - - - 

Joint (for axisymmetric solids) JAX3 - - - 

Joint (for axisymmetric shells) JXS3 - - - 

Thermal bar  BFD2 BFD3 BFS2 BFS3 

Axisymmetric thermal 
membrane 

BFX2 
 

BFX3 
 

- - 

Thermal link LFD2 - LFS2 - 

Interface - IPN6 - - 

Non structural mass LM2 LM3 LMS3 LMS4 

Notes 

 Quadratic elements are curved with a mid-side node. 

 For some beam elements rotational freedoms at the ends of a Line can be made free 

to rotate by using an element with moment release end conditions. 

 When modelling 2D frame problems it is recommended to use the relevant family of 

3D beam elements (rather than 2D elements) if, at a later date, it is intended to convert 

the 2D model into a full 3D model. 

 No check is made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, however LUSAS Solver will stop the analysis if the 

element is unsuitable. 

 This list is a guide as to which elements to use. Not all elements are listed here. See 

the Element Reference Manual for full details of all elements. 

Surface Element Selection 

The following table lists the elements available for surface meshing by type and by name. 

The first column matches the option list in the Surface mesh dialog box.  

Elements in plain text are available in Standard product versions of LUSAS software. 

Elements in bold text are in Plus versions. 
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Generic  
Element Types 

Triangle 
3 noded  

Quadrilateral 
4 noded 

Triangle 
6 noded 

Quadrilateral 
8 noded 

Plane stress TPM3 QPM4M TPM6 QPM8 

Plane strain TPN3 QPN4M TPN6 QPN8 

Axisymmetric solid TAX3 QAX4M TAX6, TAX6P QAX8, QAX8P 

Thin plate TF3 QF4 - - 

Thick plate  - QSC4 TTF6 QTF8 

Thin shell TS3 QSI4 TSL6 QSL8 

Thick shell TTS3 QTS4 TTS6 QTS8 

Membrane TSM3 SMI4 - - 

Fourier TAX3F QAX4F TAX6F QAX8 

Plane field (thermal)  TFD3 QFD4 TFD6 QFD8 

Axisymmetric solid field TXF3 QXF4 TXF3 QXF8 

Explicit dynamic - plane stress TPM3E QPM4E - - 

Explicit dynamic - plane strain TPN3E QPN4E - - 

Explicit dynamic - axisymmetric TAX3E QAX4E - - 

Interface - - - IS16 

Non structural mass TM3 QM4 TM6 QM8 

Notes 

 No check is made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, however LUSAS Solver will stop the analysis if the 

element is unsuitable. 

 This list is a guide as to which elements to use. Not all elements are listed here. See 

the Element Reference Manual for full details of all elements. 

Volume Element Selection 

The following table lists the elements available for volume meshing by type and by name. 

The first column matches the option list in the Volume mesh dialog box.  

Elements in plain text are available in Standard product versions of LUSAS software. 

Elements in bold text are in Plus versions. 
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  Tetrahedral Pentahedral 

Generic 
Element Types 

4  
noded 

10  
noded  

6  
noded 

12  
noded 

15  
noded  

Stress TH4 TH10 PN6 - PN15 

Thermal TF4 TF10 PF6 - PF15 

Explicit dynamic TH4E - PN6E - - 

Stress composite - - PN6L PN12L PN15L 

Thermal composite - - PF6C PF12C PF15C 

 

 

  Hexahedral 

Generic  
Element Types 

8  
noded 

16  
noded  

20  
noded 

Stress HX8M  HX20 

Thermal HF8  HF20 

Explicit Dynamic HX8E   

Stress Composite HX8L HX16L HX20L 

Thermal Composite HF8C HF16C HF20C 

Notes 

 No check is made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, however LUSAS Solver will stop the analysis if the 

element is unsuitable. 

 This list is a guide as to which elements to use. Not all elements are listed here.  

  

Geometric Properties 

Any geometric properties that have not already been inherently defined by the feature 

geometry need to be specified using geometric property attributes.  

Geometric properties are element dependent and are defined for an element family such as 

bars, beams, shells, joints etc. Note that geometric attributes are not required for plane strain, 

axisymmetric solid or 3D solid elements. For more details on the properties required for a 

specific elements refer to the Element Reference Manual 
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Geometric attributes are defined for each feature type using the Attributes> Geometric 

menu item and then assigned to the required geometric feature (or to an appropriate mesh 

object in a mesh-only model). Geometric properties can be defined for: 

 Lines 

 Surfaces 

 Joints 

Geometric Line Properties 

Geometric line section properties such as cross-sectional area, second moments of area etc., 

for bar/link, grillage, axisymmetric membrane etc., and thin/thick beam elements can be 

defined either by: 

 Using the Attributes> Geometric> Section Library menu item to access supplied 

and user-created sections in the section library. 

 Using the Attributes> Geometric> Line menu item to enter section properties 

directly on the Geometric Line dialog. If this option is chosen all beam cross-section 

information will need to be defined if the section was not selected from a standard 

section library or created by using the arbitrary section property calculator. The 

arbitrary section property calculator should generally be used to create sections in 

preference to manually defining geometric line property data since cross-sectional 

values (used by the fleshing facility) are automatically stored as part of the section 

property calculation. 

Varying sections can be defined by: 

 Using the Attributes> Geometric> Tapered Section menu item to define a tapering 

section where the section geometry varies linearly for the length of the assigned line. 

See Tapering Sections for details 

 Using the Attributes> Geometric> Multiple Varying Section menu item to create a 

geometric line attribute that defines completely varying section built from any number 

of cross-sections that are to be assigned to a line or a whole series or path of lines at 

specified distances. See Multiple Varying Sections for details. 

Reinforcement attributes (used in the calculation of particular crack width calculations) can 

be defined by: 

 Using the Attributes> Geometric> Bar Reinforcement menu item to access the 

reinforcement attribute dialog. See Reinforcement Attributes for details. 

The following options are available when defining geometric line properties: 

 Visualise Cross-sectional shapes for standard library items and for user sections 

(stored in local and server libraries that were created by the standard and arbitrary 
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section property calculators) will be automatically visualised. General beam sections 

defined by using the Attributes > Geometric > Line menu item, will require cross-

section properties to be defined manually in order for geometric visualisation (and 

fleshing) to take place. The orientation of the visualised section is based upon the 

vertical axis defined for the model. In LUSAS, 2D models are assumed to be drawn in 

the XY plane with the Y axis vertical, and 3D models with have the Z axis set to be 

vertical. The local axes of the section are located at its centroid. A circle, of the same 

pen colour that is defined for Lines, represents the location of the nodal line about 

which the section will be positioned when the section is assigned to a line on the 

model. Setting an eccentricity (according to element type) moves the location of the 

nodal line with respect to the centroid. See Eccentricities for more details. 

 Tapering... / Non-Tapering... Tapering beam sections can be defined by specifying 

section properties for each end of the beam. For complex sections this would normally 

be done by drawing selected cross sections for key locations along a model and using 

the arbitrary section property calculator in Modeller to calculate and save the 

properties to a library prior to using this dialog. Where both ends of a beam have been 

defined using either a LUSAS supplied standard library item or one of the LUSAS 

standard section calculators an 'exact' calculation can be made to arrive at intermediate 

section properties based upon the known shapes at either end of the beam. As a result, 

no interpolation options can be specified for this situation. In cases where one or both 

ends of a beam section have been defined using the arbitrary section calculator 

(including properties calculated from the precast section range) a choice of 

interpolation method is provided. When the tapering option is chosen, the vertical and 

horizontal alignment of one end of the beam section from the other can be specified. 

Tapered beams would normally use the same section shape at either end, but differing 

sections can be accommodated. Eccentricities of beam ends from nodal positions can 

also be defined. When modelling varying cross sections with constant section beam 

elements care should be taken to ensure that sufficient elements have been assigned. 

More complex tapering can be achieved using the Multiple Varying Section facility. 

 Section details of section properties, fibre locations and coordinates defining the 

Cross-sectional geometry of the section can be viewed in tabular format. 

 Properties Provides listings of Standard, Additional (used primarily for design 

checking) and Plastic properties. Plastic geometric properties are required for 

beams when using the stress resultant material model (model 29) and 

comprise: 
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Standard properties 
 

Additional properties for design checking 

A - Cross-sectional area 

Ixx - Second moment of area about x axis 

Iyy- Second moment of area about y axis 

Izz - Second moment of area about z axis 

Ixy, Iyz, Izx - Product moments of area 

J - Torsional constant 

Asx - Effective shear in x direction 

Asy - Effective shear in y direction 

Asz - Effective shear in z direction 

  

 kx - Radius of gyration about x axis 

ky - Radius of gyration about x axis 

kz - Radius of gyration about x axis 

Cw - Warping torsional constant 

xo - Shear centre, distance from centroid along x 
axis 

yo - Shear centre, distance from centroid along y 
axis 

zo - Shear centre, distance from centroid along z 
axis 

  

Plastic properties 

Ap - Plastic cross-sectional area (= elastic area) 

Zpy - Plastic section modulus about y axis 

Zpz - Plastic section modulus about z axis 

Zpt - Plastic torsional section modulus 

Yp - Plastic neutral axis, distance from centroid along 
y/z axis 

Zp - Plastic neutral axis, distance from centroid along 
y/z axis 

   

  

The actual parameters required for an analysis depend on the chosen beam 

element. See the Element Reference Manual for further details. 

Eccentricity values can be used to position the top or bottom of a section with 

respect to a nodal line. The use of fibre location values can assist here too. 

 Fibre locations drawn as green symbols with an 

identifying reference define positions on the perimeter of 

the beam cross-section at which stresses can be plotted 

when visualising results. Standard sections, precast beam 

sections, and box sections added to a library will have 

their cross-sectional geometry pre-defined. They also 

have default fibre locations stored for each section. 

Sections drawn by users and added to the user and server 

libraries using the arbitrary section property calculator 

have extreme fibre locations calculated automatically - 

these are denoted by 'A1', 'A2', etc. Additional fibre 

locations can also be added manually for points on the 

outer boundary of a section. Fibre location values can 

also be used for copying and pasting into the eccentricity cell of the main 

dialog if the top or bottom of a section is to lie on a nodal line, or for use in 
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calculating an eccentricity value to position the section in any other chosen 

position with respect to a nodal line. 

 Cross-section information is used to define a series of quadrilateral shapes 

that represent the cross-sectional shape of the section. These only need to be 

defined if a beam's properties have been defined manually and it is required 

that the beam's shape is visualised when using the fleshing  option, 

otherwise cross-sectional information is automatically for sections provided or 

created by LUSAS section property calculators. 

 In defining the cross-section shape the coordinate of 

each quadrilateral must be defined in local zy cross-

section coordinate pairs at each node, z1, y1, z2, y2, z3, 

y3, z4, y4. When defining a cross-section by this 

method the centroid of the section must reside at 0,0. 

For Cross Section Beam elements (for advanced use 

only) the number of integration points (also known as 

gauss points) can also be set. 

 

Once defined, the geometric section properties are added to the  Treeview using the OK or 

Apply button. The section is then available for assigning to the appropriate Lines on the 

model. Assigned beam section properties may be fleshed using the fleshing button  or 

from the  Attributes Treeview. 

Eccentricities 

 Beam elements 

accommodate 

Eccentricities which are 

measured from the 

bending plane  to the 

nodal line in the local 

element direction. Beam 

section properties are 

always input relative to 

the beam axis. 

 When sections are 

defined at either ends of a 

tapering beam the 

eccentricity of one section to the other to achieve the vertical and horizontal alignment 

setting specified is automatically calculated. Subsequent entering of an eccentricity 

value for the 'master' end in the Value field will automatically position and update the 

value for the other 'follower' end by an equivalent amount to ensure the beam ends are 

moved equally from their nodal positions. If a vertical or horizontal alignment 
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eccentricity is stated in the Alignment panel of the dialog that value will only affect 

the 'follower' end. 

Notes 

 The orientation of the visualised section is based upon the vertical axis that is defined 

for the model. In LUSAS, 2D models are assumed to be drawn in the XY plane with 

the Y axis vertical. 3D models normally have the Z axis set to be vertical.  

 For tapering sections defined using the same standard section (rectangular, rectangular 

hollow section, circular, circular hollow section etc) at each beam end the standard 

LUSAS section property calculator is used to accurately calculate all section property 

values. 

 For tapering sections defined using arbitrary sections of the same section shape at 

each beam end the standard LUSAS section property calculator is used to calculate the 

values of A, Iyy, Izz and Iyz. By default the enhanced interpolation method is used to 

calculate the values of J, Asy and Asz, but the linear interpolation method is also 

available. The Enhanced interpolation method has been proven to generally produce 

more accurate section property values than the Linear method. 

 For tapering sections defined using arbitrary sections with different section shapes at 

each beam end, by default the Enhanced method is used to calculate all values but the 

linear interpolation method is also available.  

 The visualisation of tapering sections on the Geometric Line dialog is for information 

only. Only by selecting the Visualise button will a correct representation of the 

relative arrangement of both sections be seen, incorporating any alignment options 

specified on the main dialog. 

 When modelling varying cross sections with constant section beam elements care 

should be taken to ensure that sufficient elements have been assigned. Greater than 8 

elements should be used for small variations in cross section along the length of the 

geometry to which the section has been assigned, and considerably more elements 

should be used for larger variations. 

 Models created prior to version 14.2 will not have any fibre locations data stored for 

each beam. However, the relevant fibre location data can be added automatically for 

these models by double-clicking on each Geometric line entry in the  Treeview and 

re-selecting the same section size from the appropriate sections library. 

 Double-clicking on a geometric line attribute name in the  Treeview allows editing 

of beam section information. 



  Chapter 6 

    

165 

Geometric Surface Properties 

Geometric attributes are 

defined for surfaces using the 

Attributes> Geometric> 

Surface menu item. 

  Structures modelled 

using plate, membrane 

or shell elements 

require a Thickness to 

be defined for each 

surface.  

Eccentricity 

 Optionally an 

Eccentricity can be specified for certain element types. Eccentricity is measured from 

the bending plane to the nodal line in the local element z direction. 

Varying surface properties 

Geometric properties can be varied over a surface by using a variation. See Variations 

for more details. 

Geometric Joint Properties 

Geometric attributes are defined for joints using the Attributes> Geometric> Joint menu 

item. For certain joint elements eccentricity (in teh local z direction) is an optional geometric 

property that can be defined. See the Element Reference Manual for details 

Setting Geometric Attributes for Default Use 

A geometric attribute may be designated as the default assignment using Set Default on the 

context menu. When activated, default attributes are automatically assigned to new geometry 

as it is defined. 

Visualising Geometric Assignments 

Geometric property visualisation of beams of standard or arbitrary cross-section (that are held 

in section libraries), and surface thicknesses can be toggled on and off using fleshing  

button. 

Geometric property attributes can be visualised individually by selecting an attribute name in 

the Attributes  Treeview and clicking the right mouse button to choose Select 

Assignments or Visualise Assignments from the context menu. This is the easiest way to 

interrogate the assignment of a single attribute. 
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Geometric property dependency across analyses / 

loadcases 

Geometric properties defined and assigned to features for the first loadcase within a base 

analysis can be optionally inherited by all other analyses. Assigning a different geometric 

property to selected features in a following analysis supercedes any inherited geometric 

properties but for only those assigned features. 

Styles 

The Attributes layer properties define the styles by which geometric properties are visualised 

and also permits visualisation of loadings on an individual basis. The attributes layer 

properties may be edited directly by double clicking the layer name in the Layers  

Treeview. Loading can be visualised in three ways: 

 By colouring geometry Colours the geometry according to which attributes are 

assigned to which features. 

 Visualise cross section displays any beam section shape exaggerated by a specified 

%. 

 Show variation of offsets smoothed displays a series of offset beams as a smoothed 

line rather than series of steps. 

 Use solid fill for volumes in model colour fills volumes for visualisation purposes. 

 Cross-section end shrinkage options of Automatic or Specified distance permit the 

beam sections to be shrunk away from the line ends for clarity at connections. 

Selecting None visualises the geometry from point to point with no shrinkage. 

See About Model Attributes for more details. 

Fleshing 

Beams of standard or arbitrary cross-section (that are held in section libraries), and surface 

thicknesses can be visualised on the geometry model using the fleshing  button, or from 

the Attributes  Layer properties Geometric tab.  

From the geometric settings dialog or from the context menu of the fleshing button the cross-

section may be exaggerated in size and shrunk in from the ends of the assigned Line to aid 

visualisation at the connections. When processing results the deformed cross-section shape 

may also be visualised by selecting the Deform option on the geometric properties dialog. 
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Visualisation of Attributes Without Fleshing Visualisation of Attributes With Fleshing 

 (and end shrinkage applied) 

Reinforcement Attributes 

Reinforcement bar attributes are used to model the steel reinforcement in reinforced concrete. 

When used with the Smoothed Multi Crack Concrete Model (Model 102) and the Crack 

Widths calculation utility, contours and values of crack widths can be plotted in accordance 

with EN 1992-1-1:2004 Eurocode 2. Crack width contours are plotted along the bar elements 

(actually on the surface of the fleshed bar section) corresponding to the steel strains used in 

the calculation, 

Reinforcement attributes are similar to geometric line attributes but need to be assigned to 

lines meshed with bar elements for a chosen analysis to enable a crack width calculation to be 

carried out.  

Bar attributes may be defined for a single reinforcing bar (Discrete bar method), as would be 

used in a 3D model, or be defined with suitable properties to represent a bundle or simplified 

arrangement of bars (Equivalent bar method) as would be used typically in a 2D plane strain 

analysis.  

 Bar area The cross sectional area of an individual reinforcing bar if discrete bars are 

being defined, or the equivalent area of a number of reinforcing bars if a bundle or 

simplified arrangement of bars is being considered. 

Parameters for nonlinear concrete crack checking 

This check box must be checked to enable crack width checking to take place. 

 Reinforcement cover - the nominal cover to the reinforcing bar from the concrete 

face in tension. 

 Bar diameter - the diameter of a single bar if individual (discrete) reinforcing bars are 

being considered, or the equivalent diameter if a bundle or simplified arrangement of 

bars is being considered.  
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 Reinforcement type - may be defined as Discrete bars or Equivalent bars Choosing 

Discrete bars requires input of properties for an individual bar. Choosing Equivalent 

bars requires input of a bar area that represents the bundle or simplified arrangement 

of bars being considered. For this, the bar diameter specified should always be that of 

a single bar. 

 Breadth of section/Bar spacing - If Equivalent bars are being defined the breadth of 

concrete section (the width of the effective concrete tension area) that the bars are 

occupying would be stated. If Discrete bars are being defined the centre to centre 

distance of the bar from its nearest neighbour would be stated.  

 Ratio of bond strength ( i) - An adjusted ratio of bond strength that will take into 

account the different diameters of prestressing and reinforcing steel if both are used. 

This has a (default) value of 1 when only reinforcement bars and no prestressing 

tendons are present. Refer to EN 1992-1-1:2004 Table 6.2 for suggested values 

otherwise. 

Notes 

 Any number of reinforcement attributes can be created and assigned to lines in the 

model for different analyses. 

 The cross-sectional shape is automatically created from the bar diameter. 

 If changing a bar diameter for a Discrete bar the Bar area will also need changing, and 

vice-versa.  

 If changing the bar diameter for Equivalent bars the Bar area will also need changing, 

and vice-versa. 

 If previously defined reinforcement attribute values are changed the model must be re-

solved prior to running the Crack Width calculation facility. 

  

Section Library 

The section library is available from the Attributes> Geometric> Section Library menu 

item. Standard steel section libraries are currently available for the following: 

 Australia steel sections 

 Canada steel sections 

 China steel sections 

 EU steel sections 

 KS steel sections (including Korean Rail Sections) 

 UK steel sections 

 US steel sections 
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The library of precast concrete sections supplied currently includes: 

 UK beams: Y, YE, TY, TYE, SY, M, UM and U beam types 

 US beams: AASHTO Types II to VI, Florida Bulb T72 and T78 beams, NU 

Girders and Texas DoT 'I' Beams, North-East 'T' Bulbs. 

 Australia and New Zealand beams: Super-T beams T1 to T5 (open and closed) 

 Canada 'I' beams 

In addition, user-created section properties can be saved in the following libraries: 

 User (local) - for use inside the current project folder only 

 User (server) - for use across all projects 

See Library Locations for details about library filenames and locations. 

Sections selected from a library are added to the Attributes  Treeview. From there they can 

be assigned to selected line features on a model (or to appropriate elements in a mesh-only 

model). For more details on the use of section library items see the Geometric Properties 

section. 

Adding Additional Sections to the Section Library 

In addition to sections provided in the geometric beam section library, other sections can be 

added to the library by using Section Property Calculator facilities. These are accessed from 

the Utilities > Section Property Calculator menu. Facilities exist to calculate the properties 

of standard sections, precast beam sections with a top slab, simple and complex box sections, 

and user-defined arbitrary sections that are created in LUSAS Modeller.  

Multiple Varying Sections 

The multiple varying section dialog is accessed using the Attributes > Geometric 

> Multiple Varying Section menu item. It enables pre-defined cross-sections to be specified 

at distances that can be interpolated into a single varying section for subsequent assignment to 

a single line, or to a series of lines with reference to a pre-defined reference path. A table is 

built up specifying the section shapes which define the varying section, the interpolation 

method to be used in order to describe the change of section shape between sections, and the 

alignment method to be used to set-out each section with respect to another.  

Basic usage and section selection 

A multiple varying section is defined for use with a particular element type, selected in the 

Usage part of the dialog. In the section selection table the sections that will be used to 

generate a varying cross section along a line or path of lines must each be added, and an 

interpolation method and a distance from a starting point must be specified for each. Note that 

user-defined sections need to be saved to the local or server libraries prior to using this 

facility. 

 Clicking on the launch dialog button  in the Section cell allows a pre-defined 

section to be chosen from a section library. 
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 Clicking on the drop-list button  in the Shape Interpolation cell permits the 

definition of an interpolation setting which defines the shape between adjacent pairs 

of defined sections.  

 Specifying a Distance interpretation dictates how the section spacing values entered 

are to be interpreted. 

More detail is provided in the following sections. 

Shape Interpolation 

A shape interpolation setting defines how the shape between adjacent pairs of defined 

sections is calculated. Note that it does not define or calculate the engineering properties for 

those shapes (for that see Section Interpolation below). Shape interpolation options are only 

available for second and subsequent entries in the table. The following interpolation options 

are available: 

 Smoothed is available for use with any number of sections. In practice, smoothed is 

linear for two, quadratic for three, and a cubic spline fit for more than three. Thus, 

when the interpolation technique is manually chosen, sections are entered in groups. 

 Linear can be used with any number of defined sections (if there are more than two, a 

piecewise linear approach is assumed).  

 Quadratic can be used for sets of sections, that is for 3 sections, 5 sections, 7 sections 

etc., where three values can be interpolated (for the first, middle, and last section in a 

set). 

 Function is a function based method where the order (n) for the function that is 

shown on the dialog defines the shape between adjacent pairs of sections. 

Shape interpolation settings are only available for second and subsequent entries in the table. 

If 'Specify interpolation order' is unchecked (off), the ‘shape interpolation’ column in the grid 

is disabled, and a smoothed (spline) interpolation technique is used to fit all the given sections 

at their given distances. 

Distance interpretation 

 Scaled to fit each line individually For this option values entered in the Distance 

column of the table represent the locations along each line that the sections will be 

assigned. Values are entered as proportional distances along a line (for example, 

entering 0, 0.5 and 1 would specify a section at either end and at a mid-point of any 

line that was selected and assigned this geometric line attribute). Distance values are 

normalised to the actual line length and are offset by the start distance. For example, a 

section that varies from defined geometry at start, middle and end can be input with 

distances as 0, 0.5 and 1.0, or 0, 5, and 10, or 10; 15, and 20. This flexibility can be 

used to entire a series of definitions along a common parallel chainage.  
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 Along reference path For this option values must be entered in the Distance cells of 

the table that specify the actual distance at which each section will be positioned along 

a reference path. Values are entered as absolute and not relative distances. Note that a 

section does not necessarily have to be defined to start at a distance of 0. A particular 

reference path can be specified prior to assignment or on assignment. 

Examples are provided of distance types. See Distance Types and Methods of Assignment. 

Table related buttons 

 The Symmetric section check box copies any rows above the last defined entry and 

reverses them to create a symmetric odd-numbered arrangement.  

 Edit, Insert and Delete buttons provide the means to select sections from the library, 

create new rows above a selected row, and to delete rows from the table.  

 Flip mirrors the contents of the table (and the visualisation of the varying section 

shape). 

Alignment 

 Vertical and horizontal alignments - these govern how tops, centres, bottoms and 

sides of adjacent beam sections are set out relative to the 'master' section specified in 

the adjacent 'Alignment' drop-down list. An option to enter user-defined individual 

eccentricities is also provided and enables more advanced alignment to be achieved.  

 Align all sections to section (number) - aligns all sections with respect to the 

specified 'master' section number. See Section eccentricities explained. 

Section eccentricities explained 

When sections are specified to define a multiple varying section beam it is important to 

remember that the 'master' section is the one to which all 'follower' sections are aligned to. 

The eccentricity of each 'follower' section to achieve the desired vertical and horizontal 

alignment with respect to the 'master' is automatically calculated for each section. The 

eccentricity values for 'follower' sections are made up of a value corresponding to the 

automatically calculated eccentricity required to achieve correct alignment to the master 

section plus any additional user-defined individual eccentricity that may have been defined 

for the 'master' section. These values can be seen by clicking the launch dialog button  in 

the Section cell of the table for the section. 

Maintaining a consistent 'master' section will make it easier to marry multiple varying section 

attribute assignments. Subsequent updating of an eccentricity value for a 'master' section will 

automatically update the eccentricity values for all of the 'follower' sections by an equivalent 

amount to ensure the sections are moved equally to re-align with the master section. Updating 

of eccentricity values is only possible by selecting the 'Individual offsets' option on the 

Vertical or Horizontal alignment drop-down lists, and clicking the launch dialog button  in 

the Section cell of the table for a section, and entering an eccentricity value on the 'Enter 

section' dialog). 
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Note that for beam elements an eccentricity is measured from the bending plane of the 

section to the nodal line in the local element direction. This can result in both positive and 

negative eccentricity values depending upon the size of the 'master' and 'follower' sections.  

To move a multiple varying section beam up or down from its nodal line position only the 

eccentricity for the 'master' section need be modified because all other sections will have their 

eccentricity values updated automatically to be moved by the same amount. 

  

 

Whilst not commonly used, user-defined individual eccentricity can be entered for selected 

sections by selecting the Individual eccentricity menu item from either the Vertical or 

Horizontal Alignment drop-down menu, then accessing a section's properties by clicking the 

launch dialog button  in this cell and entering an eccentricity value on the Enter section 

dialog. When an individual eccentricity is specified on a 'follower' section any connection 

with the 'master' section is broken and any eccentricity specified for a 'master' section will no 

longer update the offsets on a 'follower' section. 

Interpolation of section properties 

Where all sections have been defined using either a LUSAS supplied standard library item or 

one of the LUSAS standard section generators an 'exact' calculation is made to arrive at 

intermediate section properties based upon the defined shape (see Shape Interpolation 

above) between the sections.  

If the shape of the cross-section cannot be interpolated (because one of the sections has been 

defined using the arbitrary section calculator, the precast library, or if sections are of 

completely different shapes) the engineering properties at locations along the multiple 

varying section can be calculated in the following ways: 

 Enhanced interpolation uses proprietary LUSAS equations to calculate best-estimate 

cross-section properties for locations along a beam from the cross-sectional area (A) 
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and Moment of Inertia (I) values of the sections defined at each beam end. See the 

Theory Manual for more details. 

 Linear interpolation calculates cross-section properties for locations along the beam 

by linearly interpolating the cross-sectional area (A) and Moment of Inertia (I) values 

of the sections defined at each beam end. This method has generally known 

limitations for particular section types. 

When modelling varying sections with constant beam elements (such as BMS elements) care 

should be taken to ensure that sufficient elements have been assigned to the line(s) 

representing the tapering beam to achieve sufficient accuracy of results. If varying section 

beam elements are used (the BMI group of elements) only one element per line may be 

required. 

Attribute name 

The full name of the geometric line attribute added to the  Treeview will include the 

Attribute name followed by an automatically created name based upon the number of section 

library items used. The automatically created part of the name is uneditable. 

Once defined, the geometric section properties are added to the  Treeview using the OK or 

Apply button. The section is then available for assigning to the appropriate lines on the model 

(or elements in a mesh-only model). Assigned beam section properties may be fleshed using 

the fleshing button  or from the  Attributes Treeview. 

Section visualisation 

As the multiple varying section is built-up in the table, a visualisation of the longitudinal and 

vertical alignment and of the cross-section shapes used is displayed on the dialog. Note that 

longitudinal section visualisation only takes place once all required data for a row has been 

entered, and then only for sections that are compatible. The visualisation can be inspected by 

zooming and panning in the display panel. A changing cursor image indicates whether the 

facility is enabled or not. If necessary click in the panel to activate this facility. Use the mouse 

wheel to zoom in and out. Click and hold-down the left mouse button, or click and hold-down 

the mouse wheel to pan.  

Multiple varying sections would normally be defined to use the same section shape having 

the same set of fibre definitions throughout, but differing sections can be accommodated. In 

situations where the varying sections are too different to be connected together section 

visualisation on the dialog and fleshing of any assigned attributes on the model is not 

possible. 

Incompatible section types 

Checking for incompatible section types can only be carried-out when the OK button is 

pressed. 
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Multiple Varying Section Distance Types and Methods of 

Assignment 

A multiple varying section geometric line attribute can be defined for assignment to either: 

 A single line - where section spacing distances are scaled to fit each line individually 

 A series of lines - where section spacing distances are defined for use with a pre-

defined reference path 

  
Varying section distances defined for assignment  

of the line attribute to a single line. 

Varying section distances defined for assignment 

 to multiple lines with reference to a path. 

The values entered in the distance cell of the multiple varying section dialog depend upon the 

intended assignment. Examples of each type follow. 

Scaled to fit each line individually 

Use of the Scaled to fit each line individually option enables a simple prototyping and 

assessment model for a bridge formed of tapered box sections to be created in a very 

straightforward manner. In their simplest form, multiple varying sections can be defined for 

assigning to single selected lines on a model (or appropriate elements on a mesh-only model). 

Distance values are normalised to the actual line length and are offset by the start distance. 

For example, a section that varies from defined geometry at start, middle and end can be input 

with distances as 0, 0.5 and 1.0, or 0, 5, and 10, or 10; 15, and 20. This flexibility can be used 

to entire a series of definitions along a common parallel chainage.  
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Single line beam assigned a single multiple varying section line attribute 

(for clarity beam line has been visualised at top of section) 

 

 

  

Three varying section line attributes assigned to three separate lines of a model 

Along reference path 

Use of the multiple varying section with the reference path facility enables beam models of 

bridges formed of tapered box sections to be created for use in a staged construction analysis. 

With this, multiple varying sections are assigned to multiple lines. Distance values are entered 

that define the distances at which a defined section is to be positioned along a set of selected 

lines with reference to a pre-defined reference path. Note that a section does not necessarily 
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have to be defined to start at a distance of 0. A path can be specified to start at a particular 

distance. This method has uses in staged construction analyses where, as lines are activated, 

the appropriate elements and geometric properties for those activated features are added to the 

model. 

 

  

Multiple line beams assigned a single multiple varying section line attribute with reference to a path 

(for clarity beam line has been visualised at top of section) 

 

  

Three varying section line attributes assigned to multiple sets of lines of a model with the use of a reference path 

If necessary, one geometric multiple varying section line attribute could be defined for a 

series of multiple varying sections at specified distances that define the complete end-to-end 

run of cross-sections for a bridge. Subsequent assignment of solid or diaphragm sections at 
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supports or mid span would then override any previously assigned 'temporary' assignments of 

voided sections that may have been previously made.  

Line mesh density 

 When modelling varying sections with constant beam elements (such as BMS elements) care 

should be taken to ensure that sufficient elements have been assigned to the line(s) 

representing the tapering beam to achieve sufficient accuracy of results. If varying section 

beam elements are used (the BMI group of elements) only one element per line may be 

required. 

When defined section distances do not map exactly to 

lines on a model 

In defining distances at which sections will apply and then assigning geometric line attributes 

containing those sections to lines on a model (with reference to a path) there may be 

occasions where the set of defined sections are too short for the assigned line (or lines) or too 

long. 

 If a set of defined sections are too short for the assigned line (or lines) the geometric 

line attribute will stay assigned to all line (or lines) selected but no visualisation 

(fleshing) will take place on any line in a set of lines that does not have a complete line 

attribute assigned. Any attempt to solve a model containing such assignments will also 

produce tabulation errors. 

  If a set of defined sections are too long for the assigned line (or lines) fleshing of the 

section shape will take place but only for the length of line (or lines) that was selected 

and no tabulation errors will occur as a result when solving the model. 

Material Properties 

 Material attributes are defined from the Attributes> Materials menu item and then assigned 

to the required geometric feature (or to mesh objects in a mesh-only model). Every part of a 

finite element model must be assigned a material property attribute. Note that not all elements 

accept all material property types. Refer to the Element Reference Manual for full details of 

valid element/material combinations. 

Linear and Nonlinear Material Properties 

 Isotropic/Orthotropic Defines linear elastic or nonlinear material properties with 

options for plasticity, hardening, creep, damage (continuum or composite, viscosity 

and two-phase materials. 

 Anisotropic Different material properties are specified in arbitrary (non-orthotropic) 

directions by direct specification of the modulus matrix. See LUSAS Theory Manual 2 

for details. 

 Joint Linear and nonlinear joint material models for contact and impact analyses using 

joint elements. 
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 Rigidities Allows direct specification of the material rigidity matrix. In-plane and 

bending rigidities are defined from prior explicit integration through the element 

thickness. 

 Mass material models for specifying mass in structure using non-structural mass 

elements. 

Specialised Material Properties 

 Delamination models for use with the composite delamination interface elements. 

 Rubber Defines materials with hyper-elastic or rubber-like mechanical behaviour. 

 Crushing A volumetric crushing model such as would be used for crushable foam-

filled composite structures. 

 Modified Cam-Clay A variant of the classic Cam-clay model used for the modelling 

of clays. It is capable of modelling the strength and deformation trends of clay 

realistically. 

 Elasto Plastic Interface Defines a material to represent the friction-contact 

relationship within planes of weakness between two discrete bodies. 

 Concrete Creep Models Define material to predict the mean behaviour of a concrete 

section due to creep effects. Models include CEB-FIP (1990), Chinese creep code for 

dams, and Eurocode 2 

 Concrete Creep CEB-FIP (1990) Defines a material to predict the mean behaviour of 

a concrete section due to creep effects. 

 Concrete Creep Chinese Code Defines a material to predict the mean behaviour of a 

concrete section due to creep effects. 

 Concrete Creep Eurocode 2 Defines a material to predict the mean behaviour of a 

concrete section due to creep effects 

 Generic Polymer Defines a model that consists of a set of Maxwell dampers which 

are used to model visco-elasticity, an Eyring dashpot which is used to model 

viscoplasticity and a linear spring. 

 Generic Polymer with Damage Accounts for strain rate behaviour and irrecoverable 

damage in the modelling of polymers and other polymer-like materials. 

 Multi Linear Bar for no-tension (compression-only) or no-compression (tension 

only) material modelling for bar elements. 

 Resultant User A user defined constitutive model defining the stress resultants from 

strain. 

 Nonlinear User A user defined constitutive model defining the stress from strain. 

 Thermal User Applicable to thermal (field) elements only. Whenever thermal 

elements have been used in a model thermal material properties should be defined and 

assigned to the relevant parts of the model. 
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Editing of Material Properties  

Editing of pre-defined material data (such as that provided in the material library) allows 

users to view both the original material definition input data, as well as modify the values 

used. Editing of user-defined material properties only permits viewing and editing of the 

values used. 

Material properties added to the Attributes Treeview have context menu entries named Edit 

Definition and Edit Attribute.   

 Selecting the Edit Definition... menu entry or double clicking the attribute displays 

the original definition dialog with all the original input data intact.  

 Selecting the Edit Attribute...menu entry displays values that can be modified. For 

materials added from the material library, these values may be changed but this breaks 

the link to the original definition dialog and a warning message will be displayed. 

Notes 

 Material property attributes can be formed into a composite lay-up using the 

composite attribute facility. 

 Once assigned to geometry, material directions can be visualised using the Attributes 

layer in the Layers  Treeview 

 Rubber, crushing, and plastic material attributes cannot be combined. 

Material dependency across analyses / loadcases 

Materials defined and assigned to features for the first loadcase within a base analysis can be 

optionally inherited by all other analyses. Assigning a different material to selected features 

in a following analysis supercedes any inherited material but for only those assigned features. 

Material Library 

The more commonly used structural material properties are defined in the material library 

which is located under the Attributes> Material> Material Library menu item. 

The units will default to those chosen on model startup but may be changed if desired. Pick 

the material required from the drop down list and click OK or Apply to add the material 

properties to the  Treeview. The material properties may then be assigned to the model. 

Composite Library 

The more commonly used structural composite material properties are defined in the 

composite library which is located under the Attributes> Material> Composite Library 

menu item. 

The units will default to those chosen on model startup but may be changed if desired. Pick 

the composite material required from the drop down list and click OK or Apply to add the 
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properties to the  Treeview. The composite material properties may then be used to define 

a composite stack or be assigned to the model in the usual way. 

Isotropic/Orthotropic Material 

Isotropic and orthotropic material attributes can be defined using the Attributes > Material 

menu item. The following material properties can be specified. 

 Elastic is used to specify linear elastic material properties including Young’s modulus, 

Poisson’s ratio, mass density. Orthotropic material orientation is specified as global, 

relative to a local coordinate system or relative to the feature local axis system. 

Optional thermal expansion and dynamic constants can be specified. Note that not all 

elements accept all the orthotropic models. Refer to the Element Reference Manual for 

full details of valid element/material combinations. Orthotropic models are Plane 

stress, Plane strain, Thick, Axisymmetric, Solid. 

 Thermal is used to specify properties for general thermal and heat of hydration 

analysis. For general thermal analysis phase change state, thermal conductivity, 

specific heat coefficient, and enthalpy values can be set. For concrete heat of 

hydration analysis, where internal heat is generated by the chemical reaction between 

cement and water as concrete hardens, additional thermal options such as exotherm 

type and cement type can be specified. See Concrete Heat of Hydration for details. 

 Plastic Used to model ductile yielding of nonlinear elasto-plastic materials such as 

metals, concrete, soils/rocks/sand. 

 Hardening Used to model a nonlinear hardening curve data. Hardening is defined as 

part of the plastic properties. Isotropic, Kinematic and Granular sub-types are 

available. Isotropic hardening can be input in three ways. 

 Creep Used to model the inelastic behaviour that occurs when the relationship 

between stress and strain is time dependent. 

 Damage Used to model the initiation and growth of cavities and micro-cracks. 

 Shrinkage Used to define the shrinkage properties of a material as a piecewise linear 

curve.  

 Viscosity Used to model viscoelastic behaviour. Coupling of the viscoelastic with 

nonlinear elasto-plastic materials enables hysteresis effects to be modelled. 

 Two-phase Required when performing an analysis in which two-phase elements are 

used to define the drained and undrained state for soil. 

Plastic Material Models - Isotropic 

The following are Isotropic models available from the Attributes> Material> Isotropic 

menu item by choosing the Plastic check box on the material attribute dialog. 

 Stress Resultant (model 29) Applicable to certain beam and shell elements 

 Tresca (model 61) Represents ductile behaviour of materials which exhibit little 

volumetric strain (for example, metals and undrained clays). Incorporates isotropic 

hardening. 
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 Stress Potential general nonlinear properties based on von-Mises or modified von-

Mises criterion including hardening. 

 Optimised implicit von Mises (model 75) Represents ductile behaviour of materials 

which exhibit little volumetric strain (for example, metals). Especially for explicit 

dynamics. 

 Modified Mohr Coulomb This model applies a tensile and/or a compressive cut-off 

to the standard Mohr-Coulomb model. In tension this prevents unrealistic tensile 

stresses developing in materials such as soil or rock. In compression the cut-off results 

in irreversible deformations once the maximum compressive stress is exceeded. The 

cut-off can be applied to either a single principal stress component or to the mean 

pressure. 

 Mohr-Coulomb (model 65) with non-associative flow. Represents materials which 

exhibit volumetric plastic strain but no volumetric strain during shear. (for example, 

granular materials such as rock and soils). Incorporates isotropic hardening. 

 Drucker-Prager (model 64) Represents ductile behaviour of materials which exhibit 

volumetric plastic strain (for example, granular materials such as concrete and soils). 

Incorporates isotropic hardening. 

 Concrete (Multi Crack (model 94) and Smoothed Multi Crack (model 102) A pair of 

two and three-d imensional concrete material models that model both cracking and 

crushing behaviour. 

Plastic Material Models - Orthotropic 

 Stress Potential (Hill and Hoffman models) These models are available from the 

Attributes> Material> Orthotropic menu item by choosing the Plastic check box on 

the material attribute dialog. 

The stress potential model defines nonlinear material properties applicable to a general multi-

axial stress state requiring the specification of yield stresses in each direction of the stress 

space. Incorporates hardening, yield stress and Heat fraction. Hoffman is a pressure 

dependent material model allowing for different properties in tension and compression. 

Concrete Heat of Hydration 

Concrete heat of hydration properties can only be defined for a Thermal Analysis. Thermal 

material properties can be entered by using the Attributes> Material> Isotropic or 

Attributes> Material> Orthotropic menu items. 

See Isotropic/Orthotropic Material for general details. 

The following heat of hydration parameters can be defined: 

 Cement type Parameters defining the chemical composition of cement types I, II, III 

and V may be chosen, or the chemical composition of any cement can be defined 

explicitly from the User option in the Cement type drop down list. Further information 

on this load type can be found in theTheory Manual. 
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Modelling units to be used 

Although any set of units can be used for weights and volumes, the temperatures used in the 

analysis are assumed to be, and must be defined in, degrees Celsius.  

For all cement types the following data, using the model units, must be defined:  

 Weight of cement per unit volume 

 Water/Cementitious ratio =(weight per unit volume of cement and any slag and any 

fly ash)/(weight per unit volume of water)  

 Weight of slag per unit volume (Ground granulated blast furnace slag) 

 Weight of fly ash per unit volume (Also known as flue ash) 

 CaO content of fly ash (%) This must be specified if fly ash is to be included. Some 

typical values are Class C fly ash (24%) and Class F fly ash (11%).  

 Assumed cure temperature Temperature at which the concrete is assumed to cure 

(must be in degrees Celcius)  

If the User cement type option is selected then the following also need to be defined: 

 C3S content C3S content (%) of cement 

 C2S content C2S content (%) of cement 

 C3A content C3A content (%) of cement 

 C4AF content C4AF content (%) of cement 

 Free CaO content Free CaO content (%) of cement 

 SO3 content SO3 content (%) of cement 

 MgO content MgO content (%) of cement 

 Blaine value 
Sometimes referred to as fineness of cement (surface area/unit 

weight) 

Timescale units used for heat of hydration analysis are those specified for the model when 

first defined, or as specified on the Model properties dialog. 

See the worked example Staged Construction of a Concrete Dam in the Application Examples 

Manual (Bridge, Civil&Structural for a typical use of this facility. 

Rigidity 

The linear rigidity model is used to define the in-plane and bending rigidities from prior 

explicit integration through the element thickness. 

Notes 

 Angle of orthotropy is relative to the reference axis (degrees). 
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 The element reference axes may be local or global (see Local Axes in the Element 

Reference Manual for the proposed element type). If the angle of orthotropy is set to 

zero, the anisotropy coincides with the reference axes. 

See the Solver Reference Manual for further details. 

Mass 

Mass material models are used in conjunction with non-structural mass elements to define 

mass in a structure. Mass Properties are input for element nodes in the element local 

translational (x, y or z) directions or relative to the local coordinate system assigned to the 

feature. 

See the Element Reference Manual for further information. 

Thermal Material Properties 

Thermal material properties are used to define the thermal behaviour of a material when using 

Thermal (Field) elements. The thermal properties describe the way in which heat flows. Heat 

may be transferred through conduction, convection or radiation. For linear steady state heat 

transfer problems only the conductivity needs to be specified.  

For materials in which the conductivity is constant in all directions isotropic material input 

should be used. When the conductivity varies in different directions orthotropic material input 

should be used. The direction of orthotropy is defined relative to any local coordinate 

systems. 

For transient thermal analysis the specific heat capacity is also required. It should be noted 

that within LUSAS a specific heat coefficient is used. The specific heat coefficient is 

computed by multiplying the specific heat capacity by the density. 

If phase change is to be modelled the enthalpy must be specified. Two phase changes models 

are available . When carrying out a phase change it is recommended that lumped specific heat 

(OPTION 105) is used. This is specified in the Model Properties> Solution> Element 

Options dialog by choosing the lumped mass option.  

For heat of hydration analysis, where internal heat is generated by the chemical reaction 

between cement and water as concrete hardens, additional thermal options such as exotherm 

type, cement type and timescale units can be set.  

LUSAS Solver can model temperature dependent properties but this needs to be defined in 

the Solver datafile. See the Solver Reference Manual for further details. 

Stress Resultant (Model 29) 

The Stress Resultant model is accessed using the Attributes> Material Isotropicmenu item. 

The model is formulated directly with the beam or shell stress resultants plus geometric 

properties, therefore it is computationally cheaper. Consult the Element Reference Manual the 

check which elements are valid for this material model.  



Modeller Reference Manual   

    

184 

Material Parameters 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Section shape Match the section type to the element being used. 

See the Solver Reference Manual for further details. 

Tresca (Model 61) 

The Tresca model is accessed using the Attributes> Material> Isotropicmenu item. 

Material Parameters 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 

produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

 Slope of Yield Stress The slope of the uniaxial yield stress against equivalent plastic 

strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening curve is 

valid. 

  

 

 Hardening Curve Definition for the Tresca Yield Model 

Note 

The Modified Mohr-Coulomb model can also model the Tresca yield surface as a special case 

and provides an improved formulation with better convergence characteristics. It is applicable 

to solid, axisymmetric and plane strain applications. 
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Stress Potential (von-Mises, Hill, Hoffman) 

The Stress Potential model is accessed using the Attributes> Material> Isotropicmenu item. 

The use of nonlinear material properties applicable to a general multi-axial stress state 

requires the specification of yield stresses in each direction of the stress space when defining 

the yield surface (see the LUSAS Theory Manual).  

Notes 

 The yield surface must be defined in full, irrespective of the type of analysis 

undertaken. This means that none of the stresses defining the yield surface can be set 

to zero. For example, in a plane stress analysis, the out of plane direct stress, zz, 

must be given a value which physically represents the model to be analysed. 

 The stresses defining the yield surface in both tension and compression for the 

Hoffman potential must be positive. 

Material Properties 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 

produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

Hardening Properties 

There are three methods for defining nonlinear hardening. Hardening curves can be defined in 

terms of either the hardening gradient, the plastic strain or the total strain as follows: 

 Hardening gradient vs. Effective plastic strain Requires specification of gradient 

and limiting strain values for successive straight line approximations to the stress vs. 

effective plastic strain curve.  

In this case hardening gradient data will be input as (C1, ep1), (C2, ep2) for each 

straight line segment. LUSAS extrapolates the curve past the last specified point. 
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 Uniaxial yield stress vs. Effective plastic strain Requires input of coordinates at the 

ends of straight line approximations to the uniaxial yield stress vs. effective plastic 

strain curve.  

For the curve shown here the plastic properties will contain the yield stress (sy) and 

the hardening data will be input as (s1, ep1), (s2, ep2), etc. LUSAS extrapolates the 

curve past the last specified point. 

 

 Uniaxial yield stress vs. Total Strain Requires input of coordinates at the ends of 

straight line approximations to the stress strain curve.  

Linear properties specify the slope of the stress strain curve up to yield in terms of a 

Young's modulus. Plastic properties specify the yield stress (sy) and the hardening 

data is input as a series of coordinates, for example (s1, e1), (s2, e2), etc. LUSAS 

extrapolates the curve past the last specified point. 
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Optimised von Mises (Model 75) 

The Optimised von Mises model is accessed using the Attributes> Material> 

Isotropicmenu item. 

This model represents ductile behaviour of materials that exhibit little volumetric strain (for 

example, metals). It is especially suitable for explicit dynamics. 

Material Parameters 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 

produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

Hardening (von Mises) 

 Kinematic hardening Plasticity hardening formulation associated with translation, as 

opposed to expansion, of the yield surface. 

In the optimised implicit model the direction of plastic flow is evaluated from the stress return 

path. The implicit method allows the proper definition of a tangent stiffness matrix which 

maintains the quadratic convergence of the Newton-Raphson iteration scheme otherwise lost 

with the explicit method. This allows larger load steps to be taken with faster convergence. 

For most applications, the implicit method should be preferred to the explicit method. 

The model incorporates linear isotropic and kinematic hardening. 
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Nonlinear Hardening Curve for the von Mises Yield Model (Model 75) 

See the Solver Reference Manual and the Theory Manual for further details. 

Non Associated Mohr-Coulomb (Model 65) 

The Non Associated Mohr-Coulomb elasto-plastic model is accessed using the Attributes> 

Material> Isotropicmenu item. 

This model may be used to represent dilatant frictional materials that exhibit increasing shear 

strength with increasing confining stress (for example, granular soils or rocks). The model 

incorporates isotropic hardening and dilatancy. 

Material Properties 

 Initial Cohesion defining the degree of granular bond and a measure of the shear 

strength. 

 Friction Angle defining angle of shearing resistance 

 Dilation Angle defining magnitude of plastic volume strains. 
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 Cohesion Definition for the Non-Associated Mohr-Coulomb Model (Model 65) 

 

 Friction Angle Definition for the Non-Associated Mohr-Coulomb Model (Model 65) 

See the Solver Reference Manual for further details. 

Modified Mohr Coulomb Model  

The Modified Mohr-Coulomb model is accessed using the Attributes> Material> Isotropic 

menu item. 

This model applies a tensile and/or a compressive cut-off to the Non Associated Mohr-

Coulomb model.  When the standard Mohr-Coulomb model would potentially predict tensile 

stresses beyond the uniaxial tensile limit of the material, the tension cap may be used to 
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prevent such stresses occurring.. In compression the cut-off results in irreversible 

deformations once the maximum compressive stress is exceeded. The cut-off can be applied 

to either a single principal stress component or to the mean pressure.  

The Tresca model is recovered as a special case of the Modified Mohr-Coulomb model by 

setting both the angles of friction and dilation to 0. The cohesion value C is equal to half the 

uniaxial yield stress. 

Notes 

 The model may be used with 3D continuum, plane strain and axi-symmetric elements 

as well as the corresponding two-phase elements. 

 If neither of the Rankine or Pressure options is selected the model will behave as the 

standard Mohr-Coulomb model. 

 The cohesion, tensile and compressive stresses may be specified to be functions of the 

effective plastic strain. Their variations with effective plastic strain are input as a 

series of piecewise linear segments. 

 The dilation angle must be set to the angle of friction to model associative flow. 

 The use of non-symmetric solver is recommended if the dilation angle is not equal to 

the angle of friction, or if strain hardening is defined. 

 The effects of strain hardening on the yield surfaces using a pressure cut-off are 

shown diagramatically in the Solver Reference Manual. 

See the Solver Reference Manual and theTheory Manual for further details. 

Drucker-Prager (Model 64) 

The Drucker - Prager model is accessed using the Attributes> Material> Isotropicmenu 

item. 

This model may be used to represent the ductile behaviour of materials which exhibit 

volumetric plastic strain (for example, granular materials such as concrete, rock and soils). 

The model incorporates isotropic hardening. 

Material Properties 

 Initial Cohesion A material property of granular materials, such as soils or rocks, 

describing the degree of granular bond and a measure of the shear strength. Setting the 

initial cohesion to zero is not recommended as this could cause numerical instability 

under certain loading conditions. 

 Initial Friction angle A material property of granular materials, such as cohesive soils 

and rocks. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 
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produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

 Slope of Yield Stress The slope of the uniaxial yield stress against equivalent plastic 

strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening curve is 

valid. 

 
 Cohesion Definition for the Drucker-Prager Yield Model (Model 64) 

  

 
 Friction Angle Definition for the Drucker-Prager Yield Model (Model 64) 

See the Solver Reference Manual for further details. 
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LUSAS Multi Crack Concrete Models 

When a structural analysis is being carried out LUSAS multi crack concrete models can be 

accessed by using the Attributes> Material> Isotropic menu item, clicking the Plastic 

check-box and selecting Concrete.  

Two concrete models are available: the Multi Crack Concrete Model (Model 94), and the 

Smoothed Multi Crack Concrete Model (Model 102). Both can be used with 2D and 3D 

continuum elements, 2D and 3D explicit dynamics elements, solid composite elements and 

semiloof or thick shell elements. The capabilities, uses and limitations of both concrete 

material models are described in this topic, with notes as necessary when they are only 

relevant to one or the other. 

LUSAS also supports three concrete creep model codes. See Concrete Creep Models. 

Multi Crack Concrete Model (Model 94) 

The Multi Crack Concrete model is a plastic-damage-contact model in which damage planes 

form according to a principal stress criterion and then develop as embedded rough contact 

planes. The basic softening curve used in the model may be controlled via a fixed softening 

curve or by a fracture-energy controlled softening curve that depends on the element size. The 

former, a distributed fracture model, is applicable to reinforced concrete applications, while 

the latter localised fracture model is applicable to un-reinforced cases.  

 For this concrete model, crack/crush results can be plotted for the Values layer as 

component ‘Crack/Crush’ under the Stress entity. Planes representing the cracks are 

displayed in two and three-dimensions. Points of crushing are displayed as stars. 

Calculation and plotting of contours of crack widths is not possible using this concrete 

model. 

Smoothed Multi Crack Concrete Model (Model 102) 

The Smoothed Multi Crack Concrete model is similar to the Multi Crack Concrete model, 

converges more rapidly and is more robust, but requires a number of different input 

parameters. In contrast to the Multi Crack Concrete Model the Smoothed Multi Crack 

Concrete Model does not have distinct crack statuses (open or closed/interlocked). 

 For this concrete model crack/crush results can be plotted for the Values layer as 

component ‘Crack/Crush’ under the Stress entity. Planes representing the cracks are 

displayed in two and three-dimensions. Points of crushing are displayed as stars.  

 General crack width calculation is possible with this model and can be plotted for the 

Contour and Values layers as components of CWMax and EFSMax under the Plastic 

strain - Plane stress entity. Note that these components, will only be applicable for 

certain elements. 

 When this concrete model is used in conjunction with reinforcement attributes, a 

linear steel material model, and with the Crack Widths calculation utility, crack 
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width calculations in accordance with EN 1992-1-1:2004 Eurocode 2 can be carried 

out. See Application Manual (Bridge, Civil & Structural) Crack Width Calculation to 

EN 1992-1-1 for more information. Crack width information can be plotted for the 

Contour and Values layers as components of Maximum Crack Width under the Crack 

Widths EN1991-1 entity.   

Note that a better estimation of crack widths is likely to be achieved when linear elements are 

used; the use of quadratic elements is likely to result in less accurate crack widths. A fine 

mesh may be required to capture the stress localisation band that results in the formation of a 

crack. 

See the worked example 'Nonlinear analysis of a concrete beam' in the Application Examples 

Manual (Bridge, Civil & Structural).  

 Elastic Material Properties 

 Young's modulus It is important that the Young’s modulus, E, is consistent with the 

strain at peak compressive stress, c. A reasonable check is to ensure that  E > 1.2 fc/ c 

 Mass density The mass density of concrete (ρ) is generally taken to be of the order of 

2400kg/m³ for mass concrete and 2500kg/m³ for reinforced or prestressed concrete. 

Where more accurate determination is required information specific to the concrete in 

question should be obtained or a value determined experimentally. 

Plastic Material Properties 

These primary material properties apply to both unreinforced (mass concrete) and reinforced 

concrete except where stated. 

 Uniaxial compressive strength (fc) e.g. 40 N/mm
2
. The generally available 

“characteristic compressive strength” may not be appropriate for use in a finite 

element analysis with a concrete material model. This is because cube strengths do not 

represent a uniaxial compressive strength due to the influence of significant boundary 

restraints caused by friction on the platens of any testing machine, so it may be 

necessary to convert a cube strength to a cylinder strength. Note also that, commonly, 

“characteristic” (5% lower percentile) compressive strength is used for engineering 

purposes, and consideration should also be given to whether a mean, characteristic, or 

other value is most appropriate to the analysis in question. The CEB-FIP Model Code 

1990 equation 2.1-1 suggests that a mean cylinder strength (fcm) may be estimated 

from a characteristic cylinder strength (fck). 

 Uniaxial tensile strength (ft) e.g. 3 N/mm
2
. This is likely to be a principal parameter 

in any analysis where concrete cracking is of significance. Ideally, the tensile strength 

would be available from test results. In the absence of test results, a value must be 

assessed using available data and relationships found in literature. Many design codes 

offer estimates of the value and the CEB-FIP Model Code 1990 gives minimum, 

maximum and mean strengths based on an available characteristic cylinder strength. 
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 Fracture energy per unit area (Gf) e.g. 0.1 or 0 if e0>0. For concrete, Gf is usually in 

the range 60 to 150J/m², varying with aggregate size but not so much with concrete 

strength. Where no data is available then a value of Gf = 0.13N/mm is suggested. 

 Notes relating to material properties 

 The ‘Uniaxial compressive strength’ parameter in a concrete model is the ultimate 

strength of the material in compression. Since concrete behaves linearly only up to 

around 40% of the ultimate strength, crushing is expected to occur before that strength 

has been reached. As a result, concrete crush symbols will be plotted on the model (if 

requested to do so) when the plastic work-hardening parameter (which is calculated 

internally) is greater than zero. The presence of crushing symbols therefore indicates 

that the point at which the material begins to damage (i.e. crush) and behave 

nonlinearly, has been passed.  

Advanced properties 

These more advanced material properties are related to measurable characteristics. Additional 

information relating to some of the properties and suggested values are stated in the notes that 

follow. 

 Strain at peak uniaxial compression ( c) e.g. 0.0022 

 Strain at end of softening curve for distributed fracture ( o) e.g. 0.035 or 0 if Gf>0. 

 Biaxial to uniaxial stress ratio ( r) e.g. 1.15 

 Initial relative position of yield surface (Zo) e.g. 0.6 

 Dilatancy factor (giving plastic potential slope relative to that of yield surface)  

e.g. -0.1 

 Constant in interlock state function (mg) e.g. 0.425 

 Contact multiplier on o  for the 1st opening stage (mhi) e.g. 0.5 

 Final contact multiplier on o (mful) e.g. 5.0 

 Shear intercept to tensile strength ratio for local damage surface (r ) e.g. 1.25 

 Slope of friction asymptote for damage ( ) e.g. 1.0 

 Angular limit between crack planes (Radians) e.g.1.0 (for Multi Crack Concrete 

Model only) 

 Crack fixity strain e.g. 0.05 (for Smoothed Multi Crack Concrete Model only) 

 Fracture process zone width e.g. 0.06 (for Smoothed Multi Crack Concrete Model 

only) 

 Number of iterations e.g. 2 (for Smoothed Multi Crack Concrete Model only) 
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Notes relating to advanced properties 

 Strain at peak uniaxial compression If no data for the strain at peak uniaxial 

compression is available it can be estimated see Solver Reference Manual for details. 

As a guide, a reasonable value for most types of concrete is 0.0022. It is important that 

the Young’s modulus, E, (defined on the Elastic properties page) is consistent with the 

strain at peak uniaxial compression, c. A reasonable check is to ensure that  E > 1.2 

fc/ c 

 Strain at end of softening curve For reinforced concrete, distributed fracture will be 

the dominant fracture state. In this case a value for the strain at the end of the tensile 

softening curve, 0, should be entered and Gf set to zero. If no data is available then a 

value for 0 of 0.0035 is reasonable to use for most concretes. 

 The value for 0 must be set to zero when the fracture energy per unit area, Gf, is given 

a positive value. Gf varies with aggregate size but not so much with concrete strength. 

Typical values for various maximum coarse aggregate sizes are:  

16 mm aggregate: Gf = 0.1 N/mm;  

20 mm aggregate: Gf = 0.13 N/mm;  

32 mm aggregate: Gf = 0.16 N/mm;  

 
 Stress / strain curve for multi crack concrete model (Model 94) 

 If the effective end of the softening curve parameter, 0 , is set to zero, it will be 

calculated from 0 ~ 5Gf / Wc ft where Wc is a characteristic length for the element; if 

a finite value is given for e0 , Gf will be ignored. 

 Biaxial to uniaxial stress ratio A range of 1.05 to 1.3 is suggested and a default of 

1.15 is provided. 
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 The initial relative position of yield surface is governed by the value of Z0. For most 

situations in which the degree of triaxial confinement is relatively low, a value of 

between 0.5 and 0.6 is considered appropriate for Z0 however, for higher 

confinements a lower value of 0.25 is better. 

 Dilatancy factor The parameter  is used to control the degree of dilatancy. 

Associated plastic flow is achieved if =1, but it has been found that  values in the 

range -0.1 to –0.3 are required to match experimental results. Generally  is set to –

0.1, but for high degrees of triaxial confinement –0.3 provides a better match to 

experimental data. 

 Constant in interlock state function [mg] can be obtained from experimental data 

from tests in which shear is applied to an open crack. The default value for mg is taken 

as 0.425 but it is considered that a reasonable range for mg for normal strength 

concrete is between 0.3 and 0.6. However, it was found that a low value of 0.3 could 

lead to second cracks forming at shallow angles to the first, due to the development of 

relatively large shear forces. 

 Contact multiplier on 0 [mhi] is used to govern the amount of contact from micro-

cracks. Experimental evidence suggests that the shear contact potential drops off more 

quickly for some concretes than for others, mhi governs the early (micro-crack) loss of 

shear contact potential and mful controls the final amount (associated with coarse 

aggregate interlock). To truly calibrate these parameters, tests, which open cracks to 

different degrees and then apply shear, are required; however for a wide range of 

standard concrete mhi = 0.5 and mful = 5.0 give reasonable results. A range of 0.25 to 

2.0 is suggested and a default of 0.5 is provided 

 Final contact multiplier on 0 It is assumed that there is a crack opening strain 

beyond which no further contact can take place in shear, eful, where eful is a multiple of 

0, i.e. eful=mful 0. Trials suggest that when concrete contains relatively large coarse 

aggregate, i.e. 20 to 30mm, a value of mful in the range 10-20 is appropriate, whereas 

for concrete with relatively small coarse aggregate, i.e. 5 to 8mm, a lower value is 

appropriate, in the range 3 to 5. This variation is necessary because the relative 

displacement at the end of a tension-softening curve (related via the characteristic 

dimension to 0.) is not in direct proportion to the coarse aggregate size, whereas the 

clearance displacement is roughly in proportion to the coarse aggregate size. Thus eful 

is not in a fixed ratio to 0. 

 Shear intercept to tensile strength A range of 0.5 to 2.5 is suggested and a default 

value of 1.25 is provided. 

 Slope of friction asymptote for damage A range of 0.5 to 1.5 is suggested and a 

default value of 1.0 is provided. 

 Number of iterations This is the number of iterations beyond which the crack 

directions are fixed. Increasing the number of iterations from the default value of 2 

usually makes convergence more difficult but can lead to greater accuracy in some 
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cases. If the number of iterations is increased , then the Maximum number of 

iterations on the Nonlinear and Transient Control dialog should also be increased. 

Planes of degradation 

A Plane of Degradation (POD) is formed when the principal stress reaches the tensile strength 

(ft); the POD is formed normal to the major principal stress axis. Thereafter, further damage 

can develop due to the combined action of shear and direct (normal) strains:  

  Further normal tensile stress would increase the damage, while both the stiffness of 

the material along the POD normal (i.e. the normal stiffness) and the shear stiffness, 

would decrease  

  Further shear stress does not increase the damage; it causes aggregate interlock (i.e. 

contact) and an increase in both shear and normal stiffness 

  Further normal compressive stress does not increase the damage; normal and shear 

stiffness would increase due to contact. 

 
POD Local and Global Coordinate Systems 
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Local damage surface 

 
Local Damage Surface 

The constants r  and   are the strain equivalents of the material input parameters r  and . 

The relative shear stress intercept to tensile strength ratio r = c / ft  where c is the shear 

stress intercept. Typical plots of the damage surface in stress space (the damage surface 

represents debonding or failure of the cement – aggregate interface) have shown the ratio 

between the shear strength and tensile strength of the interface bond to be approximately 

1.25. 

General notes 

 If the dilatency factor ( ) and the constant in interlock state function (mg) are set to 

1.0 a symmetric solution will be carried out, otherwise the non-symmetric solver will 

be invoked. 

 It is recommended that fine integration be used with these material models as this 

helps prevent the occurrence of mechanisms when cracking occurs. However the use 

of fine integration is more expensive computationally and can degrade the 

performance of higher order element types. 

 Line searches should not be invoked when using the Smoothed Multi Crack Concrete 

Model (Model 102), in NONLINEAR CONTROL, ITERATIONS, nalps should be set 

to zero. 

 It is recommended that the following LUSAS options are used with these concrete 

models:  

252 Suppress pivot warnings. 

62 Allow negative pivots. 
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See the Solver Reference Manual and Theory Manual for further information relating to 

concrete material modelling. 

Creep 

Creep is the inelastic behaviour that occurs when the relationship between stress and strain is 

time dependent. The creep response is usually a function of the stress, strain, time and 

temperature history. Unlike time independent plasticity where a limited set of yield criteria 

may be applied to many materials, the creep response differs greatly for different materials.  

Creep Properties 

Power, exponential and eight parameter uniaxial creep laws are available and a time 

hardening form is available for each. The power creep law is also available in a strain 

hardening form. Fully 3D creep strains are computed using the differential of the von Mises 

or Hill stress potential. A user-definable creep interface is also available which allows a 

programmable uniaxial creep law.  

Stress Potential 

The definition of creep properties requires that the shape of the yield surface is defined. The 

stresses defining the yield surface are specified using the Stress Potential material model.  

If a Stress Potential model is used in the Plastic definition then this will override the Creep 

stress potential and will apply to both the plastic properties and the creep properties. The 

Creep stress potential is only required when defining linear materials. If a stress potential type 

is not specified then von Mises is set as default. 

None of the stresses defining the stress potential may be set to zero. For example, in a plane 

stress analysis, the out of plane direct stress must be given a value which physically 

represents the model to be analysed. 

User Supplied Creep Properties 

The user creep facility allows user supplied creep laws to be used. This facility provides 

completely general access to the LUSAS Solver property data input and provides controlled 

access to the pre- and post-solution constitutive processing and nonlinear state variable 

output.  

Notes 

 The user-supplied routine must return the increment in creep strain. Further, if implicit 

integration is to be used then the variation of the creep strain increment with respect to 

the equivalent stress, and also with respect to the creep strain increment, must be 

defined. 

 If the function involves time dependent state variables they must be integrated in the 

user-supplied routine. 
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 If both plasticity and creep are defined for a material, the creep strains will be 

processed during the plastic strain update. Stresses in the user routine may therefore 

exceed the yield stress. 

 User-supplied creep laws may be used as part of a composite element material 

assembly. 

See the Solver Reference Manual and the Theory Manual for further details. 

Damage 

Damage is assumed to occur in a material by the initiation and growth of cavities and micro-

cracks. The damage models allow parameters to be defined which control the initiation of 

damage and post-damage behaviour. Damage models are available for continuum and 

composite elements. 

Continuum Damage Models 

In LUSAS a scalar damage variable is used in the degradation of the elastic modulus matrix. 

This means that the effect of damage is considered to be non-directional or isotropic. Two 

LUSAS damage models are available (Simo and Oliver) together with a facility for a user-

supplied model. 

A damage analysis can be carried out using any of the elastic material models and the 

following nonlinear models: 

 von Mises 

 Hill 

 Hoffman 

Note. Creep material properties may be included in a damage analysis. See the Solver 

Reference Manual for further details. 

Composite Matrix Failure Model 

The composite matrix failure model simulates matrix failure using the Hashin damage 

criteria. The model can only be used with composite solid elements. It is defined under the 

Damage tab on the Material Orthotropic attribute dialog.  

Material Properties 

 Ply tensile strength in fibre direction 

 Ply compressive strength in fibre direction 

 Ply shear strength measured from a cross ply laminate 

 Ply transverse tensile strength (normal to fibre direction) 

 Ply transverse compressive strength 

See the Solver Reference Manual for further details. 
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Viscoelastic 

Viscoelasticity can be coupled with the linear elastic and non-linear plasticity, (isotropic or 

orthotropic), creep and damage models available in LUSAS. The model restricts the 

viscoelastic effects to the deviatoric component of the material response. This enables the 

viscoelastic material behaviour to be represented by a shear modulus Gv and a decay constant 

. Viscoelasticity imposed in this way acts like a spring-damper in parallel with the elastic-

plastic, damage and creep response. Coupling of the viscoelastic and the existing nonlinear 

material behaviour enables hysteresis effects to be modelled. 

User Supplied Visco Elastic Properties 

The user supplied viscoelastic properties facility enables routines for implementing a user 

supplied viscoelastic model to be invoked. This facility provides completely general access to 

the LUSAS Solver property data input via this data section and provides controlled access to 

the pre- and post-solution constitutive processing and nonlinear state variable output via these 

user supplied routines.  

Notes 

 When viscoelastic properties are coupled with a nonlinear material model it is 

assumed that the resulting viscoelastic stresses play no part in causing the material to 

yield and no part in any damage or creep calculations. Consequently the viscoelastic 

stresses are stored separately and deducted from the total stress vector at each iteration 

prior to any plasticity, creep or damage computations. Note that this applies to both 

implicit and explicit integration of the creep equations. 

 Nonlinear Control must always be specified when viscoelastic properties are assigned. 

In addition Dynamic or Viscous Control must also be specified to provide a time step 

increment for use in the viscoelastic constitutive equations. If no time control is used 

the viscoelastic properties will be ignored. 

See Solver Reference Manual for further details. 

Shrinkage Properties  

The cure of concrete and thermoset resins is accompanied by isotropic shrinkage which in the 

case of concrete depends on time, temperature and other environmental factors whilst for 

thermoset resins the shrinkage is normally described with respect to the degree of cure.  

The shrinkage implementation in LUSAS allows an irreversible reduction in volume with 

time to be modelled. The shrinkage of concrete is accommodated using the equations defined 

in the design code CEB-FIP90 and also using a more general routine in which shrinkage is 

defined using a piecewise linear curve. In the general case, shrinkage can be defined as a 

function of time or degree of cure. A user facility is also available if required.  

See the Solver Reference Manual for further details. 
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Two-Phase Material 

Two-Phase material properties (defining a drained and undrained state) can be added to 

material definitions for Isotropic, Orthotropic and Modified Cam-Clay materials that are 

defined using the Attributes> Material> menu item. A Two-phase check box along the top 

of the material dialog adds a new property page to the current material definition, and allows 

Two-phase material data to be specified 

Usage 

Two-phase material properties are required when performing an analysis in which two- phase 

elements are used to define a drained and undrained state for soil. LUSAS can model the 

deformation of undrained/fully saturated and fully-drained/unsaturated porous media, and 

slow consolidation process, under isothermal conditions and small strain assumptions. For 

both 2D and 3D cases, nonlinear material models and large deformations are supported. 

Two-phase material properties can be defined for the following soil types: 

 Saturated - is the existing material with the addition of the fluid density. This requires 

general soil properties to be defined. 

 Partially saturated - requires additional saturation properties, namely 'Irreducible 

saturation' and 'Degree of saturation to be considered fully saturated' to be specified. 

 Piecewise linear partially saturated - requires the additional saturation values and a 

'Curve tolerance' to be stated. 

The Define curves button is only enabled for the new materials and allows the draining and 

filling curves to be defined. 

The Bulk modulus of solid phase entry can be optionally excluded from the data input table 

by selection of the Incompressible solids option. 

Draining and filling curves 

Draining and filling curves can be specified for partially drained materials by defining the 

rate of water extraction, weight factor, air entry and permeability values. Manually-defined 

(piecewise linear ) draining and filling curves can be defined for partially drained materials 

by specifying pore pressure, relative permeability and effective saturation values. For both 

methods, if a draining and filling curve is defined a scanning curve factor is used to specify 

how a jump should be made between the curves if jumping draining/exsorption to 

filling/insorption or vice-versa. 
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Typical draining and filling curve showing jump from draining/exsorption to filling/insorption (left) and jump 

from filling/insorption to draining/exsorption (right) 

Notes 

 Usually, the value of Bulk modulus of solid phase is quite large compared to Bulk 

modulus of fluid phase and not readily available to the user. If Bulk modulus of solid 

phase is input as 0, LUSAS assumes an incompressible solid phase. The bulk modulus 

of fluid phase is more obtainable, and for water is 2200 MPa. 

 Two-phase material properties can only be assigned to two phase elements. 

 When performing a linear consolidation analysis transient control settings must be 

specified specifying Consolidation in the Time domain section of the Nonlinear and 

Transient control dialog. 

 Two-phase material properties may be combined with any other material properties 

and include creep, damage and viscoelastic properties if required. 

 For some flow problems, a final steady state solution may only be required. For 

saturated soils a linear analysis should be used and this will give an exact solution. For 

unsaturated soils a nonlinear transient should be used to get accurate results. A 

nonlinear static analysis may be used but may give less accurate results. For example, 

the total discharge extracted from the reactions may be incorrect. 

 For nonlinear solutions ill-conditioning may occur and a non-symmetric solution may 

be required. This can be specified by accessing the  Nonlinear analysis options 

object. A Fast Parallel Direct Solver is recommended. 

See Solver Reference Manual for further details. 
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Usage 

Use of two-phase material and coupled pore fluid diffusion/stress analysis capabilities in 

LUSAS permits: 

 Establishing the initial equilibrium state via a geostatic analysis control step. 

 Modelling partially saturated fluid flow through porous medium, e.g. seepage of water 

through an earth dam, where the position of the phreatic surface (the boundary 

between fully saturated and partially saturated soil) is of interest. 

 Including the influence of the pore fluid weight on the solid skeleton only (excess 

pore pressure solution) or on both the solid skeleton and fluid (total pore pressure 

solution). 

 Using a default analytical capillary pressure relationship or defining a piece-wise 

relationship in a tabular form, as the accuracy of simulation depends on the use of an 

accurate relationship. 

 Specifying different filling (or absorption) and draining (or exsorption) capillary (or 

pore water) pressure – effective saturation curves, which can exhibit hysteresis 

behaviour, as well as a scanning curve for transition between absorption and 

exsorption. 

 In addition to prescribed head (pressure) and impervious (closed) boundary 

conditions, the inflow/outflow over a boundary can be considered. It is also possible 

to control the boundary condition automatically when a phreatic surface meets a 

boundary surface using lift-off supports. 

Delamination Interface (Model 25) 

The Delamination interface model appears under the Attributes> Material> Specialised 

menu item. 

Delamination properties are assigned to interface elements to model delamination between 

elements. The model behaves linearly until the threshold strength is exceeded. Linear strain 

softening behaviour then occurs until the fracture energy is exceeded. Once the fracture 

energy is exceeded further straining occurs without resistance. 

Fracture Modes 

A 2D model has two fracture modes, a 3D model has three. The fracture modes are: 

 Mode 1 Opening 

 Mode 2 Shearing 

 Mode 3 Tearing (Shear orthogonal to mode 2) 

Material Parameters 

 Fracture energy Measured values for each fracture mode depending on the material 

being used, i.e. carbon fibre, glass fibre. 
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 Initiation Stress The tension threshold /interface strength is the stress at which 

delamination is initiated. This should be a good estimate of the actual delamination 

tensile strength but, for many problems, the precise value has little effect on the 

computed response. If convergence difficulties arise it may be necessary to reduce the 

threshold values to obtain a solution. 

 Relative displacement The maximum relative displacement is used to define the 

stiffness of the interface before failure. Provided it is sufficiently small to simulate an 

initially very stiff interface it will have little effect. 

 Coupled The model used for coupling the failure modes (Coupled, Uncoupled 

Reversible, Uncoupled Origin). 

See the Theory Manual for more details. 

Rubber  

Rubber materials maintain a linear relationship 

between stress and strain up to very large strains 

(typically 0.1 - 0.2). The behaviour after the 

proportional limit is exceeded depends on the 

type of rubber (see diagram below). Some kinds 

of soft rubber continue to stretch enormously 

without failure. The material eventually offers 

increasing resistance to the load, however, and 

the stress-strain curve turns markedly upward 

prior to failure. Rubber is, therefore, an 

exceptional material in that it remains elastic far beyond the proportional limit. 

Rubber materials are also practically incompressible, that is, they retain their original volume 

under deformation. This is equivalent to specifying a Poisson's ratio approaching 0.5. 

The strain measure used in LUSAS to model rubber deformation is termed a stretch and is 

measured in general terms as: 

 = dnew/dold 

where: 

dnew is the current length of a fibre. 

dold is the original length of a fibre. 

  

Several representations of the mechanical behaviour for hyper-elastic or rubber-like materials 

can be used for practical applications. Within LUSAS, the usual way of defining hyper-

elasticity, i.e. to associate the hyper-elastic material to the existence of a strain energy 

function that represents this material, is employed. There are currently four rubber material 

models available: 

 Ogden  Neo-Hookean 

 Mooney-Rivlin  Hencky 
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The rubber constants (used for Ogden, Mooney-Rivlin and Neo-Hookean) are obtained from 

experimental testing or may be estimated from a stress-strain curve for the material together 

with a subsequent curve fitting exercise. 

The Neo-Hookean and Mooney-Rivlin material models can be regarded as special cases of 

the more general Ogden material model. In LUSAS these models can be reformulated in 

terms of the Ogden model. 

The strain energy functions used in these models includes both the deviatoric and volumetric 

parts and are, therefore, suitable to analyse rubber materials where some degree of 

compressibility is allowed. To enforce strict incompressibility (where the volumetric ratio 

equals unity), the bulk modulus tends to infinity and the resulting strain energy function only 

represents the deviatoric portion. This is particularly useful when the material is applied in 

plane stress problems where full incompressibility is assumed. However, such an assumption 

cannot be used in plane strain or 3D analyses because numerical difficulties can occur if a 

very high bulk modulus is used. In these cases, a small compressibility is mandatory but this 

should not cause concern since only near incompressibility needs to be ensured for most of 

the rubber like materials. 

Using Rubber Material 

Rubber is applicable for use with the following element types currently: 

 2D Continuum QPM4M, QPN4M 

 3D Continuum HX8M 

 2D Membrane BXM2 

Notes 

 For membrane and plane stress analyses, the bulk modulus is ignored because the 

formulation assumes full incompressibility. The bulk modulus has to be specified if 

any other 2D or 3D continuum element is used. 

 Ogden, Mooney-Rivlin and Neo-Hookean material models must be run with 

geometric nonlinearity using either the total Lagrangian formulation (for membrane 

elements) or the co-rotational formulation (for continuum elements). The Hencky 

material model is only available for continuum elements and must be run using the co-

rotational formulation. The large strain formulation is required in order to include the 

incompressibility constraints into the material definition. 

 Option 39 can be specified for smoothing of stresses. This is particularly useful when 

the rubber model is used to analyse highly compressed plane strain or 3D continuum 

problems where oscillatory stresses may result in a "patchwork quilt" stress pattern. 

This option averages the Gauss point stresses to obtain a mean value for the element. 

 When rubber materials are utilised, the value of det F or J (the volume ratio) is output 

at each Gauss point. The closeness of this value to 1.0 indicates the degree of 

incompressibility of the rubber model used. For totally incompressible materials 
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J=1.0. However, this is difficult to obtain due to numerical problems when a very high 

bulk modulus is introduced for plane strain and 3D analyses. 

 Subsequent selection of state variables for displaying will include the variable PL1 

which corresponds to the volume ratio. 

 Rubber material models are not applicable for use with the axisymmetric solid 

element QAX4M since this element does not support the co-rotational geometric 

nonlinear formulation. The use of total Lagrangian would not be advised as an 

alternative. 

 There are no associated triangular, tetrahedral or pentahedral elements for use with the 

rubber material models. 

 The rubber material models are inherently nonlinear and, hence, must be used in 

conjunction with nonlinear control command. 

 The rubber material models may be used in conjunction with any of the other LUSAS 

material models. However, it is not possible to combine rubber with any other 

nonlinear material model within the same material attribute. 

Volumetric Crushing (Model 81) 

Material behaviour can generally be described in terms of deviatoric and volumetric 

behaviour which combine to give the overall material response. The crushable foam material 

model accounts for both of these responses. The model defines the volumetric behaviour of 

the material by means of a piece-wise linear curve of pressure versus the logarithm of relative 

volume. An example of such a curve is shown in the diagram below, where relative volume is 

denoted by V/V0. 

 

  

 Pressure - Logarithm of Relative Volume Curve 
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From this figure, it can also be seen that the material model permits two different unloading 

characteristics volumetrically. 

 Unloading may be in a nonlinear elastic manner in which loading and unloading take 

place along the same nonlinear curve. 

 Volumetric crushing may be included (by clicking in the volumetric crushing check 

box) in which case unloading takes place along a straight line defined by the 

unloading/tensile bulk modulus K which is, in general, different from the initial 

compressive bulk modulus defined by the initial slope of the curve. 

In both cases, however, there is a maximum (or cut-off) tensile stress, (cut-off pressure), that 

is employed to limit the amount of stress the material may sustain in tension. 

The deviatoric behaviour of the material is assumed to be elastic-perfectly plastic. The 

plasticity is governed by a yield criterion that is dependent upon the volumetric pressure 

(compared with the classical von Mises yield stress dependency on equivalent plastic strain) 

and is defined as: 

 

where p is the volumetric pressure,  is the deviatoric stress and a0, a1, a2 are pressure 

dependent yield stress constants. Note that, if a1 = a2 = 0 and a0 = (syld2)/3, then classical 

von Mises yield criterion is obtained. 

 
  

Yield Surface Representation For Different Pressure Dependent Yield Stress Values 

Notes 

 Bulk modulus used in tension and unloading (see 1st figure). The relationship 

between the elastic bulk (or volumetric) modulus, K, and tensile modulus, E, is given 

by: 
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 Shear modulus The relationship between the elastic modulus values in shear, G, and 

tension, E, assuming small strain conditions, is given by: 

 

 Heat fraction coefficient Represents the fraction of plastic work which is converted 

to heat and takes a value between 0 and 1. 

 Cut-off pressure Should be negative (i.e. a tensile value). 

 Pressure dependent yield stresses (a0, a1, a2) (Should be positive). The yield 

surface defined is quadratic with respect to the pressure variable. Therefore it can take 

on different conical forms (see 2nd figure), either elliptic (a2<0), parabolic (a2=0) or 

hyperbolic (a2>0). The parabolic form is comparable to the modified von Mises 

material model while the elliptic form can be considered to be a simplification of 

critical state soil and clay material behaviour. 

 The volumetric crushing indicator effectively defines the unloading behaviour of the 

material. If there is no volumetric crushing, the same pressure-logarithm of relative 

volume curve is used in loading and unloading and if volumetric crushing takes place 

the alternative unloading/reloading curve is used (see 1st figure). 

 Log relative volume Natural logarithm (loge, not log10) of relative volume 

coordinate for ith point on the pressure-logarithm of relative volume curve (see 1st 

figure) 

 The pressure-logarithm of relative volume curve is defined in the compression 

regime hence logarithms of relative volume must all be zero or negative and the 

pressure coordinates must all be zero or positive. 

Modified Cam-clay Model 

The Modified Cam-clay model is defined using the Attributes> Material> Specialised 

menu. 

The modified Cam-clay model is a variant of the classic Cam-clay model used for the 

modelling of clays, and is capable of modelling the strength and deformation trends of clay 

realistically. The model can be used with standard continuum elements as well as the two-

phase elements that include the effects of pore water pressure. The modelling parameters 

required can be evaluated in standard laboratory tests.  

Material Properties 

 Initial void ratio - the void ratio of the soil at the start of the analysis  

 Swelling index - relates to the change in specific volume to a decrease in mean 

pressure 
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 Compression index - relates the change in specific volume to an increase in mean 

pressure 

 Gradient critical state line - relates the deviatoric stress to the mean pressure 

 Pre-consolidation pressure - the maximum pressure the soil was subjected to prior to 

analysis 

 Poisson's ratio 

 Mass density 

Notes 

 The material modulus matrix is non-symmetric. Convergence may be improved by 

using a non-symmetric solution. This can be specified by accessing the  Nonlinear 

analysis options control for a loadcase. 

 The initial stress state can be input by using residual stress load types, or by using an 

initial stress with gravity. 

Dynamic and Thermal Properties 

Dynamic and Thermal expansion properties are optional and are usually only required when 

dynamic or thermal analyses are to be carried out.  

Two-Phase Properties 

Two-phase material properties are required when performing a consolidation analysis, in 

which two-phase elements are used to define a drained and undrained state for soil. 

Varying Attributes 

Some properties of the material typically vary with depth, for example, the initial void ratio; 

initial pre-consolidation pressure, and so on. Any such varying properties may be specified by 

selecting a previously defined variation. To do this press the variation button  when you 

enter a value in any field. 

See Solver Reference Manual : Modified Cam-Clay Model 

Results processing 

Once a model containing this material has been solved, Mean pressure, Effective stress, Shear 

modulus, Consolidation pressure, Bulk modulus and Percent change in specific volume 

components are all available within the results entity Cam-Clay Results. 

Elasto-Plastic Interface (Model 27, 26)  

Elasto-plastic interface models may be used to represent the friction-contact relationship 

within planes of weakness between two discrete bodies.  



  Chapter 6 

    

211 

 The 2D Elasto-Plastic Interface Model (Model 27) is available in plane stress and 

plane strain elements. See the Element Reference Manual for more details. 

 The 3D Elasto-Plastic Interface Model (Model 26) is available in solid continuum 

elements. See the Element Reference Manual for more details. 

For both models, a line of appropriate 2D or 3D elements must lie between the two bodies in 

the finite element discretisation. 

Elastic material properties are defined in the local basis, permitting differing values to be 

specified normal and tangential to the plane of the interface. In-plane and out-of-plane 

directions are relative to the surface axes, and refer to the contact plane rather than the plane 

of the surface features. 

The nonlinear behaviour is governed by an elasto-plastic constitutive law, which is 

formulated with a limited tension criterion normal to the interface plane, and a Mohr-

Coulomb criterion tangential to the interface plane. See the Theory Manual for further details. 

Notes 

 For the 2D model the tangential (in-plane) direction is in the element x direction and 

the normal (out of plane) is in the element h direction. The x direction is defined from 

the vector between nodes 1 and 3 of the element. See the Solver Manual for more 

details. 

 For the 3D model the tangential (in-plane) direction lies in the element x-h plane and 

the normal (out of plane) in the element z direction. See the Solver Manual for more 

details. 

 The models cannot be used within a geometrically nonlinear analysis 

Concrete Creep Models 

LUSAS accommodates three concrete creep model codes: 

 CEB-FIP Model Code 1990 - Uses a simplified linear approach to represent creep. 

This assumes that the service stresses in the concrete will not be exceeded and hence 

may not predict the effects of unloading or load cycling accurately. The model is valid 

for ordinary structural concrete (12-80 MPa) that has been loaded in compression to 

less than 40% of its compressive strength at the time of loading.  

 Chinese Creep Code (Draft 2007)- Based upon equations taken from the Chinese 

Creep Code for Dams. Allows creep of concrete to be computed as concrete ages 

while subjected to external forces, including thermal stresses that may be due to the 

hydration process. 

 EN1992-1-1:2004 Eurocode 2 - Uses a simplified linear approach to represent creep. 

This assumption assumes that the service stresses in the concrete will not be exceeded 

and hence may not predict the effects of unloading or load cycling accurately. The 

model is appropriate for cases where the compressive stress in concrete is less than 

45% of its compressive strength at the time of loading.  
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Note 

Although CEB-FIP Model Code 1990 and EN1992-1-1:2004 Eurocode 2 are only applicable 

to beams, they have been extended in LUSAS to cover multi-axial stress states. The 

assumptions made in the derivation of this extension can be found in the LUSAS Theory 

Manual. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep and Shrinkage to CEB-FIP Model Code 

1990 (LUSAS Model 86) 

Concrete material properties to CEB-FIP Model Code 1990 are defined from the Attributes> 

Material> Specialisedmenu.  

The CEB-FIP Model Code 1990 model uses a simplified linear approach to represent creep. 

This assumption assumes that the service stresses in the concrete will not be exceeded and 

hence may not predict the effects of unloading or load cycling accurately. The model is valid 

for ordinary structural concrete (12-80 MPa) that has been loaded in compression to less than 

40% of its compressive strength at the time of loading. Relative humidities in the range 40-

100% and temperatures in the range 5-30 degrees Celsius are assumed. 

Material Properties 

The following material parameters are required, citing clauses from CEB-FIP Model Code 

1990 where appropriate. 

 Tangent modulus of elasticity - the tangent modulus of elasticity of concrete at 28 

days, Eci. This value is typically determined from equation 2.1-15, adjusted for 

aggregate type according to the commentary to clause 2.1.4.2. Table 2.1.6 gives values 

in the range 27×10³ ≤ Eci ≤ 44×10³ MPa. Taking into account the adjustment for 

aggregate, the expected range of values is therefore 18×10³ ≤ Eci ≤ 53×10³ MPa. The 

default value of Eci = 36×10³ MPa corresponds to Grade C40 concrete and quartzite 

aggregate. 

 Poisson’s Ratio - will lie in the range 0.1 ≤ νc ≤ 0.2 according to clause 2.1.4.3. A 

value of νc = 0.2, corresponds to an uncracked section, acknowledging the primary use 

of the creep material in prestressed concrete where cracking is minimised. 

 Mass density - is in the range 2400 ≤ ρ ≤ 2500kg/m³ for normal weight concrete 

according to clause 2.1.2. Typically it is taken as ρ= 2500kg/m³.  

 Coefficient of thermal expansion - may be taken as 10E-6 per degree K according to 

clause 2.1.8.3. 

 Mean compressive strength at 28 days - refers to the mean value of compressive 

strength, fcm, (the cylinder strength) associated with the characteristic compressive 

strength, fck. This value is typically determined from equation 2.1-1, that is, fcm = Fck + 

8MPa. For grades C12 to C80, as per clause 2.1.1.2, this would give a likely range 20 

≤ fcm ≤ 88MPa. The default value of fcm = 48MPa, corresponds to Grade C40. 
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 Cement type - refers to clauses 2.1.6.1 and 2.1.6.4.3(c), and may be Slow Hardening 

, Normal or Rapid Hardening (the default option) or Rapid Hardening High 

Strength.  

 Relative humidity - is used in the calculation of both creep coefficient and, where 

required, shrinkage. Typical percentage values according to Table 2.1.10. would be 50 

for indoor, dry atmospheric conditions, or 80 for outdoor, humid atmospheric 

conditions. 

  Internal perimeter factor or Nominal size appear depending upon selections made 

on dialog. See Calculation of nominal section size for further details. 

Creep calculations 

Creep calculations are carried out to CEB-FIP Model Code 1990 clause 2.1.6.4.3 with the 

following limitations: 

Substantial deviations from a mean concrete temperature of 20°C are not considered. 

According to clause 2.1.6.1, the age of the concrete should be adjusted according to equation 

2.1-87. This affects the modulus of elasticity (equation 2.1-58) and the notional creep 

coefficient (equation 2.1-65). This adjustment for temperature is not implemented in the 

LUSAS model code, therefore the calculations are only strictly valid for mean temperatures 

from 5°C to 30°C (see clause 2.1.6.4.2). 

Nonlinear effects of high stresses are not considered. According to clause 2.1.6.4.3(d), a 

nonlinear notional creep coefficient (equation 2.1-73a, 2.1-73b) should be used for areas of 

high stress. This is not implemented in the LUSAS model code, therefore the calculations are 

only strictly applicable for a stress level where σc ≤ 0.4fcm (t0 ). 

Shrinkage 

 The effects of shrinkage can be included in accordance with clause 2.1.6.4.4. 

Calculation of nominal section size 

Nominal section size can be calculated automatically from the section dimensions using 

either a full perimeter (outer and inner, if voids are present) or by specifying an internal 

perimeter factor. Alternatively a nominal section size may be specified directly. For beams 

the nominal size of member is computed automatically by LUSAS for each element, and for 

tapered sections will vary along the beam. 

 Automatically calculate the nominal size from section dimensions and Use full 

perimeter when selected together cause the nominal size of section to be calculated as 

2Ac/u where Ac is the area of the cross section and u is the length of the perimeter of 

the cross section that is in contact with the atmosphere - both externally and internally 

if voids are present.  

  Automatically calculate the nominal size from section dimensions and Specify 

internal perimeter factor when selected together cause the internal perimeter factor, 

termed ks here, to be in the calculation of, u, the total perimeter of the member in 
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contact with the atmosphere. The calculation of u takes the form: u = uo + ks× ui - 

where, for sections calculated using LUSAS Section Property Calculators, uo is the 

outer perimeter and ui is the internal perimeter of any voids (e.g. the cell of a box 

girder section). The value of u determined in this way will be used in the calculation of 

nominal size, h, following CEB-FIP Model Code 1990 clause 2.1.6.4.3(b). For voided 

cross-sections a default internal perimeter factor of 0.5 is entered into the dialog (and 

can be modified to suit the situation). For solid sections the value of internal perimeter 

factor is irrelevant. 

 When Specify nominal size is selected the Nominal size entered should be compatible 

with the modelling units in use. 

Notes 

 The use of an internal perimeter factor to calculate a nominal section size is not set out 

in CEB-FIP Model Code 1990, however it is adopted by other similar codes, including 

AASHTO, which in clause 5.4.2.3.2 states: 'The surface area used in determining the 

volume-to-surface ratio should include only the area that is exposed to atmospheric 

drying. For poorly ventilated enclosed cells, only 50 percent of the interior perimeter 

should be used in calculating the surface area.' To use the approach as described in 

AASHTO therefore, ks=0.5 would be used. 

 CEB-FIP Model Code 1990 can be used with beam elements, 2/3D contimuum 

elements, semi-loof and thick shells, and composite solid elements. CEB-FIP Model 

Code 90 is only strictly applicable to beams, however, in LUSAS the creep equations 

have been extended to 2D and 3D stress states. The assumptions made in the 

derivation of this extension can be found in the LUSAS Theory Manual. It must be 

noted that it may be difficult to establish an appropriate value of "nominal size" for 

anything other than beam elements. 

 The CEB-FIP Model Code 1990 creep and shrinkage model must be run in a transient 

nonlinear analysis in which the time step and analysis termination times must be 

specified in units that represent days. The meaning of the time step and total response 

time values is specified on the Model Properties dialog. An option exists in the 

advanced time step options to use an exponent to increase the time step as the analysis 

progresses. 

 The age of concrete at the time an element is introduced to the analysis may be 

defined using the Age attribute. 

 Nonlinearity of creep due to high compressive stress (eqn 2.1-73 in CEB-FIP Model 

Code 1990); the effect of type of cement and curing temperature (eqn 2.1-72 in CEB-

FIP Model Code 1990); and the effect of temperature on the maturity of concrete (eqn 

2.1-87 in CEB-FIP Model Code 1990) are not currently considered and should be 

assessed using code requirements. 

See the Solver Reference Manual and the Theory Manual for further details. 
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Concrete Creep and Shrinkage to EN1992-1-1:2004 

Concrete material properties to EN1992-1-1:2004 are defined from the Attributes> 

Material> Specialised menu.  

The EN1992-1-1:2004 creep and shrinkage model uses a simplified linear approach to 

represent creep. This assumes that the service stresses in the concrete will not be exceeded 

and hence may not predict the effects of unloading or load cycling accurately. The model is 

appropriate for cases where the compressive stress in concrete is less than 45% of its 

compressive strength at the time of loading.  

Material Properties 

The following material parameters are required: 

 Tangent modulus of elasticity - the tangent modulus of elasticity of concrete at 28 

days, Ec This value is typically determined from Ecm in Table 3.1, adjusted for 

aggregate type according to the commentary to clause 3.1.3(2) and using Ec = 

1.05Ecm according to clause 3.1.4(2). Taking into account the adjustment for 

aggregate and 1.05 factor, the expected range of values is therefore 19×10³ ≤ Ec ≤ 

56×10³ MPa. The default value of Ec = 36.75×10³ MPa, corresponds to concrete with 

fck = 40MPa and quartzite aggregate. 

 Poisson’s Ratio - may be taken as 0.2 for uncracked concrete and 0 for cracked 

concrete according to clause 3.1.3(4). A value of νc = 0.2, corresponds to an uncracked 

section, acknowledging the primary use of the creep material in prestressed concrete 

where cracking is minimised. 

 Mass density - may be taken as ρ= 25 kN/m³ = 2548.4kg/m³ for normal weight 

concrete according to Table A.1,  

 Coefficient of thermal expansion - may be taken as 10E-6 per K according to clause 

3.1.3(5). 

 Mean compressive strength at 28 days - refers to the mean value of compressive 

strength, fcm, (the cylinder strength) associated with the characteristic compressive 

strength. This value is typically determined from Table 3.1., i.e. fcm = Fck + 8MPa. This 

would give a likely range 20 ≤ fcm ≤ 98MPa. The default value of fcm = 48MPa, 

corresponds to Fck =40Mpa. 

 Cement type - refers to cement type clauses 3.1.2(6) and Annex B, clause B.1(2) and 

may be:  Class S (slowly hardening cements), Class N (Normal or rapidly hardening 

cements) or Class R Rapid hardening high strength cements. Class N is the default 

option.  

 Relative humidity - is used in the calculation of both creep coefficient and, where 

required, shrinkage. Typical percentage values according to Figure 3.1. would be 50 

for indoor, dry atmospheric conditions, or 80 for outdoor, humid atmospheric 

conditions 

  Internal perimeter factor or Nominal size appear depending upon selections made 

on the dialog. See Calculation of nominal section size for more details. 
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Creep calculations 

Creep calculations are carried out to EN1992-1-1:2004 clause 3.1.4 and Annex B.1 with the 

following limitations: 

 Elevated or reduced temperatures within the range 0 to 80°C are not considered. 

According to clause B.1(3), the concrete age should be adjusted according to 

expression B.10. This affects the modulus of elasticity (expression 3.5) and the 

notional creep coefficient (expression B.5). This adjustment for temperature is not 

implemented in the LUSAS model, therefore the calculations would be less accurate 

where ambient temperatures fall outside the range -40°C to +40°C (this range is 

inferred from clause 3.1.4(5).) 

 Nonlinear effects of high stresses are not considered. According to clause 3.1.4(4), a 

nonlinear notional creep coefficient (expression 3.7) should be used for areas where 

compressive stress σ_c>0.45f_ck (t_0 ). This is not implemented in the LUSAS model 

code, therefore the calculations are only strictly applicable for compressive stresses 

which do not exceed this threshold. 

Shrinkage 

The effects of shrinkage can be included in accordance with clause 3.1.4(6) and Annex B 

clause B.2. Clause 3.1.4(6) states: "The total shrinkage strain is composed of two 

components, the drying shrinkage strain and the autogenous shrinkage strain. The drying 

shrinkage strain develops slowly, since it is a function of the migration of the water through 

the hardened concrete. The autogenous shrinkage strain develops during hardening of the 

concrete in the early days after casting and should be considered specifically when new 

concrete is cast against hardened concrete".  

When shrinkage calculations are switched on, an option exists for the inclusion or exclusion 

of autogenous shrinkage. 

Calculation of nominal section size 

Nominal section size can be calculated automatically from the section dimensions using 

either a full perimeter (outer and inner, if voids are present) or by specifying an internal 

perimeter factor. Alternatively a nominal section size may be specified directly. For beams 

the nominal size of member is computed automatically by LUSAS for each element, and for 

tapered sections will vary along the beam. 

  Automatically calculate the nominal size from section dimensions and Use full 

perimeter when selected together cause the nominal size of section to be calculated 

according to clause 3.1.4(5) as 2Ac/u where Ac is the area of the cross section and u is 

the length of the perimeter of the cross section that is in contact with the atmosphere - 

both externally and internally if voids are present.  

  Automatically calculate the nominal size from section dimensions and Specify 

internal perimeter factor when selected together, cause the internal perimeter factor, 
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termed ks here, to be used in the calculation of, u, the total perimeter of the member in 

contact with the atmosphere. The calculation of u takes the form: u = uo + ks× ui - 

where, for sections calculated using LUSAS Section Property Calculators, uo is the 

outer perimeter and ui is the internal perimeter of any voids (e.g. the cell of a box 

girder section). The value of u determined in this way will be used in the calculation of 

nominal size, h, following clause 3.1.4(5). For voided cross-sections a default internal 

perimeter factor of 0.5 is entered into the dialog (and can be modified to suit the 

situation). For solid sections the value of internal perimeter factor is irrelevant. 

 When Specify nominal size is selected the Nominal size entered should be compatible 

with the modelling units in use. 

Notes 

  The EN1992-1-1:2004 creep and shrinkage model can be used with beam elements, 

2/3D continuum elements, semi-loof and thick shells, and composite solid elements. 

EN1992-1-1:2004 creep and shrinkage is only strictly applicable to beams, however, 

in LUSAS the creep equations have been extended to 2D and 3D stress states. The 

assumptions made in the derivation of this extension can be found in the LUSAS 

Theory Manual. It must be noted that it may be difficult to establish an appropriate 

value of "nominal size" for anything other than beam elements. 

  The EN1992-1-1:2004 creep and shrinkage model must be run in a transient 

nonlinear analysis in which the time step and analysis termination times must be 

specified in units that represent days. The meaning of the time step and total response 

time values is specified on the Model Properties dialog. An option exists in the 

advanced time step options to use an exponent to increase the time step as the analysis 

progresses 

 The age of concrete at the time an element is introduced to the analysis may be 

defined using the Age attribute. 

 Nonlinearity of creep due to high compressive stress (eqn 3.7 in EN1992-1-1:2004); 

the effect of type of cement and curing temperature (eqn B.9 in EN1992-1-1:2004); 

and the effect of temperature on the maturity of concrete (eqn B.10 in EN1992-1-

1:2004) are not currently considered and should be assessed using code requirements. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep: Chinese Code (2007 Draft) 

This material model is accessed via the Attributes> Material> Specialised menu. 

It allows the creep of concrete to be computed as concrete ages while subjected to external 

forces including thermal stresses that may be due to the hydration process.  

The equations used to compute the creep strains are taken from the Chinese Creep Code for 

Dams. These equations are based on linear visco-elastic theory and hence may not predict the 
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effects of unloading or load cycling accurately. Thermal stresses due to the heat of hydration 

can be included in the computation by running a semi-coupled thermo-mechanical analysis. 

 Further information on both these facilities can be found in The LUSAS Theory Manual. 

Material Properties  

The following material properties are required 

  Long term Young’s Modulus 

  Poisson’s ratio  

 Mass density 

 Coefficient of thermal expansion 

  Parameters for controlling the evolution of Young’s modulus with time (a, b)  

 Parameters for controlling variation of creep coefficient with time (fi, gi, pi, ri... ) 

 Thermal properties if running a thermo-mechanical coupled analysis  

For full details and descriptions of these input parameters please refer to the LUSAS Solver 

Manual. 

Notes 

 If there is a lack of experimental data to complete the LUSAS dialog the Chinese 

Creep Code for dams recommends the following default input parameters:  

= 1.05  or  = 1.20 , A = 0.40, B = 0.34  

where  and  are instant elastic modulus at 360 and 90 days, respectively, and 

F1 = C1, G1 = 9.20C1, P1 = 0.45, R1 = 0.30, C1 = 0.23/  

F2 = C2, G2 = 1.70C2, P2 = 0.45, R2 = 0.005, C2 = 0.52/  

F3 = R3 = 0 

 The Chinese creep model must be run in a transient analysis in which the time step 

and analysis termination times must be specified in units that represent days. An 

option exists in the advanced time step options to use an exponent to increase the time 

step as the analysis progresses.  

 The age of concrete at the time an element is introduced to the analysis may be 

defined using the Age attribute 

Generic Polymer (Model 87 and 88) 

The Generic Polymer model is accessed from the Attributes> Material> Specialised menu 

item.  
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The model consists of a set of Maxwell dampers which are used to model visco-elasticity, an 

Eyring dashpot which is used to model viscoplasticity and a linear spring. These components 

are placed in series. The Properties of the Maxwell elements, Eyring dashpot and linear 

spring can be different in tension and compression.  

Model 87 is defined using an linear spring, an Eyring damper, and a number of parallel 

Maxwell elements. Model 88 is used when behaviour differs in tension and compression 

Material Properties 

 Bulk Modulus 

 Mass density 

 Coefficient of thermal expansion 

 Mass Rayleigh damping constant 

 Stiffness Rayleigh damping constant 

 Eyring damper activation energy 

 Eyring damper activation volume 

 External spring stiffness 

 Maxwell element spring constant 

 Maxwell element Newtonian dashpot viscous constant 

See the Solver Reference Manual and theTheory Manual for further details. 

Generic Polymer with Damage (Model 89 and 90) 

The Generic Polymer with Damage model appears under the Attributes> Material> 

Specialised menu item. The model accounts for strain rate behaviour and irrecoverable 

damage in the modelling of polymers and other polymer-like materials.  

 Model 89 consists of a linear spring, a spring that includes damage, an Eyring dashpot 

and a number of parallel Maxwell elements. Different sets of material properties can 

be defined to model tensile and compressive behaviour, except for the Visco-Scram 

damage model whose properties apply in both tension and compression. 

 Model 90 includes two additional features. The first feature is a set of failure criteria 

that are used to remove individual Maxwell elements when the criteria are met. The 

second is a switch between tensile and compressive material properties based on the 

stress state in an individual Maxwell element. 

Note that for the Visco-Scram Damage model the expected input units for the Threshold 

Stress Intensity parameter cannot be displayed when the cursor is hovered over the input cell. 

This is because the power value concerned cannot be created with this display method. 

Material Properties 

See the Solver Reference Manual and theTheory Manual for further details. 
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Piecewise Linear Bar Material (Model 104) 

Piecewise linear bar material is for use with 2-noded bar elements to meet the requirements of 

no compression (tension-only) or no-tension (compression-only) members. The nonlinear 

elastic behaviour is recoverable, and during the analysis the stiffness (and stress) will be 

computed from the strain value using the relationship shown in the image below.  

General usage 

For general use the piecewise linear bar material model is accessed via the Attributes>  

Material> Specialised> Piecewise Linear (Bar) menu item. Any number of piecewise linear 

segments can be defined to represent material behaviour. The stress-strain curve defined does 

not have to pass through the origin. By defining curve data that runs along the positive (or 

negative) strain axis, no compression (tension-only) or no tension (compression-only) 

behaviour can be simulated. 

 

General piecewise linear definition 

Editing curve data 

Once defined, piecewise linear bar material attributes are held in the Attributes Treeview. 

 Selecting the Edit Attribute... context menu for a bar material attribute displays the 

piecewise linear bar material data for editing. 

Tension-only and compression-only usage 

For simplified use, the piecewise linear bar material model is also used by the 

Attributes> Material> Tension / Compression Only (Bar) menu item. For a selected or 

user-defined material, automatically created curve data, that runs along the positive (or 

negative) strain axis, is used to define a simple no compression (tension-only)or no tension 

(compression-only) or behaviour.  
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Tension-only bar material Compression-only bar material 

Editing curve data 

Once defined, piecewise linear bar material attributes are held in the Attributes Treeview, and 

have context menu entries named Edit Definition... and Edit Attribute.  

 Selecting the Edit Definition... menu entry for a bar material attribute, or double 

clicking the attribute name displays the original definition dialog with all the original 

input data intact for modification. 

 Selecting the Edit Attribute... menu entry for a bar material attribute displays the 

equivalent piecewise linear bar material data for the defined data. These values may 

be changed but this breaks the link to the original definition dialog and a warning 

message will be displayed. 

Notes 

 The input data must not contain a curve segment with a negative or vertical slope. 

 Loading and unloading is assumed to occur along the same stress/strain path. 

 If strains exceed the bounds of the curve data the first or last curve segment will be 

used to extrapolate the stress. 

 A curve tolerance parameter is used to help prevent chatter (oscillations between 

adjacent segments when a computed stress/strain is very close to an apex on the 

curve). If the point falls within this tolerance an average Young's modulus value to 

form the stiffness is computed from the adjacent segments. 

 Defining a non-zero stress for zero strain has the same affect as applying an initial 

stress. Under these conditions, if an initial stress is also applied, the compound effect 
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of both stresses will be applied. In other words, an applied initial stress loading will 

act as an offset on the stress data entered for this material model. 

 Tension only /compression only material requires the use of a nonlinear material 

definition and suitable nonlinear controls. 

 Carrying out an eigenvalue analysis following a nonlinear analysis that uses this 

model can lead to unrealistic bar stresses for some modes. If a no-compression bar 

element has zero stiffness prior to the eigenvalue analysis, then some modes will 

inevitably see that element put into tension. 

Resultant User 

Used to specify user material parameters for the user defined nonlinear resultant model. 

See the Solver Reference Manual for further details. 

Nonlinear User 

This is used to specify user material parameters for the user defined nonlinear material model. 

See the Solver Reference Manual for further details. 

Material Properties Nonlinear Thermal User 

This is used to enter material parameters for user nonlinear thermal material models. 

Required inputs are: 

 User material model number The defined material model number 

 Number of state variables The number of variables required for storing results at 

gauss points 

 Values Input parameters for the user-defined material model listed in the order that 

they are required 

Joint Material Models 

Joint material models are used in conjunction with joint elements to define the material 

properties for linear and nonlinear joints. The following joint models are available: 

Linear Joint Models 

 Spring stiffness only corresponding to each local freedom. These local directions are 

defined for each joint element in the Element Reference Manual. 

 General Properties advanced specification of joint properties of spring stiffness, 

mass, coefficient of linear expansion and damping factor. 

Nonlinear Joint Models 

 Elasto-Plastic (Tension and compression equal) with isotropic hardening and equal 

tension and compression yield conditions. 
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 Elasto-Plastic (Tension and compression unequal) with isotropic hardening and 

unequal tension and compression yield conditions. 

 Smooth Contact with an initial gap. See notes below. 

 Frictional Contact with an initial gap. See notes below. 

 Trilinear Earth Pressure creates a piecewise linear joint material whose properties 

vary with depth, such as those used to represent a layer or stratum in a soil-structure 

interaction or geotechnical analysis. 

 Piecewise linear allows a single force/displacement (moment/rotation) curve to be 

defined for each freedom by defining a number of line (curve) segments.  

 Piecewise linear elastic (Axial force dependent) Allows any number of 

force/displacement (moment/rotation) curves representing the behaviour under 

different axial forces. The joint is typically used for modelling plastic hinges in 

pushover analysis. 

 Nonlinear user-defined A user-defined joint model. 

Seismic Isolator Joint Models 

 Viscous dampers - Kelvin and Four Parameter Solid modules available. 

 Lead Rubber Bearings with plastic yield and biaxial hysteric behaviour. 

 Friction Pendulum System with pressure and velocity dependent friction coefficient 

and biaxial hysteretic behaviour. 

Joint material properties 

Joint material properties are assigned to model geometry using joint elements to define the 

joint behaviour. Joint input parameters and the number of degrees of freedom will vary 

according to the joint model and element type chosen 

 Joint type selection of a joint type adds the properties relevant for that joint type to 

the tabular grid on the dialog.  

 Mass position specifies that the joint mass will be at the first node, second node, or 

between nodes 

Properties for each degree of freedom must be specified in the properties grid of the dialog. 

Some joint materials have properties that can be entered to be common for all freedoms. 

Additional Thermal expansion, Varying friction coefficient and Damping options are 

selectable according to joint type. 

See Joint and Interface Elements for general information about using joints.  

Refer to the Solver Reference Manualfor a full description of the joint material input 

parameters required for these joint models. 
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Notes 

 When defining joint properties for single joint elements the total stiffness or yield 

force should be defined. When using interface joint meshing the stiffness and yield 

force defined in the joint properties should be defined per unit length when using 

interface joints assigned to lines or per unit area when using interface joints assigned 

to surfaces. 

 Initial gaps are measured in units of length for translational freedoms and in radians 

for rotational freedoms.  

 Smooth Contact. If an initial gap is used in a spring, then the positive local axis for 

this spring must go from node 1 to 2. If nodes 1 and 2 are coincident the relative 

displacement of the nodes in a local direction (d2­ d1) must be negative to close an 

initial gap in that direction. 

 Frictional Contact Friction contact joints can be specified to permit lift-off in a user-

defined direction. If an initial gap is used in a spring, then the positive local x axis for 

this spring must go from node 1 to 2. If nodes 1 and 2 are coincident the relative 

displacement of the nodes in the local x direction ( x2­ x1) must be negative to 

close an initial gap. 

 Both Smooth Contact and Frictional Contact joints can be used for lift-off or hook 

contact by using appropriate stiffnesses, gap and yield force. 

Joint Model Force Response Curves 

Elasto-Plastic Joint Models 
   

Smooth Contact 
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Frictional Contact 1 
  

Frictional Contact 2 

 

  

 

Frictional Contact 3 
  

Viscoelastic Damper Joint Model 

 

  

 

Lead Rubber Bearing Joint   Friction Pendulum System Joint 
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Tri-linear Earth Pressure Joint Material 

 Tri-linear earth pressure joint material simplifies the modelling of a variety of soil-structure 

interaction problems. It creates a piecewise linear joint material attribute that generates earth 

pressures in relation to deflections of the structure. Earth pressures increase with depth along 

the vertical axis. Multiple attributes can be defined to represent layers of soil or changes in 

properties due to the presence of water. 

Defining Earth Pressure Joint Material 

Tri-linear earth pressure joint material is defined using the Attributes> Material> Joint 

menu item. The input parameters and the number of degrees of freedom will vary according 

to the selected joint and model geometry. 

 Joint type The Tri-linear soil joint material attribute must be compatible with the joint 

element to which it will be assigned. It is intended for use primarily with JNT3 and 

JNT4 elements, for 2D and 3D applications respectively. It is important that the local 

axes of the joint elements are orientated correctly for the intended use. For both 2D 

and 3D joint elements the joint element local x axis must align with the horizontal and 

connect the support to the structure. For 2D applications the joint element local y axis 

must be aligned to the vertical axis. For 3D applications the joint element local z axis 

must be aligned with the vertical axis. Local coordinate systems may be required to 

achieve correct element orientation. 

  

Joint element axes required for  

2D modelling applications 

Joint element axes required for 

3D modelling applications 

  

 Defining geometryJoint material parameters can be defined for assignment to either a 

point, a line or a surface. The defining geometry refers to the underlying geometry to 

which the slave nodes of the joint elements are assigned. The defining geometry is 

used to determine the angle of the structure for lines and surfaces. Note that the angle 

of the structure cannot be determined when joint material attributes are applied 

between points. 

Vertical and lateral pressure parameters 

Parameters relating to vertical and lateral pressures are entered in tabular grids. Diagrams and 

equations are provided on the Trilinear Earth Pressure dialog to clarify the meaning of the 

material parameters.  
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Local axes representations 

Because joint mesh assignments are made using master to slave assignments, and the joint 

element orientation may differ on each side of a line or surface representing a retaining 

structure, it is important to correctly specify what the positive x and y axis of each joint 

material attribute is representing. With reference to an observed element axes for an assigned 

joint element: 

 The positive displacement of the local x axis of the joint element can be set to 

represent (mobilise) Active pressures or Passive pressures. 

 The positive direction of the local y axis of the joint element (for 2D) or local z axis 

(for 3D) can be set to Opposes gravity (points up) or Matches gravity (points 

down). 

 Consider angle of structure The angle of the structure relative to the retained soil 

changes the effective direction of the soil pressures. Selecting this option (for lines and 

surfaces only) considers the orientation of the structure relative to the global vertical 

axis when resolving soil pressures. For lines, the angle of the structure is defined from 

the vector of the line. For surfaces, the angle is defined from the normal to the surface. 

Notes 

 All joints must be supported at the non-structure end by a fully fixed support 

condition. 

 Modelling with tri-linear earth pressure material requires a nonlinear analysis. 

 The pressure generated in the joint elements is interpolated from nodal displacement. 

The direction of the displacements determines from which part of the soil lateral 

response curve the forces are interpolated. The direction (either positive or negative) 

depends on the orientation of the local element axis representing the horizontal. 

 By default soil pressures are defined per unit area. Where the material is applied to 

geometry other than surfaces a factor (Weff) may be specified to define pressures over 

a fixed width or area. For example where the material is applied to a pile of fixed 

width, a factor may be specified to define pressures acting over a specified width 

rather than per unit width. 

 When creating soil layers, the overburden pressure from any soil layers above must be 

calculated manually and entered as a surcharge for the material currently being 

defined. 

 The material properties are assumed to vary with the vertical axis currently set in 

Modeller. The vertical axis can be set by selecting the Utilities > Vertical Axis… 

menu item. 

 The material definition assumes soil depth and therefore pressure increases in a 

negative direction. 
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 The datum used for the calculation of effective overburden or ground level as entered 

into the grid must coincide with the geometry to which it is assigned. For example if 

the top layer of soil is defined by a line between (0, 0, 0) to (0, 0,-2) (Z is vertical) the 

datum level must be set to 0. For the layer beneath defined by a line between (0, 0,-2) 

to (0, 0,-8) the datum level must be set to -2, and a surcharge representing the above 

strata applied. If the model geometry is altered the soil definition values must also be 

updated to suit the new configuration. 

 For all joint elements negative forces represent compression. Lateral pressures are 

therefore negative; positive forces are prevented by the defining variations (tension 

cut-off). 

 The use of the tri-linear earth pressure material is described in the worked example 

Embedded Retaining Wall. See Application Examples Manual (Bridge, 

Civil&Structural 

Editing of Earth Pressure Joint Material data 

Earth pressure joint material attributes are held in the Attributes Treeview. Context menu 

entries named Edit Definition... and Edit Attribute... can be seen by right clicking on an 

attribute. 

 Selecting the Edit Definition... menu entry or double clicking the attribute displays 

the original definition dialog with all the original input data intact.  

 Selecting the Edit Attribute...menu entry displays the stored piecewise linear joint 

material values that are used to define the earth pressure joint material. These values 

may be changed outside of the Earth Pressure Material definition dialog but it is not 

recommended to do so. If edited, the link to the original definition dialog will be 

broken. 

For a description of the piecewise linear joint material parameters that are required for this 

joint model please refer to the Solver Reference Manual.  

Piecewise Linear Joint Material 

This joint material is specified by a single Force/Displacement curve defined in a piecewise 

linear way, either by coordinate input or by spreadsheet import. Variations can also be used in 

the definition of curves. A stiffness factor governs how force/displacement values should be 

extrapolated when they fall outside the range of those defined. A factor of 1 (the default) 

keeps the same slope as the adjacent force/displacement line segment. A factor of 0 keeps the 

force the same.  
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A typical piecewise linear load-deflection curve with N linear segments is shown below. 

 

Note 

 It is possible to define segments with negative stiffness/gradient on the force-

displacement curve to the positive side of the displacement origin. However, the 

curve cannot extend below the force level at this origin as the force-displacement 

relationship would then become non-unique because of the curve data defined (or 

extrapolated) for negative displacements. This is also true for forces on the negative 

side of the displacement origin; in this case the curve cannot extend above the force 

at the displacement origin.  

Piecewise Linear Joint Material (Axial Force Dependent) 

This joint material is similar to the generic piecewise linear joint material, but allows any 

number of Force/Displacement curves to be optionally specified by defining a number of 

curve segments for a stated axial force. Variations can also be used in the definition of curves. 

The joint is typically used for modelling plastic hinges in pushover analysis.  

The curves defined are automatically interpolated by a LUSAS Solver to arrive at suitable 

force/displacement values for a particular axial force imposed upon a joint to which the 

piecewise linear joint material has been assigned. A stiffness factor governs how 

force/displacement values should be extrapolated when they fall outside the range of those 

defined. A factor of 1 (the default) keeps the same slope as the adjacent force/displacement 

line segment. A factor of 0 keeps the force the same. 

Notes 

 A force/displacement curve can be defined for an axial component axis (u) of an axial 

force dependent piecewise linear elastic material. If multiple curves defining the 

behaviour of the axial component are defined for various values of axial force, the 
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behaviour between the singular points on each curve that matches the axial force it 

was defined for will be cross-interpolated between both bounding piecewise linear 

curves. This behaviour is complex, and it is therefore recommended that only a single 

curve is defined for the axial component (u). 

 It is possible to define segments with negative stiffness/gradient on the force-

displacement curve to the positive side of the displacement origin. However, the curve 

cannot extend below the force level at this origin as the force-displacement 

relationship would then become non-unique because of the curve data defined (or 

extrapolated) for negative displacements. This is also true for forces on the negative 

side of the displacement origin; in this case the curve cannot extend above the force at 

the displacement origin.  

Support Conditions 

Support conditions describe the way in which the model is supported or restrained and are 

defined from the Attributes > Support menu. Supports can be defined for Structural or 

Thermal analysis uses. 

Structural supports 

A summary of the structural support types is given here: 

 Free For structural analyses the degree of freedom is completely free to move. For 

pore water analyses no flow will occur through the node. For thermal supports no heat 

will flow through the node. 

 Fixed For structural analyses the degree of freedom is completely restrained from 

movement. For pore water analyses flow will occur through the node. For thermal 

supports heat will flow through node to maintain temperature at zero (or at a 

prescribed temperature). 

Spring Stiffness Distribution 

Spring stiffness is applied either uniformly, per unit length or per unit area. Spring stiffness 

values can be applied uniformly to all nodes meshed on the assigned feature, or their values 

may vary over a feature by applying a variation.  

 Stiffness applies the spring stiffness uniformly to all nodes meshed on the assigned 

feature. 

 Stiffness/ unit length and Stiffness/unit area distribute the total spring stiffness 

between the nodes on the assigned feature. 

Simple lift-off supports 

A simple lift-off support can be specified by pressing the Lift-off button and selecting the 

appropriate radio button for the degree of freedom that will control the lift-off condition for 

the support. For this a single value for the lift-off freedom needs to defined, where the lift-off 

value to be stated is the value that would be required to overcome the reaction or restraint at 
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that support. This means that a positive lift-off value would be entered to overcome a 

negative reaction. Entering a negative lift-off control value effectively reverses the lift-off 

behaviour. 

 A Lift-off value is set for either Force, Moment, Hinge rotation, or Flow for a 

chosen degree of freedom. Lift-off will take place once a stated value has been 

exceeded. 

Additional behaviour can be specified for when lift-off has occurred: 

 Release restraint in lift-off direction only releases only the specified restraint 

(controlling freedom), leaving all other restraints applied. 

 Release all restraints releases all restraints. 

Advanced lift-off supports and touchdown (contact) 

More advanced lift-off behaviour can be modelled and specified using the Contact button. 

This provides for both lift-off and touch down and requires setting the appropriate contact 

conditions for the degree of freedom that will control the lift-off/contact behaviour. 

 For lift-off (whether for all directions or the chosen direction), the support fixity part 

of the dialog describes the behaviour before the lift-off has occurred.  

 For contact/touchdown, the support fixity part of the dialog describes the behaviour 

after the touchdown has occurred. 

Contact control settings for Force, Moments or Flow 

 Contact control can be set for either Force, Moments, or Flow values, and for a 

chosen degree of freedom. Upper and lower limits can be specified at which lift-off 

will occur. Contact will be deemed to be taking place once a stated value has been 

reached. 

 As for simple lift-off, additional behaviour can be specified for when lift-off or contact has 

occurred: 

 Release restraint in lift-off direction only releases only the specified restraint, 

leaving all other restraints applied. 

 Release all restraints releases all restraints. 

Contact control settings for Displacements or Pore Pressure 

Contact control for a Displacement or a Pore pressure based support condition is set using a 

Gap condition. For this, a supported node is free to move within an upper value and lower 

value. Touch down (contact) will occur when a limiting value is exceeded. This option would 

be used to restrict the movement of a pipe in a pipe support, or the movement of a bridge 

beam or deck supported by a displacement-restricted bridge bearing for example. 
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Lift-off / Contact examples 

 

 Notes 

 The degrees of freedom which may be restrained for any analysis depend on the 

chosen element type. Those applicable for each element are defined in the Element 

Reference Manual. 

 For structural problems Translation in X, Y, Z and Rotation about X, Y, Z refer to 

freedoms along and about the global axes unless a local coordinate is assigned in 

which cases the axis directions refer to local directions x, y, z. 

 A hinge (loof) rotation is a local freedom which refers to rotation about the side of an 

element. Pore pressure is a special freedom type used in two phase elements. 

 For thermal (field) problems there is only one freedom type, temperature (or the field 

variable). 

 A support can only be set to have lift-off or contact properties, not both. 

 If a particular freedom has been chosen as the freedom that controls lift-off / 

touchdown, it must either be either a restrained of spring freedom, it may not be 

‘free’. 

 When loadcases that contain supports with lift-off or contact behaviour are used in 

load combinations or envelopes, a warning symbol is added to the load 

combination/envelope icon to signify that lift-off/contact supports are defined and that 

the principal of superposition is not true for these results. These combinations can be 

expanded to enable a nonlinear analysis to be carried out. See Combinations and 

Envelopes for details. 

Additional settings for use with nonlinear analysis 

Two system parameters ICNTCT and MXLFTO may be set to modify how the lift-off 

freedoms are handled in a nonlinear analysis. The parameters only affect lift-off freedoms 

which are lifting-off for the first time, that is, those that may have a bolt or anchor to break. 
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After the increment in which lift-off occurred has converged, a freedom may lift-off and re-

ground without restriction. 

 ICNTCT =0 (Default value) Lift-off freedoms which lifted-off for the first time in the 

increment are not allowed to re-ground until the increment has converged. Once 

converged the initial fixity of the re-grounded freedom is restored and the increment is 

resolved 

 ICNTCT=1 No freedom is allowed to lift-off or re-ground for the first time until the 

increment has converged. On convergence the increment is resolved with the 

application of all pending lift-off/re-grounding conditions. 

 ICNTCT=2 No freedom is allowed to lift-off or re-ground until the increment is 

solved. On solution all pending freedoms may re-ground but only the freedom with the 

largest lift-off force is allowed to lift-off. The increment is then resolved. 

 ICNTCT=3 All freedoms are allowed to lift-off and re-ground at any point in the 

increment. 

After a freedom has lifted-off for the first time, possibly breaking a restraining bolt or anchor, 

it is allowed to re-ground and lift-off but the lift-off force is set to zero in subsequent 

increments reflecting the fact that lift-off has in some way damaged the restraint. If all nodal 

freedoms were released on lift-off, these remain free regardless of future touch downs. 

ICNTCT can be set to 3 if there are no restraints to be broken. 

 MXLFTO limits the number of times in an increment that the lift-off variables can be 

released or restored. It is used to prevent an infinite loop developing in which a node 

may repeatedly come into and then lose contact, a process known as chatter. 

See Model Properties for details about setting these system parameters. 

Thermal Supports 

Thermal support conditions describe the heat flow at the model boundaries. Degrees of 

freedom can be made Free or Fixed. By default all freedoms are Free. 

 Free no heat will flow through the node (insulated) 

 Fixed heat will flow through the node to maintain temperature at zero (or at a 

prescribed temperature). 

Assigning Support Conditions 

Supports can be assigned to a model in a number of ways: 

 By dragging a support attribute from the Attributes  Treeview onto previously 

selected geometric features (or to mesh objects in a mesh-only model).  

 By assigning a support type to all relevant features in a model by use of the Assign to 

All context menu available for the loading type.  

 By copying and pasting a support type between Analysis entries in Analyses  

Treeview. 
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For linear static analyses all support conditions are assigned to the first loadcase. For a 

nonlinear or transient analysis, in which the support conditions change, the loadcase after 

which the support is applied is specified when carrying out the assignment.  

Features that are supported automatically support common lower-order features. For 

instance,two lines supported in X and Y directions respectively, will automatically result in a 

common point being restrained in those directions also. 

 

Support dependency across analyses / loadcases 

 Supports defined for the first loadcase within a base analysis can be optionally 

inherited by all other analyses. 

  For a linear analysis, supports assigned to the first loadcase of the analysis will be 

used by all following loadcases within that analysis. Supports cannot be changed for 

different loadcases within a linear analysis. 

 Assigning a different support to selected features in a following analysis supercedes 

any inherited supports but for only those assigned features. 

 For a nonlinear analysis, or a new time step of a transient problem, supports may only 

be reassigned on a new loadcase increment. All support assignments from previous 

increments or time steps that are not reassigned will remain unchanged. 

 For an eigenvalue analysis support conditions may be omitted provided a shift is used 

in the eigenvalue control. 

Notes 

 Support assignments on lower order features override those on higher order features. 

 On the common feature where support assignments meet, the support condition 

applied is additive. 
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 Assigning a local coordinate to a feature changes the freedom directions of the 

underlying element nodal freedoms and will hence also affect any global loads applied 

to that feature.   

 Supports which act in tension, but not in compression, may be modelled using joints 

or interface meshes 

Visualising Support Conditions 

Support visualisation can be toggled on and off using the  support visualisation button. 

Support attributes can be visualised individually by selecting an attribute name in the 

Attributes  Treeview and clicking the right mouse button to choose Select Assignments or 

Visualise Assignments from the context menu. This is the easiest way to interrogate the 

assignment of a single attribute. 

Viewing support assignments 

Loadcases and analyses to which attributes such as supports have been assigned can be 

viewed in a tabular form by selecting View Assignments from the context menu for the 

attribute. 

Deassigning Supports 

Supports may be deassigned from all or selected features by selecting the support attribute in 

the Attributes  Treeview  with the right hand mouse button and picking the Deassign entry 

from the context menu. The menu item entries From Selection or From All may then be 

chosen to deassign from the items in the current selection or from all the features in the 

model. Unassigned attributes will be denoted with a greyed-out bitmap . 

Support attributes may also be defined by selecting View Assignments from the context 

menu for the attribute and unchecking the relevant loadcase. 

Support Styles 

The Attributes layer properties define the styles by which supports are visualised and also 

permits visualisation of supports on an individual basis. The attributes layer properties may 

be edited directly by double clicking the layer name in the Layers  Treeview. Loading can 

be visualised in three ways: 

Support conditions can be visualised in three ways: 

 Arrows Visualises restraints as straight arrows representing translational freedoms, 

and circular arrows for rotational freedoms. Spring supports are visualised as spring 

representations. Hinge freedoms are not visualised. For supports defined using lift-off 

or contact criteria the controlling freedom is, by default, coloured orange with other 

support freedoms remaining the default green. 

 Symbols Places a symbol on each supported node. 
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 Codes Writes a code next to each supported node representing the type of support 

assigned. The code uses F = Free, R = Restrained (Fixed), S = Spring. For example, a 

code RRSFFF represents a six degree of freedom node that is restrained in X and Y 

directions, supported with a spring in Z direction and free in all three rotational 

freedoms. 

See About Model Attributes for more details. 

Notes 

 For nonlinear and transient problems, by default, supports are visualised for the active 

loadcase by combining the assignment in the loadcase history. To view the supports 

assigned to the active loadcase only, select the Show only assignments in the active 

loadcase option on the support visualisation dialog accessed from the attributes layer 

properties. 

 Support visualisation may be drawn using the parent feature colour by selecting the 

Colour support by geometry option on the  support visualisation dialog accessed 

from the attributes layer properties. This is useful to identifying which feature type a 

support attribute is assigned to. 

Example: Translational Fixed and Spring 
Supports 

This 3D structure is restrained from any lateral 
movement at the base of all legs. The same points 
are also sprung vertically to represent a non-rigid 
base support. 

 
  

   
Example: Translational Supports 

This 2D structure is restrained horizontally and 
vertically at the left edge with a single restraint in 
both in-plane translational directions. This rigidly 
fixes the body along the edge shown while allowing 
the rest of the model to move. 
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Example: Symmetry 

Only the right half of this structure is modelled using shell 
elements but the full structure is represented by assuming 
symmetry at the centre-line. Symmetry assumes the same 
behaviour for both sides of the model therefore a 
translational restraint is applied to stop movement across 
the symmetry boundary and a rotational restraint is 
applied to force zero rotation at the boundary. 

  
Example: Symmetry 

This quarter plate membrane model uses 
symmetry restraints to effectively model the 
whole plate. Supports are positioned in order 
to prevent any movement at lines of 
symmetry. 

 

  

 

Loading Attributes 

Loading attributes describe the external influences to which the model is subjected. Structural 

and Thermal loading options are provided on separate Attributes > Loading menu items 

according to the user interface in use. A summary of the loading types is given here: 

Structural Load Types 

 Structural Loads are concentrated, body force, distributed, face, temperature, 

stress/strain, and beam loads. 

 Prescribed Structural Loads are used to specify initial displacements, velocity or 

acceleration at a node.  

 Discrete Structural Loads are used to distribute a given loading pattern (such as for a 

type of vehicle) over full or partial areas of the model, independent of the model 

geometry. Point and Patch loads are discrete loads - also known as general loads. 

Compound discrete loads permit sets of point and patch (and compound loads) to be 

defined. 

Thermal Load Types 

 Thermal Loads describe the temperature or heat input to a thermal analysis. 
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All Structural and Thermal loads are feature-based loads that are assigned to the model 

geometry (or to mesh objects in a mesh-only model) and are effective over the whole of the 

feature to which they are assigned. Discrete loads are feature independent. Further control 

over how discrete loads are applied is available by using a Search area. Once defined. 

loading attributes are added to the Attributes  Treeview.  

Assigning Loading 

Loading can be assigned to a model in a number of ways: 

 By dragging a loading attribute from the Attributes  Treeview onto previously 

selected geometric features (or to mesh objects in a mesh-only model).  

 By assigning a loading type to all relevant features in a model by use of the Assign to 

All context menu available for the loading type.  

 By copying and pasting a loading type between Analysis entries in Analyses  

Treeview. 

When a load is assigned, an analysis and a loadcase must be defined. A load factor may also 

be specified. If a load factor is entered the loadcase name will include this load factor. If the 

load is to be assigned to a new loadcase the new loadcase name may be entered into the 

loadcase combo and the new loadcase may be set active if required using the checkbox 

provided. Setting the loadcase as the active loadcase ensures that immediate load visualisation 

will take place. Additional options are available when applying discrete loads see Assigning 

Discrete Loads for more information. 

Some loads act in global directions, others in local element directions. The defined loading 

value will be assigned as a constant value to all of the nodes/elements in the feature unless a 

variation is applied. Variations can be applied to all feature load types except for Beam 

Distributed loads that have a variation built into the definition.  

Tip. If the required loading directions of a global load do not lie in the global axes then a 

local coordinate may be assigned to the feature to transform the loads to local coordinate 

directions. 

Notes 

 Load factors of assigned loads can be changed by selecting the Change load factor 

menu item accessed from the loading name context menu.  

 In nonlinear and transient analysis feature-based loads can be factored using load 

curves.  

 Consult the Element Reference Manual in order to check that the required loading is 

available for a particular element. 
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Gravity loading 

Gravity loading can be applied on an analysis or loadcase by loadcase basis. Gravity loading 

is applied as a Body Force load type. 

Loading dependency across analyses / loadcases 

Unlike supports, loadings defined for one analysis or loadcase are not inherited by following 

analyses or loadcases. Loadings can however be copied and pasted between analyses in the 

Analyses  Treeview. 

Visualising Assigned Loading 

Loading visualisation is done on a loadcase-by-loadcase basis requiring each loadcase to be 

set active in turn. Load visualisation can be toggled on and off using the  load 

visualisation button. 

Loading attributes can be visualised individually by selecting an attribute name in the 

Attributes  Treeview and clicking the right mouse button to choose Select Assignments or 

Visualise Assignments from the context menu. This is the easiest way to interrogate the 

assignment of a single attribute. 

 Viewing loads by definition and by effect on the mesh is also possible via the  load 

visualisation button's drop-down menu. 

Viewing loading assignments 

Loadcases and analyses to which attributes such as loading has been assigned can be viewed 

in a tabular form by selecting View Assignments from the context menu for the loading entry 

in the Attributes  Treeview. 

Styles 

The Attributes layer properties define the styles by which loading is visualised and also 

permits visualisation of loadings on an individual basis. The Attributes layer properties may 

be edited directly by double clicking the layer name in the Layers  Treeview. Loading can 

be visualised in three ways: 

 By colouring geometry Colours the geometry according to which loading attributes 

are assigned to which features. 

 Using symbols Marks the geometry with symbols according to which loading 

attributes are assigned to which features. 

 Using arrows Visualises the loading attribute using arrows. For discrete loads the 

definition and the effect on the mesh may be different.  

See About Model Attributes for more details. 
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Structural Loading 

Structural loading is feature based and hence it is assigned to the model geometry (or to mesh 

objects in a mesh-only model). Variations in loading on a feature can be specified using a 

Variation. For information on which load types can be applied to which element types, see 

the Element Reference Manual. 

Structural loading is accessed via the Attributes > Loading or Attributes > Loading 

> Structural menu items depending upon the type of user interface in use. 

Structural load types available are: 

 Concentrated Load 

 Body Force 

 Global Distributed Load 

 Face Load 

 Local Distributed Load 

 Temperature Load 

 Stress and Strain Loading 

 Internal Beam Point Load 

 Internal Beam Distributed Load 

 Initial Velocity Load 

 Initial Acceleration Load 

In the following headings the Solver name for the loading is showed in parentheses. 

Concentrated Load (CL) 

A Concentrated Load defines concentrated 

force and moment loads in global (or 

transformed) directions.  

A Concentrated Load is applied per node of 

the underlying feature onto which the load 

attribute is assigned. A Concentrated Load is 

therefore normally only used to assign a 

load to a point as the total applied load 

would otherwise be dependent on the mesh 

density of each feature assigned to. 

Concentrated loads are defined relative to 

the nodal coordinate system. If the required 

loading directions of a global load do not lie in the global axes then a local coordinate may 

be assigned to the feature to transform the loads to local coordinate directions. 

Concentrated loads can be applied in cylindrical coordinates for Fourier elements by setting 

the option on the Attributes tab of the Model Properties dialog. 
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Body Force (CBF) 

A Body Force defines an acceleration or 

force per unit volume loading in global 

directions. A typical example of body force 

loading is self weight, which requires the 

specification of gravitational acceleration 

and mass density (in the material 

properties).  

By default, Body Forces define 

accelerations, but an option on the 

Attributes tab of the Model Properties dialog, can be set so that Body Forces define a force 

per unit volume.  

Note that gravity loading can be defined either by directly specifying a constant body force 

load or by defining its existence as a property of a structural loadcase. 

Global Distributed Load (CL) 

Defines concentrated force or moment loads in global (or transformed nodal) axis directions. 

Concentrated force loads are applied to all nodes underlying the feature onto which the load 

attribute is assigned. Nodal freedoms can be transformed using local coordinate sets. The 

following sub-types are supported: 

 Total applies nodal load values calculated according to contributions from 

surrounding elements and to element nodal weighting values, e.g. loads are weighted 

with ratios 1:4:1 at nodes along the edge of a quadratic shell in such a way as to make 

the shell strain equally. 

 Line (per unit length) applies nodal loads using the specified values per unit length 

loads. Must be assigned to Lines. 

 Surface (per unit area) applies nodal loads using the specified values per unit area 

loads. Must be assigned to Surfaces. 
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Face Load (FLD) 

Defines face traction values and normal 

loading applied in local element face 

directions. Face loads are applied to the 

edges of plane elements or the faces of solid 

elements. This type of loading is applicable 

to 2D and 3D continuum elements, and 

certain shell, membrane and thermal 

elements.  

In the example shown, a local y direction 

structural face load is assigned to the 

Surface boundary Lines. Note the direction 

of the axes of the local element faces.  

Where a loaded Line or Surface feature is common to two or more higher order features, it is 

possible to specify to which higher order feature elements the load is assigned.  

See the Element Reference Manual for details of element face directions. 

Local Distributed Load (UDL)  

Defines a load per unit length or area for line or surface elements in the local element 

directions. Typically, local distributed loading is applied to beam elements and shell faces. 

An example of a local distributed load is internal pressure loading. For beam elements, when 

the element type permits, uniformly Distributed Load will be written to the LUSAS data file 

as Beam Element Loading (ELDS). 

Temperature Load (TEMP, TMPE) 

Nodal and Element temperatures define the LUSAS Solver TEMP and TMPE load types 

respectively. These loads apply temperature differences on a nodal and element basis. 

Temperature gradients in X, Y and Z directions may also be input. This load type can be used 

in conjunction with temperature dependent material properties to activate a different set of 

properties at a specified point in the analysis. The thermal expansion coefficient is normally 

set to zero in this case.  

Notes 

 Nodal temperatures apply to all elements connected to that node, except joints, in 

which temperature loading is invoked using Option 119. 

 Elemental temperature is only applied to the node of the element specified. 

 For step by step problems, the (initial) temperature values need only be specified on 

the first load step. 
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 The Temperature load may be used to provide a temperature field for computing 

initial material properties in a nonlinear analysis. To initialise the temperature field in 

a nonlinear field analysis, the temperature loading must be applied using a manual 

loading increment. 

Case Study. Temperature Gradient 

Through Slab Thickness 

Nodal and element temperature values accept 

gradient values for some element types. This 

gradient applies a differential thermal load across 

the top and bottom surfaces of a Surface element. 

The effect of this gradient is to cause bending in 

the structure. See the Element Reference Manual 

for temperature load input variations on an 

element basis. 

In this example (which assumes no slab 

eccentricity) a 0.5m thick concrete slab is at 20 degrees Celcius. The top surface is subjected 

to a temperature of 50 degrees Celsius and the bottom surface remains at 20 degrees Celsius. 

 To model this enter the following on the structural temperature loading dialog: 

 The final slab mid-surface temperature of (50+20)/2 should be entered in the Final 

temperature field 

 The temperature gradient through the slab of dT/dZ should be entered as (50-20)/0.5 

in the Final Z temperature gradient field 

 The initial slab mid-surface temperature of 20 is entered in the Initial temperature 

field 

When the analysis is run, LUSAS will multiply the temperature gradient by the thermal 

coefficient of expansion specified in the material property attribute to calculate the thermal 

bending strain.  

This method assumes a linear temperature distribution through the depth of the slab. If a 

known nonlinear variation is required, solid elements must be used with a variation defining 

the nonlinear through-thickness behaviour. 

Stress and Strain Load (SSI, SSR) 

The input values that are required in order to define stress and strain loading for particular 

elements can be seen by selecting the either the element description or by entering the 

element name in the Stress and Strain loading dialog.  

 Initial defines an element initial stress/strain state in local directions. Initial stresses 

and strains are applied as the first loadcase and subsequently included into the 

incremental solution scheme for nonlinear problems. Initial stresses and strains are 

only applicable to numerically integrated elements. 
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 Residual defines element residual stress levels in local directions. This can only be 

done for elements with a nonlinear capability. Residual stresses (unlike initial stresses) 

are assumed to be in equilibrium with the undeformed geometry and are not treated as 

a loadcase as such. They are considered as a starting position for stress for a nonlinear 

analysis. Failure to ensure that the residual stresses are in equilibrium will result in an 

incorrect solution. There is no concept of residual strains and therefore when the 

residual button is chosen a reduced number of components are presented. 

Refer to the individual element descriptions in the Element Reference Manual for full details 

of the initial stress and strain, and residual stress components. 

LUSAS Modeller will automatically write an appropriate initial stress and strain, or residual 

stress type to the datafile when a solve is requested. See the Solver Manual for more detailed 

information regarding the tabulation of initial stresses and strains, and residual stresses in 

LUSAS datafiles. 

Internal Beam Point Load (ELDS) 

The Internal Beam Point load is a point load 

applied to lines in the local or global direction. 

The distance to the point load from the start of 

the line may be defined as either a parametric 

distance (0 to 1 with respect to the line length) or 

an actual distance. Force and/or Moment 

components are defined for each point location. 

Several point loads may be defined in one load 

attribute if required. 

See the Element Reference Manual - Appendix A for examples of internal beam loading 

(ELDS) types. Refer to each element's main listing to see if an element supports this loading 

type. 

Internal Beam Distributed Load (ELDS)  

The Internal Beam Distributed load is a 

distributed load that can be applied to lines in a 

model in a local, global or projected direction. 

The distance from the start of the line to the 

start of the distributed loading, and the distance 

from the start of the line to the end of the 

distributed loading are defined along with the load component and the start and end load 

values. For local and global loading the start and end distance may be defined as either an 

actual distance or a parametric (0 to 1) distance - both measured along the line. For projected 

loading only an actual distance measured along a global axis is permissible. Several 

distributed loads may be defined in one load attribute if required. As an example, trapezoidal 

loading would be defined as 3 separate load sets with a load varying from zero to a load value 

over an initial stated distance, then remaining at the same load level up until a second stated 

distance, and then varying from the same load value back to zero over from that point to a 
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distance equal to the length of the line.  

Note that for projected loading on a line not sitting in a primary plane the start and end points 

of each load set are based upon projecting the line back into either an XY, YZ, or ZX plane 

(depending upon the load component selected) with the start of the internal loading pattern 

being measured from the start of the line along the shortened plane length of line and not 

along the actual line length itself. 

See the Element Reference Manual - Appendix A for examples of internal beam loading 

(ELDS) types. Refer to each element's main listing to see if an element supports this loading 

type. 

Initial Velocity / Initial Acceleration Load (VELO/ACCE) 

In dynamic analyses, velocities or accelerations at a nodal variable can be defined. These 

values can be used to specify an initial starting condition or they may be prescribed for the 

whole analysis. If values are to be prescribed throughout the analysis load curves must be 

used and the appropriate freedoms must be restrained. 

Prescribed Structural Loads 

Structural loading is feature based and hence it is assigned to the model geometry (or to mesh 

objects in a mesh-only model). Variations in loading on a feature can be specified using a 

Variation. For information on which load types can be applied to which element types, see 

the Element Reference Manual. 

Prescribed Structural loading is accessed via the Attributes > Loading or Attributes 

> Loading > Structural or menu items depending upon the type of user interface in use. 

Prescribed Structural load types available are: 

 Displacement 

 Velocity 

 Acceleration 

Prescribed Displacement Loading 

A prescribed Displacement defines a nodal 

movement by either a Total or Incremental 

prescribed distance in global (or 

transformed) axis directions. Freedoms 

which are assigned a non-zero prescribed 

value will be restrained.  

The adjacent example shows two methods of 

applying prescribed displacement. 

Incremental loading adds displacements to a 

previous increment, whereas Total requires 

the full displacement to be specified on each increment.  
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Notes 

 For linear analyses with multiple loadcases an automatic restraint is only assigned if 

the prescribed displacement is applied in the first loadcase. If a prescribed 

displacement is not assigned in the first loadcase but is assigned in subsequent 

loadcases a restraint must be assigned manually. 

 Prescribed displacements can be assigned and turned-off on a loadcase basis. 

 Total and incremental prescribed displacements should not be used in the same 

analysis. 

 It is recommended that total prescribed displacements are used with load curves. 

 Prescribed rotations should be specified in radians. 

 The assignment of a prescribed displacement of zero to a freedom of a node (in order 

to return it to an original undeformed position) causes a 'hidden' support to be created 

that remains active in all following loadcases, until it is superceded either by another 

prescribed displacement load, or by another support assigned to a following loadcase. 

A Prescribed Loading entry within an analysis loadcase in the Attributes  Treeview 

effectively represents a support condition. 

Prescribed Velocity and Acceleration Loading 

In dynamic analyses, prescribed velocities and accelerations may be defined for any nodal 

variable. These values can be used to specify an initial starting condition or prescribed for the 

whole analysis.  

 A prescribed, or initial Velocity defines a velocity loading in global (or transformed) 

directions. 

 A prescribed, or initial Acceleration defines an acceleration loading in global (or 

transformed) directions. If acceleration loads are required, the density must be 

specified in the material properties. Initial accelerations are only valid for implicit 

dynamic analyses. 

Notes 

 If the values are to be prescribed throughout the analysis load curves must be used, 

see Load Curve Definition. 

 Initial velocities and accelerations should only be applied to the first loadcase. 

 In general, load curves should be used to prescribe velocities and accelerations in an 

analysis. However, initial values may be defined without using load curves if no other 

load type is controlled by a load curve. 

 If velocities and accelerations are prescribed for the same variable at the same point in 

time in an analysis, the acceleration will overwrite the velocity and a warning will be 
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output. An exception to this rule occurs for implicit dynamic analyses where an initial 

velocity and acceleration may be used to define an initial condition for the same 

variable. 

 If initial conditions are to be applied, refer to Transient Dynamic Analysis for details 

on how to compute the data input required for the appropriate integration scheme. 

Discrete Structural Loads 

Discrete structural loads are used to distribute a given loading pattern (such as for a type of 

vehicle) over full or partial areas of the model, independent of the model geometry. Discrete 

structural loads are defined in relation to their own local coordinate system, the origin of 

which is given by the coordinates of the Point feature to which the load is assigned. Note that 

discrete loads are always assigned to Points. Discrete structural loads differ from feature-

based loads in that they are not limited to application over whole features. Discrete structural 

loads may be projected over an area, onto Lines or into Volumes. Separate discrete loads may 

be applied to a model as a set or load train using the Compound load option. Search areas can 

be used to control load assignment. 

To identify critical vehicle loading patterns on bridges (using discrete point and patch loads) 

vehicle load optimisation is available for selected software products only. See Application 

Manual (Bridge, Civil & Structural) for details.  

Discrete loads are useful for applying a load 

that does not correspond to the features 

underlying the mesh. A patch load may be 

spread or skewed across several features. 

LUSAS automatically calculates the nodal 

distribution of forces that is equivalent to the 

total patch load. This example shows a 

typical set of point loads assigned to a 

grillage model. A single point, a group of 6 

and a group of 16 point loads are shown. 

The coordinates of the vertices defining the patch are relative to the Point to which the patch 

load is assigned, i.e. a load definition is defined in a local coordinate system, the origin of 

which is given by the coordinates of the Point to which the load is assigned. The Point does 

not have to lie on the Surface to which the load will be applied as the patch load is projected 

in a specified direction.  

Using Search Areas with Discrete Loads 

A discrete load is distributed onto the elements over which the load lies. A Search Area is a 

way of controlling the load distribution onto these elements. If no search area is specified 

when assigning the load, then all of the underlying elements will be eligible for load 

distribution. 



Modeller Reference Manual   

    

248 

Notes 

 While projecting the loads into the search area a check is made for multiple 

intersections of the load and the search area. Multiple intersections indicate an 

ambiguity in the location of the load. This ambiguity may be resolved with a more 

specific search area.  

 The distribution of load to the nodes follows the shape functions of the particular 

element. In quadratic elements, this distribution can appear at first unlikely. For 

example, a unit positive load at the centre of an 8-noded quadratic element, results in 

negative 0.25 loads at the corners and positive 0.5 loads at the mid-side nodes. 

 Search areas are automatically created and used by the prestress wizards to define 

the target to be loaded. 

LUSAS generated discrete structural loads 

Examples of discrete structural loads that are created automatically by LUSAS include patch 

and point loadings created by vehicle load optimisation software to represent vehicle and 

lane loading, and equivalent nodal loading defined as a result of using a prestress wizard. 

Discrete loads generated by LUSAS for these applications cannot be deleted or edited of 

them.  

Discrete Structural Load Types 

A discrete load consists of coordinates defining the local x, y and z position and a load 

intensity. Any Points selected prior to the Discrete loading dialog being displayed are entered 

as coordinates into the grid and are ordered to an expected point order where possible. 

Discrete load types available are: 

 Point load 

 Patch load  

 Compound load. 

 

Point Load  

Point loads provide concentrated loading at specified locations. Point loads can be defined 

singly or as a set of discrete point loads in 3D space. Each individual load can have a separate 

load value. Point loads can be defined via Arbitrary input or by specifying a Grid input. 

This example uses 16 distinct load values. The loads are applied to the model as distinct 

loads. 
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Patch Load  

Patch loads provide a loading per unit length or per unit area. Loads can be defined in global 

or local untransformed load directions. Loading types are: 

 8 node patch - used to define a curved sided quadrilateral 

 4 node patch- used to define a straight sided quadrilateral 

 Multi-node patch - used to define a series of straight sided patches of any number of 

points.   

 Straight line - requires 2 specified coordinates to define a straight line load 

 Curve - requires 3 specified coordinates to define a curved line load 

The following examples show patch loads assigned to Point 1. Once assigned, the load origin 

is located at Point 1. The discrete load point order (P1, P2 etc) shows the order in which the 

coordinate definitions should be made. 

Example 1.  

A straight line load defined using 2 coordinates. 
   

Example 2.  

A curved line load is defined using 3 coordinates. 
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Example 3.  

A straight sided quadrilateral defined using 4 
coordinates.  

  
Example 4.  

A curved sided quadrilateral defined using 8 
coordinates.  

  

 

  

 

Example 5.  

Multi node patch loading.  

  

 

Notes 

 The mid-side nodes for a curved line load and for a curved sided quadrilateral load 

must lie with +/- 10% of the overall distance between the corner nodes. 

 Multi node patch loading is always straight sided. A minimum of 4 coordinate points 

and an even number of coordinate points overall must be defined. 

Compound load  

Compound loads may be created to simplify the definition and assignment of more complex 

load patterns. A compound load can be formed from a set of previously defined discrete loads 

and be subsequently assigned to a model as one loading. A compound load may be defined 

from any combination of existing point, patch and compound discrete loads. For example a 

discrete patch load representing a vehicle may be included in a compound load twice with the 
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distance between the vehicles specified. x, y, z offsets and a translation can be specified to 

locate the compound loading from away from an assigned point. When created, compound 

discrete loads are held in the Loading section of the Attributes Treeview in their own section 

named Compound. 

  

 

  

Defining Discrete Point and Patch Loads 

 Arbitrary permits the definition of any number of Point loads. If the points are 

defined in an expected grid order (see Grid entry), then the loading components can be 

optionally projected along the columns and rows of the patch load grid into a search 

area (if used), otherwise the loading is applied to the nearest load location in the search 

area. 

 Grid adds the correct number of rows to the point load definition grid for the number 

of x and y values defined and expects the coordinate points to be defined in a 

particular order so that any loads that may overhang a search area (if used), can be 

optionally projected to be included into the search area. For a grid of points of x=3, 

y=2 the expected order of coordinate input is x1,y1, x2, y1, x3, y1, x1, y2, x2, y2, x3, 

y2. 

Coordinates and magnitude 

 For a point load each attribute defines multiple loads, one concentrated load at each 

given vertex. 

 For patch loads the vertices combine to specify the shape of a line or patch load. The 

load is specified at each vertex allowing the load intensity to be varied. Patch types 

include 8 node, 4 node, multi node, straight line and curve. 



Modeller Reference Manual   

    

252 

Load direction 

  Load Direction (an 

untransformed load 

direction) defines the 

direction of the loads in the 

patch before any 

transformation is carried out 

at the assignment stage. 

Options are: X, Y, Z, XYZ, 

Patch x, Patch y, or 

Surface normal. The Patch 

x and Patch y load 

directions apply a patch 

load in the local x or local y 

direction of the patch (and 

not the local coordinates of 

the assignment object.) 

Patch y is not available for the line patch type. 

 

In the example shown, untransformed global loads are projected onto a model normal 

to the patch definition. The projection vector is denoted by a double-headed arrow on a 

visualised patch. The direction of the load applied to the model is defined using the 

untransformed load direction. 

Use of a Patch x load direction in conjunction with any of the patch types would, for 

example, permit modelling of train or vehicle braking effects on straight or curved 

paths.  

Projection Vector 

 Projection Vector is used to work out which 

features are actually loaded. The vector is 

followed (in both directions) and any features 

intersected by the assigned discrete load vertices 

projected in the direction of the projection vector 

are loaded in the direction specified by the 

untransformed load direction. For patch loads 

defined by 4 or 8 vertices the projection vector is 

always perpendicular to the patch. 

 

This example shows a typical 3D patch load where 

the patch is defined in space and projected onto 

the model. 
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Patch load divisions 

 Patch load divisions specifies the 

numbers of divisions in the local x and y 

directions of the patch being assigned. 

The divisions are used to split the applied 

patch into individual component loads 

before they are in turn used to calculate 

equivalent nodal loads on the model. By 

default, the patch load division are based 

upon the values set in the  Patch 

divisions object which is created when a 

discrete loading is added to the Attributes 

Treeview. Again by default,10 patch load 

divisions are used in the local x direction 

and the aspect ratio of the patch is used to calculate the divisions in the y direction. 

When creating a patch ideally at least one division should be used per element 

division. The more individual loads a patch is split into, the more accurate the solution 

obtained. Patch load divisions can also be explicity defined on the main patch loading 

dialog as a number in x and a number in y. In this case if X=0 and Y=10 is entered the 

number in the x direction will be calculated proportionally to the patch shape. 

Equivalent weighting values are used to calculate the portion of each discrete load that 

is applied to each corner of the element that it lies within. The load is then applied as 

Concentrated Loads. These weighting values are based on element shape functions and 

may vary with element type. 

 

Assigning Discrete Loads 

Discrete loads are independent of features therefore their application can be more flexible. 

The load assignment parameters are explained below: 
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 Patch Transformation Discrete load 

patches can be mirrored, rotated, scaled 

and generally translated from their initial 

defined orientation during their 

assignment to a feature on a model. For 

example, a patch load may be skewed by 

applying a rotation transformation when 

assigning the load.  

 

In the example shown right the Point load 

defined about local xy axes is assigned to 

Point 1 subject to a patch direction 

transformation using a 30 degree xy 

rotation about the global origin. Note that 

the local origin of the patch load is rotated 

and repositioned as well as the patch itself.  

 

To rotate a patch about its centre, define the patch with its local origin at its centre. 

Note that static vehicle loadings (as supplied in the vehicle libraries) are generally 

defined with a loading origin at their centre.  

 Load transformation Changes the load orientation from the (untransformed) 

direction given in the load definition. The transformation applies to the direction of the 

individual load components rather that to the patch as a whole. For example, it can be 

used to model braking loads on a 3D model that have horizontal and vertical 

components by specifying a transformation that will rotate the loads out of the vertical 

direction and into an inclined plane in the direction of vehicle travel. 

 Search area A search area restricts loading to a specified portion of the model. If a 

search area is not specified, the load is projected onto the whole model. For 2D models 

it is usually acceptable to default to the whole model, but for 3D models where 

multiple intersections of the load projection onto the model may occur it is safer to 

restrict the loading to the required face using a search area. In either case the time 

taken to assemble the loads is significantly improved by using a search area to restrict 

the number of elements tested for intersection with the load. Search areas are 

automatically created and used by the prestress wizards to define the target to be 

loaded. 

In addition, the discrete load can be specified to: 

 Project onto line This option is used to project discrete loads onto 2D line beam 

structures and frame models. Discrete loading is applied to the beam as corresponding 

forces and moments along the beam. 

 Project over area This option is used to project discrete loads over an area. The area 

may be defined by a grid of beam elements (a grillage), a plate or shell structure 

(slabs), or the face of a solid model. 

 Project into volumes This option is used to project discrete loads into volumes (solid 

models) and is primarily for use with tendon loading. 
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Loads that extend beyond a search area can be included or excluded using: 

 Options for loads outside search area Loads that fall outside the search area can be 

moved into the search area or be excluded entirely using a variety of options. See 

 Processing Loads Outside Search Area. 

The analysis in which the loading applies must be stated and general loadcase information 

that can be entered includes: 

 Loadcase specifies in which loadcase the loading is to be applied. Loadcases can 

themselves be manipulated. See Loadcase Management for more details. 

 Load factor specifies a factor by which the loading is multiplied before the equivalent 

nodal loads are calculated. 

Editing of Discrete Loading Data 

Editing of pre-defined discrete loading data (such as that used for supplied vehicle loads) 

allows users to view both the original vehicle definition input data, as well as the actual 

loading applied (the vehicle load converted into a discrete load format), for any and all 

vehicles within LUSAS. Editing of user-defined discrete loading data only permits viewing 

and editing of the discrete loading data. 

So, for the case of creating a vehicle load from a pre-defined vehicle, the resulting attribute in 

the Attributes Treeview has context menu entries named Edit Definition... and Edit 

Attribute... These menus can be seen by right clicking on the attribute.  

 Selecting the Edit Definition... menu entry or double clicking the attribute displays 

the original definition dialog with all the original input data intact. The user can 

change these inputs that may be either loading parameters such as width, length and 

intensity etc or even the type of vehicle, at any time. For each modification, the name 

of the attribute and the equivalent discrete load values are modified. Although the 

name of the attribute is altered, the attribute itself is merely modified and so the 

assignment links between the bridge structure and the load will not be lost.  

 Selecting the Edit Attribute...menu entry displays the equivalent discrete loads. 

These values may be changed but this breaks the link to the original definition dialog 

and a warning message will be displayed. 

Editing of automatically generated discrete loading data (such as that created by the use of the 

prestress wizards ) is not permitted.  

Editing patch load divisions  

 When the first discrete load type is added to the Attributes Treeview, a  Patch 

divisions object is also created. Double-clicking on this object displays a dialog which 

allows the type and default number of patch divisions used on discrete patch loading 

to be edited. 
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Case Study. Hydrostatic Loading 

In this example, a discrete patch load will be used to apply a hydrostatic load to the side-wall of an 

underground box culvert. 

1. The box culvert wall is defined using a Surface in the global XZ plane with corners at 

coordinates (0,0,0), (5,0,0), (5,0,3) and (0,0,3). Define a Surface using the New Surface button 

at the specified corner positions. 

2. Rotate the view using the Dynamic Rotate button until the Surface can be visualised in 

3D. 

3. Using Attributes> Mesh> Surface, define a mesh using Thick Shell, Quadrilateral, Linear 

elements. Specify the spacing as 15 divisions in the local x and 9 divisions in the local y 

directions. Since only one Surface is present in the model, the divisions for the mesh can be 

entered directly onto the Surface mesh dialog. 

4. With the cursor in normal mode, assign the mesh to the Surface by dragging the attribute 

from the  Treeview onto the selected Surface.  

5. To define a patch load that is coincident with the side-wall Surface, first select the four Points 

defining the Surface in the order they were defined. Choose the Attributes> Loading menu 

item and pick the Discrete Patch option. Note that LUSAS has selected a 4 node patch and 

filled the Point coordinates into the dialog.  

6. The load direction coincides with the global Y axis direction so select Y from the 

Untransformed Load Direction. Specify patch corner load intensity values of -3, -3, -1, -1 

respectively. 

7. The patch definition uses a coordinate system that is coincident to the global Cartesian axis 

system, so the load can be assigned to the Point at the origin (Point 1). Assign the load to Point 

1 (0,0,0) leaving all dialog entries as default and press OK to assign the load. Note that the 

patch is drawn as discrete point loads. This is because the patch load is automatically split into 

point loads. 

8. The number of discrete loads in each direction is dependent on the numbers of divisions entered 

in the Assign Loading dialog. In this case, the default number of divisions (10) is insufficient as 

there are insufficient loads to apply at least one load per element along the culvert. To improve 

the load application accuracy, deassign the load from the Point, and reassign using 15 divisions 

in the local X direction. Leave the Y divisions field blank. Note that LUSAS has automatically 

used the aspect ratio of the patch load to calculate a suitable number of divisions in local Y. 
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 Hydrostatic Patch Load 

Default number of divisions showing insufficient 
discrete point loads. 

 

Hydrostatic Patch Load 

Increased number of divisions on assignment. The 
double arrow vector indicating patch orientation. 

 

Thermal Loading 

Thermal loading is feature based and hence it is assigned to the model geometry (or to mesh 

objects in a mesh-only model). Variations in loading on a feature can be specified using a 

Variation. For information on which load types can be applied to which element types, see 

the Element Reference Manual. 

Structural loading is accessed via the Attributes > Loading or Attributes > Loading 

> Structural or menu items depending upon the type of user interface in use. 

Thermal load types available are: 

 Flux 

 Distributed Flux 

 Internal Heat generation 

 Prescribed Temperature 

 Environmental Temperature 

 Internal Heat User 

Flux 

 A Flux loading produces the LUSAS CL load type which in a field analysis applies a 

rate of internal heat generation (Q). Positive Q defines heat input. 

 A total flux, a flux per unit length or a flux per unit area can be specified. 

 Flux is defined relative to the nodal coordinate system. If the required loading 

directions of a global load do not lie in the global axes then a local coordinate may be 

assigned to the feature to transform the loads to local coordinate directions. 
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Distributed Flux  

 A Distributed Flux loading produces the LUSAS FLD load type which in a field 

analysis applies a rate of flux. 

Internal Heat Generation  

Defines the internal heat generation for an element. Positive loading values indicate heat 

generation and negative values indicate heat loss. 

 The temperature dependent internal heat loading (RIHG) defines the rate of internal 

heat generation. This load attribute requires a reference temperature for each set of 

properties. 

 Defining temperature dependent properties turns a linear thermal field problem into a 

nonlinear thermal problem. 

Notes 

 Load curves can be used to maintain or increment the RIHG as a nonlinear analysis 

progresses. 

 Automatic load incrementation under Nonlinear Control cannot be used with RIHG 

loading. 

Prescribed Temperature 

Defines a prescribed temperature for an element. 

 The Incremental prescribed load type adds to any temperatures present from a 

previous increment. 

 The Total prescribed load type defines the total temperature at a given node at a 

specified increment. 

Environmental Temperature 

Models external fluid temperature and associated convection and radiation heat transfer 

coefficients. If an element face does not have an environmental temperature assigned it is 

assumed to be perfectly insulated. 

 The temperature dependent environmental temperature loading (TDET) models 

properties that vary with nodal temperature. This load attribute requires a reference 

temperature for each set of properties. 

 Defining temperature dependent properties will turn a linear thermal field problem into 

a nonlinear thermal problem. 
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Notes 

 The ‘environmental temperature’ is the temperature of the surrounding fluid to which 

the object is losing heat to (or gaining heat from). 

 The ‘convection heat transfer coefficient’ is in units of ‘power per unit area per unit 

temperature’ (e.g. J.s-
1
.m

-2
.K

-1
). 

 The ‘radiation heat transfer coefficient’ is in units of ‘power per unit area per unit 

temperature to the power four’ (e.g. J.s-
1
.m

-2
.K

-4
) and is determined by multiplying the 

emissivity of the material by the Stefan-Boltzmann constant. 

 The ‘reference temperature’ is only required if more than one row of data is being 

entered for temperature-dependent properties. For example different convective and 

radiative coefficients could be specified at 0, 50 and 100°C. Linear interpolation will 

be used. If only one reference temperature is entered the others properties will be 

constant for all temperatures. 

 If heat transfer coefficients vary on a specified face the values will be interpolated 

using the shape functions to the Gauss points. 

 If a non-zero radiation heat transfer coefficient is specified, the problem is nonlinear 

and Nonlinear Control must be used. 

 Load curves can be used to maintain or increment the environmental temperature as a 

nonlinear analysis progresses.  

 Automatic load incrementation within the Nonlinear Control can be used to 

increment ENVT loading. 

Internal Heat User   

Allows user-defined input of internal heat generation for an element for use with user-written 

software programs. Values can be entered in multi-column format. Positive loading values 

indicate heat generation and negative values indicate heat loss. 

 

Case Study. Temperature Dependent Loading 

Temperature dependent environmental loading can be useful to model experimentally 

determined correlation for convective coefficients. For example, if the convective coefficient 

may be given by C [deltat] to the power one third where C is a constant, deltat is the 

temperature difference between the surface and the environment. To specify this loading in 

LUSAS you would define the convective coefficient at as many reference points as are 

required to give a good piece-wise linear approximation of the function. Each reference 

temperature point is defined in a loading attribute and collectively these attributes define a 

single loading table. The loading table is then assigned to the features as required. 
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1. Define a row of Surface features. 

2. Use an incremental prescribed loading to fix the temperatures at one end of the model. 

3. Define a convective coefficient function using environmental loading (temperature 

dependent). 

4. Assign the loading and solve. 

5. Since the problem is one-dimensional the solution may be checked to ensure that the 

convection coefficient has been correctly interpolated. 

  

Search Areas 

Search areas may be used to restrict the area of application of discrete loads (point and 

patch). This is useful for several reasons: 

 Improved Control of Load Application. The search area will effectively limit the 

area over which the load is applied so that the effect of loads on certain features may 

be removed from the analysis. For 3D models it is possible that a chosen projected 

direction will cross a model in several locations. A search area is therefore used to 

limit the application of load to one of these multiple intersections. Restricting the area 

of application of discrete loads allows the same load attributes to be used to apply 

loads to different parts of the model. 

 Speed Improvement the speed of calculation of equivalent nodal loads will be 

increased by cutting down the number of features considered in the calculation. 

Search areas are automatically created and used by the prestress wizards to define the target 

to be loaded. 

In the example shown, a multiple span grillage 

structure is defined with Span 1 as the search 

area. A discrete Patch load, indicated by the 

grey shaded region in the upper diagram, is 

applied across the whole structure, Span 1 and 

2. The area of the structure coinciding with 

both the Search Area and the patch load will 

take the load as shown in the lower diagram. 

Tip. Search areas should be used if the model is 

three dimensional and discrete loads are 

applied, as, for example, for box-section or 

cellular construction decks. 
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Defining and Assigning Search Areas 

Search areas are defined from the Attributes menu then assigned to the required Lines or 

Surfaces. Control of loads lying outside the search area is available when the load is 

assigned, see Assigning Discrete Loads. If a search area is not specified when the load is 

assigned, all of the highest order features, excluding volumes, in the model will be used as a 

default search area. Valid search area configurations are shown below. 

Note: The default maximum number of elements that can be used with search areas per 

grillage bay (each four-sided framing of a section of slab) is 30. In the unlikely event that a 

higher number is required this can be changed by setting a user-defined option in Modeller. 

Contact LUSAS technical support if you wish to do this. 

Rules for Creating Search Areas for Grillages 

The following general guidelines should be noted when assigning a search area to a grillage 

model. 

  

Overhanging elements defined such that only one side of a cell is 

missing are included in the search area, as shown. 

In these cases LUSAS automatically 'closes' the cell. 

 

 
 

Elements cannot be included in the search area when they overhang 

from the same node, as shown. 

In this case, a dummy Line can be added manually between the 2 

overhanging points to close the bay to make the search area valid. 

When closing the bay in this way note that a single null-line mesh 

should be used having one mesh division.  
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Cells of more than four edges are automatically subdivided into 

triangles, but overhanging elements are only included if divided by 

no more than one edge.  

In this case, a dummy Line can be added manually between the 2 

overhanging points to close the bay to make the search area valid. 

When closing the bay in this way note that a single null-line mesh 

should be used having one mesh division. 

For the invalid region shown, a dummy Line can be added manually 

between the 2 overhanging points to close the bay and make the 

search area valid. When closing the bay in this way note that a 

single null-line element, having one mesh division should be 

assigned. If done, the resulting cell of five edges will be subdivided 

into 4 triangles. 

 

 
 

There is no limit to the number of edges that may hang over the 

main body if the overhanging members are only separated by one 

edge (right). 

In these cases LUSAS automatically 'closes' the cell and either sub-

divides the resulting cells into triangles or uses a quadrilateral as 

appropriate. 

 

Processing Loads Outside a Search Area 

For point and patch loads any load outside a search area can either be excluded from the 

search area, or be projected to be included into the search area.  

Discrete loads on lines 

When discrete loads of patch or point loading are assigned onto Lines with an assigned 

Search Area the individual load components are projected onto the line, normal to the local x 

axis of the Line, and their effective loading is calculated and applied to the line as forces and 

moments along the line.   

Options available when assigning onto Lines are:  

 Exclude All Load beyond the end of the Line (default)patch load components 

beyond the end of line will be disregarded and all load components within the search 

area will be applied to the line with an appropriate force and moment to represent the 

positions of the loads. 
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 Include Full Load all load components within the search area will be applied to 

theline with an appropriate force and moment to represent the positions of the loads. 

Patch load components beyond the end of line will be applied to the point at the end of 

the line with an appropriate force and moment to represent the actual position of the 

loads. 

Note that when a search area is assigned to a line the search area extends for the length of the 

line and for an infinite distance perpendicular to the line direction. See the diagram that 

follows or details. 

  

 

Patch Load onto Line 

Patch loads not lying on a line but within an 
assigned search area will be applied to the 
line as effective forces and moments. Loads 
outside the search area can be either 
included or excluded. If included, the applied 
moments will be computed by using the actual 
location of the defined loads 

Discrete loads over areas 

When discrete patch loads are assigned over an area the projection path(s) is/are defined by 

the local x and y axes of the loading patch. Each patch load component is 'moved' along a 

specified local x or y direction and added to the first loading positions found inside the patch 

in that projected direction. See the diagram that follows which illustrate the various options. 

Options available when assigning onto areas are:  

 Exclude All Load (default) 

 Include Local X Projected Load 

 Include Local Y Projected Load 

 Include Local X and Y Projected Loads 

 Include Non-Projected Load 
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 Include Full Local X Load 

 Include Full Local Y Load 

 Include Full Load 

Notes 

 Loads will not be moved to the edge of the search area if the entire patch load lies 

outside the search area.  

 Loads inside the search area are not moved. 

 Discrete patch loads assigned over areas are not work equivalent as the discrete points 

are simply lumped at the nearest node. 

 Patch loads outside the search area are lumped onto the nearest edge of the search 

area. 

Patch Load Divisions 

The number of patch load divisions in local x (div x) 
and y (div y) are specified at load assignment. The 
load intensity is then split into individual load 
components with an associated area of application. 

   
Patch Load Local Coordinates 

The local coordinate set is dependent on the order 
in which the coordinates of the patch vertices are 
defined. 
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Local X Projected Load 

Loads in the local y projected region (dark area) are 
lumped at nearest loading positions within the search 
area (light area). 

  
Local Y Projected Load 

Loads in the local y projected region (dark area) 
are lumped at nearest loading positions within the 
search area (light area). 

 

  

 

Local X and Y Projected Loads 

Loads in the local x and y projected regions (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 

  
Non-Projected Load 

Loads not in the local x and y projected regions 
(dark area) are lumped at nearest loading 
positions within the search area (light area). 
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Full Local X Load 

Loads in the full local x region of the patch (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 

  
Full Local Y Load 

Loads in the full local y region of the patch (dark 
area) are lumped at nearest loading positions 
within the search area (light area). 

 

  

 

Full Load 

All patch loads lying outside the search area (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 

    

 

  
  

Discrete point loads over areas 

When discrete point loads are defined by specifying a Grid of points they can either be 

excluded from the search area, or be projected to be included into the search area in exactly 

the same way as for discrete patch loads. The expected coordinate input for a grid of points 

defined in this way for a grid of x=3, y=2 is x1,y1, x2, y1, x3, y1, x1, y2, x2, y2, x3, y2. If 

discrete point loads are defined by the Arbitrary option, and if the points are defined the 
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expected grid format, then the loading is applied as per the patch loading (that is, the loading 

components can be projected along the columns and rows of the patch load grid into the 

search area), otherwise the loading is applied to the nearest load location in the search area. 

Discrete point loads into volumes 

When discrete point loads are projected into volumes (by being assigned to a particular point 

on, or within the volume) the applied discrete loads are extrapolated within the elements to 

create equivalent concentrated nodal loads. When search areas are assigned to volumes the 

following options are available: 

 Exclude All Load (default) Patch load components outside the volume will be 

disregarded and all load components within the search area will be extrapolated within 

the elements to create equivalent concentrated nodal loads 

 Include Full Load Patch load components outside the search area will be applied to 

the nearest elements in the volume.  

Local Coordinates 

Local Coordinates define coordinate systems that differ from the default global Cartesian 

system. They have several uses: 

 Geometry Definition Geometry features may be defined in a local coordinate system 

by set the chosen local coordinate active. When a local coordinate is active, all dialog 

entries relating to global X, Y and Z coordinate input use the transformed axis set as a 

basis for input. 

 

 Transforming Nodal Freedoms When assigned to features the effect is to transform 

the degrees of freedom of the underlying element nodes. This has the effect of 

transforming the directions of applied global load and support conditions. In the 

example below, global freedoms are transformed to radial directions by assigning a 

cylindrical coordinate to the Lines around the hole. This method of transforming nodal 

freedoms is only valid for small deflections, since the freedom directions are not 

updated during analysis. 
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 Materials A local coordinate may be used to align orthotropic and anisotropic 

materials. 

 Variations Variations may be defined using functions in terms of a local coordinate. 

 Composites A local coordinate may be used to align composite attributes when they 

are assigned to the model. 

 Element Orientation A local coordinate may be used at the mesh assignment stage 

to orient beam and joint elements. 

 Results Transformation Results can be output relative to a local coordinate. For 

example, this is useful when looking at results on elements when the axes are not 

consistent. 

Defining Local Coordinates 

Local coordinates are defined from the Attributes> Local Coordinate menu item by 

specifying the local coordinate type and, for Cartesian, cylindrical and spherical types an 

origin and either a rotation about a global plane or a rotation matrix.  

 Rotation about a global plane specifying angular rotations about the global planes, 

XY, YZ or XZ. When defining coordinate systems using this method, the local x axis 

is oriented parallel to the global X axis and rotated into position using the specified 

angle in the specified plane. 

 Rotation matrix specifying a direction cosine matrix. A Rotation matrix may be 

defined from selected Points by first selecting 3 Points (1st Point defines the origin, 

2nd Point defines the positive direction of the local x axis, 3rd Point defines the local 

xy plane) and clicking the Use button. 

Notes 

 Defining a new coordinate set does not automatically make it the active set, see 

Visualising Local Coordinates below. 

 Local coordinate set types cannot be modified so, for example, a Cartesian set can not 

be changed to a cylindrical or spherical set. 

 Local cylindrical coordinates defined by matrix are always defined with the local z 

axis along the cylinder. 
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Local Coordinate Types 

Cartesian, cylindrical and spherical local coordinates are defined by indicating three positions 

in space defining a local xy plane (origin, x axis, xy plane). The type of coordinate chosen 

will dictate how the axes are defined. 

 Cartesian - Based on standard x, y and z coordinates arbitrarily oriented in space. 

 Cylindrical  - Based on the axes of a cylinder defined by a radius, angle and distance 

along the cylinder axis.  

 For a local cylindrical coordinate 

defined along the z axis a point is 

specified as (r, theta, z), where: 

r is the radius perpendicular to the 

local z axis 

theta is the angle in degrees measured 

from the positive x direction of the 

local xy plane, clockwise about the 

local z axis when looking in the 

positive z direction 

z is the distance along the z axis. 

 Spherical  Based on the axes of a sphere defined by a radius, tangential angle and 

angle around a meridian.  

Coordinates of a point are specified as (r, 

t, phi), where: 

r is the radius of the sphere on which 

the point lies from the local origin 

t is the angle in degrees measured from 

the positive x direction of the local xz 

plane, clockwise about the local z axis 

when looking in the positive z 

direction  

phi is the angle in degrees measured 

from the positive z axis to the radius line 

Warning. There is no equivalent spherical coordinate set in Solver, therefore freedoms 

cannot be transformed using this type of local coordinate system. 

 

 Surface local coordinate systems define a local axes which has the x and y axes in the 

plane of the surface and a local z axis normal to the surface. This is useful for 

extruding a volume normal to a surface and assigning supports normal to a surface. 

Surface local coordinates cannot be set active. 
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Visualising Local Coordinates 

The active local coordinate system is defined from the Model Properties Geometry tab or 

from the local coordinate attribute context menu using the Set Active menu item. A black dot 

is shown next to a local coordinate attribute to indicate it is active. 

By default the active coordinate is visualised on the graphics area, this can be switched off 

from the View properties. Click on the View Axes tab to change the view axes settings. 

Local coordinates assigned to features may be visualised in the same way that other attributes 

are visualised. 

Composites 

Composite attributes allow previously defined materials to be collected together to define a 

laminate or composite lay-up. Layup definition methods allow for properties to be defined 

manually for use on solid and shell models and optionally include additional specific values 

for draping over model surfaces. Layup data can also be imported from a FiberSIM XML file, 

also for draping over selected model surfaces. 

Composite Layup Methods  

The following methods are available as a result of selecting the Attributes > Composite 

menu item: 

 Solids and Shells 

 Draped Solids and Shells 

 FiberSIM Solids and Shells 

 Simulayt Solids and Shells 

Solids and Shells 

This method allows a manual definition of the composite lay-up where orientations and 

thicknesses for the plies can be specified by stacking layers of differing materials at various 

angles and thickness. The orientation angles can be applied with respect to the local element 

x-axis (in the x-y plane) or with respect to the x-axis of a predefined Cartesian set. The z-axis 

defines the direction of the lay-up with ply 1 located at the bottom of the stack. The lamina 

thickness specified depends upon the element types used. 

Notes 

 Only orthotropic plane stress (for semi-loof shell) or orthotropic solid (for thick shell) 

materials can be used for structural shell composite lay-ups. Structural solid 

composites models must use the orthotropic solid material model and thermal solid 

composites models must use the orthotropic solid field material model. Isotropic 

materials may be used within any composite lay-up. 
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 For shell elements an appropriate plane stress nonlinear material model may be used 

whilst for solid elements a 3D nonlinear continuum model may be used (see the 

Element Reference Manual). 

 The lay-up sequence is from bottom to top. In the case of a shell this will be in the 

direction of the Surface normal. In the case of a solid this will be in the direction of 

the local z. 

 In cases where surface normals need correcting good use can be made of the cycling 

facility, where feature local axes can be cycled relative to a reference feature to ensure 

a consistent set of composite material axes. 

 Composite attributes may not include materials that contain variations. 

Draped Solids and Shells 

This method makes use of the native draping functionality in LUSAS. A start point (which 

should lie inside or on the boundary of the surface to be draped) can be defined for each ply 

and the start direction is defined by the x-axis of a predefined Cartesian set. Prior to assigning 

a composite attribute of this type to a model a draping surface must be selected or specified. 

The orientations of fibres following the drape are computed by LUSAS and are tabulated with 

respect to the x-axis of the local element axes. As with the Solids and Shells option, it is 

essential that the z-axis of the volumes to which the composite is to be assigned are 

consistently oriented. See Draping below. 

FiberSIM Solids and Shells and Simulayt Solids and 

Shells 

Composite stack details can be read in from an external FiberSIM XMLfile or Simulayt 

LAYUP file. A default fibre volume fraction can be specified and by default it is assumed 

that all plies are of the same thickness but this can be modified. It is not necessary to select a 

draping surface or to define a start point when using this option.  

Notes 

 The coordinates of the ply data in the FiberSIM or Simulayt file must coincide with 

the coordinates of the drape surface. 

 Any XML file should only contain lay-up data relating to a single drape surface. For 

example, if a non-composite core is sandwiched between two composite skins then at 

least two XML files will be required. The volumes defining each skin must be 

selected in turn and the appropriate XML file assigned to it. 

 A draping grid can be extended by one grid row to ensure the edges of the component 

are fully enclosed. See Extending the draping grid. 
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Draping in General 

Composite attributes may be orientated on a 

solid or shell model by specifying a start point 

and a local coordinate defining the drape 

direction of each lamina   

Draping assumes the thickness remains constant 

and hence the volume fraction (the proportion of 

the volume in a lamina that is fibre with the 

remaining portion being the resin) is adjusted 

when the fabric is distorted. After assignment of 

a composite attribute that contains draping data 

to a model, the skew angle and fibre volume 

fraction may be contoured and the fibre orientations may be visualised. 

  

Notes 

  The native draping functionality in LUSAS is controlled by Draping 

options.accessed via the File > Model Properties menu item (Solution tab). FibreSIM 

and Simulayt draping options can be specified at the xml file import stage (accessed 

via the Attributes > Composite menu item). 

 The Volume xy axes control the local element axes which must lie in the plane of the 

composite lamina. The local element axes may be visualised from the Mesh properties 

dialog. 

 The local coordinate defining the drape direction must lie in the xy plane of the drape 

Surface at the start point. 

Defining Composite Layups 

Composite attributes require composite materials to be defined prior to defining composite 

layups. Composite attributes consist of a number of named layers where each layer contains 

specified material properties, and for certain element types, the angle of fibres and layer 

thickness. Composite layers can be defined using a Normal or a Grid method. Once 

composite attributes have been defined, they are assigned to the model on a feature basis. 

For Solids and Shells and Draped Solids and Shells composites definition the procedure 

described below can be used to define a layup. For FiberSim Draped Solids and Shells 

definition the composite stack will already have been created using a default material and 

volume fraction for all laminae. If required, for this case, the Normal and Grid Tabs can be 

used to modify details for selected laminae. 
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Procedure 

The procedure to define a composite layup using the Normal Tab is described, ending with 

details of how the Grid Tab can also be used to check or add layer data. 

1. Define the Layup 

Click on the New button to define a new layer. Enter a unique lamina name, select a 

composite material,and enter thickness and layup angle values. Note that a lay-up sequence is 

defined from bottom to top. The name may given a suitable prefix in the box provided. Click 

the OK button. 

2. Enter details for the next lamina. 

3. Repeat this process for each layer as required.  

If a symmetric layup sequence is to be defined check the Symmetric button. This duplicates 

and reverses the layup sequence previously entered. The Reverse button is used to upturn the 

defined stack so the uppermost layer becomes the bottom layer. The Insert button can be 

used to add layers between existing layers. 

4. Check the Layup sequence 

There are two ways to check the composite layup sequence: 

i) Select the Visualise button to display a representation of the defined composite 

layup. If desired this image can be annotated to the screen by clicking on the Create 

Annotation button from the visualise dialog. 

ii) Select the Grid tab to display the layer properties in grid format. Data may also be 

created or edited using this option. Pressing the Tab key with the cursor sitting in the 

last row and cell of the grid creates a new row populated with the same data as the 

previous row. A right mouse click in a row opens a context menu that allows rows to 

be inserted or deleted. 

Defining Lamina Thicknesses   

The definition of lamina thickness depends upon the element types and model type used. 

 The lamina thicknesses for shell models that have been assigned a geometric thickness 

are relative, not absolute, and represent the proportion of the total thickness (as 

specified by geometric surface properties) apportioned to each lamina. 

 When assigning a draped layup to a shell model the assignment of geometric thickness 

properties to the shell is not always of use. In these cases, if a geometric property is 

not assigned to the model then the thickness of the assigned laminates is used to 

calculate the corresponding element (and hence geometric) thickness at any point. So, 

in this case the lamina thicknesses would be absolute values. 

 The lamina thicknesses for solid models comprised of pentahedral and hexahedral 

composite elements are relative, not absolute, and represent the proportion of the total 

space that the elements of the volume represent apportioned to each lamina. For these 

models the number of laminate layers must correspond to, or exceed, the number of 
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elements through the Volume. Element nodal positions will be moved to correspond 

with laminate boundary positions if the node/laminate layer positions do not coincide. 

 The lamina thicknesses for solid models comprised of tetrahedral composite elements 

are absolute values and represent the actual thickness of each lamina. For these 

models the total of all lamina thicknesses as measured from a tooling surface must 

exceed the space occupied by the tetrahedral elements. 

 For a 'mesh-only' model (a model that has been created by importing a LUSAS 

datafile) the actual thickness of each lamina would be entered, so in this case the 

lamina thickness is absolute. 

Visualisation of Composite Layup 

The orientations and thicknesses for each lamina can be viewed by clicking on the Visualise 

button of the Composites dialog for a particular chosen entry method. This will display a 

layered representation of the composite stack with annotations. This representation may be 

used to create a bitmap annotation by clicking on the Create Annotation button. 

 

Assigning Composite Properties  

The method of assigning composite properties to a model differs according to the type of 

composite definition method used: 

For the Solids and Shells definition method: 

 The composite attribute created by this method is assigned to selected surfaces or 

volumes of a model by specifying the overall composite orientation. Options for 

orientation are: Local Coordinate, Local Element Axes, Axes From Surface. An angle 

of zero degrees aligns the laminate axis with the x axis from the orientation axes. 
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For the Draped Solids and Shells definition method: 

 For solid and shell models the composite attribute needs to be assigned to a draping 

surface. This is done by selecting and placing the Surfaces defining the drape surface 

into selection memory and assigning the composite attribute to the model. 

For the FiberSIM Solids and Shells and Simulayt Solids and Shells definition methods: 

 No assignment to a draping surface is required because the layup data is already 

included and correctly positioned in the FibreSim or Simulayt XML files. However, 

the composite attribute must be assigned to the model to enable visualisation of other 

composite model data. 

Visualisation of Composites Properties 

To visualise assigned composites properties the surface or volume must be meshed. The 

following composite properties can be visualised: 

 Fibre (ply) directions 

 Draping grid 

 Lamina thickness, Skew angle, Offset layer, Fibre volume fraction 

Visualisation of Fibre (Ply) Directions 

Once assigned to features which have a mesh assigned, the fibre directions of assigned 

composite data can be examined graphically as follows: 

1. Right-click on the Attributes entry in the  Treeview and select Properties.  

2. On the Composite tab, click on Settings and select Visualise ply directions. The x 

and y axes define the warp and weft directions respectively; the item x&y displays 

both directions at the same time.  

Lamina directions can be plotted as an x, y, z or x&y axes at any layer. For solids the axes 

may be placed at the top/bottom or middle of the chosen layer, for shells the axes are placed 

on the mid surface of the shell element. For details of how to choose a composite layer see 

Setting The Active Composite Layer. 

 Visualisation of Draping Grid  

The draping grid for individual lamina can be examined graphically as follows: 

1. Right-click on the Attributes entry in the  Treeview and select Properties.  

2. On the Composite tab, click on Settings and select Visualise ply directions. Then 

select Draping grid.  
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If no mesh has been assigned to a model prior to selecting this option only the draping grid 

(and not the ply directions) will be visualised.  

For details of how to choose a composite layer see Setting The Active Composite Layer. 

Extending the draping grid 

LUSAS Draped Solids and Shells grids are automatically trimmed at Surface boundaries. 

FiberSIM and Simulayt generated grids are not. If required, the draping grid can be extended 

by one grid row to ensure the edges of the component are fully enclosed by the draping grid. 

For FiberSIM and Simulayt grids this is specified at the file import stage (accessed via the 

Attributes > Composite menu item). For LUSAS Draped Solids and Shells grids, this is done 

via the Draping options on the Model Properties dialog. 

  
Example of draping grid  

being extended by one row 

Example of draping grid  

being trimmed to a surface boundary 

Visualisation of Other Composite Model Data 

To view other composite model data such as lamina thickness, skew angles, offset layers and 

fibre volume fractions: 

1. With a Contours layer in the  Treeview right-click on Contours.  

2. On the Contour Results tab select the Composites (model) entity and select the 

composite attribute name in the right-hand panel. The fibre volume fraction and skew 

angle (and any other composite modelling options relevant for the model) will appear 

for selection in the Component combo box. 
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Setting the Active Composite Layer  

Composite shell and solid elements have 

multiple layers (laminae) of different 

materials though their thickness. The lamina 

or lamina name on which results or 

orientation axes are to be viewed is chosen 

by setting that lamina active. A lamina is set 

active by selecting the lamina with the right-

hand mouse button from the  Treeview 

and picking Set Lamina Active or Set 

Name Active from the context menu. A 

black dot next to a lamina indicates the 

active lamina.. 

If a lamina is set active only results or orientation axes for that lamina in that composite 

attribute will be displayed. If the lamina name is set active, results or orientation axes will be 

displayed for all laminae with that name across all composite attributes. 

When viewing results the material transformation should be used to display stresses on or off 

axis. 

Slidelines 

Slidelines are attributes which can be used to model contact and impact problems, or to tie 

dissimilar meshes together. They can be used as an alternative to joint elements or constraint 

equations, and have advantages when there is no prior knowledge of the contact point. 

Slideline applications range from projectile impact, vehicle crash worthiness, the containment 

of failed components such as turbine blades, to interference fits, rock joints and bolt/plate 

connections. Slidelines can be defined to apply to all analyses that are present in the Analysis 

treeview, or be applied on a loadcase by loadcase basis for individual analyses. 

Slideline properties are defined from the Attributes> Slideline menu item. 

The properties of a slideline are used to model the contact interaction between master and 

slave features, such as the contact stiffness, friction coefficient, temperature dependency etc. 

The figure below shows a contact application in which a frictional slideline is defined 

between two bodies and where tied slidelines are used to join dissimilar meshes. The latter 

avoids the need for stepped mesh refinements between different mesh densities. 
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Slidelines are assigned to pairs or groups of features in a model, with one pair/group termed 

master and the second pair/group termed slave. An element face that lies on a slideline is 

called a slideline segment. 

When one slideline surface is much stiffer than the other it can be defined as a rigid slideline 

surface. This approximation can improve the convergence rate and hence reduce the solution 

time. If the rigid surface is not part of the model, rigid elements should be assigned to the 

features. 

Note. To use any type of slideline a nonlinear licence is required. However, tied-slidelines 

may be used in a linear loadcase. 

Table of Elements for use with Slidelines 

The following table gives a list of elements valid for use with slidelines: 

Element type    LUSAS elements 

Thick shells   TTS3, QTS4 

Plane stress 
continuum 

  TPM3, TPM3E, TPK6, TPM6, QPM4, QPM4E, QPM4M, QPK8, QPM8 

Plane strain 
continuum 

  TNK6, TPN3, TPN3E, TPN6, QNK8, QPN4, QPN4E, QPN4L, QPN4M, QPN8 

Axisymmetric solid 
continuum 

  TAX3, TAX3E, TAX6, TXK6, QAX4, QAX4E, QAX4L, QAX4M, QAX8, QXK8, 

Solid continuum    TH4, TH4E, TH10, TH10K, PN6, PN6E, PN6L, PN12, PN12L, PN15, PN15K, 
PN15L, HX8, HX8E, HX8L, HX8M, HX16, HX16L, HX20, HX20K, HX20L 

Continuum two-phase   TH10P, TPN6P, PN12P, PN15P, HX16P, HX20P, QPN8P 

2D rigid surface   R2D2 

3D rigid surface   R3D3, R3D4 

Slideline Types 

There are several different types of slideline: 

 Null The slideline attribute is ignored. Useful for performing a preliminary check on 

the model.  

 No Friction Used to model contact without friction.  

 Friction Used to model contact with friction. 

 Tied Used to tie different meshes together. 

 Sliding Used for problems where surfaces are kept in contact but which are free to 

slide relative to each other. The sliding behaviour is frictionless. 

The friction/no-friction slideline types model the finite relative deformation of contacting 

bodies in two or three dimensions where the contact is stationary or sliding, constant or 

intermittent. The sliding only option is similar but does not permit intermittent contact, i.e. 

the surfaces are kept in contact, allowing frictionless sliding contact without lift-off to be 
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modelled. The tied slideline option allows meshes of differing degrees of refinement to be 

connected without the need of a transition zone between the meshes. 

Slideline Properties 

 Master/slave stiffness scale Controls the amount of inter penetration between the two 

surfaces. Increasing the scale factor will decrease the amount of penetration but may 

cause  ill-conditioning. Recommended values are: 

 Implicit/static solution 1.0 

 Explicit solution 0.1 

 Tied slidelines 100 to 1000 

Slideline stiffnesses are automatically scaled at the beginning of an analysis if the 

average master/slave stiffnesses differ by a factor greater than 100. This is to account 

for contact between bodies that have significantly different material properties. This 

facility can be suppressed via File > Model properties > Attributes and selecting 

‘Suppress initial slide-surface stiffness check’. 

 Coulomb friction coefficient Defines the coefficient of friction between contacting 

bodies for Coulomb’s law. Only applicable for friction slidelines.. 

 Zonal contact detection parameter This defines the region around a node within 

which a search for contact is conducted. The size of the region is a factor of the size of 

the overall model – the model is projected onto the global x, y and z axes and the 

largest projection is used as a reference. For further information refer to the Theory 

Manual.  

 The default value of the zonal contact detection parameter is 0.01, i.e. 1% of 

the model size. A smaller value may result in undetected inter-penetration. The 

value should be set to 1.0 if the contact search should consider the entire 

model (though only points on the adjacent slideline surface will be considered 

valid contacts). 

 Slideline extension A boundary of a slideline segment can be expanded by specifying 

a slideline extension. Points outside the segment but within the extended boundary are 

considered valid for contact. This is particularly useful near the edges of a slideline 

surface, where a node could be on a segment in one nonlinear iteration and off the 

segment in the next iteration – a form of chatter that can cause nonlinear convergence 

difficulties.  

 The extension parameter is an absolute number. 

 Close contact This defines a region above a slideline surface within which a soft 

spring is applied, but with no force. The stiffness of this spring is applied to all nodes 

that are above a surface but within the close-contact region. This softens the transition 

between in-contact and out-of-contact states. 
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 The close contact facility helps stabilise solutions suffering from chatter in 

which nodes oscillate between in-contact and out-of-contact states. Chatter can 

cause a nonlinear analysis to experience convergence difficulties. 

 The size of the close contact region is a factor of the segment size. The 

stiffness of the close contact spring is 10-3 that of the slideline stiffness. It’s 

stiffness is controlled by the Solver system parameter SLSTCC. 

 For analyses that continue to suffer from chatter, the size of the close contact 

region should be increased and the value for SLSTCC reduced accordingly. 

SLSTCC can be changed via File > Model properties > Solver system 

variables. 

 The close contact facility is not available for explicit dynamics. 

Temperature Dependency 

Choosing the Temperature dependent check box allows different sets of slideline properties to 

be specified at different temperatures, thus providing temperature dependence. With 

temperature dependency, the stiffness scale factors and the coefficient of friction are linearly 

interpolated across the reference temperatures. All other properties remain unchanged. 

Pre-contact 

Pre-contact is used to overcome problems encountered when applying an initial load (other 

than Prescribed Displacement) to a discrete body that, without the slideline, would undergo 

unrestrained rigid body motion. This is particularly the case when an initial gap exists 

between the contacting surfaces and a load is applied to bring them into contact. Pre-contact 

is only applicable to static analyses. 

 

Pre-contact brings two bodies into initial contact by using interface forces that act between 

the slideline surfaces in order to avoid unrestrained rigid body motion. These forces act in a 

direction normal to each surface. One of the surfaces must be free to move as a rigid body and 

the direction of movement is dictated by the interface forces, applied loading and support 

conditions. The facility allows a gap to exist between the surfaces. In the example above pre-

contact is defined for slideline 1 but not for slideline 2. 
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Warning. Incorrect use of this procedure could lead to initial straining in the bodies or to an 

undesirable starting configuration. By selecting specific slidelines for the pre-contact process 

(i.e. slidelines where initial contact is expected) minimum initial straining will occur and 

more control over the direction of rigid body movement can be exercised. 

Contact Cushioning 

Contact cushioning can be used when convergence difficulties related to in-contact/out-of-

contact chatter are experienced. The formulation applies a contact force and stiffness above a 

surface that increases exponentially as a node moves closer to the surface. This cushions the 

impact of a node with the surface and softens the transition between in-contact and out-of-

contact states. Contact cushioning can therefore help improve nonlinear convergence when 

chatter is encountered and the set of active contact nodes is continually changing. See Theory 

Manual for details. 

Initial slideline type 

The slideline type at the start of the analysis (as described earlier) 

Change slideline type during a single analysis 

Select this option if the slideline type is to change with respect to a loadcase during a 

particular analysis. If the option is not specified, the slideline defined will apply to all 

analyses. Note that for the vast majority of analyses it will not be necessary to select this 

option. 

The slideline type can be changed from one type to another at any loadcase stage within a 

particular analysis. For example, the slideline can be set to be a Friction slideline in loadcase 

1, and will apply by default to loadcases 2 and 3, and then be stated to be a No Friction 

slideline in loadcase 4. 

If a loadcase is specified at which a slideline type is to change, the slideline only affects the 

one analysis that contains that loadcase. If if the slideline type is also required in another 

analysis, a duplicate slideline attribute will need to be specified for that analysis and assigned 

to the same model geometry. 

Type after change 

The slideline type after change (e.g. Friction). 

Changes at loadcase 

The loadcase at which the slideline type should change from the initial setting to the changed 

setting. (e.g. Tied to Friction). 
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Rigid type 

To model contact with rigid bodies, rigid slideline surfaces are available. Rigid surfaces can 

be assigned to valid structural elements as well as to special rigid surface elements R2D2, 

R3D3 and R3D4. The latter are recommended for modelling rigid bodies, since they remove 

the need for defining structural elements and hence speed up the solution. All nodes on a rigid 

surface need to be completely restrained. Since rigid surfaces cannot contact each other only 

one slideline surface can be defined as rigid – master or slave. 

Number of passes 

Slidelines involve a two pass procedure in general, in which contact on both slideline surfaces 

is processed. With rigid surfaces, however, a one pass procedure is available that only checks 

the penetration of the deformable surface into the rigid surface. If the one pass procedure is 

selected, it is recommended that the deformable body should have the finer mesh.  

Geometric definition 

Slideline surfaces can be modelled using linear/bi-linear segments, or as curved contact 

surfaces using quadratic patches.  

 With quadratic patches the curved contact geometry is constructed from a patch of 

slideline segments. The contact forces are then distributed to the closest segment. 

 The quadratic patches and the curved geometry are set-up automatically within 

LUSAS Solver and no additional specification is required. The standard patch 

configuration consists of two linear segments in 2D and four bi-linear segments 

(quadrilateral or triangular) in 3D. Where a patch definition is not possible the 

standard linear/bi-linear definition is used instead.  

 The quadratic patch contact formulation has a non-symmetric tangent stiffness matrix. 

The non-symmetric solver is therefore set automatically. 

Assigning Slidelines 

Slideline surface pairs are created by assigning a slideline attribute to selected Lines or 

Surfaces (or to edges and faces in a mesh-only model).  

To assign a slideline: 

1. Select features that will form the master surface 

2. Assign the slideline attribute to these features 

3. In the Assign Slideline dialog that appears, specify Master and the set of features to 

which it applies. The orientation is computed automatically but needs to be specified 

for shells (Top or Bottom) 

4. Select features that will form the slave surface 

5. Assign the slideline attribute to these features 
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6. In the Assign Slideline dialog that appears, specify Slave and the set of features to 

which it applies. The orientation is computed automatically but needs to be specified 

for shells (Top or Bottom) 

Slideline Modelling Considerations 

 Except for tied slidelines, the slideline contact facility is inherently nonlinear and must 

be used in a nonlinear analysis 

 Only the expected region of contact should be defined as a slideline surface for tied 

slideline analyses. 

 Coarse mesh discretisation in the region of contact should be avoided. 

 Slidelines must be continuous and should not subtend an angle greater than 90 

degrees. Sharp corners are best described by two separate slidelines. 

 Large mesh bias should be avoided when using quadratic patches, to ensure a 

reasonable curved geometry is generated 

 The stiffness scale factors should be increased for rigid wall contact 

 The nodal constraint slideline (explicit tied slideline) treatment is more robust if the 

mesh with the greatest contact node density is designated the slave surface 

 The use of tied slidelines to eliminate transition meshes is recommended for areas 

removed from the point of interest in the structure 

 The use of a larger value for Young's modulus to simulate a rigid surface in a dynamic 

contact analysis is not advisable since this will increase the wave speed in that part of 

the model and give rise to a reduced time step. This practice significantly increases the 

computing time required. 

 Slidelines may be utilised with higher order elements (quadratic variation of 

displacements) but it is necessary to constrain the displacements of the slideline nodes 

so that they behave in a linear manner (LUSAS Modeller will do this automatically). 

The deformation of the slideline surface will therefore be compatible with the slideline 

algorithm. This may, however, lead to a stiffer solution 

 When defining slidelines for use in implicit dynamics or static analyses, low order 

continuum elements are recommended 

 Explicit dynamics elements only may be utilised to define a slideline surface in an 

explicit dynamics analysis 

 Do not converge on the residual norm with PDSP loading in a nonlinear analysis. This 

norm uses external forces to normalise which do not exist with PDSP loading. 

 Slidelines may be used with automatic solution procedures (e.g. arc-length methods). 

The line search and the step reduction algorithms are also applicable. 

Slideline Options 

Options relating to slidelines are set from the Attributes tab of the Model Properties dialog. 
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Slideline Example: Metal Forming Analysis 

 

Initial configuration. Deformed configuration. 

  

 

 

   

Constraint Equations 

A constraint can be defined to constrain the movement of a geometric or nodal freedom. 

Constraint equations allow linear relationships between nodal freedoms to be set up. 

Constraint equations can be used to allow plane surfaces to remain plane while they may 

translate and/or rotate in space. Similarly straight lines can be constrained to remain straight, 

and different parts of a model can be connected so as to behave as if connected by rigid links. 

These geometric constraints are only valid for small displacements. Constraint equations can 

also be used to model cyclic symmetry, for example a single blade from a complete rotor may 

be modelled and then constrained to behave as if it were part of the complete model. As 

constraint equations refer to transformed nodal freedoms, any local coordinate assigned to the 

features are taken into account during tabulation when the constraint equations are 

assembled. 

Several different types of Constraint Equations can be defined from the Attributes> 

Constraint Equation menu item. Constraints are grouped under the following types: 
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Displacement Control 

 Specified Variable a nodal freedom takes a 

specified value across all the nodes in the assigned 

features, In this example, a specified variable 

constraint of Displacement in the X direction with 

value 1.0 is assigned to Point 1. The underlying 

node is then allowed to displace only by the 

specified distance in the specified X direction. 

 Constant Variable used where a nodal freedom 

value is constant but unknown across all the nodes 

in the assigned features. 

In this example, a constant variable constraint of 

displacement in the X direction is assigned to Line 

1. The underlying nodes move a constant amount in 

that direction. 

 Vector Path The nodes in the assigned features 

may be constrained to move along a specified 

vector defined by 2 Points or by 2 sets of X, Y and 

Z coordinates. 

 

In this example, vertical and horizontal vectors are 

used to restrict movement in those directions. Note 

that the vectors are used purely to define a 

direction. Nodes can travel along a vector in either 

direction. 
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Geometric 

 Rigid Displacements The nodes in the assigned 

features may be constrained to be rigid, the group 

of nodes may translate and/or rotate but their 

positions relative to one another remain constant. 

Only translational displacements can be constrained 

using this type of constraint. This type of constraint 

is only valid for small displacements.  

Assigning a constraint of this type to Lines on 

either side of a gap, as in the example shown, 

maintains the underlying undeformed node positions relative to each other as if a rigid 

block were in place between the structures. 

  

 Rigid Links  Each rigid link attribute can be used 

at one location, to create a rigid fixity between 

features that it is assigned to. It is similar to the 

Rigid Displacements constraint type, except that 

rotational freedoms are also constrained to be rigid. 

In the example shown here, the end of a beam is 

rigidly linked to the shell edges around a cylinder. 

The plane containing beam and cylinder end will 

remain plane throughout the analysis. 

 Planar Surface A surface may be constrained to 

remain plane, the surface may translate and/or 

rotate but remains plane. Nodal positions may vary 

relative to other nodes on the surface. This type of 

constraint is only valid for small displacements. In 

this example, a planar Surface constraint is 

assigned to the top Surface to force the underlying 

nodes to remain planar during loading. Constrained 

nodes may move relative to each other as long as 

they remain in plane. 
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 Straight Line A straight line may be constrained to 

remain straight, the line may translate and/or rotate 

but will remain straight. Nodal positions may vary 

relative to other nodes along the line. This 

constraint type is only valid for small 

displacements. In the example shown, a straight 

Line constraint is assigned to Line 3 to force 

underlying nodes to remain in a straight line 

relative to each other during loading. Constrained 

nodes may move relative to each other as long as 

they remain in a straight line. 

Cyclic 

 Cyclic Rotation Cyclic rotational symmetry may 

be used to model a section from a continuous ring. 

The mesh on the two planes of symmetry may be 

different. In the example shown, the radial Lines 

are defined as a Master and Slave pair maintaining 

cyclic symmetry around the structure. Meshes on 

the Master and Slave Lines need not match. 

 Cyclic Translation Cyclic 

translational symmetry may 

be used to model a section 

from a continuous strip. The 

mesh on the two planes of 

symmetry may be different. 

In the example shown here, 

Master and Slave Surfaces 

define start and finish 

positions of repeating sections. Meshes on Master and Slave need not match. 
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Tied Mesh 

 Specified Constraint Tied meshes may be used to 

force two sets of assigned features to move together 

in a similar manner to tied slidelines. The meshes 

are tied along Master and Slave Lines to restrict 

relative movement. The mesh on the two sets of 

features need not match. A search direction vector 

is defined to limit the mesh to which it is tied. A 

vector defines the direction in which the constraint 

is applied. 

 Normal Constraint Meshes tied along Master and 

Slave Lines to restrict relative movement. The 

underlying nodes maintain their original relative 

positions under loading. Meshes on Master/Slave 

need not match. This form of tied mesh constraint 

uses a search direction normal to the Master/Slave 

surfaces to detect the mesh to which it is tied. 

Constraint equation dependency across analyses / 

loadcases 

Constraint equations defined for the first loadcase within a base analysis can be optionally 

inherited by all other analyses. Assigning a different constraint equation to selected features 

in a following analysis supercedes any inherited constraint equations but for only those 

assigned features. 
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Case Study. Using Constraint Equations 

Differing meshes may be constrained to displace together in a similar way to a tied slideline. 

1. Define two Surfaces separated by a small gap using Geometry> Surface> 

Coordinates. 

2. Mesh the Surfaces with Linear Plane Strain elements using different mesh spacing on 

each Surface using the Attributes> Mesh> Surface menu item. 

3. Define and assign a valid Material to the Surfaces and define and assign Supports and 

Load attributes so that the Surfaces are being forced towards each other. 

4. Define a normal tied mesh Constraint using the Attributes> Constraint Equation> 

Tied Mesh menu item. Assign it to the Lines on either side of the gap. One Line must 

be selected as a master and the opposing Surface as a slave. If meshes on tied Lines 

have different spacing, choose the Line containing the finer mesh as the master. 

5. Run Solver  and view the deformed mesh. The constraint equations will have 

prevented one surface from passing through the other. 

  

Retained Freedoms 

Retained freedoms are used to manually define the master freedoms for use in the following 

analyses: 

 Guyan reduction eigenvalue analysis 

 Superelement analysis 

Retained freedoms are defined from the Attributes menu. They contain the definition of the 

master (retained) and slave (condensed) degrees of freedom and are assigned to the features 

designated as the master nodes. 

  

Full Subspace Iteration    20 Masters 
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15 Masters   10 Masters 

 

  

 

5 Masters     

 

    

Damping 

Damping is used to define the frequency dependent Rayleigh damping parameters for 

elements which contribute to the damping of the structure. Viscous (modal) and structural 

(hysteretic) damping can be specified. If no damping attributes are specified the properties are 

taken from the material properties (click on dynamic properties on the elastic page of the 

material attribute dialog). 

Damping is usually specified when distributed viscous and/or structural damping factors are 

required for modal damping control. A modal damping analysis is performed as part of an 

eigenvalue analysis.  

Defining Damping 

Structural or viscous damping is defined from the Attributes> Damping menu item and 

assigned to features in the usual way. Mass and stiffness Rayleigh damping parameters are 

linked with the corresponding reference circular frequency value at which they apply in a 

damping attribute. If more than one set of damping values is defined linear interpolation is 

used to calculate damping values at intervening frequencies. 

Birth and Death (Activation/Deactivation of Elements) 

Birth and death enables the modelling of a staged construction or demolition process, 

whereby selected elements are activated and/or deactivated as the features to which they are 

assigned are activated and/or deactivated. Activate and deactivate attributes are defined from 
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the Attributes> Birth and Death menu item and are assigned to features (or elements in a 

mesh only model) and manipulated in the same way as other attributes.  

Activate 

To model the creation or addition of a previously de-activated part of a model, an activate 

attribute is assigned to those features that are to be added. 

  In a structural analysis, an unmodified stiffness matrix is computed for the underlying 

elements and these activated elements are introduced in a stress/strain free state 

(uninfluenced by previous stages), except for any initial stresses or strains that have 

been defined. Strains are incremented from the point of activation and the deformed 

mesh is used to define the activated element’s initial position.  

 In a thermal/field analysis activation works in the same manner as for a structural 

analysis, except that the quantities affected are the conductivity matrix (or other 

analogous quantity), the fluxes and the gradients. 

Deactivate 

To model the absence or removal of a part of a model, a deactivate attribute is assigned to 

those features that are to be removed. In a structural analysis, the underlying elements have 

their stiffness matrix reduced in magnitude, while for field analysis the conductivity matrix 

(or other analogous quantity) is reduced. This ensures the deactivated elements have a 

negligible effect on the behaviour of the remaining model. The element stresses and strains, 

fluxes and gradients and other analogous quantities are all set to zero. 

Percentage to Redistribute 

In a deconstruction situation a deactivate attribute controls the way in which internal forces in 

a loaded structure are processed by specifying how much of the internal forces should be 

redistributed to the remaining elements. 

 Zero Redistribution 0% of the internal forces in a deactivated element are 

redistributed in the remaining elements (if this is prescribed in a static analysis, and the 

load remains constant, the stress, displacements etc. in the other elements will remain 

unchanged). 

 Full Redistribution 100% of the internal forces in a deactivated element are 

redistributed in the remaining elements (this has the same effect as re-assigning very 

weak material properties to the element). 

 Fractional Redistribution A percentage of the internal force to be redistributed is 

specified. Provides a solution which is part way between the two extremes. 

Any remaining internal equilibrating force associated with a deactivated element is 

maintained in the system until the element is subsequently activated. When an element is 

activated it is assumed that the element has just been introduced to the model (although all 

elements must be defined at the outset). The current (deformed) geometry for that element is 

taken as the initial geometry and the element is assumed to be in a stress/strain free state 
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(unless initial stresses or strains are defined). All internal forces that exist in the element are 

redistributed and the computed strains are incremented from the time at which the element 

becomes active. 

Maintain relative position of inactive nodes 

Specifying Maintain relative position of internal nodes ensures that all internal nodes 

within an inactive feature are constrained such that, for example, a straight line will remain 

straight and move as a rigid body. This is currently only for use with meshed line features. 

 Inactive line control This controls how the deactivated elements will be rotated or 

aligned with respect to existing or previously activated adjoining lines in a model. 

There are four options: 

 Fixed restrains the position of the inactive end(s) of an inactive member 

 Horizontal ensures the inactive member remains horizontal 

 None allows rotation between the active and inactive members. This would be 

used for a key section as, for example, when a section is positioned between two 

existing sections. 

 Tangent forces the rotation of the inactive members to match that of the active 

feature at their connection 

 Notes  

 The Horizontal, Tangential and Fixed options are only currently available for line 

features.  

 Use of the tangent option may additionally require the use of a jacking load or a 

prescribed displacement if it is required to return the end of a beam to its original 

undeformed position. For more information see Prescribed Structural Loads. 

 If a deactivation attribute is inadvertently assigned to a surface any inactive line 

control setting will be ignored. 

Inactive line control examples 

  

Fixed line control Horizontal line control 

    



  Chapter 6 

    

293 

 

Tangential line control 

Using Activate and Deactivate Attributes 

All features (and hence elements) to be used in the model need to be defined at the start of the 

analysis. Activate and Deactivate attributes are assigned on a feature basis and control the 

history of the underlying elements throughout the analysis. An analysis and a loadcase are 

specified during assignment to indicate at what point the elements are added or removed. 

Dependency across analyses / loadcases 

Activate and deactivate attributes defined for one analysis or loadcase are not inherited by 

following analyses or loadcases, but they can be copied and pasted between analyses in the 

Analyses  Treeview. 

Notes 

 Activation and deactivation can only be carried out within a nonlinear analysis. 

 Deactivation and activation can take place over several increments if convergence 

difficulties are encountered.  

 Elements cannot be activated and deactivated in the following circumstances: 

 Explicit dynamics analyses. 

 Fourier analyses. 

 When they are adjacent to slidelines. 

 Deactivated elements remain in the solution but with a scaled down stiffness so that 

they have little effect on the residual structure. The stiffness is scaled down by a 

parameter which can be user-defined. In an implicit dynamic analysis the mass and 

damping matrices are also scaled down by the same factor. 



Modeller Reference Manual   

    

294 

 When an element is deactivated, by default, all loads associated with that element are 

removed from the system and will not be re-applied if an element is subsequently re-

activated. This includes concentrated nodal loads unless the load is applied at a 

boundary with an active element. The only exception to this rule is a prescribed 

displacement which may be applied to a node on deactivated elements. Accelerations 

and velocities may also be prescribed in a dynamic analysis but this is not 

recommended. By setting LUSAS Solver option 385, the default behaviour can be 

overridden and loads applied to deactivated elements can be preserved to enable re-

application if and when the elements are re-activated. 

 If required, initial stresses/strains and residual stresses may be defined for an element 

at the re-activation stage. 

 The activation of an element which is currently active results in an initialisation of 

stresses/strains to zero, an update of the initial geometry to the current geometry and 

the element is considered to have just become active. The internal equilibrating forces 

which currently exist in the element will immediately be redistributed throughout the 

mesh. This provides a simplified approach in some cases.  

 The direction of local element axes can change during an analysis when elements are 

deactivated and reactivated. In particular, 3-noded beam elements that use the central 

node to define the local axes should be avoided as this can lead to confusion. For such 

elements the sign convention for bending moments for a particular element may 

change after re-activation (e.g. it is recommended that BSL4 should be preferred to 

BSL3 so that the 4th node is used to define the local axes and not the initial element 

curvature). 

 Care should be taken when deactivating elements in a geometrically nonlinear 

analysis, especially if large displacements are present. It may be necessary to apply 

prescribed displacements to deactivated elements in order to attain a required 

configuration for reactivation. 

 It should be noted that the internal forces in the elements will not balance the applied 

loading until all residual forces in activated/deactivated elements have been 

redistributed. 

 For solving analyses involving constraint equations, such as those used by this 

facility, it is recommended that the Fast Parallel Iterative Solver solver is used. 
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General example 

Excavation Stage 1 

Top layer of soil deactivated and lining activated. 
Lining and soil elements duplicated in the model. 

Tunnel Excavation Stage 2 

Second layer deactivated as soil excavated. 
Surrounding lining elements activated 

 
 

Tunnel Excavation Stage 3 

Remaining second layer soil elements deactivated. 

Tunnel Excavation Stage 4 

Supporting soil pillar removed and top lining 
activated. 
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Tunnel Excavation Stage 5 

Final central soil column removed. 

  

 

  

  

Equivalencing 

The equivalence facility is used to merge coincident nodes on otherwise unconnected 

features. If an equivalence attribute is assigned to any features the nodes will automatically be 

equivalenced after meshing has been carried out. 

There are several ways equivalencing can be set up to work:  

 By assigning equivalence tolerances to certain features - only these features will be 

equivalenced, all others are ignored. 

 By switching on the automatic tolerancing, and accepting the default tolerance - all 

features are equivalenced according to the default tolerance. 

 By switching on the automatic tolerancing, and assigning other equivalence tolerances 

to certain features - all features are equivalenced according to either an assigned 

tolerance or the default tolerance. 

  

Example  

In this example, Surfaces 1 and 2 do not share a common boundary 
Line, therefore the nodes created on their common boundaries will 
not be joined and must be equivalenced. Node 2 will merge with 
node 1 if it lies within the equivalence tolerance.  
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Using Equivalencing 

Equivalence attributes are defined from the Attributes menu. They are defined as a tolerance, 

which is used to determine whether nodes are considered to be coincident.  

The equivalence attribute is assigned to the features that are to be checked for coincident 

nodes. When an equivalence dataset is assigned to a lower order feature it will search through 

all higher order features for nodes to be checked. For example, in order to equivalence two 

Volumes at their boundaries, it is more efficient to assign the equivalence to the Surfaces on 

the boundaries, as a smaller number of nodes need to be checked. 

Automatic Equivalencing 

Automatic equivalencing can be activated from the Meshing tab of the Model Properties 

dialog. This will equivalence all features in the model on meshing if they are within the 

default equivalence tolerance, or within an assigned tolerance. Note. Remeshing occurs each 

time a relevant command is issued, but a forced remesh is possible using the Utilities> 

Mesh> Mesh Reset menu item. Automatic equivalencing can be time consuming for models 

with a large number of nodes. 

Visualising Equivalences 

Displays the features which have a specified equivalence 

assigned to them in a chosen colour and line style. 

In this example different equivalence tolerances are assigned to 

different parts of a model to merge more coarsely or finely as 

required. Using visualisation, the lines to which the equivalence 

is assigned can be highlighted. Equivalenced nodes can also be 

visualised as they are removed. In this diagram they are shown 

using the square symbol. 

 

Summary 

 More than one equivalence attribute may be defined in order to rationalise more than 

one section of the model independently. 

 More than one equivalence attribute can be assigned to a feature to equivalence it 

within a different subset of the model. 

 A check for unconnected elements and nodes can be performed using an outline mesh 

plot (Mesh layer properties), or by checking for duplicate node numbers using the 
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View > Browse selection menu item and box-selecting around selected points to see if 

more than one point appears in the list shown. 

 The equivalence tolerance must be less than the smallest distance between two nodes 

on the same feature, otherwise the equivalencing operation will fail.  

 Equivalencing may be used to position a point load or support at a node (which is not 

at a defining feature Point). A Point must be created, the load or support assigned, and 

the Point and meshed feature equivalenced. 

 Equivalencing may be used to merge nodes on the constituent Lines of combined 

Lines i.e. the nodes on an entire combined Line may be equivalenced, including the 

Lines forming it. 

Influence Attributes 

Influence attributes define the result component and methodology that, when assigned to a 

part of the structure, and in combination with an influence analysis, will be used to create an 

influence surface. They can be defined for use with the following methods: 

 Reciprocal Theorem - also known as the Muller-Breslau Theorem, or Maxwell's 

Theorem, is a means of calculating an influence by the use of an auxillary structure, 

to which a deformation corresponding to a load effect of interest is applied.  

 Direct Method - is a more general and powerful way of calculating an influence 

where the effect of a specified point load is assessed at each node or grid location on a 

loadable area of a structure. The value of the load effect of interest at each specified 

location is then used to construct an influence line or surface for that location. 

Both methods create influence attributes that need to be assigned to a model prior to an 

influence analysis being carried out. For details on how to define and assign influence 

attributes see Influence Analysis. 

Reciprocal Theorem Influence Attributes 

Reciprocal Theorem influence attributes are defined from the Attributes > 

Influence> Reciprocal Theorem menu item.  

Specifying an influence attribute 

The influence attribute may be set by defining an Influence type of either Shear force, a 

Reaction, a Moment or a Displacement, an Influence direction of either Longitudinal or 

Transverse, and a Displacement directionof either Positive or Negative.  

Note that a shear or moment influence type is mesh dependent. The Influence direction 

defines the axis about which the component of interest will be evaluated. Once created, an 

influence attribute is held in the Attributes  Treeview for assignment to selected mesh 

nodes or Points on a model. A Direction definition object containing information relating to 

setting the vertical, longitudinal and transverse axes for a model is added to the Influence 

entry in the Attributes  Treeview once the first influence attribute has been defined. 
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A short influence name is recommended since this is used to create filenames that also 

include coordinates of assigned influence attributes and element details, and if collectively 

this is too long, the Windows path limit of 260 characters may be exceeded. For more details 

see File and folder naming in LUSAS. 

Assigning Reciprocal Theorem Influence Attributes 

One or more nodes or Points on the model may be selected to make a reciprocal theorem 

influence attribute assignment. Assigned attributes are stored within an Reciprocal Influence 

analysis entry in the Analyses  Treeview. Influence loadcase naming is based upon node 

coordinates. When assigned to the model LUSAS automatically determines the break-away 

elements required by the Reciprocal Theorem method in each case. Influence type symbols 

are drawn at each influence location to show the type of mesh break that is being used.  

 

Visualisation of Assigned Influence Attributes 

Reciprocal Influence surfaces can be visualised if attributes are assigned to a model and 

solved. The type of visualisation that takes place to help identify the influence type and the 

participating elements at each node or point of interest depends upon the type of influence 

and whether any manual selection of participating elements was done.  

Visualisation settings are accessed using the context menu for an influence attribute. If 

influence assignments are visualised the whole model may be re-displayed after viewing 

selected influences by right-clicking in the View window and selecting the All Visible option. 

Note that if a solve (to visualise influence surfaces) is not carried out prior to a Vehicle Load 

Optimisation analysis being run (with the generate Influence Surfaces check-box checked), 

influence loadcases are added to the Analysis Treeview but no visualisation of these influence 

shapes can be done. 
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Identifying Assigned Attributes 

The location of an assigned influence attribute can be found on the model by using its context 

menu and choosing Select Assignments to list it in the Selected items window. Any objects 

listed in this window can be located on the model by using the Find menu item on the context 

menu for the object. The location of the assigned attribute will be identified by a temporary 

indicator. 

Changes to Mesh after Attribute Assignment  

 If a model is re-meshed or has its geometry edited the influence points will remain visualised 

with those influence points still overlying a node or Point remaining marked with an 

appropriate 'break' symbol. Influence points that no longer lie on nodes or Points as a result of 

any modifications remain visualised on screen but with a 'not assigned'  symbol alongside 

their name in the Analyses  Treeview. Models can be solved with unassigned influences 

present in the Analyses  Treeview. 

Direct Method Influence Attributes 

Direct Method influence attributes are defined from the Attributes > Influence> Direct 

Method menu item.  

Specifying an influence attribute 

The influence attribute may be set by defining an Entity of interest (such as a Reaction, or a 

Force/Moment, or a Stress for example), an influence Direction (such as a local axis of a 

member, or a path along a structure etc.) and a Component of interest (such as My etc).  

The Entity drop-down list is populated according to the elements that are present in the 

model. The Direction drop-down list presented depends upon the type of entity selected. The 

Component drop-down list shows the influence components available for the chosen entity. 

Using paths 

Specification of an influence direction using the Path facility is recommended for grillage 

models, curved beam models, and for curved decks modelled with plates or shells where 

longitudinal and transverse effects are of interest. A default path of  longitudinal = global X 

is provided to allow influences to be assigned to models where element axes lie in this 

direction without having to actually define a path. This default path does not appear in the 

Utilities treeview and is not editable. Otherwise for most models, the specification of a path 

will require a reference path to have been previously defined prior to selection. If a reference 

path has been defined incorporating a skew angle then selecting the Skew check-box will 

ensure that for grillage or beam models all elements lying at that skew angle will be 

considered to be the transverse elements. Otherwise, by default, transverse elements are 

assumed to be those elements perpendicular to the longitudinal elements. A path cannot be 

selected for 2D line beam elements; for these, all components are calculated using the 

element local x-axis. 
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The Component drop-down list shows the influence components available for the chosen 

entity. Note that when a Path has been specified, in addition to the standard choices of 

Component, an Entity selection of Force/Moment will show component values of: 

 FV (longitudinal members) (Force in the Vertical direction for longitudinal 

members) 

 FV (transverse members) (Force in the Vertical direction for transverse members) 

 MF (longitudinal members) (Flexural Moment in longitudinal members) 

 MF (transverse members) (Flexural Moment in transverse members) 

Element Participation and Influences Generated 

It is possible to control the number of influences created and the way in which values from 

participating elements are calculated or averaged for a node or point of interest when a solve 

is carried out. The influence type group consists of the following options:  

 Unaveraged influence for each connected element - For this option, when assigning 

the attribute, a separate influence assignment is created for each connected element (if 

a node is selected) or connected geometry feature (if a point is selected). An 

assignment created this way provides un-averaged nodal results at the node of interest 

from the element for which the assignment was created. This is typically desirable in 

beam models where more than two elements meet, or when elements and their axes are 

not aligned, or when support conditions oppose the influence direction. This 

assignment type is drawn, by default, in orange and the contributing element is 

identified with a blue square box. Note that selecting adjacent elements to a node or 

point of interest prior to assignment of an influence attribute limits the operation to 

only those selected elements.  

 Average influence of all connected elements (not available for displacement or 

reactions) - For this, when assigning the attribute, only one influence assignment is 

created at the node/point selected. An assignment created this way provides averaged 

nodal results at the node of interest from all connected elements at the time of solving. 

This is typically desirable for influences in shell models with a regular grid of nodes or 

points. Averaging of all connected element values is not generally appropriate where 

element axes are not aligned, or when support conditions oppose the influence 

direction, or for grillage models (see note). This type of influence assignment is 

referred as ‘averaged influence assignment’ and, by default, is drawn in blue. Note that 

selecting adjacent elements to a node or point of interest prior to assignment of an 

influence attribute limits the averaging to only those selected elements. 

 Automatically choose elements for averaging (not for available plate and shell 

elements) - For this, when assigning the attribute, Modeller looks at the location of the 

assigned direct method influence attribute, checks for element type and a common 

alignment of element axes for the elements meeting at the point of interest (within a 

small tolerance), and if there are no supports opposing the influence, the 'Average 

influence of all connected elements' option is chosen (see note for grillage models). 

Otherwise, if the element axes are not aligned the 'Separate influence for each 

connected element' option is chosen instead. 
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 Name A short influence name is recommended since this is used to create filenames 

that also include coordinates of assigned influence attributes and element details, and 

if collectively this is too long, the Windows path limit of 260 characters may be 

exceeded. For more details see File and folder naming in LUSAS. 

Once created, an influence attribute is held in the Attributes  Treeview for assignment to 

selected mesh nodes or Points on a model - either directly or by the use of a loading grid. 

Subsequent assignment of the same attribute to other nodes or points of interest will use the 

same element participation settings.  

Element participation notes 

 Grillage models (whether constructed using 2D grillage elements or 3D beam 

elements) generally require moment results to be averaged over adjacent pairs of 

longitudinal members only, or adjacent transverse members only. This is 

automatically done by Modeller when an influence attribute has been defined with 

respect to a Path and with the 'Automatically choose elements for averaging' option 

selected.  

 When assigning a shear influence defined with ‘Average influence of connected 

elements’ it will be necessary to additionally select elements to one side or other of 

the node or point at the support to clarify which elements should participate in the 

calculation. 

 When only a point/node is selected at the time of assigning an ‘Average influence of 

all connected elements’ influence type, only a single assignment is made, but results 

will be presented for all elements that are connected to that node at the time of 

solution. So, if an additional member is added to the intersection after making the 

assignment, that additional member will also be considered when results are 

presented. 

 When only a point/node is selected at the time of assigning a ‘Unaveraged influence 

for each connected element’ influence type, an assignment is made for each 

line/element connected at the time of assignment. If an additional member is added to 

the intersection after making the assignment, that additional member will not be 

considered when results are presented. 

 It is not currently possible to edit element participation choices once an influence 

attribute has been assigned to a model. However, the de-assignment of the attribute 

from the model, or the deletion from the Analyses  Treeview of a Direct Method 

Influence analysis that uses the influence attribute will allow participation settings to 

be changed. 

The availability of influence entity options for different influence entities is summarised in 

the following table: 
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Influence entity 

Separate influence for 
each connected element 

Average influence of all 
connected elements 

Automatically choose 
elements for averaging 

Displacement or 
Reaction 

Not available Not available Not available 

Force or Moment Available Available Available (for bar and beam 
elements only) 

User defined 
results 

Available Not available Not available 

  

The availability of element type options for different element types is summarised in the 

following table: 

 
Element type 

Separate influence for 
each connected element 

Average influence of all 
connected elements 

Automatically choose 
elements for averaging 

Bar and beam 
elements 

Available Available Available 

Plate, shell and 
membrane elements 

Available Available Not available 

Continuum elements Available Available Not available 

Joint elements Available Not available Not available 

Assigning Direct Method Influence Attributes 

Influence attributes can be assigned to one or more selected nodes or points on the model 

using either a drag and drop technique or the context menu options for an attribute.Note that 

selecting adjacent elements to a selected node or lines adjacent to a selected point prior to the 

assignment of an influence attribute limits the averaging of values to only those selected 

items. Influence attributes are assigned in a Direct Method Influence analysis and if one has 

not been created at the time of assignment a prompt will be given to create one.  

Assigning influence attributes to points as opposed to nodes of the mesh (as may be preferred, 

perhaps, for reaction influences) has the benefit that, if changes are made to the geometry and 

the location of the point is moved, the attribute assignment will continue to remain valid. An 

assignment to a node that has a coincident point will assign the attribute to that point instead. 

Attributes assigned to mesh nodes only, remain valid only if the influence location overlays a 

mesh node and the elements are compatible with the results entity specified in the Influence 

attribute. See Changes to Mesh after Attribute Assignment. 

If a shear influence type is assigned to a node or point that is supported , a shear influence 

assignment is made to the end of each connected element or line at that assignment location. 
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Case Study: Defining and assigning Direct Method Influence 

attributes to a grillage model 

The basic procedure to define and assign Direct Method influence attributes to a grillage 

defined using the LUSAS grillage wizard is as follows: 

1. Define an influence attribute for Flexural Moment (Longitudinal members) using 

Automatically choose elements for averaging. 

2. Using the point selection tool, select all points in the model. 

3. In the Groups  Treeview, right-click on the Longitudinal group name and choose 

Add to Group. 

4. Assign the influence attribute to the selected points creating every possible 

longitudinal influence. 

5. Define an influence attribute for Flexural Moment (Transverse members) using 

Automatically choose elements for averaging. 

6. In the Groups  Treeview, right-click on the Transverse group name and choose Add 

to Group. 

7. Assign the influence attribute to the selected points creating every possible transverse 

influence. 

8. Solve the model to generate the influences and view them by adding the Influence 

shape layer to the Layers Treeview. 

 

For grillages created outside of the grillage wizard a similar process would apply using 

repeated box selections to select all longitudinal members (and their lower order points) prior 

to assignment of an influence attribute to create every possible longitudinal influence, 

followed by repeated box selections of all transverse members (and their lower order points) 

prior to assignment of an influence attribute to create every possible transverse influence. 

Note also that a similar result could be obtained by using the “Automatically choose elements 
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for averaging” influence type by selecting a suitable reference path and component, and 

assigning the influence attribute to all points in the model. 

Using a Loading Grid 

For certain types of Direct Method influence analysis (see Examples of Loading Grid use) it 

is beneficial to use a loading grid. Loading grids are predominantly used with line beam 

models where the geometric beam section represents a loadable top slab. The loading grid 

also provides the means to define a grid of points that can be used as an alternative to the 

nodes or points present in a shell or plate model that are used in an influence analysis, and 

depending upon grid settings used, can ensure that loadable grid locations do not occur at 

supported nodes - which, for particular components of interest, can be an issue. The use of a 

reference path defining the centreline of a loadable carriageway is recommended whenever a 

loading grid is used. 

The use of a loading grid will require the following to be specified: 

 Centreline - the centreline of the grid can be defined with reference to a previously 

defined Path or the X, Y or Z global axes. The use of a reference path is 

recommended for most situations. 

 Transverse width - the width of the grid to be loaded (must be greater than 0.1).  

 Grid settings control the density of the grid of points that will be loaded. Longitudinal 

and transverse values can be specified. If one of the global axes has been selected as 

the centreline of the grid, then the extents of the model will be calculated. 

 Loading settings The magnitude of the influence load (in terms of a positive or 

negative direction) and its actual direction of loading (in terms of the X, Y, or Z global 

axes, or the Vertical axis of the model can be defined. A default load magnitude of 1e3 

is used if the model units are metric, with an equivalent rounded value used if the 

model units are imperial. This default value is used in preference to a unit load so that 

any factoring or scaling of the loading (depending on the unit system in use) does not 

cause the order of magnitude of displacement to fall below tolerances used in vehicle 

load optimisation software. 

Loading grid notes 

 When using a loading grid to represent a generally loadable region of carriageway on 

a bridge deck, lines representing the extent of the carriageway will still need to be 

defined and selected prior to carrying out a Vehicle Load Optimisation analysis. 

 For a model with a very fine mesh, loading a grid having fewer points will reduce the 

solution time. But note that coarse mesh refinement or coarse loading grid settings can 

lead to inaccurate influence shapes being created, especially near any cusps. 
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Loading Grid Visualisation 

The visualisation of the loading grid is controlled for each direct method influence analysis 

entry in the Analyses  Treeview by deselecting / selecting the Show grid context menu 

item. The default is to always show a loading grid. It is not possible to delete a loading grid. 

Examples of Loading Grid Use 

 Loading grids are used in the following situations: 

 When a general grid is required to encompass a whole model. (Note that this cannot 

be used for carriageways that divide into two or more branches). 

 On a line beam model where the geometric section represents a beam with a loadable 

top slab. 

 When a different set of loadable points is required in preference to nodes on a finely 

meshed shell and plate models. 

 On a skewed grillage model where it is required to obtain results for longitudinal and 

transverse (skewed) members. 

Case Study: Defining and assigning Direct Method influence 

attributes to a 3D line beam model using a loading grid 

The basic procedure to carry out a Direct Method Influence analysis of a 3D line beam model 

where the geometric section represents a beam with a loadable top slab is as follows: 

1. Define an influence attribute that uses a pre-defined reference path along the beams 

that represent the deck and loadable slab. 

2. Using the node selection tool, select all the nodes in the beams along the path. 

3. Assign the influence attribute to all the selected nodes using a loading grid with a 

centreline along the reference path and specify a width appropriate to the loadable 

carriageway. 

4. Solve the model to generate the influences and view them by adding the Influence 

shape layer to the Layers Treeview. 
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Note that to carry out vehicle load optimisation analysis, lines defining the width of the 

carriageway must also be defined. 

Naming and Visualisation of Assigned Influence 

Attributes 

Assigned influence attributes create influence loadcases within a Direct Method Influence 

analysis entry in the Analyses  Treeview. The naming of these influence loadcases and the 

type of visualisation that takes place (or not) to help identify the influence type and the 

participating elements at each node or point of interest depends upon three things: the type of 

influence Entity chosen; the element participation settings made when the attribute was first 

defined; and whether any manual selection of participating elements was done. 

 Nodes assigned an influence attribute where a direction is associated with a 

component are denoted by an assignment  symbol.  

 Nodes assigned an influence attribute where a direction cannot be associated with a 

component are denoted by a blue  symbol. 

 If Unaveraged influence for each connected element was chosen when the attribute 

was first defined, the assigned attribute is drawn, by default, in orange and all elements 

participating in the calculation for that influence point are identified in the View 

window by a participating element  symbol . In the Analyses  Treeview a separate 

assignment is created for each node/point and participating element/line.  

 If Average influence of all connected elements was chosen when the attribute was 

first defined, the assigned attribute is drawn, by default, in blue and no visualisation of 

participating elements take place. By implication all elements seen to be connected to 

the node or point of interest are being used in the calculation for that influence 

location. If any elements or features were explicitly defined as participating, these will 

be identified by a participating element  symbol. 

 Initially assigned influence attributes that no longer overlay a node (perhaps because 

of a revised mesh arrangement) are denoted by a red  symbol. These influences are 

termed 'pending' and appear in red text in any list of influences to be analysed. 

Assigned influence attributes can also be denoted as 'pending' if some participating 
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features are not meshed at the time of assignment, or if those features are not 

compatible with the results entity defined for the influence attribute. 

 Assigned moment or reaction influence types are denoted by arrows in the plane in 

which the calculation of averaging of values is taking place. 

 Additional visualisation settings are accessed using the context menu for an influence 

attribute. 

Examples of Element Participation and Visualisation 

Symbols 

Showing symbols used to identify nodes, participating elements and components of interest. 

Plate/shell model 

Symbols used for an influence attribute defined to investigate Flexural Moment in 

longitudinal members with reference to a path. 

"Separate influence  
for each connected element" 

"Average influence  
of all connected elements" 

 
"Selected elements only" 

   

Elements identified by square 

symbols are participating at the 

node 

All connected elements to the node 

are being averaged 

Only those selected elements 

identified by square symbols are 

participating at the node 
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Grillage Model 

Symbols used for an influence attribute defined to investigate Flexural Moment in 

longitudinal members with reference to a path. 

"Separate influence  
for each connected element" 

"Average influence  
of all connected elements" 

"Automatically choose  
elements for averaging" 

   

Elements identified by square 

symbols are participating at the 

node 

All connected elements to the node 

are being averaged.  

(Not normally applicable to 

grillages) 

Only the longitudinal elements 

identified by square symbols are 

participating at the node  

2D/3D Frame Model 

Symbols used for an influence attribute defined to investigate axial forces or moments in 

members of a 2D/3D frame with reference to a path. 

"Separate influence  
for each connected element" 

"Average influence  
of all connected elements" 

 
"Selected elements only" 

   

Elements identified by square 

symbols are participating at the 

node 

All connected elements to the node 

are being averaged. 

Only the elements identified by 

square symbols are participating at 

the nodes. 

Identifying Influence Locations on the Model 

The location on the model of an influence entry in the Analyses  Treeview can be found by 

using the context menu for the influence entry and choosing the Find menu item. The 

location will be identified by a temporary indicator of animating concentric shrinking squares. 
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Changes to Mesh after Influence Attribute Assignment  

If a model is re-meshed or has its geometry edited 

affecting the mesh, assigned influence attributes 

will remain visualised with those influence types 

still overlying a node remaining marked with an 

appropriate influence type symbol. These marked 

locations will be included in an influence analysis. 

Influence points that no longer lie on nodes as a 

result of any modifications remain visualised on 

screen and are denoted by a red  symbol, but they 

will have a 'not valid'  symbol alongside their 

name in the Analyses  Treeview. These 

influences are effectively 'pending' (requiring correction or removal) and appear in red text in 

any list of influences to be analysed. These will not be included in an influence analysis. Note 

that models can be solved with influences marked as 'not valid' and with unassigned 

influences present in the Analyses  Treeview. 

Solving an Influence Analysis 

See Influence Analysis 

Age 

Age attributes are defined from the Attributes> Age menu item. Age attributes define the 

time in timescale units between the creation and activation of features in the model and are 

used in conjunction with the CEB-FIP Concrete Material Model. When assigned to a 

feature all elements created by that feature are assigned the specified age.  

See Solver Reference Manual for further details. 

Crack tip attributes 

A crack tip attribute allows a crack tip location to be defined at a point in a surface model and 

at either a point or line in a volume model. Crack tip attributes are defined from the 

Attributes > Crack tip menu item and are only for use with 2D and 3D quadratic continuum 

elements. After assignment the mid-point nodes of elements adjacent to the crack tip 

assignment are automatically moved to the nearest quarter point position within the element 

and the continuum elements adjacent to the crack tip assignment are automatically replaced 

with an equivalent crack tip element. When assigned to a point, the crack tip always occurs at 

a corner node of an element. When assigned to a line (volume models only), the crack tip 

occurs all along the line. Assigned crack tip attributes can be visualised using symbols 

displayed on the nodes of the assigned feature and at the mid-side nodes of the adjacent 

elements that have been moved towards the assigned feature. 
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Crack tip attribute assigned to a point in a 

2D model 

Crack tip attribute assigned to a line in a 

3D model 

Thermal Surfaces and Heat Transfer 

The thermal surface facility allows thermal gaps, contact and diffuse radiation to be modelled. 

Thermal surfaces are used to model the thermal interaction of two distinct bodies, or two 

different parts of the same body through a fluid medium.  

 Thermal Gaps are used to model gaps between structures that are relatively close 

together. 

 Contact is used in a thermo-mechanical coupled analysis where contact takes place 

and the contact pressure effects are then included in the analysis. 

 Diffuse Radiation is the process of heat transfer from a radiation surface to the 

environment or to another thermal surface defining the same radiation surface. 

Radiation is modelled by specifying radiative properties for thermal surfaces. 

Thermal surfaces 

Thermal Surfaces are the thermal equivalent of structural slidelines. They are defined from 

the Attributes> Thermal Surface menu item and are assigned to features of the model and 

manipulated in the same way as all other attributes. A thermal surface must be defined before 

thermal gap or radiation properties can be specified. 

 Radiation properties are required when defining a radiation surface for heat transfer 

by radiation exchange.  

 Environment properties are required when thermal environment properties exist. 

Used for heat transfer to the environment (convection and conduction).  

Thermal Surfaces work in conjunction with Thermal Gaps and RadiationSurfaces. See 

below for details. 

Heat Transfer 

Thermal gap and radiation surface properties are used to dictate the type of heat transfer that 

can take place between Thermal Surfaces. They are defined from the Utilities> Heat 

Transfer...  menu item. As utilities they cannot be assigned directly to features of the model 

as Thermal Surfaces can.  A thermal surface must have been defined prior to specifying any 
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thermal gap or radiation properties. The process of thermal surface / heat transfer definition is 

summarised in the following diagram. 

 Thermal Gaps Thermal gaps are 

used to model heat transfer across 

a gap and heat transfer by contact 

when a gap is deemed to have 

closed. If these effects are 

required, the thermal surfaces 

defining the gap must be specified 

on the Thermal Gap properties 

dialog. 

 Radiation Surfaces Diffuse 

radiation exchange may be 

modelled with a radiation surface 

that is defined by any number of 

thermal surfaces. Planes of 

symmetry that cut through the 

radiation enclosures may be 

defined so that it is not necessary 

to model the whole structure. 

Radiation surfaces allow for the 

calculation of diffuse view factors. 

These view factors may be output 

to a print file 

Specifying thermal surfaces 

defining a gap 

Pre-defined thermal surfaces can be 

selected on the Thermal Gap properties 

dialog in order to define a gap. The gap 

can be defined as active or inactive 

initially and be set to change according to 

loadcase. 

 

Choosing Thermal Properties 

The following flowchart guides the decision making process for choosing thermal properties. 

The process is simplified if the analysis only considers a single body, when only 

environmental thermal properties are required. For analyses where discrete (multiple) bodies 

are considered, factors such as body proximity and whether the bodies are touching, or are 

likely to touch during the analysis, become important and the choice of thermal properties 

changes. Follow a route through the flowchart below and define your thermal surfaces using 

the properties given in the shaded box. 
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Environmental Nodes (LUSAS Solver data file only) 

Environmental nodes may be used to represent the medium which separates the thermal 

surfaces between which heat is flowing. As the length of a link directly connecting two 

surfaces increases, the validity of the assumed flow becomes more tenuous. Alternatively, 

instead of forming a link, heat could flow directly to the surroundings, but in this case, the 

heat is lost from the solution. This, in some cases, is a poor approximation to reality, 

particularly when the thermal surfaces form an enclosure. In this instance an environmental 

node can be used to model the intervening medium, with all nodal areas which are not 

directly linked to other areas linked to the environmental node. The environmental node then 

re-distributes heat from the hotter surfaces of the enclosure to the cooler ones without 

defining the exact process of the transfer. 

Note. Environmental nodes cannot be defined in LUSAS Modeller, and must be edited 

directly into the LUSAS Solver data file if required. See the Solver Reference Manual for 

further information. 
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Radiation Options 

Radiation options are set from the  Coupled analysis options object in the Analyses  

Treeview. 

 Suppress Recalculation of View Factors in Coupled Analysis   Turns on/off the 

view factor recalculation. The option should be turned on when the radiation surface 

geometry is unchanged by the structural analysis. This stops recalculation of the view 

factors. LUSAS Solver option 256. 

Overriding of thermal surface attributes between 

analyses 

The default state for a second or subsequent thermal analysis is to inherit the attribute 

assignments from the first one, but the additional analysis can 'override' some or all of those 

assignments. However the overriding of thermal surfaces relies on no overlaps between 

defining lines/surfaces so is only meaningful if they are assigned in exactly the same pattern. 

For example, in analysis 1, Thermal Surface 1 can be assigned to Surface 1 and 2, and 

Thermal Surface 2 can be assigned to Surface 3 and 4. In analysis 2 it is valid to assign 

Thermal Surface 3 to Surface 3 and 4, 'overriding' the assignment of the first analysis. But to 

assign Thermal Surface 3 to Surface 4 and 5 would cause an overlap because the state of 

Surface 4 is undefined - it cannot be a part of two different thermal surfaces. To overcome 

this the inheritance of the thermal surfaces would need to be switched off on the analysis 

definition so that the two analyses are independent. 

Loadcases 

 

A loadcase is a collection of loading types such 

as a point load, a body force, or a face load etc., 

that have been assigned to a particular analysis in 

a model using the same loadcase name. Each 

loadcase name and its loadcase dependent 

assignments (such as supports and loading) is 

held within an analysis entry the Analyses  

Treeview.  

A typical model may have many loadcases 

assigned to potentially more than one analysis. 

When each analysis is run each loadcase is 

solved and the results for each loadcase are 

provided separately. Note that nonlinear analyses 

produce results loadcases for each iteration used 

to achieve a convergent solution. Combinations 

and envelopes of loadcase results can be created 

to look at combined or maximum / minimum 

effects.  
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Analysis control parameters for eigenvalue, fourier and nonlinear and transient analyses are 

defined as properties of a loadcase using its context menu. In a nonlinear analysis, LUSAS 

loadcases may be modelling individual analysis stages and within this type of analysis the 

loading or supports can be modified between loadcases. 

Loadcase dependent attributes and results for a loadcase can only be visualised by setting that 

loadcase active. This is done by choosing the Set Active menu item from its context menu.  

Loadcases can be copied, pasted, renamed, and deleted within the Analyses  Treeview. 

Loadcases may be re-ordered using drag and drop within each analysis entry - but only when 

no results files are loaded. 

Load curves 

For analyses in which the load varies with time (or increment number) load curves may be 

used. When using load curves all loads must be assigned to a load curve instead of a loadcase. 

All other loadcase dependent attributes (support, slidelines etc.) and analysis control is 

assigned to loadcases in the usual way. The analysis control assigned to each loadcase 

determines the time over which the load is applied. The magnitude of the applied load is 

computed from the time dependent function defined within each load curve. Any number of 

loadcases and load curves may be specified within a single analysis. Each load curve is 

assumed to begin at the start of the analysis (t=0). If the input values stat from t=n the load 

curve is assumed to be zero when t<n. For more information see Load Curves. 

Creating Loadcases / Loadcurves 

New loadcases/loadcurves may be added to the Analyses  Treeview in the following ways: 

 By selecting the Analyses> Loadcase menu item. 

 By right-clicking on the Structural analyses (or Thermal Analyses) folder or the 

analysis entry and selecting the New > Loadcase... menu item. 

 By entering a loadcase name when a load attribute is assigned to a feature on a model.  

 By copying and pasting existing loadcases in the Analyses  Treeview. 

Attribute dependency across loadcases 

 Within a linear analysis, and with the exception of loading, all attributes assigned to 

the first loadcase of an analysis will apply to any additional loadcases that follow in 

that analysis. 

 For nonlinear and transient analysis many attributes may be modified on a loadcase by 

loadcase basis as the analysis progresses. An attribute assigned in a loadcase will 

remain active until it is changed. This means a support assigned in the first loadcase 

will apply to all loadcases unless it is set free in a subsequent loadcase. 
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Loadcases and supports 

 Supports defined for the first loadcase within a base analysis can be optionally 

inherited by all other analyses. 

  For a linear analysis, supports assigned to the first loadcase of the analysis will be 

used by all following loadcases within that analysis. Supports cannot be changed for 

different loadcases within a linear analysis. 

 For a nonlinear analysis, or a new time step of a transient problem, supports may only 

be reassigned on a new loadcase increment. All support assignments from previous 

increments or time steps which are not reassigned will remain unchanged. 

Adding Gravity Loading to a Structural Loadcase 

Gravity loading can be defined automatically either as a property of an analysis or loadcase, 

or manually by use of a menu item on the Bridge menu, or by specifying a constant body 

force load. The letter two require assignment of the gravity attribute to the model 

 For an analysis entry in the Analyses  Treeview select Add Gravity from its 

context menu. This effectively sets gravity loading to be 'on' for all structural 

loadcases within that Analysis regardless of whether they previously had gravity 

loading added or not. For the special case of loadcases having nonlinear controls, 

gravity loading is only added to those loadcases defined with Manual incrementation 

and not to loadcases defined with Automatic incrementation because the latter inherit 

the properties of the preceding defined Manual increment.  

 By selecting the the Automatically add gravity to this loadcase option on the dialog 

that is displayed when defining a new loadcase or when editing the properties of an 

existing loadcase. 

 By selecting the Gravity menu item from the context menu for an individual 

loadcase. 

No visualisation of gravity loading on the model is provided for gravity defined as a property 

of an analysis or a loadcase. However, the general loadcase icon will change to include a 

loading arrow symbol  to show that gravity is included for a particular loadcase.  

Gravity loading, like other loadings, cannot be inherited from a base or other analysis. 

Gravity loading is defined in accordance with the vertical axis direction that was specified 

either initially on the New Model dialog or subsequently on the Vertical Axis dialog accessed 

using the Utilities > Vertical Axis menu item.  

Analysis Control Parameters 

Analysis control parameters for certain analysis types are set as properties of a loadcase. If no 

control properties are defined, a linear elastic analysis is performed. 
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Analysis control parameters can be set to change throughout an analysis by specifying 

separate loadcases using different control parameters. Note that settings made on loadcases 

prior to solving will not necessarily correspond to post-processing load increments/time steps 

due to the use of automatic load incrementation. Analysis controls can be set for the 

following analysis types:  

 Nonlinear and Transient Used to define control parameters for nonlinear, and/or 

transient (dynamic, thermal or consolidation) analyses. Settings must be specified on 

the first loadcase if they are to be respecified on a subsequent loadcase. It is not 

possible to change between thermal and dynamic during the course of an analysis. 

 Eigenvalue Used to define natural frequency, eigenvalue buckling and stiffness 

analyses. Can be specified on any loadcase, but only once. 

 Fourier Used to define Fourier analyses. Must be used if Fourier elements have been 

used. Can only be specified on loadcase 1. 

Manipulating Loadcases 

General loadcase editing commands are available from the context menu that is activated by 

right-clicking on a loadcase the Analyses  Treeview. The following commands are 

available: 

 Set active Sets a loadcase active for viewing attributes assignments and results for the 

current window. 

 Loadcases to solve Select which loadcases to solve (if more than one are present) 

 Edit View and edit the defined loadcase information 

 Copy Copies the selected loadcase (including all defined loadcase controls for 

eigenvalue, fourier or nonlinear and transient analysis) in readiness for a paste. 

 Paste Duplicates the copied loadcase and adds it to the bottom of the relevant section 

in the Analyses  Treeview. 

 Rename Allow the loadcase title to be modified. Note that loadcases are tabulated and 

solved in the order listed within each analysis entry in the Analyses  Treeview. 

 Delete Attribute assignments must be deassigned before a loadcase can be deleted. At 

least one loadcase will always exist in the Treeview. 

 Close Results File closes the open results file for that loadcase. 

 Controls Set analysis control parameters for eigenvalue, fourier, and nonlinear and 

transient analyses.  

 Deassign Deassigns attributes from the loadcase, by choosing from a list of attribute 

types. Permits activation and deactivation of the loadcase. 

 Gravity Apply gravity as a property of the loadcase. See Adding Gravity to a 

Structural Loadcase for more information. 
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Solving loadcases 

Loadcases are solved in the order in which they are listed within each analysis entry in the 

Analyses  Treeview.  

Setting the Active Loadcase 

An important concept is the active loadcase in the current window. The active loadcase is a 

window property, and is the loadcase that all results and visualisations will be generated 

from. This speeds up the process of comparing results and visualising loads and supports as a 

different windows can be used for each loadcase. 

The active loadcase is set from the Analyses  Treeview using the Loadcase context menu. 

A loadcase icon changes from being greyed-out to coloured when made the loadcase is set 

active. When modelling, the active loadcase is denoted by a coloured loading icon. When 

results are loaded the active loadcase is denoted by a coloured contoured results icon. 

Viewing the Assignments in a Loadcase 

Loadcase dependent attribute assignments such as supports or loading are displayed in the 

Analyses  Treeview under the loadcase to which they have been assigned. The geometry to 

which an attribute has been assigned may be selected by picking Select Assignments from 

the context menu for each attribute in the Analyses  Treeview. The location or extent of an 

assigned attribute assignment may be visualised for an active loadcase by picking the 

Visualise Assignments from the context menu for that attribute in the Analyses  Treeview. 

Load Combinations or Envelopes  

Combinations and envelopes can be defined as part of the modelling process prior to carrying 

out an analysis, or as part of the post processing after carrying out an analysis. For more 

details see Combinations and Envelopes in the Viewing the Results section. 

Viewing results for loadcases 

Viewing results from the active loadcase for the current window. See Visualising the 

Results for more details. Loadcases results may be manipulated using combinations and 

envelopes, fatigue loadcases and IMD loadcases ggg 

Load Curves 

Load curves can be used to describe the variation of the loading in nonlinear, transient and 

Fourier analyses. For example, in a transient problem the loading changes with time, in a 

nonlinear problem the loading level varies with load increment and in a Fourier analysis the 

loading varies with angle. 

Load curves are used to simplify the input of load data in situations where the variation of 

load is known with respect to a certain parameter. An example of this is the dynamic response 
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of a pipe to an increase of pressure over a given period. The load curve factor would then 

consist of the variation of pressure with time. 

Creating Load Curve Entries 

New load curve entries may be added to the Analyses   Treeview in the following ways: 

 By creating a load curve from the Analyses> Load Curvemenu item. 

 By right-clicking on a Structural or Thermal analysis entry in the Analyses  

Treeview and selecting the New Load Curve menu item. 

 By copying and pasting an existing load curve in the Analyses  Treeview. 

Defining Load Curves 

A load curve is defined either using a user defined time vs factor curve, a standard sine, 

cosine or square wave curve, or a variation. 

 Time versus Factor specify values for both in a table on the load curve dialog. 

 Sine, cosine, square wave input values for amplitude, frequency and phase angle must 

be defined along with activation and termination points. 

 Variation A line interpolation variation may be defined from the Utilities> 

Variation> Line menu item. The dependent variable in the variation will represent 

time (or increment number) depending on the type of analysis. The value of the 

variation will be the factor by which to scale the values in the assigned loading 

attribute.  

Scaling in the form of activation and termination points for the curve, and a scale factor can 

also be specified. 

Load curves scale all loads assigned to them. Therefore, if loads have a different variation of 

load factor with time, several load curves should be used. 

Manipulating Load Curves 

General load curve editing commands are available from the context menu that is activated by 

right-clicking on a  load curve entry in the Analyses  Treeview. The following 

commands are available: 

 Copy Copies the selected load curve (including all defined load curve data) in 

readiness for a paste. 

 Paste Duplicates the copied load curve and adds it beneath any current load curves in 

the Analyses  Treeview. 

 Delete Deletes a load curve. Attribute assignments must be deassigned before a 

loadcase can be deleted. At least one loadcase will always exist in the Treeview. 

 Rename modifies the load curve name. 

 Edit changes previously entered load curve data. 
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Notes 

 Load curves are only applicable to nonlinear, transient and Fourier analyses. 

 When defining load curves for transient (or nonlinear) analyses the time in all load 

curves must be defined from the start of the analysis. 

 For Fourier analysis the load must only be applied over an angular range of 0 to 360 

degrees. 

 If the interpolation variable doesn't lie within that specified within the load curve a 

zero load factor will be applied. 

 Only line variations with distance type Actual can be used for defining load curves. 

 Time-based values are based upon currently set timescale units. 

Evaluating a Load Curve 

Load curves (and variations) may be viewed using the Graph Wizard. 

  

Case Study. Pressurisation of Two Tanks with Multiple Load Curves 

Two tanks are to be pressurised at different stages of a nonlinear dynamic analysis. This will 

be achieved using two different loadcases and two load curves to vary the loads individually. 

The following procedure outlines the steps required: 

1. Use the Utilities> Load Curve menu item to define two user defined load curves 

which give the correct pressure variation with time. Note that the time is always from 

the start of the analysis. 

2. Use the Attributes> Loading> 

Structural menu item to define a face 

load attribute containing a unit 

pressure load. Note that the pressure 

value in the load definition will be 

multiplied by the load factor used on 

the load curve associated with it. 

3. Assign the face load to the features in 

the model, selecting the appropriate 

load curves for each tank. The 

accompanying diagram shows a 

schematic of the tanks under internal 

pressure with their corresponding force 

versus time graphs. 

4. To set the size and number of time steps right click on Loadcase 1 and choose 
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Controls> from the context menu. Pick Nonlinear and Transient and on the dialog 

switch on the Time Domain option and choose Implicit Dynamics from the combo. 

Set the initial time step and response time as required.  

Notes 

Supports should be assigned to the loadcase. If the support conditions are to be modified part 

way through the analysis the response time in the Nonlinear and Transient control should be 

set to terminate at the time the supports are to be modified and a second loadcase should be 

created to which the modified supports are assigned. A Nonlinear and Transient control 

should be then set on this loadcase which terminates at the end of the analysis or when a 

future support is to be modified. 
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Chapter 6 : Utilities 

  

Model Utilities 

Model utilities differ from model attributes in that they are not intended for assignment to the 

model geometry or mesh objects. A utility, however, may be used in the definition of model 

geometry or attributes, or to control an analysis, or to provide a particular functionality, such 

as to define a load combination or produce a report for example. 

Details of the features and use of many of the utilities listed below are provided in other 

relevant chapters of the manual. Annotation utilities, for example, are described in the 

Chapter 2: Using Modeller in the Annotating the Model section. The remainder are described 

in this chapter. 

Some Utilities create entries in the Utilities  Treeview. 

The complete list of LUSAS utilities (accessed from the Utilities menu) is shown below. 

 Mesh - mesh node measurement, the controlling of automatic remeshing. and saving a 

deformed mesh for re-use in a new analysis 

 Annotation - adding of text, line, bitmap and border annotation to the view window 

 Transformation - moving, mirroring and copying of geometry 

 Heat transfer - specification of thermal gap properties and radiation surfaces 

 Variation- ways of varying attributes over features  

 Reference Path - defines a route through the model that provides a concept of 

distance for positioning multiple varying sections or applying vehicle load patterns. 

 Objects to drape - for use with Composites or High Precision Moulding 

 IMDPlus - the investigation of various dynamic responses using the results from an 

eigenvalue analysis 

 DesignFactors - assess the reserve strength capacity of a component or structure 

 Set Fourier Angle - specify the angle around the circumference at which Fourier 

results are required 

 Background Grids - grade the mesh pattern locally when irregular surface meshing 

 Graph Wizard - plot results on x,y graphs 

 Animation Wizard - animate the mode shapes or load history of a structure 

 Section Through 3D - slice a solid model and plot results on the section defined 

 Slice Resultants Beams/Shells - etc 
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 Graph Through 2D - slice a model and plot a graph based upon the intersection of 

the elements sliced.   

 Print  Results Wizard - printing of selected results to a grid or a file. 

 User Defined Results - create results components from user-defined expressions 

 Vertical - Axis - sets the model X, Y,or Z direction to be the vertical axis. 

 Direction Definition - sets the vertical, longitudinal and transverse axes for a model to 

assist with model orientation and calculation of particular effects 

 Renumber All - renumbering of Nodes and Elements, and Point, Line, Surface and 

Volume geometry features for all of a model.  

 Renumber Selection - renumbering of Nodes and Elements, and Point, Line, Surface 

and Volume geometry features for selected parts of a model.  

 Library Management - specify library locations and add and delete basic section data 

from a library 

 Section Property Calculation - calculate cross sectional geometric properties for a 

range of sections 

 Report Generation - build reports containing model and results data and images from 

your model 

Some utilities menu items, for example Heat transfer, are only listed if the appropriate user 

interface is in use. 

Utilities can be transferred between models. See Transferring Data Between Models. 

Variations 

Variations allow parameters in attributes to be varied over the assigned geometry by defining 

the manner in which the parameter will vary. If a variation is not specified, the parameters 

within an attribute will be constant over the geometry to which the attribute is assigned.  

Note that geometric section property variations along a beam are best defined using tapering 

or multiple varying section facilities. See Geometric Properties and Multiple Varying 

Sections - Types and methods of assignment for more details. 

The different types of variation are available are: 

 Field allowing variations to be defined in terms of the global Cartesian coordinate 

system variables. This form of variation can be used for hydrostatic and wind loading 

and is applicable to all feature types except Points. Variations on volumes are limited 

to field variations. 

 Interpolation variations may be applied to Lines and Surfaces. The variation is 

defined by interpolating between values at specified local distances. The order of the 

interpolation may be specified as constant, linear, quadratic and smoothed (cubic) in 

either actual (local) or parametric distance. 

 Function variations are expressed as symbolic functions in terms of the parametric 

coordinates of a feature. They can be applied to Lines and Surfaces. For Lines, the 

parametric distance is the distance along the Line (u), and for a Surface the distances 

are the local parametric u and v coordinates. 
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 Boundary defines values by specifying variations around the Surface boundary Lines.  

 Grid defines a grid of values in Surface local x and y directions.  

Defining and Using Variations 

Variations are defined from the Utilities menu and are presented in the Utilities  Treeview. 

Once defined, a variation is used by clicking on the additional input button   in the 

appropriate edit box on the attribute dialogs. This allows each parameter within a single 

attribute to be varied independently. 

Variations can also be defined from inside dialogs that support the use of the variations 

facility by selecting the New... entry on the drop-down list displayed for the Select a 

Variation Attribute dialog. 

Notes 

 It is possible to vary all load types except General Point and Patch loads and Internal 

Beam Point and Internal Beam Distributed loads, which incorporate variable loading 

implicitly in their definition. Values of loads which are applied to elements will be 

evaluated at the element centroid.  

 Geometric attributes containing a variation are tabulated as multiple geometric 

properties. An additional parameter is added to the assignment to relate to the original 

defining attribute number for use in post-processing. 

 To vary geometric properties along bar or beam elements use the geometric beam 

tapering facility.  

 Variations in materials are limited to elastic material values and certain joint 

properties. Attributes containing a variation are tabulated as multiple material 

properties containing the material value calculated at the element centroid. An 

additional parameter is tabulated to the assignment data chapter in the data file to 

relate to the original defining attribute number for use in post-processing.  

 When defining supports the spring stiffness values can be varied but the spring 

stiffness values are not scaled when drawn in post-processing . 

 Checking of the assigned variations can be carried out by contouring the assigned data 

using an unsmoothed contour display. 

 Variations of the Rayleigh parameters cannot be contoured as they are calculated at 

element centroid positions. 

Field Variations 

Field variations allow a variation according to a mathematical expression in terms of 

coordinate variables in either the global Cartesian or a specified local coordinate. 

Coordinates may be Cartesian, cylindrical or spherical. The expression may be cutoff if 

desired. 

Field variations are applicable to all Lines, Surfaces and Volumes. The value of the variation 

at any position on the structure will be calculated by substituting the values of the coordinate 

variables at that position. 
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A field variation is defined by specifying a field expression and an optional local coordinate 

which will be used to specify a coordinate system other than the global Cartesian set. 

These examples show field 

variations expressed in terms of the 

global X coordinate displayed 

along a Line parallel to the global 

X axis. The typical field 

expressions used are shown in the 

boxes next to each diagram. 

For example, a field expression in 

Cartesian coordinates would 

typically be: 

-9.81*y 

and in cylindrical coordinates: 

10+r*tan(thetaz) 

Coordinate Systems in Field Variations 

The functions available in the definition of 

field expressions are listed below. The 

variables used in field expressions are 

limited to those used in the LPI language 

plus the Cartesian, cylindrical and spherical 

coordinate variable names. The coordinate 

variable names that should be used in a field 

expression are dependent on the type of 

coordinate systems in use. Definitions are 

given in the tables below.  

In this example, a field expression referring 

to the global axis coordinates (XY), is also 

used with a local coordinate axis set (indicated by xy) to create a variation relative to a rotated 

system. Cylindrical and spherical axis sets can also be used. 
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Variables 

Cartesian (global/local) Z Cylindrical (local) Z Spherical (local) 

x X ordinate r Radial distance r Radial 
distance 

y Y ordinate thetaz Angle about axis of cylinder thetaz Angle about z 
axis 

z Z ordinate z Distance along cylinder 
longitudinal axis 

thetac Second angle 

Operators 

+  -  *  /  ^ 

Functions 

Trigonometric functions Radians Degrees 

Sine of angle sin(angle) sind(angle) 

Cosine of angle cos(angle) cosd(angle) 

Tangent of angle tan(angle) tand(angle) 

Arcsine of a asin(a) asind(a) 

Arccosine of a acos(a) acosd(a) 

Arctangent of a atan(a) atand(a) 

Arctangent of the specified x- and y-coordinates. atan2(x,y)   

hyperbolic sine of a sinh(a)   

hyperbolic cosine of a cosh(a)   

hyperbolic tangent of a tanh(a)   

  

Function return value   

e raised to the power of a. The constant e equals 2.71828182845904, the base of the natural 
logarithm. 

exp(a) 

natural logarithm of a  log(a) 

logarithm of a to base 10 log10(a) 

square root of a sqrt(a) 

a rounded up, away from zero, to the nearest integer ceil(a) 

a rounded down, towards zero, to the nearest integer floor(a) 

absolute value of a  abs(a) 

maximum value of a and b max(a,b) 

minimum value of a and b min(a,b) 
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Function return value   

x to power y pow(x,y) 

remainder of a/b mod(a,b) 

  

Cylindrical and spherical field variation expressions can use radians (default) or degrees to 

specify angles. If trigonometric functions are used in a field expression, they will dictate what 

angular measure is used. For example, a function will use degrees if degree-based 

trigonometric functions, such as sind, cosd and tand are used.  

Notes 

 An expression may not mix radian and degree functions.  

 Any angle cut-off values will use the same units as the expression. 

Maximum and Minimum Cut-Off Values 

Maximum and minimum cut-off values 

may be specified for the chosen 

coordinate system. This allows the 

range of application of load to be 

limited, such as would be necessary to 

model a structure not wholly submerged 

in water. These examples (right) show 

field variations in terms of the global X 

ordinate displayed along a Line parallel 

to the global X axis. The typical field 

expressions used are shown in the boxes 

next to each diagram. All expressions 

are subject to a cut-off in minimum and 

maximum X at parametric distances of 

0.25 and 0.75 respectively. 

The example above shows a variation in terms of the global Z axis ordinate with minimum 

and maximum cut-offs at specified Z ordinate values. 

 

Case Study. Applying Hydrostatic Loading 

A hydrostatic loading may be modelled using a combination of a field variation and a 

Structural Face Loading. The loading can be considered to be dependent on the depth varying 

as: water density*g*(h-y) where g is the acceleration due to gravity, h is the height of the 

water above the structure origin and y is the height of the structure. Use the following 

procedure: 
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1. Define a simple 100 unit square Surface using the 

Geometry> Surface> By Coordinates menu item and 

entering the following coordinates (0,0,0), (100,0,0), 

(100,100,0) and (0,100,0).  

2. Define a simple thin shell mesh using the Attributes> 

Mesh> Surface menu item and Assign the mesh to the 

Surface. 

3. Define a field variation using the Utilities> Variation> 

Field menu item and specify a function of 

density*g*(h-y), where density is the water density 

(1000), g is acceleration due to gravity (9.81), h is the maximum height of the water 

above the structure origin (80) and y is the global Cartesian y ordinate. This will apply 

a hydrostatic loading down the depth of the Surface (global y axis). Enter 

1000*9.81*(80-y) on the dialog.  

4. To model a water depth of 80 (and to avoid negative loading above the surface of the 

water), select a Cut-off in Maximum y at 80. Click on the Advanced button and set 

the maximum second coordinate to 80. Click the OK button. 

5. Name the variation Hydrostatic variation. Click the OK button. 

6. Using Attributes> Loading> Structural menu item, define a Local Distributed load 

entering the Z component as 1, notice that in doing so the additional input button   

appears. Click on the button and select the variation Hydrostatic variation. This will 

factor a negative unit load using the variation defined in 1. Type Water load as the 

attribute title. Click the OK button. Assign the loading to the Surface. 

7. The applied loading with the variation is visualised as arrows on the model. Use 

dynamic rotate  to get a 3D view of the surface. If the load is not visualised, select 

the load attribute in the Treeview , right-click and choose Visualise from the 

context menu. Note. Visualising attribute assignment requires that the model is 

meshed. 

Line Interpolation Variations 

Line interpolation variations allow values to be varied along a line at any number of 

distances. The distances may be equally or unequally spaced and the interpolation order my 

be constant, line, quadratic or smoothed (cubic). Line interpolation variations are defined 

from the Utilities> Variations> Line menu item and selecting Type Interpolation. 

 By Equal Distances defines values at equal distances along a Line. The actual value 

used will be interpolated at the appropriate distance between these values using the 

interpolation method specified. 
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 By Unequal Distances defines values at specified distances along a Line. The 

distances can be entered as actual or parametric values. The actual value used will be 

interpolated at the appropriate distance between these values using the interpolation 

method specified. 

The unequal distance examples below show user distances specified by actual or 

parametric values (indicated in square brackets) with a corresponding interpolation 

value at each position. Repeating a distance and specifying an additional associated 

interpolation value will allow a discontinuity in the variation to be defined.  
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Linear variations require a minimum of two values. Quadratic variations require a 

minimum of three values and Smoothed (cubic) variations require a minimum of four 

values to be specified. Where more values are specified multiple interpolation 

functions are used. i.e. if three values are specified for a linear variation, two straight 

line interpolations are used. 

Line Function Variations 

A Line function variation defines a variation by a series of functions specified at distances 

along a Line. The function is specified in terms of the parametric or actual coordinate along 

the Line. The interpolated value of the variation at any position along the Line is calculated 

by finding the interval in which the position occurs and then substituting the parametric or 

local distance into the function. Line function variations are defined from the Utilities> 

Variations> Line menu item and selecting Type Function. 

  

 By Equal Distances [in u] defines 

functions in terms of u, the 

parametric distance along the Line. In 

this example, the Line is split into a 

specified number of distances, each 

with an associated function. 

 By Unequal Distances [in u] defines 

a series of parametric or actual 

distances, and a set of functions. The 

distance specified is the starting 

position for the function associated with it. Each distance must have an associated 

function specified. To enter a maximum cut-off position, associate a zero function 

with it. In this example, a parametric distance of 0 is associated with the value 0.0, a 

parametric distance of 0.33 is associated with u**2 and a parametric distance of 0.92 

is associated with the value 2.0 

Surface Variations 

On Surfaces, interpolation may be defined using a grid of values or a set of line variations 

applied to the boundary Lines. For interpolation by grid the interpolation order may be 

constant, linear, quadratic or smoothed (cubic). 

 Surface By Grid defines a grid of values in Surface local x and y directions. Surface 

grid interpolation can only be used on 3 and 4 sided Surfaces.  
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 Quadratic vs Constant Surface 

variation 

The quadratic variation in the local x 

direction is specified with three 

interpolation points. The constant 

variation in the local y direction requires 

no additional points. A total of three 

values are required. 

 Smoothed (Cubic) vs. Linear Surface 

grid variation 

The local x direction takes a smoothed 

(cubic) variation defined with four 

interpolation points and the local y 

direction takes a linear variation using 

three interpolation points. A total of 

twelve values are required. 

 Surface By Boundary defines values by specifying variations around the Surface 

boundary Lines. A variation must be specified for each Line in the Surface definition. 

If no variation is required along a Line, a constant order variation must be specified. 

Care must be taken to ensure that values at common points are common to both 

variations meeting at that point otherwise an error will occur. Variations are defined in 

the same direction on opposite sides of the Surface (see the following example) and 

use the Line order in the Surface definition on which to base the variation direction. 

Individual Line directions have no effect on variation directions. 

 Surface boundary interpolation using three Line interpolation variations. 

A discontinuous Line interpolation (1) is 

specified for first and third Lines using a 

Line by unequal distance variation. 

 

Note that the Line axes drawn here 

dictate the variation directions and the 

line directions on opposite sides of a 

surface must match as shown. Variations 

are applied in a positive surface normal 

direction. 

 

The second and fourth Lines in the Surface definition use constant interpolation 

variations. The variation sense is denoted by double and single arrows shown on 

boundary Lines. The variation along the local x axis (signified by the double arrow) is 

specified first. The Surface variation in this case is 1;3;1;2. 
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Surface Function Variations 

A Surface function variation consists of a single function 

in terms of the parametric coordinates of the Surface u 

and v. The value of the variation at any point on the 

Surface is given by finding the parametric coordinates of 

the point within the Surface and substituting them into 

the specified function. Surface function variations are 

only allowed for 3 and 4 sided Surfaces. 

The example shown here defines a variation using the 

function max(4,10*u) in terms of the local Surface x 

direction parametric distance. The max function takes two arguments and returns the 

maximum of both arguments. In this case, 4 is the maximum value until u exceeds 0.4. 

Plotting Graphs of Line & Field Variations 

Line and Field variations can be evaluated along a 

specified Line and displayed using the Graph 

Wizard from the Utilities menu and Line variations 

can be evaluated alone. The number of points at 

which to sample the variation can be specified. A 

factor may be applied to the variation values before 

the ordinates are calculated. This example 

demonstrates the graphical visualisation of a 

discontinuous Line interpolation variation. 

Reference paths 

A reference path defines the direction of a single line, or route that a series of lines take in a 

model, that can be used to provide a concept of distance to other points in a model. Reference 

paths are currently used for the following aspects of modelling, analysis and results 

processing: 

 Modelling of multiple varying sections For line beam models, and grid or grillage 

models where longitudinal and transverse beams are modelled with individual grillage 

or line beam elements a reference path can be used in the definition of a varying 

section, such that when the section is assigned to a set or series of lines, the path is 

used to interpret which part of the defined varying section is appropriate to each line. 

 Direct Method Influence Analysis Reference paths can be optionally used in the 

definition of a direct method influence attribute (where for grillages they aid in the 

calculation of influences for longitudinal and transverse members), and also in the 

definition of a loading grid that can be used as an alternative to using the nodes or 

points present in the model for an influence analysis.  
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 Results Transformation Specification of a reference path provides an easy way of 

transforming results relative to the angle or route of the defined path. 

 Any number of reference paths can be created within a model. Once created, the data that 

defines each path can be viewed in the Utilities  Treeview. Like other utilities, paths are 

not directly assignable to geometry and can only be edited by editing their properties via their 

context menu. 

Defining paths 

Paths are created by using the Utilities> Reference Path menu item. They can be defined by 

 By defining and selecting lines, arcs and splines in LUSAS Modeller (the most 

commonly used method). 

 Specifying the coordinates of each point defining a line/arc in a table 

 Importing geometry and line segment information from a spreadsheet. 

A reference path can be defined as a line between two points (if a straight path is to be 

considered), an arc between three points (if a simple curved path is to be considered), or be 

created from as many consecutive lines and/or arcs as necessary. Paths can be created either 

separate from model geometry, or make use of it in the definition by selecting the line (or 

lines) defining a path prior to selecting the menu item. It is important to remember that whilst 

model geometry may be used to arrive at the points required to generate a reference path, no 

connection between the model geometry and reference path data exists. 

Reference paths are usually defined to be along and coincident with beam lines. For clarity it 

is also possible to define reference paths away from beam lines but if the beam lines are not 

straight (perhaps they curve on plan) the path should be defined above the beam lines rather 

than be defined in the same horizontal plane. 

The way that two adjacent and intersecting reference path lines will be shaped can be 

controlled by smoothing which involves adding a radius transition between two lines inside of 

their defined intersection point or adding a radius transition between two lines through their 

defined intersection point. 

Transverse direction settings control how line attributes containing multiple varying sections 

are assigned to more than one set of lines when using the same common reference path. One 

example of use is for straight or skewed grid or grillage line beam models. For this type of 

modelling a single reference path can be used in conjunction with a transition setting to offset 

multiple tapering section line attributes appropriately for each longitudinal beam member.  

A 'Value of distance at start of path' can be used specify the local x value at which the path 

should begin. For bridge engineering this would equate to specifying a chainage value for a 

known point at the 'start' of the structure. This value is added to the distance value that can be 

displayed for each of the points defining the path. 
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Deleting paths 

Defined reference paths can be viewed in the Utilities  Treeview. A reference path can be 

deleted from this location by using the Delete option on its context menu, but only if the path 

is not used in the definition of any other modelling attributes that are present in the Attributes 

 Treeview, or in the definition of a Direct Method Influence Analysis. 

Reference paths for use in modelling multiple varying 

sections 

3D line beam models 

For 3D line beam models consisting of multiple longitudinal lines a reference path can be 

used. This allows one multiple varying section geometric line attribute to be assigned to 

multiple lines. The number of line beams required to model the changing section depends 

upon whether a staged construction analysis will be carried out. For the creation of simple 

models it is possible to assign a multiple varying section line attribute to a single line beam 

without the use of a reference path but for staged construction analysis (where individual 

lines need to be activated and deactivated) the multiple varying section line attribute can be 

assigned to multiple lines with reference to an associated path. See Distance types and 

methods of assignment for more information. 

 
Reference path showing multiple line beams assigned a single multiple varying section 

 (for clarity beam lines have been visualised at top of section) 

3D grid/grillage-type models 

For grid/grillage models, longitudinal beams are comprised of separate line beams often 

grouped together (for ease of manipulation and assignment of properties etc). Because the 

actual profile of the set of grouped members as a whole may vary along the longitudinal 

beam's length a reference path is used to control the assignment of a multiple varying section 
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line attribute to the set of lines. When assigning a geometric line attribute the following 

transverse direction settings are available: 

 Perpendicular to path - the plane of constant distance is normal to the path tangent in 

both local y and z directions 

 Skew angle - is defined as the horizontal angle between the orthogonal plane and the 

plane of equal distance. 

 Local coordinate - as skew angle, but where the skew angle is read from an existing 

local coordinate system. 

  

Perpendicular Skew angle to path  

  

 Local coordinate 

Reference paths for Direct Method Influence Analysis 

See Direct Method Influence Attributes 

Reference paths for Results Transformation 

See Results Transformation 

Visualisation of reference paths 

By default, reference paths are drawn in red and direction arrows at mid-points along each 

line segment, show the direction of the path. Each path entry in the Utilities  Treeview has 

a context menu enabling the following selections: 
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 Rename changes the path name 

 Delete removes the path entry from the Utilities treeview but the menu item is only 

available if a path has not been associated with a geometric line assignment. 

 Edit Path displays the path definition dialog to enable changes to be made 

 Create geometry converts the path into points, lines, arcs and splines in the Geometry 

layer. 

 Visible turns the display of the reference path on, if off. 

 Invisible turns the display of the reference path off, if on. 

 Visualise at points labels the points defining the path with absolute distances along 

the path. This also labels other lines in the model to show what would happen if the 

path were associated with those lines. See below for examples. 

Visualisation of reference path at points on the model 

The reference path context menu option Visualise at points shows the value of the reference 

path distance for other points in the model. It helps to show the validity of using the reference 

path for other lines in the model and in cases where path labels drawn on these other points 

did not match those of the reference path it would, for some situations, draw attention to an 

invalid transverse direction settings being used.  

  
Perpendicular (orthogonal) grid/grillage Skewed grid/grillage 

Examples of valid reference path points visualised on the model  

Vertical axis 

The vertical axis dialog is accessed from the Utilities> Vertical Axis menu item. The vertical 

axis setting specifies whether the model X, Y,or Z direction is to be used as the vertical axis. 

It: 

 Defines the initial vertical axis and orientation of element types and section library 

items as visualised on the Geometric Line dialog prior to them being added to a model. 

 Defines the model orientation that is viewed when using the isometric, dimetric and 

trimetric views.  

 Determines the direction that gravity loading will be applied if it has been specified as 

a property of a loadcase. 
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 Determines the direction that gravity loading will be applied if added using the Bridge 

> Bridge Loading > Gravity or theCivil > Gravity menu item.  

 Note that setting the vertical axis on the Vertical axis dialog will supercede any vertical axis 

setting defined on the Direction definition dialog. 

 Direction Definition 

Specifying a direction definition sets the vertical, longitudinal and transverse axes for a model 

to assist with model orientation and the calculation of particular effects. The Direction 

definition dialog is accessed from the Utilities> Direction Definition menu item. The options 

are: 

Vertical 

 Global axis  This determines the direction that gravity loading will be applied if added 

using the Bridge > or Civil > Gravity menu item. It also defines the initial vertical 

axis and orientation of element types and library items as displayed on the Geometric 

Line dialog prior to them being added to a model. It also defines the model orientation 

viewed when using the isometric, dimetric and trimetric views.  

Note that setting the vertical axis on the Direction definition dialog will supercede any 

vertical axis setting defined on the Vertical Axis dialog. 

Longitudinal  

 Global axis For the majority of models this will simply be the global X-axis. However 

LUSAS allows generic input of any direction which may even be a complex path 

through or along a structure, such as that defined by a set of lines forming a continuous 

path. 

 Local axis Use a local coordinate set to define the direction. An example of use is for 

aligning influence attributes along a singly curved bridge deck. 

 Follow line path If a path of lines is to be used, selecting the lines to be used prior to 

selecting Utilities > Direction definition will cause the correct line path definition to 

be automatically inserted into the line path field. An example of use is for ensuring 

correct alignment of influence attributes along all spans of a bridge deck when those 

spans are formed of multiple straight lines, arcs or any combined sequence of these 

two feature types in order to describe the carriageway shape. 

Note that a longitudinal direction definition must always be correctly defined for an influence 

analysis. 

Transverse  

This is assumed to be orthogonal to both longitudinal and vertical directions. This is currently 

only used for an influence analysis.  



  Chapter 6 

    

339 

Renumbering 

By using Utilities > Renumber All... or Utilities > Renumber Selection... renumbering of 

Nodes and Elements, and Point, Line, Surface and Volume geometry features (referred to 

collectively as 'objects' in this topic) can be carried out for all, or selected parts of a model. 

Renumbering can be done by specifying numerical increments with respect to either global 

axis directions or reference paths.  

To visualise node, element and geometry numbers/names add the Labels layer to the Layers 

 Treeview, choosing the object names to be displayed. 

Renumbering options 

When Renumber All is chosen the following two options are seen: 

 Auto renumber using these settings when re-meshing If checked, renumbering of 

all nodes and/or elements in a model will take place according to the settings made on 

the dialog after remeshing is requested. If not checked, renumbering of all nodes 

and/or elements in a model will take place according to the default Global direction 

settings after remeshing. Autorenumbering is always checked 'on' by default when a 

new model is created. This status is shown by a tick on the Renumber All menu item. 

 Renumber now applies the renumbering straightway once the Apply or OK buttons 

are pressed. 

The ability to check (turn-on), or not check (turn-off) either of these two options results in 

either one, both or neither being applied. When both are checked both actions that are 

described above take place. When both a re unchecked, auto-renumbering is turned-off, as 

subsequently shown by a greyed-out tick on Renumber All menu item. 

When Renumber Selection is chosen only the following option is seen: 

 Preserve numbering in other parts of the model (for Renumber Selection menu 

item) If checked, renumbering of only selected objects will take place according to the 

settings chosen on the Renumber Selection dialog with all other objects retaining their 

current number. If not checked, numbers used in the re-numbering of the selected 

objects may use numbers from other parts of the model, and these in turn will then also 

be re-numbered with previously unused numbers. 

Global direction method 

Renumbering of objects using the global direction method is carried out with respect to the 

three model view axes. Positive and negative numbering directions can be stated. The 

incremental value defines the interval between the numbers assigned to each object within 

each specified direction. 

To help understand the effect of choosing certain renumbering settings note how Modeller 

evaluates a model prior to carrying out a renumbering operation for selected objects.  
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1. For the first global axis direction specified, (a positive Z-axis by default), Modeller 

sweeps through the model in that direction locating all and any objects of equal 

distance along that axis.  

2. For those objects that it finds, Modeller then sweeps along the second global axis 

specified, (a positive Y-axis by default) locating all and any objects of equal distance 

along that axis.  

3. For the objects that it finds Modeller then sweeps along the third global axis specified, 

(a positive X-axis by default) locating all and any objects of equal distance along that 

axis. 

Once a set of objects has been assembled, renumbering of objects then takes place using the 

starting values and specified increments for each axis, but in the reverse order to the axis 

order chosen. So, for the default settings stated above, renumbering would start and increment 

along the X axis first, then along the Y axis, and then along the Z axis. 

Reference path method 

Renumbering of objects using reference paths uses longitudinal, transverse and vertical 

reference axes in place of the named model axes of the Global direction method. Positive and 

negative renumbering directions can be stated for each direction considered. The incremental 

value defines the interval between the numbers assigned to each object within each specified 

direction. 

The reference path method requires specifying longitudinal, transverse and vertical directions 

and requires specifying positive and negative renumbering directions that may not be initially 

obvious: 

1. For a defined and selected reference path, the positive longitudinal direction is 

measured along the path, in the direction that the path was defined.  

2. The transverse direction is measured orthogonally to the longitudinal direction and the 

vertical direction. 

3. The vertical direction is orthogonal to the longitudinal direction and the plane 

described by the longitudinal direction and the global vertical direction. 

Once a set of objects has been assembled renumbering of objects then takes place using the 

starting values and specified increments for each axis, but in the reverse order to the axis 

order chosen. 

Notes 

 Points and Nodes are located by their coordinates 

 2D Elements and Lines are located by the coordinates of their mid-points. 

 2D Surfaces, 3D Elements and Volumes are located by the coordinates of their 

centroids. 
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 The renumbering facility can renumber all or just selected objects but the renumbering 

strategy defined is applied separately to each object type. For instance, renumbering a 

selection of nodes and elements with a starting value of 1 and an increment of 2 will 

result in a renumbering sequence of node 1, element 1, node 3, element 3 etc. If 

different renumbering patterns are required these should be carried out by restricting 

the type of object selected and carrying out successive individual renumbering passes 

through the model. 

 Auto renumbering is only applied to nodes and elements. If the model has no mesh, 

the auto renumbering option is disabled. 

 Use of the Utilities> Mesh Reset menu item and other remeshing events will cause 

any nodes and elements to revert to their initial numbering, or to a re-numbering 

scheme as specified on the Renumber dialog if the 'Auto renumber using these settings 

when re-meshing' check box has been checked. 

 For models created prior to Version 15 auto renumbering is turned off by default.  

Renumbering examples 

In these examples note that for 2D models created in the XY plane, the Z axis direction is 

redundant and no incrementation settings in the Z axis are applied. The same would be true 

for models drawn in other planes with other redundant axes. Similarly, when selecting a 

single row of objects for renumbering (as in the case of the Simple line beam bridge example 

that is shown) the second and third global directions are effectively redundant. 

Simple node and element renumbering 

Nodes and element numbers in a 2D surface mesh are renumbered using 

Utilities> Renumber All 

  

Before: All nodes and elements numbered  

using global directions.  

Start value=1, Positive Z-axis, increment 1, Positive Y-axis, 

increment 1, Positive X axis, increment 1 (Default 

numbering method) 

After: All nodes and elements renumbered  

using global directions.  

Start value=1, Positive Y-axis, increment 10, Positive X 

axis, increment 1, Positive Z axis, increment 1 - is not used. 
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Simple multi-storey building frame 

Surfaces are re-numbered in a 3D model using Utilities> Renumber All 

  
 

Before: All surfaces numbered  

using global directions.  

Start value=1, First: Positive Z-axis, increment 1, Second: 

Positive Y-axis, increment 1, Third: Positive X axis, 

increment 1 (Default numbering method) 

 

After: All surfaces renumbered  

using global directions.  

Start value=1 , First: Positive Z-axis, increment 100, 

Second: Positive Y-axis, increment 10, Third: Positive X 

axis, increment 1 

Simple line beam bridge 

Lines are renumbered in a 2D line model using Utilities> Renumber Selection. 

  

 
 

Before: All lines numbered as drawn. Three separate renumbering selections shown. 
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After: Renumbered using three steps as follows: 

Step 1: Lines 3 and 4 selected (on Before model) and renumbered using Global direction, Start value=1 , Positive Y-

axis.  

Step 2: Line 9 and 10 selected (on Before model) and renumbered Global direction, Start value=3 , Positive Y-axis, 

preserving numbering in other parts of model.  

Step 3: Remaining lines (Lines 1 to 14 on Before model) selected and renumbered using Global direction, Start value=5 

, Positive X-axis, preserving numbering in other parts of model. 

Skewed slab 

Lines are renumbered in a 2D line model with respect to a reference path and a skew angle 

using Utilities> Renumber All. 

 
 

Before: All lines numbered as drawn. Reference path defined along lines L2, L5 and L13  



Modeller Reference Manual   

    

344 

 
 

After: All lines renumbered along and transverse to reference path.  

Start value=1 , First: Positive vertical axis, increment 1, Second: Positive transverse axis, increment 10, Third: Positive 

longitudinal axis, increment 1 

Curved path 

Lines are renumbered in a 2D line model with respect to a reference path using Utilities> 

Renumber All. 

 
Before: All lines numbered as drawn. Reference path defined along lines L10, L5, L8, L7 and L6  
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After: All lines renumbered along and transverse to reference path.  

Start value=1 , First: Positive transverse axis, increment 10, Second: Positive longitudinal axis, increment 1, Third: 

Positive vertical axis, increment 1 - is not used. 

  

Section Property Calculation 

Cross-sectional geometric properties (for use with line beam models) can be calculated for: 

 Standard sections - a range of commonly used section shapes 

 Arbitrary sections - any user-defined cross-sections, with and without internal voids, 

that are drawn in LUSAS Modeller 

 Precast beam sections with and without a concrete slab. 

 Box sections for both simple and complex box sections, with and without an internal 

void.   

Standard Section Property Calculator 

Standard section property calculators are accessed from the Utilities> Section Property 

Calculator menu item. The following sections are supported: 

 Rectangular solid section - equal and unequal thickness 

 Rectangular hollow section - equal and unequal flange / web thicknesses 

 Circular solid section 

 Circular hollow section 

 I section - equal and unequal flanges, haunch section 

 T section 

 L section - single and double (back to back) 
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 C section - lipped, unlipped, double (back to back), double (face to face), top hat 

 Z section - lipped right-angle, lipped inclined, unlipped 

 

 

Typical standard section property calculator dialog Section visualisation showing fibre locations 

Section properties for standard cross-sections are computed instantaneously once valid user-

defined dimensional data has been entered. The resulting section can be optionally visualised 

to verify the section shape created, and to view the automatically defined fibre locations (used 

when plotting stresses on fleshed beams). The section can also be optionally converted into 

model geometry and used as a base for further modification in some way inside LUSAS 

Modeller before re-calculating the new section properties of the edited section using an 

Arbitrary Section Property Calculator. Sections can be added to a local library (model folder 

specific) or a server library (typically computer specific) for use on the current project, or for 

re-use across other projects respectively. 

Note that standard section property calculators for standard sections (such as rectangular, 

circular, L-sections, T-sections etc) and for box sections (both simple and complex), do not 

currently calculate the additional section properties required for use with design calculations. 

Instead, after defining a section shape, the Create geometry button should be used to draw 

the section prior to using the arbitrary section property calculator to calculate the full set of 

section properties for the shape. Note that the additional properties required for design 

calculations are not required for a general analysis to be carried out. 

Using standard sections 

To use the computed section properties in a model the section must be saved to a local or 

server library. To add a library item to the Attributes  Treeview select the Attributes> 

Geometric> Section Library menu item, then select User Sections, then select Local or 

Server before choosing the section required from the list available. The section can then be  

assigned to the required Line(s) in the model. 
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Arbitrary Section Property Calculator 

The arbitrary section property calculator is accessed from the Utilities> Section Property 

Calculator> Arbitrary Section menu item. It computes section properties (area, moments of 

inertia and torsion constant etc.) of any open or closed section of similar (homogenous) 

material, or of a compound section made of two or more materials, and calculates extreme 

fibre positions for use when plotting stresses on fleshed beams.  

The arbitrary section property calculator should generally be used in preference to manually 

defining geometric line property data since cross-sectional shapes, as used by the fleshing 

facility, and fibre locations are automatically calculated and stored as part of the section 

property calculation. 

Defining cross-sections 

Cross-sections must be defined in the View window in the XY plane. Whilst they will 

normally be created initially using points and lines, the cross-section must ultimately contain 

surfaces that define a single continuous shape. Individual surfaces separated by gaps do not 

form a valid cross-sectional shape for section property calculation purposes. See Creating 

Holes in Surfaces for details of how to create sections with voids. 

Compound sections constructed of two or more materials can be accommodated using the 

modular ratio approach. For this an isotropic field material property attribute is created with 

the thermal conductivity set to the Ei / Ebase value of the material and then assigned to 

surfaces made from that material. Ei is the Youngs Modulus of the material the surface 

defines and Ebase is the Youngs Modulus of the material to be used in the structural analysis. 

See Case study: Arbitrary Section Property Calculation of a Compound Section for a 

basic procedure. 

Options/Settings 

On the Arbitrary Section Property Calculator dialog: 

 Annotate properties displays the calculated section properties and section location 

data to the Annotation layer. 

 Automatic meshing lets LUSAS create the model mesh. 

 Max elts/line specifies the maximum elements to be assigned to any one line, when 

automatically meshing. 

 Recompute section properties Recalculates properties if mesh setting or geometry 

has been modified. 

 Add to local library Adds the calculated values to the local library when the Apply 

button is selected 

 Add to server library Adds the calculated values to the server library when the Apply 

button is selected. 

 Name used to identify the section when saved as a library item. 

The mesh used to compute arbitrary section properties determines the accuracy of the section 

properties but also affects the computation time. It has been found that a reasonable result is 
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achieved if at least two elements are used through thin sections of the model. If a finer mesh 

is required themaximum number of elements per line should be increased. If the mesh still 

requires adjustment it is recommended that the problem is initially set up using the default 

mesh and then the Automatic Meshing option is switched off to allow the mesh to be 

manually adjusted. 

Calculation of arbitrary section properties is done using thermal/field equations and, as a 

result, a Thermal Analysis entry will appear in the Analyses  Treeview. This is not 

intended for use or for manipulation by users. 

Using arbitrary sections 

To use the computed section properties in a model the section must be saved to a local or 

server library. To add a library item to the Attributes  treeview select the Attributes> 

Geometric> Section Library menu item, then select User Sections, then select Local or 

Server before choosing the section required from the list available. The section can then be 

assigned to the required Line(s) in the model. 

The use of the arbitrary section property calculator is described further in the worked 

example; Arbitrary Section Property Calculation and Use. See LUSAS Examples Manual. 

Precast Beam Section Generator 

The Precast Beam Section Generator (for beams with a top slab) is available for Bridge and 

Civil & Structural software products only. See Application Manual (Bridge, Civil & 

Structural) for details. 

Box Section Property Calculator 

The Box Section Property Calculator is available for Bridge and Civil & Structural 

software products only. See Application Manual (Bridge, Civil & Structural) for details. 

Section properties for unspecified cross-sections 

Section properties of an unspecified cross-sectional shape may be defined using the 

Attributes> Geometric> Line menu item to enter section properties directly prior to saving 

in a user or server library. See Library Locations for more details. 
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Case Study: Arbitrary Section Property Calculation of a 

Compound Section 

The basic procedure to carry out section property calculation of a compound section such as 

that typically encountered with a precast beam and a cast insitu slab, is as follows: 

1. Draw the section, assign the beam material to the surfaces or lines representing the 

beam and the in situ slab initially, run the Arbitrary Section Property Calculator 

(ASPC) to calculate homogeneous section properties, and save the section to a user 

library with the name homogenous_section. 

2. Use the Attributes > Material > Isotropic menu item to define a new material, setting 

the Thermal Conductivity, K, to be G1/G2 where G1 is the Shear Modulus of the 

material to be used, and G2 is the Shear Modulus of the material to be represented, 

and setting the Specific Heat, C, to be E1/E2, where E1 is the Young's Modulus of 

the material to be used, and E2 is the Young's Modulus of the material to be 

represented, These calculated properties will take into account the modular ratios. 

Note that for isotropic elastic materials, the shear modulus, G=E[2(1+v)]. 

3. Assign the newly defined properties to the surfaces or lines representing the in situ 

slab. 

4. Re-run the ASPC to calculate the compound section properties, and save the section 

to a user library with the name compound_section. 

Library Files 

Library files are used to store geometric section property, material, and composite data for 

use when building a model. Some library files contain data supplied by LUSAS, and are read-

only, others contain data that can be saved by users. The full range of library files are 

summarised here. 

Section property libraries 

 Section library is a LUSAS supplied library of a range of steel section sizes for 

various countries. 

 User (local) library stores user-created section properties for use inside the current 

project only. 

 User (global) library stores user-created section properties for use across all projects. 

Material property libraries 

 Material library is a LUSAS supplied library of commonly used structural materials. 

 Composite library is a LUSAS supplied library of materials for use in the composites 

industry. 
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Library Management 

The location of the section and material libraries is defined from the Utilities> Library 

Management> Library Locations menu item. The local section library is always located in 

the current working (project) directory while the server library may be located anywhere on a 

computer network. The server library allows common sections to be stored and made 

available across an organisation. 

Add Section to Library 

Basic geometric section properties may be manually added to either the local or server section 

library from the Utilities> Library Management> Section Library> Add Propertiesmenu 

item. This facility is intended primarily for entering section data of an unspecified cross-

sectional shape.  

Geometric section properties for standard cross sections or arbitrary cross sections can be 

added to either the local or server section library by choosing the appropriate button on the 

dialog where they are defined. 

Delete Section from Library 

Section properties may be deleted from either the local or server section library from the 

Utilities> Library Management> Section Librray> Delete Properties menu item. 
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Chapter 7 : 

Analyses 

  

The Analyses Treeview 

The Analyses  Treeview provides access to all analysis, loadcase / load curve and post-

processing information related to a model. From this panel new analyses can be defined, new 

loadcases added, solving of selected analyses carried out, and results loadcases can be set 

active for viewing results. 

By default, a base analysis  entry is automatically created in the Analyses  Treeview by 

LUSAS Modeller when a new model is defined, or when a model is read from a previous 

version.  

Additional analysis entries can be added to the Analyses  Treeview from the using the 

Analysis> menu items. New analysis entries, copies of analysis entries, and other entries can 

also be added to the Analyses  Treeview using context menus.  

 

 

 

Analysis entries in the Treeview are listed alphabetically for ease of location but the order has 

no relevance to the order in which solving of the various analyses takes place. Any analyses 

that are dependent upon others are automatically solved after those analyses. Analyses entries 

can be copied and pasted within the Analyses  Treeview. Analysis entries cannot be re-

ordered. 
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An analysis entry cannot itself be made active in order to display loading arrangements or to 

view results. Instead, individual loadcases or load curves within an analysis are set active for 

a given view window. To identify which analysis contains an active loadcase a black dot is 

added to the analysis icon . See Visualising the Results for more details.  

Analysis entries 

Analysis entries are held within folders according to analysis type. Folder names are 

Structural Analysis or Thermal Analysis. 

The following analysis entries (showing their default names) may appear in the  Structural 

analysis folder: 

 Analysis 1, 2, 3 etc 

 Direct Method Influence  

 Reciprocal Influence Analysis 

 VLO Analysis 1, 2, 3 etc 

 Cable Tuning Analysis 

Note that an ASPC analysis entry will also appear when the arbitrary section property 

calculator is used 

Main folder 

Context menus for the main model folder  provide the means to view model properties and 

define new analysis types such as General Structural Analysis, General Thermal Analysis, 

Direct Method Influence Analysis, Vehicle Load Analysis and Cable Tuning Analysis. 

Analysis folders 

Context menus for the Structural analysis or Thermal analysis folders in the Analyses  

Treeview provide the means to define new loadcase related entries such as envelopes, basic 

and smart combinations, and fatigue, IMD and target values loadcases as well as new analysis 

types. Close All Results files does exactly what it says. Sort by Name lists loadcase and 

loadcurve names aphabetically for all analyses entries. 

Analysis entries 

Within each analysis folder the context menu for each analysis entry provides general editing 

facilities allowing analysis entries to be copied and pasted within the Analyses  Treeview, 

renamed or deleted. Other entries permit selection of which loadcases to solve, the means to 

add new loadcases, the adding of gravity as a property of an analysis, and various Solver 

related options. 
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Copying and pasting analysis and attribute data 

Copying an analysis entry in the Analyses  Treeview will copy Support and Loading data 

into the newly created analysis entry. Note that Geometric and Material attribute data, if 

defined for an analysis, is also copied, otherwise this data is inherited from the Base analysis. 

Geometric, Material, Support and Loadcase data can also be copied and pasted individually 

between analysis entries by the use of their own context menus. 

Loadcase entries 

Loadcases (a collection of attributes that have been assigned to a particular analysis in a 

model) and loadcase dependent assignments (such as loading and supports) are displayed 

within each analysis entry. When solved the results for each loadcase are provided separately 

and can be accessed by using context menus on each loadcase. See Loadcases for more 

details. 

Post-processing folder 

The  Post processing folder (which only appears when one of the entries on its context 

menu is created) contains entries that may reference loadcase results data from more than one 

Analysis. Its context menu provides the means to create envelopes, basic and smart 

combinations, and fatique, IMD and target values loadcases.  

The  Combination and envelope results options object allows selected envelope and 

combination components to be automatically calculated at the end of a LUSAS Solver 

analysis. 

Analyses Treeview Icons 

Refer to Appendix F for an explanation and details of the status of any Analyses  

Treeview icons that are seen. 

The Analyses Menu 

The Analyses menu entries listed here all add entries to the Analyses  Treeview by using a 

similarly named Analyses> menu item. 

Analysis types 

 General Structural Analysis - used to carry out all kinds of linear static, eigenvalue, 

fourier, nonlinear, or transient dynamic analysis. 

 General Thermal Analysis - used to assess conduction, convection or radiation 

effects. 

 Direct Method Influence Analysis - used to carry out influence analysis where the 

effect of a specified point load is assessed at each node or grid location on a loadable 

area of a structure. The value of the load effect of interest at each specified location is 

then used to construct an influence line or surface for that location. 
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 Vehicle Load Optimisation - used to identify critical vehicle loading patterns on 

bridges and apply these loading patterns to LUSAS analysis models. 

 Cable Tuning Analysis - calculates load factors for selected lines in a model that 

represent cables in order to achieve defined target values set for various components or 

features. 

The use of some analyses menu items, such as Vehicle Load Optimisation, or Cable Tuning 

Analysis is dependent upon the software licence key in use. Note also that some analysis 

menu permutations are not allowed - for example Cable Tuning analysis and General Thermal 

Analysis. 

Coupled analysis 

Coupled Analysis - performs a thermal and structural analysis simultaneously, or one after 

the other, by transferring data between them via an additional data transfer file. Whilst not 

accessed via the Analyses menu, a Coupled Analysis can be created by choosing analysis type 

'Coupled' when a new model is created, or by adding a structural analysis entry to an 

Analyses  Treeview containing a single Thermal analysis entry or vice-versa. 

Load cases and load types 

 Loadcase adds a new empty loadcase to the Analyses  Treeview. Control settings 

for eigenvalue, fourier and nonlinear and transient analyses can be set using the 

loadcase context menu. 

 Load Curve is used to describe the variation of the loading in nonlinear, transient and 

Fourier analyses. 

 These facilities can also be accessed using the context menu of an Structural or Thermal 

analysis entry. 

Other entries 

 Envelope - create an envelope of maximum and minimum effects. 

 Basic Combination - combine results from different loadcases applying load factors 

to get max and min effects. 

 Smart Combination - combine results from different loadcases taking into account 

beneficial and adverse load factors to get max and min effects. 

 Fatigue - calculate fatigue life and number of cycles to failure. 

 IMD Loadcase - create a loadcase for use with interactive modal dynamics. 

 Target Values - specify a target values loadset of chosen components for selected 

features in the model. 

Each of these facilities can also be accessed using the context menu of the Post processing 

entry (once it has been created by defining one of the above) 
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Base Analyses 

A base analysis is used a reference for other analyses defined in a single model file and it is 

identified by a green solve  icon alongside its Analysis name in the Analyses  Treeview. 

For models containing both structural and thermal analyses, there are two base analyses – one 

of each analysis type. If a number of analysis types (that may include a nonlinear analysis) are 

to be added to the Analyses  Treeview it is sensible for the base analysis to be a simple 

linear static analysis. Other analyses present in the Analyses  Treeview that inherit 

assignments, options and settings from the base analysis are identified by a cyan solve  

icon. 

Creating a base analysis 

By default, a base analysis entry is automatically created by LUSAS Modeller when a new 

model is defined, or when a model is read from a previous version. When a new general 

structural or general thermal model is created a base analysis will be the only analysis listed 

in the Analyses  Treeview. A Coupled analysis creates two base analysis entries - one for 

each analysis type. 

When additional analyses are defined in the same model by default they will inherit most of 

the attribute assignments, options and settings etc. of the base analysis, but it is possible to 

override this default and individually select which attribute assignments, options and settings 

should be inherited from the base analysis and, by their non-selection, any which should not.  

Attribute dependency across analyses / loadcases 

The following table summarises how attributes assigned in a base analysis are inherited in 

other dependent analyses. 

 

Attribute type Behaviour 

Mesh, Local coordinates, 
Equivalence, Search Area, Crack 
Tip, Retained Freedom  

Assignments apply to all analyses 

Constraints, Damping, Geometric, 
Material (Composites, Age, 
Damping), Radiation Surface, 
Thermal Surface, User Attributes  

Assigned per-analysis. Optionally inherited from base analysis. 

Appear in their own folder in the Analyses Treeview. 

Note that Material entry also controls whether Composite, Age and 
Damping attributes are inherited or not. 

Note that radiation surfaces and thermal surfaces, unlike slidelines, 
cannot change type during an analysis. 

The User setting only appears if a User attribute has been defined 
(advanced use only) 

Supports Optionally inherited from first loadcase of base analysis. Supports 
can be assigned to any loadcase (in a nonlinear model) but note 
that only supports from the first loadcase can be inherited between 
analyses. Supports in other loadcases are not inherited. 

Loading, Activate, Deactivate Not inherited between analyses. 
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Attribute type Behaviour 

Transformation Not an attribute that is used on a per-analysis basis. 

Thermal gap Not an attribute that is used on a per-analysis basis, but note that 
thermal gap definitions contain a ‘change’ loadset. The definition 
dialog checks that all referenced thermal surfaces are assigned in 
the same analysis, and that this is the same analysis as the change 
loadset. An error message is generated if this is not the case. 

Reciprocal Influence Assigning a reciprocal influence creates an analysis to contain it. 

Direct Method Influence Can only be assigned with a Direct Method Analysis 

Making changes to analyses referencing a base analysis 

If any changes are made to attribute assignments, options and settings in an analysis that is 

linked to a base analysis those specific changes will then override any behaviour it was 

previously inheriting from the base analysis. For example, consider a model having two 

analyses with Analysis 1 defined as the base analysis with a "steel material" assigned to all 

surfaces. By default, Analysis 2 will inherit those material assignments, and "steel material" 

would appear to be assigned in Analysis 2 as well. But if a different material, say 

"aluminium", were to be assigned to a single surface in Analysis 2 that single assignment 

would override the previous "steel material" assignment, but only for that assigned surface. 

When solving the model all surfaces would be solved with "steel material" properties in both 

analyses with the exception of the surface that had "aluminium" assigned to it in Analysis 2. 

This surface would be solved using "steel material" in Analysis 1 and "aluminium" in 

Analysis 2. 

Setting an existing analysis to be a base analysis 

Only an existing general structural or thermal analysis entry (as marked by a cyan solve  

icon in the Analyses  Treeview) can be set to be a base analysis. This is done by selecting 

its context menu and choosing Edit... to access the Analysis definition dialog. Note that 

setting a different analysis as a base analysis can have a significant impact on all other 

analyses because all inherited attribute assignments will be affected.  

Multiple Analyses within a Single Model 

Within a single model file multiple analyses may be defined. Each analysis will inherit most 

of the assignments, options and settings of the base analysis for the model. Analyses that 

inherit from a base analysis are identified by a cyan coloured 'Analysis'  icon. 

Use of the multiple analyses facility does away with the need to create separate models, or 

maintain “clone” copies of a model, in order to switch between and create results from linear 

static analysis and other analysis types. It also overcomes the need to load results files from a 

variety of different models on top of one model in order to carry out combinations of 

loadcases from those different models. 
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Examples of use 

There are many situations where multiple analyses within the one model file should be 

employed. A few examples are stated here: 

 Where static analysis and dynamic analyses are both of significance as, for example, 

in footbridge design. Multiple analyses would be stored in the same model with 

typically the same attribute assignments but with different analysis controls and 

loadcases appropriate to the analysis in question. 

 Where static analysis and influence analysis are both of significance, as in bridge 

design. 

 Where it is required to combine load effects derived from models that are identical in 

terms of mesh, but have some attributes changed, such as the use of long term 

concrete modulus for some loadcases and short term concrete modulus for others.  

 Where superposition of effects with different material properties needs to be 

considered as, for example, with linear analyses of any beam and slab deck structure 

where effects arising over long term and short term need to adopt appropriate Young’s 

Modulii of concrete. 

 For buckling analysis of symmetrical structures, where the unstressed deformed mesh 

derived from an eigenvalue buckling analysis (with a magnitude multiplier) is 

typically required as the starting point for a subsequent nonlinear analysis.  

 For sensitivity analyses, such as soil-structure interaction analyses where a range of 

analyses could represent clone models with differing material properties, support 

stiffnesses etc. Results from those analyses could be enveloped to ensure that design 

makes adequate allowance for uncertainties.  

 For pushover analysis (a static-nonlinear analysis method where a structure is 

subjected to gravity loading and a monotonic displacement-controlled lateral load 

pattern which continuously increases through elastic and inelastic behavior until an 

ultimate condition is reached) may require several analyses to achieve the analysis 

goal.  

General Structural / Thermal Analysis Types 

LUSAS may be used to numerically model a wide range of engineering problems. The 

following section briefly explains the analysis types available. 

Default analysis 

 Linear Analysis is the most common analysis carried out by engineers and unless 

specified otherwise, LUSAS will perform a linear elastic, static analysis or a steady 

state thermal/field analysis (according to the user interface in use). In these types of 
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analysis multiple loadcases can be accommodated but the model geometry and other 

boundary conditions cannot be altered. Linear analysis assumes that: 

 The loads are applied instantaneously and transient effects are ignored.  

 The loaded body instantaneously develops a state of internal stress so as to 

equilibrate the total applied loads.  

 The structural response is linear, i.e. both the geometric and material response 

are assumed to be linear. 

Analyses defined as a property of a loadcase 

The solving of analyses other than a linear analysis or a steady state thermal/field analysis 

requires an analysis control to be specified. Analysis controls are specified as a property of a 

loadcase. Loadcases can be seen and are accessed within each analysis entry in the Analyses 

 Treeview. 

The control parameters for the following analysis types are specified as properties of a 

loadcase.  

 Nonlinear Analysis is used to model significant changes in geometry, material or 

boundary conditions. Significant geometry deformation may occur due to the applied 

loading. Changes in material may occur due to material yield. Changes in boundary 

conditions may occur due to the lift-off of supports or from changes in contact or 

frictional behaviour. Examples of nonlinear analyses include Creep Analysis and 

Impact Dynamics. 

 Transient analysis is used to carried out analyses over a period of time and is 

progressed in a step-by-step manner, giving results at each time-step. Both Transient 

Dynamic Analysis and Transient Thermal Analysis are available. 

 Eigenvalue Analysis is available to compute the Natural Frequencies of a structure 

or to carry out an Eigenvalue Buckling Analysis in order to estimate the maximum 

load that can be supported by a stiff structure prior to structural instability. Eigenvalue 

Stiffness may also be performed on the stiffness matrix at a selected stage of an 

analysis. This facility can be used in conjunction with a nonlinear analysis to predict 

structural instability or bifurcation points during a geometrically nonlinear analysis. 

 Fourier Analysis provides an extended form of axisymmetric analysis where applied 

loading can be considered to be non-axisymmetric when applied using a Fourier 

distribution around the circumference. 

 Thermo-Mechanical Coupled Analysis either performs the thermal and structural 

analyses simultaneously or one after the other with transfer of data between them via 

an additional data transfer file. 

Solver-based analyses 

The following analysis types are also possible in Solver but the tabulation of the harmonic 

analysis control is not fully supported by LUSAS Modeller: 
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 Harmonic Response Analysis The behaviour of a structure subjected to vibrating 

loads can be analysed without the need for a full dynamic step-by-step analysis. See 

also Modal Response analysis. 

 Temperature dependent materials The definition of temperature dependent 

materials in a tabular form are supported by LUSAS Solver. See Solver Reference 

Manual for details. 

Specifying initial deformations for an analysis 

When defining an analysis, an undeformed or deformed mesh of a chosen loadcase or load 

increment, time step, or eigenvalue from one analysis can be used as the starting point for the 

'undeformed' mesh of another general or thermal analysis. The coordinates of all nodes in the 

mesh can be adjusted based upon a specified deformed mesh factor. Initial deformations are 

specified as a property of an analysis.  

Nonlinear Analysis 

Nonlinear analysis controls are defined as properties of a loadcase. To do so, in the Analyses 

 Treeview access the loadcase context menu and choose the Controls menu item.  

The Nonlinear and Transient object  created provides the means to modify the control 

settings. Additional Nonlinear analysis control options are accessed via the Nonlinear 

analysis options control object  in the Analyses  Treeview. Nonlinear analysis options 

can be specified separately for each analysis present. 

What is Nonlinear Analysis? 

Linear finite element analysis assumes that all materials are linear elastic in behaviour and 

that deformations are small enough to not significantly affect the overall behaviour of the 

structure. Obviously, this description applies to very few situations in the real world, but with 

a few restrictions and assumptions linear analysis will suffice for the majority of engineering 

applications.  

The following indicate that a nonlinear finite element analysis is required: 

 Gross changes in geometry 

 Permanent deformations 

 Structural cracks 

 Buckling 

 Stresses greater than the yield stress 

 Contact between component parts 
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Good practice when carrying out nonlinear analysis 

It is good practice to perform a linear static analysis prior to carrying out a nonlinear analysis. 

This eliminates the added complexities of the nonlinear variables and will enable a check on 

the basic performance of the structure for the applied loadings. Any warning or error 

messages in the LUSAS output file should be investigated.  

It is advisable to add in nonlinear behaviour in stages. For example in a material and 

geometrically nonlinear run containing slidelines it would probably be advisable to start with 

only slidelines, then add the geometric nonlinearity and finally add the nonlinear material 

effects. By proceeding in this manner will ensure that each nonlinear procedure is stable 

before progressing to the next. 

Nonlinear Analysis Types 

Three types of nonlinear analysis may be modelled using LUSAS: 

 Geometric Nonlinearity e.g. large deflection or rotation, large strain, non-

conservative loading. 

 Boundary Nonlinearity e.g. lift-off supports, general contact, compressional load 

transfer, dynamic impact. 

 Material Nonlinearity e.g. plasticity, fracture/cracking, damage, creep, volumetric 

crushing, rubber material. 

The LUSAS analysis types within which nonlinear geometric and material effects may be 

incorporated are shown in the following table: 

Analysis Type 
   

Geometric Nonlinearity  
   

Material Nonlinearity  

Static 
  

yes 
  

yes 

Dynamic 
  

yes 
  

yes 

Thermo mechanical 
  

yes 
  

yes 

Creep 
  

yes 
  

yes 

Natural Frequency 
  

yes 
  

yes 

Eigenvalue Buckling 
  

- 
  

- 

Spectral Response 
  

- 
  

- 

Harmonic Response 
  

- 
  

- 

Fourier Analysis 
  

- 
  

- 

Field or Thermal   - 
  

yes 
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Geometrically Nonlinear Analysis 

Geometric nonlinearities arise from significant changes in 

the structural configuration during loading. Common 

examples of geometric nonlinearity are plate structures 

which develop membrane behaviour, or the geometric 

bifurcation of truss or shell structures. The changing 

application of loads or boundary conditions are also 

geometrically nonlinear effects. The figure below shows 

two simple structural examples which serve as good 

illustrations of geometrically nonlinear behaviour. 

For the simply supported beam (top) the linear solution 

would predict the familiar simply supported bending 

moment and zero axial force. In reality as the beam 

deforms its length increases and an axial component of 

force is introduced.  

For the loaded strut (bottom) the linear solution would fail 

to consider the progressive eccentricity of the vertical 

load on the bending moment diagram.  

In both these cases depending on how large the deflections 

were, serious errors could be introduced if the effects of 

nonlinear geometry were neglected. 

In LUSAS geometric nonlinearity is accounted for using four basic formulations: 

 Total Lagrangian 

 Updated Lagrangian 

 Eulerian 

 Co-rotational 

These are defined from the Model Properties> Solution - Nonlinear Options tab. All four 

formulations are valid for arbitrary large deformations. In general, if rotational degrees of 

freedom are present, rotations must be small for Total Lagrangian. An exception to this rule is 

the Total Lagrangian formulation for thick shell elements where large rotations may be 

applied. Large rotations are allowed for Updated Lagrangian (provided that they are small 

within each load increment) or Eulerian. The co-rotational formulation is unconditionally 

valid for large rotations and results are generally independent of load step size. 

All formulations are valid for small strains. For some elements the Updated Lagrangian 

formulation is valid for moderately large strains. The Eulerian formulation is also generally 

valid for moderate strains. In general, the Total Lagrangian is a more robust formulation, 

which is usually able to cope with substantial load increments. The Updated Lagrangian, and 

particularly Eulerian, formulations generally require smaller load increments in order to avoid 

a divergent solution. 

Standard geometrically nonlinear formulations account for the change in position of the 

loading, but not the change in direction relative to the deformed configuration. Loading is 
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always conservative for the Total Lagrangian geometrically nonlinear formulations (that is, 

the load is always applied in the same direction as was initially prescribed). Using an Updated 

Lagrangian formulation, the geometry is updated at the end of each increment and the applied 

loads may maintain the same relative orientation as to the original surface (depending on 

element and load types). Therefore non-conservative loading can be increment size 

dependent. True non-conservative loading may only be achieved by using the Eulerian and 

co-rotational formulations. 

The choice of particular formulations is both problem and element dependent (the element 

formulation determining which strain formulations are available). The availability of each 

formulation is given for each element in the Element Reference Manual. For further details 

regarding the geometrically nonlinear formulations refer to the Theory Manual. 

 

Nonlinear Boundary Conditions 

Deformation dependent boundary condition models account 

for the modifications to the external restraints resulting from 

support lift-off, or smooth or frictional contact within an 

analysis. Within LUSAS node on node contact may be 

accounted for using joint elements and arbitrary contact may 

be accounted for using slidelines. 

Consider the simple example shown in the figure right in 

which the structure and its supporting surface can resist being 

pushed together, but not being pulled apart. The required 

contact condition may be imposed by using joint elements to 

connect between the structure and the rigid support, and 

specifying a nonlinear contact joint model incorporating large 

and zero local stiffness in compression and tension 

respectively. 

 

Materially Nonlinear Analysis 

Materially nonlinear effects arise from a nonlinear constitutive model (that is, progressively 

disproportionate stresses and strains). Common examples of nonlinear material behaviour are 

the plastic yielding of metals, the ductile fracture of granular composites such as concrete, or 

time-dependent behaviour such as creep. 

LUSAS incorporates a variety of nonlinear constitutive models, covering the behaviour of the 

more common engineering materials. Details of these material models and their applicability 
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to each LUSAS element are described in About Material Properties which should be read in 

conjunction with the Element Reference Manual. 

Nonlinear Solution Procedures 

For nonlinear analysis, since it is 

no longer possible to directly 

obtain a stress distribution which 

equilibrates a given set of external 

loads, a solution procedure is 

usually adopted in which the total 

required load is applied in a 

number of increments. 

Within each increment a linear 

prediction of the nonlinear 

response is made, and subsequent 

iterative corrections are performed 

in order to restore equilibrium by 

the elimination of the residual or 

out of balance forces. 

The iterative corrections are referred to some form of convergence criteria which indicates to 

what extent an equilibrium state has been achieved. Such a solution procedure is therefore 

commonly referred to as an incremental-iterative (or predictor-corrector) method shown 

in the figure above. In LUSAS, the nonlinear solution is based on the Newton-Raphson 

procedure. The details of the solution procedure are controlled using the nonlinear control 

properties assigned to loadcase. 

For the analysis of nonlinear problems, the solution procedure adopted may be of significance 

to the results obtained. In order to reduce this dependence, wherever possible, nonlinear 

control properties incorporate a series of generally applicable default settings, and 

automatically activated facilities. 

Iterative Procedures 

In LUSAS the incremental-iterative solution is based on Newton-Raphson iterations. In the 

Newton-Raphson procedure an initial prediction of the incremental solution is based on the 

tangent stiffness from which incremental displacements, and their iterative corrections may 

be derived. 

Standard Newton-Raphson Procedure 

In the standard Newton-Raphson procedure each iterative calculation is always based upon 

the current tangent stiffness. For finite element analysis, this involves the formation (and 

factorisation) of the tangent stiffness matrix at the start of each iteration. 

Although the standard Newton-Raphson method generally converges rapidly, the continual 

manipulation of the stiffness matrix is often expensive. The need for a robust yet inexpensive 
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procedure therefore leads to the development of the family of modified Newton-Raphson 

methods. 

Iterative Acceleration (Line Searches) 

A slow convergence rate may be significantly improved by employing an iterative 

acceleration technique. In cases of severe and often localised nonlinearity, encountered 

typically in materially nonlinear or contact problems, some form of acceleration may be a 

prerequisite to convergence. 

In LUSAS, iterative acceleration may be performed by applying line searches. In essence, 

the line search procedure involves extra optimisation iterations in which the potential energy 

associated with the residual forces at each iterative step are minimised. Line search 

application is controlled via parameters on the Iteration section of the Nonlinear Control 

properties. 

The selection of line search parameters is problem dependent and largely a matter of 

experience. However, a maximum of 3 to 5 line search iterations with a tolerance of 0.3 to 0.8 

is usually sufficient (the closer the tolerance is to unity, the more slack the minimum energy 

requirement). 

Separate Iterative Loops 

In problems where both material and contact nonlinearities are present, convergence 

difficulties can arise when evaluating material nonlinearities in configurations where the 

contact conditions are invalid because the solution is not in equilibrium. To avoid this 

situation contact equilibrium can be established using elastic properties from the previous 

load increment before the material nonlinearity is resolved. The option to define separate 

iterative loops is defined on advanced solution strategy dialog which can be found on the 

nonlinear control dialog. 

See the Theory Manual for further details. 

Incremental Procedures 

For the Newton-Raphson solution procedures it is assumed that a displacement solution may 

be found for a given load increment and that, within each load increment, the load level 

remains constant. Such methods are therefore often referred to as constant load level 

incrementation procedures. 

However, where limit points in the structural response are encountered (for example in the 

geometrically nonlinear case of snap-through failure) constant load level methods will, at 

best, fail to identify the load shedding portion of the curve and, at worst, fail to converge at all 

past the limit point. The solution of limit point problems therefore leads to the development 

of alternative methods, including displacement incrementation and constrained solution 

methods. 
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Constrained Solution Methods (Arc-Length) 

Constrained methods differ from constant level methods in that the load level is not required 

to be constant within an increment. In fact the load and displacement levels are constrained to 

follow some pre-defined path. 

In LUSAS two forms of arc-length method have been implemented: 

 Crisfields modified arc-length procedure in which the solution is constrained to lie on 

a spherical surface defined in displacement space. For the one degree of freedom case 

this becomes a circular arc. 

 Rheinboldts arc-length algorithm which constrains the largest displacement increment 

(as defined by the predictor) to remain constant for that particular increment. 

The use of the arc-length method has the following advantages over constant load level 

methods 

 Improved convergence characteristics 

 Ability to detect and negotiate limit points 

In LUSAS, control of arc-length solution procedures is via the Incrementation section of the 

Nonlinear Control properties. If required, the solution may be started under constant load 

control, and automatically switched to arc-length control based on a specified value of the 

current stiffness parameter (defined as the scaled inner product of displacements and loads). 

The required stiffness parameter for automatic conversion to arc-length control is input in the 

Incrementation section of Nonlinear Control properties. 

Where limit points are encountered LUSAS will automatically determine the sign of the next 

load increment by the sign of the determinant of the stiffness matrix. This is a reliable 

method in most cases, however, it will often fail in the vicinity of bifurcation points when 

negative eigenvalues may cause premature unloading. In such cases the load reversal criteria 

may be optionally changed to be dependent on the sign of the current stiffness parameter. 

This method is better at coping with bifurcation points, but will always fail when a snap-

back situation is encountered. 

Note. In certain circumstances, notably in the presence of strain-softening, the arc-length 

method may converge on alternative, unstable equilibrium paths. 

Bracketing Critical Points And Branch Switching 

Bracketing can be used to locate a limit or bifurcation point during a geometrically nonlinear 

analysis. The nonlinear analysis is executed and one of three methods is used to isolate the 

first critical point. 

 Bi-section 

 Interpolation 

 Riks semi-direct approach 
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Two further options for the bracketing procedure exist depending on whether the material 

response is elastic (reversible) or plastic/path dependent (irreversible). Only the first critical 

point can be processed and a subsequent eigenvalue analysis must be invoked to determine 

whether the critical point encountered is a limit or bifurcation point. A limit point may be 

defined as the point at which load starts to decrease as displacements increase (e.g. the snap 

through of a shallow arch). In this instance the structure may not have failed completely and 

could subsequently still be capable of carrying more load. A bifurcation point indicates that 

the solution of the nonlinear differential equations has encountered an alternative unstable 

solution path or paths which may be followed instead of the stable equilibrium path. The 

branch switching procedure must then be undertaken if an unstable equilibrium path is to be 

followed. 

The branch switching procedure should only be carried out within a restart analysis after 

bracketing has been successfully completed. Two options exist for guiding the solution onto a 

secondary path. 

 Eigenmode injection 

 Artificial force and Rheinboldts arc 

Incremental Loading 

Incrementation for nonlinear problems may be specified in four ways: 

 Manual Incrementation where the loading data in each load increment is specified 

separately. 

 Automatic Incrementation where a specified loadcase is factored using fixed or 

variable increments. 

 Mixed Incrementation Mixed manual and automatic incrementation. 

 Load Curves where the variation of one or more sets of loading data is specified as a 

graph of load factor vs. load increment or time step. 

The choice and level of incrementation will depend on the problem to be solved. 

Automatic Load Incrementation 

Two methods of automatic incrementation are available: 

 Uniform Incrementation By default, uniform incrementation will be applied. That is, 

for each increment the current load factor will be multiplied by the specified load 

components to generate the applied load.  

 Variable Incrementation Alternatively, variable incrementation may be requested. In 

this case the current load factor will be automatically varied according to the iterative 

performance of the solution. The variation is a function of the required number of 

iterations and a specified desired iterative performance. Thus, where the number of 

iterations taken is less than the desired value the incremented load factor will 

subsequently be increased, and conversely, if the number of iterations is greater than 

the desired value, it will be decreased. Variable incrementation may be used in 

conjunction with either constant load level or arc-length solution methods and is an 

effective way of automatically adapting the performance of the solution procedure to 



  Chapter 6 

    

367 

the degree of nonlinearity encountered. The overall effect is therefore to increase and 

decrease the numerical effort in the areas of most and least nonlinearity respectively. 

Mixing Manual And Automatic Incrementation 

If required, manual and automatic incrementation procedures may be mixed freely. When 

mixing manual and automatic incrementation the following rules apply: 

 Loadcases may be respecified as often as required. 

 If the automatic procedure is specified, it will continue until one of the termination 

criteria is satisfied. 

 In switching from manual to automatic control, any loading input under the manual 

control is remembered and held constant, while the automatic procedure is operating. 

 In switching from automatic back to manual control, any loading accumulated under 

automatic control is forgotten and must be input as a manual loadcase if required. 

 If prescribed displacements are being used, then in any switching from one type of 

control to another, the effect of prescribed displacements will be remembered and will 

not need to be input again. 

Automatic Increment Reduction 

Where an increment has failed to converge within the specified maximum number of 

iterations it will be automatically reduced and re-applied. This will be repeated according to 

values specified in the step reduction section (Advanced Nonlinear Incrementation 

Parameters dialog) until the maximum number of reductions has been tried. In a final attempt 

to achieve a solution the load increment is then increased to try and step over a difficult point 

in the analysis. If after this the solution has still failed to converge the solution terminated. 

Solution Termination 

When using manual incrementation, the solution will automatically terminate following 

execution of one increment. With automatic incrementation, the solution progresses one 

Nonlinear Control chapter at a time. The finish of each Nonlinear Control chapter is 

controlled by its Termination parameters. 

Termination may be specified in 3 ways: 

 Limiting the maximum applied load factor. 

 Limiting the maximum number of applied increments. 

 Limiting the maximum value of a named freedom. 

Where more than one criteria is specified, termination will occur on the first criteria to be 

satisfied. 

Failure to converge within the specified maximum number of iterations will either result in a 

diagnostic message and termination of the solution or, if automatic incrementation is being 
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used, a reduction of the applied load increment. If required, the solution may be continued 

from an unconverged increment (Option 16, 17), although the consequences of such an action 

should be appreciated. 

In addition, the solution will be terminated if, at the beginning of an increment, more than two 

negative pivots are encountered during the frontal elimination phase. 

Use of Load Curves 

Load curves are used to simplify the input of load data in situations where the variation of 

load is known with respect to a certain parameter. An example of this could be the dynamic 

response of a pipe to an increase of pressure over a given period. The load curve would 

consist of the definition of the load and its variation with time. 

Nonlinear Solution Convergence Criteria 

The convergence criteria specifies to what extent the numerical iterative procedure has 

reached the true equilibrium state. The specification of convergence therefore involves two 

considerations: 

 Type of convergence criterion. 

 Convergence tolerance. 

The types of convergence criteria incorporated in LUSAS are as follows: 

 Absolute residual norm 

 Root mean square residual norm 

 Displacement norm 

 Residual force norm 

 External work norm 

 Incremental displacement norm 

The convergence tolerance for each criteria is specified in the Solution parameters and 

advanced solution parameters section of the Nonlinear Control properties. The selection of a 

convergence criteria, and the associated tolerance, is problem dependent. However, the 

following points should be considered: 

Clearly, the convergence criteria must not be too slack so as to yield an inaccurate solution, 

nor too tight so as to waste computer time performing unnecessary iterations. In general, 

sensitive geometrically nonlinear problems require a tight convergence criteria, whereas with 

predominantly materially nonlinear problems, larger local residuals may be tolerated. 

Where more than one criteria has been specified, convergence will be assumed only on the 

satisfaction of all specified tolerances. 

The following considerations apply to individual convergence parameters: 

 Absolute Residual Norm is of limited use owing to its dependence upon the units 

being used. It is a strict criteria and for some problems, especially those involving 
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plasticity, it may be very difficult to reduce locally large residuals. However, in 

sensitive geometrically nonlinear problems near bifurcation points, it can sometimes 

be necessary to ensure that large residuals are completely eliminated. 

 Root Mean Square Residual Norm is the square root of the average of the squares of 

the residual forces and is generally more applicable than the above, but is still 

dependent upon the units being used. 

 Displacement Norm is the sum of the squares of all the iterative displacements as a 

percentage of the sum of the squares of the total displacements and is a useful measure 

of how much the structure has moved during an iteration. Being a scaled norm it is not 

affected by units but convergence is not guaranteed. Typical values of slack and tight 

norms are (5.0 - 1.0) and (0.1 - 0.001) respectively. 

 Residual Force Norm is the sum of the squares of all the residual forces as a 

percentage of the sum of the squares of all the external forces. This is the most 

versatile of the five criteria. Typical slack and tight values are (10.0 - 5.0) and (0.1 - 

0.00001) respectively. 

 External Work Norm is the work done by all the residuals acting through the 

iterative displacements, as a percentage of the work done by the loads on iteration zero 

of the increment. Since all freedoms are considered it is very versatile (the default 

displacement and force norms consider only the translational freedoms). However, it 

should be noted that a minimum detected potential energy need not necessarily 

coincide with the equilibrate state. Typical values of slack and tight norms are (0.1 -

 0.001) and (10-E6 - 10-E9) respectively. 

 Incremental Displacement Norm is the sum of the squares of all the iterative 

displacements as a percentage of the sum of the squares of the total displacements for 

the increment. This norm is an incremental form of the total displacement norm 

previously described and the same comments regarding usage apply. 

Nonlinear Output Control 

Nonlinear analyses may generate a vast amount of output. In addition to the normal nodal and 

element output controls, the frequency of nonlinear solution output may be restricted via the 

Output section in the Nonlinear Control properties. 

The restart output facility enables failed or terminated analyses to be restarted from the last 

saved restart output dump. This is particularly useful where the termination of the analysis 

was due to a failure of the solution process rather than that of the structure. In this way, the 

solution may be restarted from the last converged increment with a different or modified 

solution strategy. For example, a failed increment may be restarted under either constant load 

or arc-length control. Restarts are not supported by LUSAS Modeller and hence must be 

defined directly in a LUSAS Solver data file. 

The Nonlinear Logfile 

During the course of a nonlinear analysis, various information is output to the screen or 

logfile, so that you may assess the performance of the solution. For more information refer to 

the Solver Reference Manual. 
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Creep/Viscoelastic Analysis  

Nonlinear viscous behaviour occurs when the relationship between stress and strain is time 

dependent. The viscous response is usually a function of the material properties, stress, strain 

and temperature history. Unlike time independent plasticity where a limited set of yield 

criteria may be applied to many materials, the viscous response differs greatly for different 

materials. 

A creep/viscoelastic analysis may be carried out using a linear or nonlinear material model 

within a nonlinear, transient dynamic or thermo-mechanically coupled analysis. When carried 

out in a nonlinear analysis inertia effects are neglected and the time component is introduced 

using viscous control. To do so, in the Analyses  Treeview access the loadcase context 

menu and choose the Controls menu item. The Nonlinear and Transient object  created 

provides the means to modify the control settings.   

When using viscous control, automatic time step calculations are only available when creep is 

included in the analysis. 

 Creep material properties are defined using the Attributes> Material> Isotropic / 

Orthotropic menu item. 

 Viscoelastic material properties are defined using the Attributes> Material> 

Isotropic / Orthotropic menu item. 

Consolidation Analysis 

Consolidation is the process in which reduction in soil volume takes place by expulsion of 

water under long term static loads. It is a typical diffusion process in which the field changes 

rapidly at the start of the process before settling down to a steady state condition a 

considerable time after the initial load is applied. As a result, time step parameters must be 

defined, and these are based upon currently set timescale units.  

A consolidation analysis is controlled using nonlinear and transient loadcase control 

properties which are defined as properties of a loadcase. To do so, in the Analyses  

Treeview access the loadcase context menu and choose the Controls menu item. The 

Nonlinear and Transient object  created provides the means to modify the control settings. 

Nonlinear analysis options can be specified separately for each analysis present.  

Specifying an automatic time stepping procedure enables the time step to be modified so that 

the small time steps required at the start of the problem can be increased as the analysis 

progresses. In some cases the overall response time can be orders of magnitude larger than 

the initial time step. The value of the initial time step is important since the early variations in 

pore pressure must be accurately accounted for. Vermeer and Verruijt suggest the following 

criteria for determining the initial time step:  

 

where 'delta h' is the minimum distance between mesh nodes, which can be determined by 

selecting the two nodes and picking the Utilities>Mesh>Distance between Nodes menu entry. 
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Additionally, for a consolidation analysis, both the elastic and two-phase soil properties need 

to be defined.  

See the Application Manual (Bridge, Civil & Structural) 2D Consolidation under a Strip 

Footing worked example for more details. 

Geostatic control 

Most geotechnical problems begin from a geostatic state. This represents the initial stress 

distribution where the undisturbed soil or rock body remains in equilibrium with the 

prescribed boundary conditions and geostatic loads, including self-weight, or overburden, 

producing zero deformations. This stress state is then used as the initial stress field in a 

subsequent static or coupled pore fluid diffusion/stress analysis. 

Geostatic control can be set as part of the Nonlinear and Transient control properties of a 

loadcase, or by accessing the Nonlinear and Transient analysis control object  in the 

Analyses  Treeview.  

Eigenvalue Analysis 

Eigenvalue analysis controls are defined as properties of a loadcase. To add an eigenvalue 

analysis control to a loadcase, in the Analyses  Treeview access the loadcase context menu 

and choose the Controls menu item. Eigenvalue analysis options can be specified separately 

for each analysis present. In a linear analysis, eigenvalue control should be specified on 

loadcase 1. 

Applications 

 Eigenvalue (also known as a frequency analysis) extracts the natural modes of 

vibration of a structure. 

 Eigenvalue (complex) is used when joint or material damping has been specified for a 

model. For this, resultant displacement results of the real and imaginary components 

are displayed within Modeller. 

 Buckling load analysis A linear analysis which may be applied to relatively ‘stiff’ 

structures to estimate the maximum load that can be supported prior to structural 

instability or collapse. 

 Stiffness analysis Used to perform an eigenvalue analysis of the stiffness matrix at a 

selected stage of an analysis. This facility may be used in conjunction with a 

nonlinear analysis to predict structural instability or bifurcation points during a 

geometrically nonlinear analysis. 

 By including Modal Damping, the overall damping factors for each mode can also be 

printed as a table in the LUSAS Solver output file. These values may then be used in a 

modal dynamic or spectral (harmonic/IMD) analysis if desired. 
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Good practice when carrying out eigenvalue analysis 

It is good practice to perform a linear static analysis prior to carrying out an eigenvalue 

analysis. This eliminates the added complexities of the dynamic variables and will enable a 

check on the basic stiffness matrix for the structure. Any warning or error messages in the 

LUSAS output file (such as zero, negative or small pivots) should be investigated. In the 

event of problems occurring after completing the linear static and the eigenvalue analysis 

refer to When An Eigenvalue Analysis Goes Wrong 

Solving an Eigenvalue Problem 

Solving an Eigenvalue problem requires setting the Eigenvalue control properties for a 

particular loadcase.  

In LUSAS, the following methods for eigenvalue extraction are available (described below): 

 Subspace Iteration (Jacobi and QL solvers) The objective of the subspace iteration 

algorithm is to solve for a specified number of the lowest or highest eigenvalues and 

corresponding eigenvectors.  

 A Guyan Reduction eigenvalue analysis may also be performed in conjunction with 

the subspace iteration method. 

 Inverse Iteration (only available if a range of eigenvalues is specified) Computes the 

eigenvalues and corresponding eigenvectors within the range of interest.  

 Lanczos Derived from the same principles as the subspace iteration method, but 

significantly faster, although convergence is not guaranteed. As well as calculating an 

eigenvalue range, as with the inverse iteration method, it is also able to calculate the 

minimal and maximal eigenvalues.  

Having calculated all the required eigenpairs, the solution is completed by calculating error 

estimates on the precision with which the eigenvalues and eigenvectors have been evaluated, 

and normalising the eigenvectors according to a user-specified criterion.  

For further details regarding the operation of the eigenvalue extraction facility, refer to the 

Theory Manual. 

Subspace Iteration 

The first step in the subspace iteration procedure is to establish the number of starting 

iteration vectors. This should be greater than the number of required eigenvalues to increase 

the rate of convergence. It is important to remember that the number of starting iteration 

vectors cannot exceed the number of degrees of freedom of the system. The default is the 

lowest of: 

 2 * number of Eigenvalues 

 8 + number of Eigenvalues  

 The number of structural degrees of freedom 

Note that entering zero (0) will force LUSAS to use the default value. 
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Occasionally insufficient eigensolutions are computed in the initial eigenvalue analysis. The 

number of eigensolutions can be increased by specifying an eigenvalue range. 

Convergence Of Subspace Iteration 

As the procedure iterates it is necessary to refer the numerical solution to a criterion with 

which to measure its convergence. It is assumed that the eigensolution has converged on 

iteration k when: 

 

for all eigenvalues i. 

Using Eigenvalue Shifts 

An important procedure that may be used in eigenvalue extraction is shifting. If rigid body 

modes are present in the system, the stiffness matrix will be singular, hence causing 

numerical problems in the subspace iteration and the Guyan reduction algorithms. To 

overcome this a shift may be applied to form a modified stiffness matrix, of which the 

associated eigenvalues will all be positive. To obtain the actual eigenvalues the shift is 

automatically subtracted from the calculated eigenvalues. The eigenvectors for both systems 

are the same. 

The frequency shift enables the eigenvalues of unrestrained structures to be computed by 

removing the zero diagonal terms from the stiffness matrix. The convergence rate of the 

iterative eigenvalue solution procedure will increase with a smaller shift provided the shift is 

large enough to avoid numerical problems.  

A frequency shift value can be estimated between 10% to 50% of the lowest expected 

fundamental eigenvalue. 

Guyan-Reduced Eigenvalue Extraction 

Good finite element approximations to low frequency natural vibrations may often be 

obtained by considering only those freedoms whose contribution is of most significance to the 

oscillatory structural behaviour. This characteristic may be utilised in the condensation of the 

full discrete model to a reduced system, in which the remaining equations adequately 

encompass the required vibration modes. Such a procedure is often termed Guyan reduction, 

and may be used to significantly reduce the overall problem size. 

In a Guyan-reduced eigenvalue extraction, the stiffness contribution of those freedoms whose 

inertia effect is considered insignificant (designated the slave freedoms), are condensed from 

the system. The reduced equation system is therefore dependent on those freedoms remaining 

(designated the master freedoms). The resulting eigenvectors of the reduced problem are 

linear approximations to the true eigenvectors. 

Guyan-reduced eigenvalue extraction is specified from the advanced dialog of the eigenvalue 

control properties. 
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Selecting The Master Freedoms for Guyan-Reduction 

Master freedoms may be specified in one of three ways: 

 Manually Using the attribute Retained Freedoms. 

 Automatically Alternatively, a specified number of master freedoms may be 

automatically generated by setting the Eigenvalue properties (Advanced button). The 

generated master freedoms will be automatically selected such that the highest 

stiffness to mass ratios of the associated structural freedoms are used. 

 Mixed manual and automatic Where manual and automatic master selection is 

combined, the specified number of automatic masters will be automatically selected 

from the available free equations. 

The effective selection of the master freedoms is central to the accuracy of the simulated 

structural response. In the selection of the master freedoms, the following points should be 

considered: 

 The master freedoms must accurately represent all the significant modes of vibration. 

 Master freedoms should exhibit high mass to stiffness ratios. Hence rotational 

freedoms are usually inappropriate masters. 

 Master freedoms should, where appropriate, be as evenly spaced throughout the 

structure as is appropriate. 

 The ratio of master to slave freedoms should generally be within the range 1:2 to 1:10. 

 Poor selection of the master freedoms will have a detrimental effect on the accuracy 

of the Guyan reduction solution especially at higher frequencies. 

Sturm Sequence Check 

When extracting eigenvalues it is important to verify that the computed eigenvalues constitute 

a continuous set, and that intermediate eigenvalues are not missed. To do this the Sturm 

sequence check is invoked; this may be switched off by setting the appropriate parameter on 

the eigenvalue control properties. All eigensolutions present are searched for, unless you 

request a smaller number of solutions by specifying the number of eigenvalues (note that in 

this case, the eigenvalues returned will not necessarily be the lowest in the range, unless the 

Fast Lanczos solver is used). A number of shift points are set up from which the 

eigensolutions are computed. These are determined by the maximum number of 

eigensolutions (system parameter MEIGSH) that can be located from each shift point. Shift 

points may be altered automatically in order to improve the rate of convergence. 

Eigensolutions are computed from each shift point in turn until all eigensolutions have been 

located. 

Modal damping 

By including Modal Damping, the overall damping factors at the eigenmodes can also be 

output as a table in the LUSAS Solver output file. These values may then be used in an 
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Interactive Modal Dynamic analysis if desired. Modal damping is only applicable to a 

Frequency analysis. 

Inverse Iteration With Shifts 

Eigenvalue extraction by inverse iteration may be utilised when calculating an eigenvalue 

range or frequency range. 

This method uses a series of shift points from which to extract the eigensolutions using the 

inverse iteration method. The convergence to each eigensolution is governed by the closeness 

of the eigenvalue to the shift point and the method is thus efficient for locating the 

eigensolutions within narrow bands. 

Convergence Of Inverse Iteration 

As the procedure iterates it is necessary to refer the numerical solution to a criterion with 

which to measure its convergence. For inverse iteration it is important that the eigenvectors as 

well as the eigenvalues are computed to some degree of accuracy. The convergence criteria 

for the inverse iteration scheme is therefore based upon the mass orthogonality tolerance: 

 i j  

for all eigenvectors i and global mass matrix M. 

Lanczos 

When convergence is achieved, the Lanczos eigenvalue solver is usually faster than the 

subspace or inverse iteration solvers, and can use significantly less physical memory and hard 

disk than subspace methods. For these reasons it is ideal for large numbers of requested 

eigenvalues, and for large problems, although convergence cannot be guaranteed.  

Fast Lanczos 

The Fast Lanczos solver is both faster and much more robust than the original Lanczos 

solver, and is the recommended solver of choice for all eigenvalue analyses. When a software 

licence includes a fast Solver option this is used by default when the Default solver option is 

selected. 

Centripetal Stiffening Effects 

In rotating machinery, load correction terms that arise from the effects of rotation may 

significantly influence the natural frequencies of vibration. Within LUSAS the load 

correction terms due to centripetal acceleration can be considered. 

The load correction terms, due to Coriolis forces and angular acceleration, are currently 

ignored because they result in non-symmetric damping and stiffness matrices respectively. 

An eigenvalue analysis in LUSAS will include the gyroscopic effects in the stiffness matrix 

(for certain elements; see Element Reference Manual) if you use a CBF load to simulate the 

angular velocities of the shafts (note that this requires a nonlinear analysis). Such a natural 

frequency analysis would give the frequencies of the lateral modes of vibration. The physical 



Modeller Reference Manual   

    

376 

effect modelled by the centripetal stiffening facility for eigenvalue analyses is the stiffening 

that a rotating be as a result of radial expansion and the corresponding increase in hoop 

stresses. These stresses effectively stiffen the structure and can significantly increase the 

eigenvalues. See the Theory Manual for further information. 

Notes 

 The relationship between the eigenvalue, , and the angular frequency, , is: 

   

 An eigenvalue analysis of the stiffness matrix has no physical meaning except that a 

zero magnitude implies a critical point of some description. 

 Ensure that mass normalisation is chosen for the eigenvalue analysis if it is to be 

followed by a spectral or IMD analysis. 

 It is possible to use constraint equations in both an eigenvalue and a harmonic 

response analysis in LUSAS. However, the Sturm sequence check may prove 

unreliable, unless the fast Lanczos solver is used. 

 Non-zero rigid body eigenvalues may be experienced when using QSI4 elements. This 

is due to the method used to obtain the lumped mass matrix for this element (a 

consistent mass matrix not being available). QSL8 and QTS4 elements give correct 

eigenvalues for both lumped and consistent mass matrices, forming the mass matrix 

using a shape function array. QSI4, however, forms the rotation terms explicitly 

without the use of these functions. Small inaccuracies in the lumping of the mass to 

the rotational degrees of freedom may thus be possible for certain mesh definitions. If 

these eigenvalues are significant, the analysis should be continued using another shell 

element type, such as QSL8 or QTS4 elemnts. 

 The error norm for a given mode provides a relative measure of the accuracy of the 

computed modes. A high error norm will provoke a warning message, and signifies 

inaccuracy in either the eigenvalue or the eigenvector, or both. Warnings are not 

issued for computed modes which are close to zero, since they may approximate rigid 

body modes which are exactly zero, and are thus prone to incurring a large relative 

error. 

 For eigenvectors which are normalised to unity, the largest translational component 

will be set to one. Thus analyses containing rotational degrees of freedom, for 

example, may have eigenvectors normalised to unity that contain rotational 

components greater than one in magnitude. 

 If it is required to use the 1/1-buckling load option to try and obtain all positive 

eigenvalues the specified load must be close to the collapse load in order to obtain an 
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accurate load factor. It should be noted that this procedure is not without its problems. 

Depending on the structure and the load level considered the eigenvalues can be very 

closely spaced, causing convergence problems in the iterative solution. 

 When specifying the range within which Eigen solutions will be located Sturm 

sequence checks are carried out on the range limits in order to determine the number 

of eigen solutions that exist within the range. All solutions are then searched for. 

Eigenvalue Buckling Analysis 

A linear buckling analysis is a useful technique that can be applied to relatively stiff 

structures to estimate the maximum load that can be supported prior to structural instability or 

collapse. The assumptions used in linear buckling analysis are that the stiffness matrix does 

not change prior to buckling, and that the stress stiffness matrix is simply a multiple of its 

initial value. Accordingly, the technique can only be used to predict the load level at which a 

structure becomes unstable if the pre-buckling displacements and their effects are negligible. 

As this procedure involves assembly of the stress stiffness matrix, only elements with a 

geometric nonlinear capability can be used in a linear buckling analysis. 

The main objective of an eigenvalue buckling analysis is to obtain the critical buckling load, 

which is achieved by solving the associated eigenvalue problem. 

For buckling analyses involving constraint equations, the Fast Lanczos solver will only find 

eigenvalues either side of zero, i.e. in the range (- , 0) or (0, ). If a range of eigenvalues is 

required in an interval which contains zero, two separate analyses must be carried out, where 

the interval is divided into two sub-intervals either side of zero. 

Alternative Eigenvalue Buckling 

Occasionally the initial stress stiffness matrix may not be positive-definite, causing the 

eigensolution method to fail. To overcome this problem the original buckling problem may be 

recast into a form where all eigenvalues are positive except when the buckling load factor is 

less than unity. When using this technique the load level must be adjusted to ensure that all 

the load factors are greater than unity. In other words, the load applied should be below the 

lowest expected buckling mode of the structure. An accurate load factor will however only be 

obtained if the specified load is close to the collapse load.  

It should be noted that this procedure is not without its problems. Depending on the structure 

and the load level considered the eigenvalues can be very closely spaced, causing 

convergence problems in the iterative solution. 

Output From Buckling Analyses 

For a linear eigenvalue buckling analysis, the buckling load is obtained from the print results 

wizard. This buckling load is directly related to the eigenvalues extracted and will be in the 

following format 
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MODE 
   

EIGENVALUE 
   

LOAD FACTOR 
   

ERROR NORM 

1 
  

33.0456 
  

33.0456 
  

0.190087E-10 

2 
  

64.3432 
  

64.3432 
  

0.179595E-07 

3 
  

130.903 
  

130.903 
  

0.202128E-11 

The buckling load for a mode is obtained by multiplying the actual magnitude of the applied 

loading by the load factor (33.0456 in the case of the 1st mode). 

Absolute displacement output is not available from any eigenvalue analysis. It is available, 

however in a normalised state. For buckling analyses the eigenvectors (mode shapes) are 

normalised to unity, where the maximum translational degree of freedom is set to one (mass 

normalisation is not applicable to buckling analyses).The mode shapes are, therefore, accurate 

representations of the buckling deformation but do not quantitatively define the displacements 

of the structure at the buckling load. 

Reactions, stresses and strains represent the distribution at the buckling load, again their 

magnitude is not quantitative. 

Spectral Response Analysis 

To study the effects of ground motion excitation on structures it is necessary to input the 

intensity of the motion. One practical measure can be obtained from a knowledge of the 

response spectra. Spectral response analysis seeks to determine the response of a structure 

subjected to a specified support excitation using modal superposition. This can be achieved 

without recourse to direct integration of the model over the complete duration of an event. 

A spectral response analysis is available using the IMD loadcase. 

Starting Procedure 

Before specifying the spectral response data the eigenvalues and eigenvectors of the system 

are computed using an eigenvalue extraction analysis (note that the computed eigenvectors 

must have been normalised to the global mass). 

Spectral Response Data Input 

The spectral curve, spectral curve type and percentage damping are specified in the spectral 

curve which is part of the IMD loadcase definition. 

The spectral curve may be defined as: 

 Frequency or period vs displacement 

 Frequency or period vs velocity 

 Frequency or period vs acceleration 

To compute the participation factors it is necessary to specify the direction of excitation. The 

excitation may be specified simultaneously in three directions. The factor specified in each 

direction is used to scale the spectrum intensity in that direction.  
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For each mode the spectral displacement is determined from the frequency and this is 

multiplied by the participation factor and the excitation vector to determine the response.  

Damping may be specified for each mode of the structure or at known frequencies of 

vibration. If damping is only specified for the first Eigen mode this value is applied to all 

modes. When the percentage damping specified on the spectral curve differs from that 

specified in the viscous damping a correction is made to the spectral displacement based on 

the formula chosen when defining the spectral combination. Damping may also be described 

in terms of the Rayleigh damping parameters and transferred from LUSAS Solver.  

Normally the number of modes included should ensure the sum of the mass participation is 

not less than 90% in all significant excitation directions.  

To obtain the design values some form of combination may be used. Within LUSAS the 

following methods of combination are available: 

 Square root of the sum of the squares (SRSS) 

 Complete quadratic combination (CQC) 

 Absolute Sum 

Note: When zero damping is specified the CQC gives exactly the same results as the SRSS 

technique. 

Transient Dynamic Analysis 

A dynamic analysis is controlled using nonlinear and transient loadcase control properties 

which are defined as properties of a loadcase. To do so, in the Analyses  Treeview access 

the loadcase context menu and choose the Controls menu item. The Nonlinear and Transient 

object  created provides the means to modify the control settings. Additional Nonlinear 

analysis control options are accessed via the Nonlinear analysis options control object  in 

the Analyses  Treeview. Nonlinear analysis options can be specified separately for each 

analysis present. Time-based values are based upon currently set timescale units.  

Application 

A transient dynamic analysis (sometimes referred to as step-by-step) will be required when 

loading may not reasonably be considered to be instantaneous, or where inertia or damping 

forces are to be considered. 

Solution methods 

Dynamic solution methods generally numerically integrate in the time domain. The solution 

is progressed through time in a step-by-step manner by assuming some variation of the 

displacements and velocities over small intervals of time. Within each time step the solution 

yields the displacements at the discrete time points representing the end of the current time 

step. For known initial conditions, successive application of this procedure furnishes the 

dynamic response of the structure.  
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The following numerical integration schemes are available: 

 Central Difference 

 Hilber-Hughes-Taylor 

Implicit and Explicit Dynamics 

Dynamic analysis may be performed using two methods: 

 Implicit Dynamics Implicit methods require the inversion of the stiffness matrix at 

every time step, and are therefore relatively expensive, but unconditionally stable. By 

default the Hilber-Hughes-Taylor is used. 

 Explicit Dynamics In contrast, explicit methods de-couple the equilibrium equations, 

hence removing the necessity for stiffness matrix inversion. Explicit methods are only 

stable for a range of time steps, determined by the problem being analysed, and the 

discretisation adopted. Explicit methods are automatically invoked by specifying 

explicit dynamic elements. In this instance the central difference scheme is mandatory 

and chosen by default. For explicit analysis lumped masses must be used. 

Starting procedure 

To start a dynamic analysis a knowledge of the initial conditions is required. The initial 

conditions for the Hilber-Hughes-Taylor integration scheme are: 

 

where: 

 are the velocities at time steps 0,1 

 are the accelerations at time steps 0,1 

 is the time step 

 is the Hilber-Hughes-Taylor integration constant gamma 

The initial velocity, , and initial acceleration, , can be defined in an implicit dynamics 

analysis. 

The starting conditions in explicit dynamics must be consistent with the central difference 

integration scheme: 

 

where: 

 are the velocities at times - t/2, t/2 

 is the acceleration at time 0 
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Only the initial velocity, V, (actually relating to time -Dt/2) can be defined in an explicit 

dynamics analysis. The displacements, d, (relating to time zero) and accelerations, A, 

(relating to time -Dt) are assumed to be zero. Because of the nature of the central difference 

integration scheme, an initial velocity will generate accelerations at time zero. Accelerations 

relating to time zero are used to compute displacements at time Dt and will in fact be output 

at time t.  

In general, the values output at any time t will be: 

, ,  

This means that in the output for any time step, the displacements will relate to the current 

response time while the accelerations effectively lag one time step behind the displacements. 

Impact Dynamics 

In addition to using nonlinear joint models to represent contact and impact, a specialised 

procedure is available for modelling impact in dynamic analysis. This procedure uses a 

slideline technique, and permits the surfaces of 2D, axisymmetric, and 3D structures to 

register and react to contact with one another. See Slidelines for more information. 

Thermal / Field Analysis 

A thermal/field analysis can be defined initially when creating a new model or by adding a 

general thermal analysis to an existing structural base analysis.  

Transient thermal/field analysis controls are defined as nonlinear and transient properties of a 

loadcase. To do so, in the Analyses  Treeview access the loadcase context menu and 

choose the Controls menu item. The Nonlinear and Transient object  created provides the 

means to modify the control settings. The default state for additional thermal analyses added 

to an existing one is to inherit the assignments from the first, but the additional thermal 

analyses can 'override' some or all of those assignments. 

Thermal / Field Analysis Types 

Two types of thermal/field analysis may be performed: 

 Steady State thermal/field analysis 

 Transient themal/field analysis 

Facilities for thermo-mechanically coupled analysis are also available. 
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Applications 

The quasi-harmonic equation 

defines the behaviour of a variety 

of field problems.  

Some of the more common quasi-

harmonic applications, and the 

associated field variables, are 

listed in the table shown right. 

  

   Application 

Thermal conduction 

Seepage flow 

Incompressible flow 

Soap film 

Elastic torsion 

Electric conduction 

Electrostatics 

Magnetostatics 

   Field Variable 

Temperature 

Hydraulic head 

Stream function 

Deflection 

Warping function 

Stress function 

Electric potential 

Magnetic potential 

Method 

The modelling and solving of a thermal/field problem follows an identical process to that of 

modelling and solving a general structural problem. The domain is discretised using a series 

of field elements, thermal material properties are specified, thermal loads are applied, and 

the equations solved for the values of the field variable at each nodal point. Thermal link 

elements or the specification of thermal surfaces determine how heat is conducted, 

convected or radiated across gaps and spaces between different domains.  

Steady State Thermal / Field Analysis 

In a manner similar to static structural analysis, steady state thermal/field analysis assumes 

that the loaded body instantaneously develops an internal field variable distribution so as to 

equilibrate the applied loads. Note that the use of temperature dependent material properties 

or loads renders the problem nonlinear. 

Transient Thermal Analysis 

A transient thermal/field analysis should be performed when time effects are significant in a 

thermal/field problem. In a similar manner to structural dynamics, transient field analysis 

involves the evolution of a new field variable distribution from a set of initial conditions via a 

set of transition states evolving through time. The initial conditions of the body must firstly 

be prescribed. This may be done by performing the appropriate linear or nonlinear steady 

state analysis. 

Defining a transient thermal analysis 

A transient thermal/field analysis can be defined initially when creating a new model or by 

adding a general thermal analysis to an existing structural base analysis.  

Transient thermal/field analysis controls are defined as nonlinear and transient properties of a 

loadcase. To do so, in the Analyses  Treeview access the loadcase context menu and 

choose the Controls menu item. The Nonlinear and Transient object  created provides the 

means to modify the control settings. Thermal/field analysis options can be specified 

separately for each analysis present. 
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Linear transient analysis 

Integration Scheme 
   

beta  

Crank-Nicholson 
  

1/2 

Euler 
  

0 

Galerkin 
  

2/3 (default) 

Backward difference 
  

1 

The transient problem is integrated through time using a 2-point integration scheme. The type 

of integration scheme maybe changed on Advanced Time step parameters dialog accessed 

from the nonlinear and transient control dialog by specifying the parameter beta. Some of 

the more common 2-point integration schemes and their associated beta values are shown in 

the table above. 

Notes 

 In the limit the final solution should be the same as the steady state analysis subject to 

the new loading and boundary conditions; the transient analysis merely models the 

thermal inertia in moving from the initial to the final conditions. The body property 

which is used to describe this inertia is the effective heat capacity. 

 When choosing an increment of time, the stability of the incrementation scheme must 

be examined. When beta is greater than or equal to 0.5 the solution is 

unconditionally stable (the Crank-Nicholson, Galerkin and Backward difference 

schemes are of this form). 

 When beta is between the limits 0 and 0.5 the solution is stable provided that: 

 

where  is the input parameter beta and max is the maximum eigenvalue of the 

system. 

 The time step used for implicit algorithms is dependent upon the number of modes 

that influence the response of the system. Generally, the major part of the response is 

governed by the lower modes so that: 
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where  is the minimum eigenvalue of the system. 

 The Galerkin scheme is recommended since it generally provides good accuracy and 

is the least susceptible to oscillations. 

Nonlinear Transient Analysis 

For nonlinear transient analysis the backwards difference algorithm must be used (beta = 

1.0). The backward difference algorithm is unconditionally stable, and the time step length 

considerations are the same as for linear analyses. 

For analyses including a phase change, there is either an absorption or release of energy in 

order to create or break the molecular bonds. This is modelled by varying the effective heat 

capacity in the transient analysis. To do this the material property of enthalpy is introduced. 

Enthalpy, H, is defined as: 

 

where C is the effective heat capacity including the effects of the latent heat of evolution due 

to phase changes and  is the temperature. In the material data input both H and C may be 

specified. For analyses where phase changes are not represented, the effective heat capacity 

value C is used in the calculations. 

For analyses where phase changes are represented, tabular input should be used to define the 

variation of H with temperature, together with an initial value of C. Providing a variation in 

temperature exists at a point, the effective specific heat is then interpolated from the enthalpy 

values. If no variation exists, for example, in an area of the problem that has experienced no 

change in temperature from the initial temperature, then the initial value of C is used. 

For nonlinear analysis the nonlinear control parameters are used to define the iterative 

strategy. The convergence section is utilised to provide tolerances for defining steady state, 

and either a field norm (temperature equivalent to the displacement norm), or a residual flow 

norm (equivalent to the residual force norm) may be used. 

Coupled Analysis 

A coupled analysis can be defined initially when creating a new model or by adding a general 

thermal analysis to an existing structural base analysis, or a general structural analysis to an 

existing general thermal analysis structural base analysis. Coupled analysis options can be 

accessed via the Coupled analysis options object  in the Analyses  Treeview.  

Coupled analysis 

The flow of heat through a body and the corresponding distribution of temperature is 

described by the quasi-harmonic equation; the body geometry is assumed to remain constant. 

The displacements of the same body, subjected to various forces, is described by equations of 

static or dynamic equilibrium; the temperature distribution is assumed not to vary with 
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displacement. To include the effect of the change in geometry in the thermal analysis, and the 

change of temperature in the static analysis, requires that this information is separately 

calculated by the appropriate analysis and then transferred. This process is known as thermo-

mechanical coupling. 

Thermo-mechanical coupling may be sub-divided into two classes depending on the nature of 

the problem. 

 Semi-coupled analysis 

 Fully coupled analysis 

Semi-coupled analysis 

In a semi coupled analysis, for instance, the structural response is influenced by the 

temperature field, but the thermal response is independent of the structural response, or vice-

versa. In such a case, the thermal analysis is performed prior to the structural analysis, and 

either a single or series of nodal temperature tables are created. These are read during the 

structural analysis at the required loadcase or time step. 

Fully coupled analysis 

In a fully coupled analysis, the thermal and structural analyses must be performed 

simultaneously with a continuous transfer of information between the two analyses. For 

instance, in addition to modelling the influence of the thermal field on the structural response, 

the effect of the structural response on the thermal field is represented. Temperatures are 

transferred from the thermal to the structural analysis, and the updated geometry is transferred 

from the structural to the thermal analysis. The analyses may be coupled on the incremental 

or iterative levels (iterative coupling is machine dependent). 

For true full coupling of two nonlinear fields, information transfer has to occur on an iteration 

level within each increment, so that in addition to preserving equilibrium of the local thermal 

and structural fields, equilibrium of the combined system is maintained. Iterative coupling is 

essential for strongly coupled systems, e.g. structure to structure contact. For weaker thermo-

mechanical coupling, information transfer at an increment level should provide an adequate 

solution. 

Heat dissipated due to plastic work 

The heat flux produced due to plastic work can be considered in a coupled analysis. In this 

type of problem the structural analysis is started first and the heat dissipated through elasto-

plastic deformation is transferred to a thermal analysis. The nodal temperatures may then be 

returned to the structural analysis where they can be used to produce thermal strains and 

compute temperature dependent properties. The following points should be considered when 

using this facility: 

 The heat flux generated due to plastic work is a function of the time increment over 

which the work is done. For a meaningful solution to this type of problem a dynamic 

structural and/or a transient thermal analysis should be undertaken. 
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 In general, it is recommended that reading and writing to the data transfer file is 

carried out at the same point in the analysis. This avoids any inconsistency occurring 

between the time of generation of plastic work and the time of diffusion in the thermal 

analysis. 

 The thermal softening facility is only valid for nonlinear material models which allow 

input of a heat fraction. The heat fraction takes a value between 0 and 1 and represents 

the fraction of plastic work converted into heat. 

Initialisation of Structural Temperatures 

LUSAS structural elements allow you to input both an initial temperature field and a current 

temperature field. The structure is not strained if its current temperature field is the same as 

the initial temperature field; variations in temperature, defined by the current temperature 

field, from this initial temperature field, cause thermal straining. The nodal temperatures 

transferred from the thermal to the structural analyses are read directly into the current 

temperature field and the thermal strains are then calculated from the difference between the 

current and initial fields. The initial field in this case is zero everywhere unless it is directly 

input using the structural temperature loads. It is possible to initialise the initial temperature 

field to the current temperature field which is read from the data transfer file. Further data 

transfers will be read into the current temperature field only. 

Initialisation of Reading And Writing Commands 

To maintain consistency between reading and writing on a specific increment both data reads 

and writes are performed at the end of the current increment, i.e. if data is required for use in 

the 100th step then it must be read in the 99th step. Similarly, if data is required to initialise 

the structural temperature or geometry field, it must be read on step zero. 

Data Transfer Between Joints And Links 

The physical nature of the joint and link elements is essentially different. Heat flow can occur 

between two unconnected bodies via convection and radiation across the intervening medium. 

On the other hand, joint elements introduce stiffness against displacement, implying a 

physical connection between two bodies. Whilst both may be true simultaneously, more 

usually, only one condition will apply. In these circumstances it is necessary to introduce 

dummy joints with springs of zero stiffness or links with zero conductivity to ensure that the 

appropriate element data is correctly transferred. 

Fourier Analysis 

Fourier analysis controls are defined as properties of a loadcase. To do so, in the Analyses  

Treeview access the loadcase context menu and choose the Controls menu item. Fourier 

analysis options can be specified separately for each analysis present. 
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Fourier elements 

Fourier elements offer an efficient method to solve problems in which axisymmetric 

structures are subjected to non axisymmetric loading, provided that the displacements are 

small and linear theory applies. The circumferential displacements and variations of load are 

expressed as the sum of the components of a Fourier series, whilst the axial and radial 

variations are described by the standard finite element formulation. Each term of the Fourier 

series is analysed individually and the results are then combined to provide the overall 

solution.  

Fourier elements can be used to model both solid and thin walled structures; in particular they 

offer an ideal method to obtain an initial estimate of the eigenvalues of thin walled structures 

without the expense of performing a full shell analysis on the complete structure. The choice 

between a full structural discretisation using solid or shell elements and the use of the Fourier 

element depends upon the number of Fourier terms that are required to accurately describe 

the load; if only a few terms are required then the Fourier element should be considered. 

Attributes and settings 

A Fourier analysis can be considered as a generalisation of the standard axisymmetric 

analysis. The finite element mesh is defined in the XY-plane and may be axisymmetric about 

either the X or the Y axis. Loading is applied to the mesh in the standard manner using the 

loadcase properties, with its circumferential variation defined using the curve definition. 

Finally the Fourier components to be computed are input using the Fourier control as part of 

the loadcase properties. 

Supports are defined in the usual manner, with the declaration 

free, restrained or spring supports. For the n=0 harmonic the 

spring stiffness per unit radian must include a factor of 2p for 

the implicit integration around the surface. For harmonics 

other than n=0 the factor should be p. Certain restrictions are 

applied to the freedoms of nodes lying on the axis of 

symmetry. These conditions, shown in the accompanying 

table, are automatically imposed on the centre line nodes. 

   
Axisymmetric  
about X axis 

n=0 v, w=0 

n=1 u=0 

n>1 u, v, 
w=0 

   
Axisymmetric  
about Y axis 

n=0 u, 
w=0 

n=1 v=0 

n>1 u, v, 
w=0 

Dynamic, Eigenvalue And Harmonic Response Analyses 

A Fourier analysis processes each harmonic individually as they possess their own unique 

stiffness, mass and damping matrices and load vector. By selecting just one harmonic a 

dynamic, eigenvalue or harmonic response analysis can be executed for that particular 

harmonic. The complete structural response can be obtained by superimposing the different 

results from the selected harmonics. 

The Fourier control should specify just one harmonic of a series. The automatic calculation of 

the load coefficients from a given load input is suspended and you must input the appropriate 

load coefficient; if this is not known it may be obtained from a static analysis. Note that to 

represent a global load, the applied load will have components in both the tangential and the 
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radial directions (see the Theory Manual for details of the loading calculations). Only one 

loadcase may be processed. 

Inertial Loading 

The operation of the inertial loading, input using the load type body force, is slightly 

different to the other standard loads. Inertial loads are calculated from element volumes and 

applied accelerations. The specification of linear accelerations, angular velocities and angular 

accelerations is enough to define the forces acting on the structures since the element volume 

and density from which the mass is calculated are element properties. Depending on the input 

data, loads are applied for the n=0,1,2 harmonic components. However, the body force data 

must still be associated with a dummy load curve and must be declared in the first loadcase. 

In addition to the input accelerations, angular velocities and angular accelerations you can 

input an offset origin about which the rotations are applied. The local rotation about the finite 

element axis of symmetry should not be confused with the global rotation about the global 

axes. The local rotation implies that the body is rotating with respect to the finite element 

axes, while the global rotation is a rigid body rotation of the complete finite element model. 

For further details see the Theory Manual. 

Centripetal Load Stiffening 

Centripetal load stiffening has been applied to the n=0 harmonic, but there is no nonlinear 

stress stiffening contribution. 

Special Application to Non-Axisymmetric Structures 

In some instances, the structure may not be truly axisymmetric but it may be desirable to 

obtain an approximate response from an axisymmetric analysis. An example of this is a 

turbine where the turbine axis is axisymmetric but the fan blades are not. The use of the 

standard Fourier material properties is inappropriate for the fan blades since the hoop stresses 

introduced by the element material model provide significant artificial stiffening. To alleviate 

this problem the use of the plane stress material model input using the orthotropic materials 

properties is permissible provided that the element is given adequate torsional restraint. The 

use of this material model can be thought of as smearing the individual stiffness of the fan 

blades into an equivalent axisymmetric structure. 

For Fourier elements using orthotropic properties, body forces are applied using the 

associated load curve.  

If the load curve is input as a series of 1s 

and 0s this is equivalent to selectively 

integrating the internal forces for each fan 

blade. The scheme is illustrated in the 

diagram. 
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Thermal Problems 

If temperature dependent material properties are used the temperature field must be 

axisymmetric. For non-temperature dependent materials, a general temperature field can be 

input in the same manner as the other element loads. Temperature loads cannot be used in 

dynamic or harmonic response analyses. 

Post-Processing 

Fourier results may be expanded using the Graph Wizard. 

Influence Analysis 

An influence analysis identifies where, on a structure, the application of load will result in the 

most onerous load effects for a specific point of interest. This region where the most onerous 

loading will occur is commonly known as the adverse area. In bridge analysis, and 

considering carriageways in particular, this adverse area is typically required by design codes 

to be used to apply live loads such as vehicle and lane loading. Additionally, for some design 

codes, traffic load intensities are a function of the length of lane which is loaded and where 

this is this case an influence analysis is key to determining where, and to what intensity, 

loading should be applied. 

Influence Analysis Methods 

 Influence analysis can be carried out using the following methods: 

 Reciprocal Theorem - also known as the Muller-Breslau Theorem, or Maxwell's 

Theorem, is a means of calculating an influence by the use of an auxillary structure, 

to which a deformation corresponding to a load effect of interest is applied.  

 Direct Method - is a more general and powerful way of calculating an influence 

where the effect of a specified point load is assessed at each node or grid location on a 

loadable area of a structure. The value of the load effect of interest at each specified 

location is then used to construct an influence line or surface for that location. The 

Direct Method can calculate influences for user-defined results components; for 3D 

beam models including torsional effects; for slice resultants from shells; calculate 

influence as a post-processing facility; and can calculate influence for many locations 

and quantities with a single analysis. Solving an influence analysis using the Direct 

Method will take the same time regardless of the number of influence locations solved. 

Both methods require influence attributes to be defined and assigned to a model prior to an 

influence analysis being carried out. Note that Vehicle Load Optimisation analysis requires 

influence attributes to be assigned to a model in order to generate influence surfaces and 

calculate the most adverse vehicle load patterns on bridge structures. 

Notes 

 Only one Reciprocal Theorem analysis entry is added to the Analyses  Treeview. 
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 Multiple Direct Method influence analysis entries can be added to the Analyses  

Treeview. 

Which Influence Analysis Method to Use? 

The main differences between the two influence attribute types are summarised in this table 

Reciprocal Theorem  Direct Method 

Provides only limited options to solve influences for 
grillage, slab and deck models 

Provides more general and powerful options 
to solve influences for line beam, frame, 
grillage, slab and deck models 

List of available influence types is limited to Shear, 
Moment, Reaction and Displacement 

List of available results entity / components 
for influence location is only limited by the 
elements used within the model 

Unable to calculate influence for user-defined results 
components 

Can calculate influence for user-defined 
results components  

Unable to calculate influence surface for 3D beam 
models including torsional effects 

Can calculate influence surface for 3D beam 
models including torsional effects 

Unable to calculate influence for derived results such 
as My-Fx*Rz 

Can calculate influence for derived results 
such as My-Fx*Rz 

Unable to calculate influence for slice resultants from 
shells etc 

Can calculate influence for slice resultants 
from shells etc 

Unable to calculate influence as a post-processing 
facility 

Can calculate influence as a post-processing 
facility 

Unable to calculate influence for many locations and 
quantities with a single analysis. One solution (solve) 
is required for each influence location 

Can calculate influence for many locations 
and quantities with a single analysis (solve) 

In summary, the reciprocal theorem method provides less functionality than the Direct 

Method, but is useful when a load direction is not known as, for example, to identify where to 

apply wind to a tower in order to produce a certain effect within the internal structure 

members. It is also retained to support legacy models. The Direct Method is useful for when a 

load direction is known as, say, downwards in the case of bridge loading. This method also 

provides more general functionality. 

Influence Analysis Attributes 

 Reciprocal Theorem influence attributes are defined from the Attributes > 

Influence> Reciprocal Theorem menu item. The influence type may be a Shear 

force, a Reaction, a Moment or a Displacement only. For each influence type the 

influence direction and either a positive or negative displacement direction needs to be 

specified. For more information see Reciprocal Theorem Influence Attributes 

 Direct Method influence attributes are defined from the Attributes > 

Influence> Direct Method menu item. The influence type may be set by defining any 

Entity of interest (such as a Reaction, or a Force/Moment, or a Stress), an influence 

direction (such as an axis of a member, or a path along a structure, or a material 
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direction) and a Component of interest (such as My). For more information see Direct 

Method Influence Attributes 

Solving an Influence Analysis 

The presence of assigned influence attributes on a model determines that an influence 

analysis will automatically be carried out when a model is solved. 

To solve an influence analysis  choose the Solve Now menu item on its context menu or 

press the Solve button  on the main toolbar menu. Influences for the Reciprocal Method 

can also be solved selectively by choosing the Influences to Solve context menu. 

A successful solve will add influence loadcase results to the Analyses  Treeview.  

Writing a Datafile with Influence Attributes 

Once all influence attributes have been assigned to a model, they can be exported to a data 

file using the menu option Files> Export Solver datafile.... LUSAS will automatically 

identify the datafile to be one that will require an Influence analysis as opposed to a general 

analysis and as such data file names will be generated from the specified file name and the 

influence number. For example, if the specified file name is bridge, then files bridge1.dat 

and bridge2.dat will be created for influence lines 1 and 2 respectively.  

Viewing results of an Influence Analysis 

After solving a model with assigned influence attributes the influence shape for each 

influence point of interest can be viewed on the Influence shape layer in the Layers  

Treeview. This layer name is a renaming of Deformed mesh layer and cannot be added 

manually. 

The influence shape for each influence can be seen by setting each influence loadcase active, 

in turn, in the Analyses  Treeview. 

By adding a Contours layer to the Layers  Treeview contours of Influence result can be 

displayed. By referring to the contour key regions of the model where positive or negative 

loading effects take place can be seen. 

Notes 

 Influence shapes created from a Reciprocal Method influence analysis cannot be used 

directly in a Vehicle Load Optimisation analysis. The Generate Influence Surfaces 

check box on the Vehicle Load Optimisation dialog should be checked to calculate the 

influence surfaces required. 

 When a Direct Method influence analysis has been solved for one assigned attribute 

the effect of a unit load on any part of the structure can be seen immediately for any 

subsequently assigned influence attributes. Additional solving is not necessary. 
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Accuracy of influence solutions 

The accuracy of influence solutions, as with all finite element analyses, improves with 

increased mesh refinement and, in the case of the Direct Method, with closer spacing of 

loading points in the loading grid. 

When using the Reciprocal Method, the influence ordinate at any location is generally 

obtained to the accuracy of the element shape function and mesh refinement. A specific issue 

arises where a discontinuity occurs in an influence surface - such as where the influence of 

shear "jumps" at the central support in a two-span structure. At such a discontinuity, the peak 

value given will be that associated with the node adjacent to the discontinuity. Therefore in 

order to minimise inaccuracy, small element sizes should be used adjacent to the 

discontinuity meaning, for this example, a short element adjacent to the support. 

When using the Direct Method, the influence ordinate is affected not only by the element 

shape function and mesh refinement but also by the density of the grid of points in the loading 

grid (if such a grid is used). With a coarse mesh or coarse loading grid, faceting could lead to 

significant inaccuracy, especially near cusps or discontinuities. In all such cases, increased 

accuracy is gained with closer spacing of grid points. Taking the example of shear force 

adjacent to an internal support, a loading grid which "follows" the FE mesh may give a less 

accurate answer than use of an independent loading grid of similar spacing since it the key 

results are obtained by the loads each side of the support rather than directly applied to the 

supported node. 

Direct Method Influence Analysis 

A Direct Method Influence Analysis requires Direct Method influence attributes to be defined 

and assigned to a line beam, frame, grillage, or slab and deck model. The locations at which a 

prescribed load will be applied to nodes or points on the model also need to be specified. 

Influence attributes are defined and assigned from the Attributes> Influence menu. Load 

locations are defined on the Direct Method Influence dialog, which is displayed either when a 

Direct Method Influence attribute is first assigned to a node or point on the model, or when 

the Analyses> Direct Method Influence Analysis menu item is selected or edited. 

Previously defined settings can be accessed and edited from the context menu for each Direct 

Method Influence entry in the Analyses  Treeview. 

Load locations 

 Search area -  A search area can be used to  limit the area over which the unit load is 

applied so that the effect of the load on certain features may be removed from the 

analysis. If a search area is not specified the default loading area is Whole model. 

 Nodes in search area - restricts the application of the applied load to just those mesh 

nodes within the search area, or to the whole model, as appropriate. 

 Grid - predominantly used with  line beam models where the geometric beam section 

represents a loadable top slab. For this, the grid of points is used to represent the 

loadable region of the slab.  The Grid method also provides the means to define a grid 

of points that can be used as an alternative to the nodes or points present in a shell or 
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plate model that are used in an influence analysis. For a  model with a very fine mesh, 

loading a grid having fewer points will reduce the solution time. For line beam models 

the use of a reference path using lines representing the centreline of a loaded region of 

a structure is recommended if the grid loading method is used. For plate and shell 

models a reference path may represent the centreline of a carriageway on which a 

loading grid would be positioned. 

 Centreline - the centreline of the grid can be defined with reference to a previously 

defined Path or the X, Y or Z global axes. For most types of modelling the use of a 

reference path is recommended.  Specifying X, Y or Z causes the grid to be created 

along each of those axes at X=0, Y=0 or Z=0. 

 Transverse width - the width of the grid to be loaded (must be greater than 0.1). Grid 

settings control the number of load locations within this defined width. 

 Grid settings - These control the density of the grid of points that will be loaded. 

Longitudinal and transverse values can be specified. If one of the global axes has been 

selected as the centreline of the grid, then the overall extent of the model will be 

calculated and a suitable grid generated to encompass the whole model. 

Loading settings  

Loading settings provide the means to specify the magnitude and direction of the loading 

applied to a grid of points used for an influence analysis. 

Vehicle Load Optimisation 

Vehicle load optimisation is used to identify the most onerous vehicle loading patterns on 

bridges for a chosen design code and to apply these loading patterns to LUSAS models. It 

reduces the amount of time spent generating models and leads to more efficient and economic 

design, assessment or load rating of bridge structures.  

Vehicle load optimisation analysis is available in Bridge software products only. It is 

accessed from the Analyses > Vehicle Load Optimisation menu item.  

See Vehicle Load Optimisation in Application Manual (Bridge, Civil & Structural) for more 

details. 

Cable Tuning Analysis 

A cable tuning analysis calculates load factors for selected lines in a model that represent 

cables in order to achieve defined target values set for various components or features. 

Cable tuning analysis is available in selected Bridge and Civil & Structural software products 

only by use of the Analyses > Cable Tuning Analysis menu item.  

See Cable Tuning Analysis in the Application Manual (Bridge, Civil & Structural) for more 

details. 
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LUSAS Solver Types 

Solver type and options can be specified via the Solver Options dialog which is accessed via 

the Model Properties or Solver option control objects in the Analyses  Treeview. The 

current solver options supported are as follows: 

 Standard Frontal- an element-by-element frontal solver which does not require 

assembly of the global stiffness matrix. It uses a direct, sparse solution technique 

based on Gaussian elimination. Stiffness and load arrays are read into memory and 

assembled into the structural stiffness matrix and load vector. This solver is applicable 

to all types of analysis present in LUSAS Solver. The frontwidth of the problem may 

be reduced by optimising the order in which the elements are presented. See Frontal 

Optimisation for details. 

 Fast Multi Frontal- a global frontal solver which assembles global stiffness and load 

data. It uses a direct, sparse solution technique based on Gaussian elimination. 

Stiffness and load arrays are read into memory and assembled into the structural 

stiffness matrix and load vector. This solver is applicable to all analysis types except 

for superelements, Guyan reduction, and nonlinear problems involving branching and 

bracketing. 

 Iterative (Conjugate Gradient) selects an iterative, sparse solution technique for 

solving static, linear analyses. The global stiffness matrix and load vector(s) are 

assembled, and is designed to run entirely in-memory. Three preconditioning 

techniques are available to assist the convergence rate of the conjugate gradient 

method: 

 Standard - The incomplete Cholesky preconditioning technique is the most 

robust (provided an appropriate drop tolerance is chosen), and is applicable to 

all analyses for which the conjugate gradient solver may be used. 

 Decoupled - The decoupled incomplete Cholesky preconditioning technique 

may be used for all analyses except those involving tied slidelines, thermal 

surfaces and Fourier elements. It generally leads to faster overall solution 

times than Incomplete Cholesky preconditioning, although more iterations are 

required for convergence. For less well conditioned problems, the conjugate 

gradient algorithm may not converge using this technique, so care should be 

taken. 

 Hierarchical - The hierarchical decoupled incomplete Cholesky 

preconditioning technique is only available for models consisting entirely of 

two- and three-dimensional, solid continuum, quadratic elements, and offers 

excellent convergence properties. It is by far the most effective technique for 

models of this type, and when used in conjunction with fine integration allows 

solutions to be obtained for relatively ill-conditioned problems. For very ill-

conditioned problems of this type (e.g. where the average element aspect ratio 

is high), an extra preconditioning option exists which will often yield a 

solution faster than using a direct solver. 
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 Assembly Assembles a stiffness matrix only and is primarily intended for research 

use. 

 Fast Parallel Direct Solver a high-performance, robust, memory efficient solver for 

solving large sparse symmetric and non-symmetric linear systems of equations on 

shared memory multiprocessors. This solver cannot currently be used for any form of 

eigenvalue analysis, or for superelement or Fourier analyses, or for nonlinear problems 

using branching and bracketing. 

 Fast Parallel Iterative Solver a high-performance, robust, memory efficient solver 

for solving large sparse symmetric and non-symmetric linear systems of equations on 

shared memory multiprocessors. This solver cannot currently be used for any form of 

eigenvalue analysis, or for superelement or Fourier analyses, or for nonlinear problems 

using branching and bracketing. 

In general, care should be taken when solving problems with high aspect ratios (thin or 

elongated), or excessively curved or distorted elements, or extreme or widely disparate 

material properties, since all of these can lead to ill-conditioning. Note also the convergence 

of the Iterative (Conjugate Gradient) solver is related to the condition number of the stiffness 

matrix which becomes worse for ill-conditioned problems. 

Notes relating to the Iterative (Conjugate Gradient) solver 

The Iterative (Conjugate Gradient) solver can be configured using the following parameters: 

 Drop tolerance- a value between 0.0 and 1.0 which measures the amount of new non-

zero entries (known as fill-in) allowed to remain in the preconditioning matrix during 

the incomplete Cholesky factorisation of the stiffness matrix. The default value is 1.0, 

leading to a very sparse preconditioning matrix suitable for well conditioned 

problems. For more ill-conditioned problems, however, this value should be decreased 

exponentially, and values in the range [1.0e-3, 1.0e-6] are recommended. The lower 

this parameter becomes, the larger the preconditioning matrix will be, giving rise to 

fewer iterations during the conjugate gradient solution, although each iteration will 

take longer to process. This parameter affects all preconditioning techniques, although 

the effect is less pronounced for the decoupled techniques. 

 Maximum number of iterations- an upper limit on the number of conjugate gradient 

iterations to be processed; the default value is 5000. If the convergence criterion has 

not been satisfied when the iteration limit is reached, LUSAS Solver will issue a 

warning and then continue the analysis. 

The following points need to be taken into account: 

 Conjugate gradient methods can only be used for problems having symmetric 

positive-definite matrices. By definition, standard linear, static analyses yield positive-

definite matrices in general, but mixed-formulation problems (such as pore pressure 

models) do not. 
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 Problems involving constraint equations cannot currently be solved with the iterative 

solver, since the resulting stiffness matrix is non-positive-definite. 

 For problems with multiple loadcases, iterative solvers are less efficient since a 

separate iterative process is required for each loadcase, and the total time taken will 

increase in proportion to the number of load cases. By contrast, direct solvers incur 

very little extra cost when solving for multiple loadcases. 

 Guyan reduction and superelement analyses cannot be solved iteratively, since 

matrix reduction does not take place. 

 When using hierarchical basis preconditioning, if any midside degrees of freedom are 

supported or prescribed, their corresponding vertex neighbours must also be supported 

or prescribed. For example, if a midside node is fixed in the x-direction, all nodes on 

the same edge of that element must also be fixed (or prescribed) in the x-direction. 

 The iterative solver will perform very poorly if there is not enough physical memory 

for the solution to proceed in-memory. To guard against this, a data check (OPTION 

51) may be performed (as with the direct solvers), which will estimate the amount of 

memory the iterative solver would use with the specified drop tolerance and choice of 

preconditioning technique.  

 The iterative solver has limited error diagnostics to warn against ill-defined or 

incompletely specified models. If this is suspected, the analysis should be run through 

the standard frontal solver for more comprehensive error diagnostics. 

For further information see the Solver Reference Manual 

Choosing a Solver 

The default solver is the standard frontal solver and is used unless the fast solver option has 

been licensed in which case the fast multi-frontal solver is used. An alternative solver may be 

set from the Solver Options dialog under the Model Properties> Solution tab. 

Direct (e.g. frontal) solvers are more robust than iterative solvers and are applicable to all 

types of analysis. Direct solvers should always be used for very ill-conditioned problems 

since the time taken to obtain a solution is independent of the problem conditioning. Iterative 

(e.g. conjugate gradient) solvers are usually only applicable to static, linear analyses, and will 

perform best on large, well conditioned problems, since the time taken for solution is less 

dependent on the size of the problem than for direct solvers. Iterative solvers require far less 

storage (memory + disk space) than direct solvers. This means that iterative solvers 

sometimes have the advantage of remaining in memory where a direct solver would have to 

run "out of memory". Iterative solvers are only applicable for a single loadcase. 

Frontal Optimisation Options 

The frontal optimisation options are set from the Solver Options dialog which is accessed via 

the Model Properties or Solver option control objects in the Analyses  Treeview.  
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Frontal optimisation is only required when using the standard frontal solver. It is not required 

for the fast multi-frontal solver. When no optimiser is specified the Sloan optimiser will be 

used to optimise the front width for the standard frontal solver. The frontwidth of the problem 

may be reduced by optimising the order in which the elements are presented.  

Optimising methods supported are: 

 Standard uses the standard LUSAS optimiser. 

 Akhras-Dhatt uses the Akhras-Dhatt optimiser. A number of iterations must be 

specified for this optimiser. The iterations are used to find the best starting point in the 

structure for the optimisation. The higher the number of iterations, the better the 

chance of locating the optimal starting point, but the longer the optimisation process 

takes. 

 Cuthill-McKee optimises the solution based on the Cutill-McKee optimiser. This 

algorithm bases its optimisation on a specified parameter. Options are: maximum 

bandwidth, RMS wavefront, bandwidth and profile. This optimiser was originally 

written by E.H. Cuthill and J.M. McKee, and was improved by G.C. Everstine. 

 Sloan uses the Sloan optimiser (default). 

If no optimiser is specified then the Sloan optimiser is used by default. 

Solver Licence Selection 

When running an analysis, LUSAS Modeller passes all details of the licence it is running with 

to LUSAS Solver. It includes the minimum set of licence options required to solve the job, 

and a teaching and training identifier if Modeller is running in teaching and training mode.  

To find a suitable Solver licence with which to run an analysis Solver does the following: 

 By default a Solver licence with the same licence key number or 25 character key as 

the Modeller licence is sought and if available and valid is used. 

 If the Solver licence that matches the Modeller licence is in use, or is invalid or 

unavailable, Solver will re-order all suitable Solver licences and internally list them 

such that the least functional Solver licence that is still able to solve the job is listed 

first.  

 Once listed, Solver will tumble through the licences in the list until one is found that is 

both valid and available. This is then used for the duration of the analysis. 

Creating shortcuts 

Shortcuts can be created to tie a licence type to a shortcut used to run LUSAS Solver. For 

more information see the LUSAS Configuration Utility. 

Pre-Analysis Checks 

Prior to running an analysis it is prudent carry out a few basic checks: 
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1. Check the consistency of your co-ordinate systems between the finite element model 

and any engineering drawing that you have worked from. 

2. Check key drawing dimensions against co-ordinates of respective points in the model. 

3. Check the mesh for cracks and voids. Checks for cracks must be made to ensure 

that the features form a continuous structure.  

4. Check for correct material properties and assignments. 

5. Check for consistent units. 

6. Check for correct orientation of beam properties. 

7. Check for correct boundary conditions (loads/supports). 

8. Check element thickness against original model data (plates/shells). 

9. Check reversed normals for plates/shells/2-D. 

10. Check element shapes for aspect ratio, skew, warp, taper, curvature and centrality 

of mid-side nodes. Warning messages will be present in the output file for all of the 

above. 

11. From the LUSAS datafile dialog, File> Export Solver datafile... menu item, click on 

the Output button to check that the output provides sufficient checking information in 

the LUSAS Solver output file (e.g. reactions).  

Notes 

 It is often a good idea to carry out a ‘pilot’ analysis on a crude model to check load 

paths and equilibrium. 

 In order to ensure that an adequate mesh density is used a mesh sensitivity study 

should be carried out.  

 It is good practice to keep an up to date log book with adequate plots (including 

hidden line views) to cover all parts of the model. It is also useful to set-up a reference 

system to select individual regions of the model using the groups facility. 

 Keep a log of analysis runs for future reference. Note information such as element 

types, numbers of loadcases, frontwidth, file sizes, run-times, etc. 

 Keep regular backups of model. This is done automatically by LUSAS Modeller. See 

Model Files for more details. 

Running an Analysis 

There are various ways in which an analysis can be run from within LUSAS Modeller.  

The Solve now toolbar button  allows particular analyses to be selected for solving.  
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A context menu for each analysis name in Analyses  Treeview provides additional Solving 

options: 

 Solve now allows individual analyses to be solved in isolation from others that are 

present in the Analyses  Treeview, and solves all loadcases defined within that 

analysis. 

 Loadcases to solve allows selection of loadcases to be solved (the checkbox is ticked) 

when the Solve now toolbar button or context menu option are chosen. Loadcases 

where the check box are unticked will not be solved and these loadcases are denoted in 

the Analyses treeview with a red cross   to show that they have been turned off for 

solving. 

When using the Solve now toolbar button, the initial state of the checkbox alongside each 

analysis name on the Solve Now dialog shows whether an analysis needs to be solved 

(because results for that analysis do not exist or are out-of-date due to changes being made to 

the model after an initial solve had been done). Descriptive text alongside each analysis name 

shows the reason why an analysis needs to be solved or not. Analyses needing to be solved 

will be shown checked; those not requiring to be solved will be shown unchecked. An 

analysis will be solved (whether it needs to be or not) if the checkbox is ticked on. No solving 

will take place if a checkbox is off when the OK button is pressed.  

Note that solving a model automatically creates a Solver data file, an output file and, if 

successful, a solver results file for each analysis. 

If an Analysis is Successful 

Results loadcases for each analysis are loaded into the relevant analysis entry in the Analyses 

 Treeview in readiness for optional processing and viewing of results. 

If an Analysis Fails 

If an analysis fails, information relating to the nature of the error encountered is written to the 

text output window and, depending upon the nature of the error, also to an output file. Any 

errors listed in the text output window should be corrected in LUSAS Modeller before saving 

the model and re-running the analysis. 

 Errors and warnings reported in the Text Output window can be double-clicked to open the 

Identify Object facility which can be used to locate the referenced items. For an explanation 

of the errors which may occur see Appendix B - LUSAS Solver Trouble Shooting 

When the termination of an analysis is due to a failure of the solution process rather than a 

problem with the modelling of the structure, if solver restart files were being written as the 

model was being solved, the solution may be restarted from the last converged increment with 

a different or modified solution strategy. See Solver Restart Files for details. 

Identifying objects causing errors during a solve 

Command confirmation and error messages are displayed in the Text Output window.  
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Double-clicking on an error or a warning reported in the Text Output window opens the 

Identify Object facility which can be used to locate the referenced geometric feature or mesh 

object. Options are provided to select the offending item in the View window, move it to the 

centre of the view, scale it to fit the screen, have its properties displayed, or be identified by 

an annotation arrow or a temporary indicator.  

Post-Analysis Checks 

All Analysis Types 

1. Check the deformed mesh for each loadcase to ensure the model has deformed as 

expected. 

2. Compare your finite element results with estimates of stress and deflection from hand 

calculations. This may not always be possible to do very accurately, but an estimated 

should be obtainable. 

3. Check reactions for equilibrium. 

4. Check magnitudes of displacements and stresses. If possible compare to hand 

calculation. 

5. Check for matrix conditioning messages. Small pivot and diagonal decay warning 

messages are invoked when the stiffness matrix is poorly conditioned. Diagonal decay 

means that round-off error during the solution has become significant which could 

lead to inaccurate results. A poorly conditioned stiffness matrix is the result of a large 

variation in magnitude of the diagonal terms. This could be caused by large stiff 

elements being connected to small less stiff elements or elements with highly 

disparate values of stiffness (e.g. a beam may have a bending stiffness that is orders of 

magnitude less than it's axial stiffness).  

 

A negative pivot in a non-linear analysis usually means that a limit or bifurcation 

point has been encountered. However, negative pivots sometimes occur during the 

iterative solution (which sometimes means that the load step is too big) but disappear 

when the solution has converged. If negative pivots occur and the solution will not 

converge then first try reducing the load step. 

 

If the solution still does not converge a limit or bifurcation point may have been 

encountered in which case the solution procedure may need to be changed. Running 

the problem under arc length control gives the best chance of negotiating a limit or 

bifurcation point. A load limit point can also be overcome by using prescribed 

displacement loading. 

6. Check the LUSAS Solver output file for other warning or error messages. 

7. Check adequate mesh density. 

8. Check average nodal stress calculations are not carried out across discontinuities. 
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9. Check the model summary information available in the LUSAS Solver output file. 

This gives the total length, area, volume and mass for the structure together with the 

centre of gravity, moments of inertia and resultant applied load at the origin. 

Dynamic Analysis Types 

1. Check the first natural frequency against hand calculation. 

2. Check of convergence of the eigenvalue extraction algorithm. 

Non-linear Analysis Types 

1. Check convergence of the non-linear analysis. 

Technical Support 

Assistance with Modelling, Analysis and Results 

Engineers in LUSAS Technical Support are available to help all clients with a current support 

and maintenance contract and assist with any modelling or analysis problems that may be 

encountered. Support may be requested by telephone or by email. Email is preferred contact 

method. All relevant files must be sent. See below for details. 

Please note that if LUSAS was supplied to you by a LUSAS distributor then they should be 

your first point of contact for support.  Your local distributor will have access to the main 

LUSAS Technical Support Centre for assistance if required. 

What information should be provided? 

As a guide, providing some or all of the following information will help the support engineers 

get to the bottom of your problem more quickly: 

 The exact text of any warning or error message(s). 

 Machine specification operating system, memory and available disk space. 

 A copy of the model file data that is causing a problem (along with all associated 

model files - see below for details) 

 A list of the last commands used in LUSAS Modeller or a copy of the session file. 

 The contents of the last LUSAS Modeller error log LUSASM_x.ERR 

 Full details of the LUSAS Modeller/LUSAS Solver version numbers in use, the 

LUSAS Solver version number is written to the header section of the output file and 

the LUSAS Modeller version number is obtained from the Help> About LUSAS 

Modeller menu item.. 
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 For telephone support with complex or difficult to describe problems, emailing or 

faxing a simple diagrammatic representation before telephoning can aid in the 

understanding of a problem. 

Sending files to LUSAS Technical Support 

Small files may be emailed in isolation but note that LUSAS model files normally refer to 

many other associated files. For these models, use the LUSAS Support Tool to create a 

compressed file of all relevant data to send to LUSAS Technical Support.  

If within sending and receivable email limits, files may be emailed, but if larger, files can be 

uploaded to a LUSAS Support Area using FTP.  

LUSAS Technical Support can be contacted at support@lusas.com 

Web Resources 

A number of resources are also available via the main LUSAS website.    

Main LUSAS website 

http://www.lusas.com 

General support services  

http://www.lusas.com/support 

LUSAS User Area  

http://www.lusas.com/usrcheck.html 

Note that the LUSAS User Area requires a username and password for access. This will be 

provided initially to the named LUSAS contact within your organization who should be 

consulted if necessary. It can also be requested by and sent to registered users of LUSAS. The 

User Area contains: 

 Answers to the most frequently encountered problems when using LUSAS 

 Detailed instructions for carrying out various tasks with LUSAS 

 Theory on many aspects of LUSAS and finite element analysis in general 

 Explanations and remedies for specific LUSAS error/warning messages 

 Technical and ‘How to’ notes 

 Knowledge base of recently fixed software errors and outstanding issues 

 Links to online copies of LUSAS manuals for recent versions (PDF format) 

 Details of recent LUSAS software releases, LUSAS scripts and other useful files. 

 And more...  
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LUSAS Support Tool 

The LUSAS Support Tool ensures that if a support query is raised all relevant files can be 

submitted to LUSAS Technical Support to aid with the resolution of the query. It is accessed 

using the Help > Support Tool menu item. The following data can be optionally included in 

the archive: 

 Vehicle Load Optimisation settings and input files 

 Model and session files 

 Results file (.mys) 

A single file is created in a compressed file format containing selected data relating to the 

current model. The file is created in the current working directory with a .zip file extension, 

using the model name and date and time of creation as the filename. 

Automated Error Reporting 

LUSAS Modeller makes use of a third party crash reporting facility (CrashRpt) to allow users 

to optionally submit crash reports to LUSAS for investigation. If a crash occurs a crash dump 

is also assembled.  

The automatically assembled error report contains useful information relating to the operating 

system in use, the amount of memory in use by Modeller at the time, where in LUSAS the 

error occurred, and the state of the program when the error occurred. No personal information 

whatsoever is obtained.  

It is requested that crash report information be sent to LUSAS for the benefit of other users, 

and to aid in the continual improvement of the software. Additional information, such as an 

email address, and a brief description of what was been carried out at the time of a crash can 

be optionally given.  

An option to Restart LUSAS Modeller after submitting the error report is also provided. 

This enables a model recovery to be carried out. 

Recovering from a crash 

If a crash has occurred, and if the option to restart LUSAS Modeller after submitting the 

automated error report was chosen LUSAS will automatically be re-started, and display 

startup dialogs culminating in the ModelRecovery dialog where options for recovering the 

previous session are presented. See Model Recovery for more details. 

Not-automated Error Reporting 

For a fully documented investigation of a problem a Support Query should be raised by email 

or telephone with LUSAS Technical Support. This will normally require a model and all 

associated files to be provided. 

Model Recovery 

The model recovery dialog will appear if a model selected for opening had, in a previous 

LUSAS session, been interrupted unexpectedly before it could be saved, resulting in a 
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recovery file being created. This may have been because of a power failure, a program error, 

or from a deliberate interruption. The last command carried out prior to the interruption is 

reported in the dialog. There is a choice in how the model should be recovered from this 

point: 

 Recover whole session Choose this option to recover the whole session (carrying out 

all the commands you made) including the last command shown. This would 

generally be chosen unless the last command consistently caused similar problems 

that prevented a recovery from taking place.  

 Recover all except last command above Choose this to carry out all commands 

except the one shown. This would be chosen if it was known, or subsequently found, 

that the last command shown caused the interruption or prevented a model recovery 

from being made. 

 Open last saved model Ignores all commands and changes made to the model since 

the last save. The last saved model file of the same name is opened. 

 Preserve a backup copy of the model and recovery file  This option is selected by 

default and is used to save all files related to an interrupted session for sending to 

LUSAS Technical Support. 
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Chapter 8 : Viewing 

the Results 

  

Introduction 

This section deals with procedures for results processing. It covers manipulation of results 

files, selection of the correct results type and loadcase, and differences between results 

viewing coordinate systems.  

 Results Processing provides an overview of results processing. 

 Results Files covers manipulation of results files. 

 Results Selection covers selection of the active loadcase, a fibre location and a 

composite layer. It outlines all the different results types available during post-

processing. 

 Results Transformation provides options for transforming results to a consistent or 

alternative coordinate system 

Results Processing 

Results processing, also known as post-processing, is the manipulation and visualisation of 

the results produced from an analysis. Prior to visualising and extracting results, further 

calculations may be carried out to create or assemble results, or the results model can be 

manipulated to create results at particular model locations for a particular results viewing use. 

This diagram summarises what is possible: 
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Analysis Results

Visualising results

Deformed mesh

Peak values

Bending moment and force diagrams

Contour plots

Results as vectors

Concrete crack and crush patterns

Yield of nonlinear material

Further calculations

Combinations/Enveloping

Wood and Armer reinforcement

RC Slab Design

Crack Widths to EN1992-1-1

Fatigue analysis of a linear model

Design factors

Composite failure criteria

Modal analysis

Beam stress resultant from beam and shells

Expansion of Fourier analysis results

IMD Plus calculations

Target values

User defined results

Manipulating the model

Results transformation

Plotting results for groups

Results on a section through the model

Slideline results processing

Thermal surface results processing

Plotting beam stresses

Plotting results for assigned attributes

Graphing of results

Animation sequences

Printing results to the screen or a file

Generating a Report

 

Further Calculations  

 Combinations and envelopes 

 Wood and Armer reinforcement 

 RC Slab Design 

 Crack Widths to EN1992-1-1 

 Fatigue analysis of a linear model 

 Design factors 

 Composite failure criteria 

  Modal analysis 

 Beam stress resultant from beam and 

shells 

 Expansion of Fourier analysis results 

 IMDPlus calculations 

 Target values 

 User defined results 
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Manipulating the Model 

 Results transformation 

 Plotting results for groups 

 Results on a section through the 

model 

 Slideline results processing  

 Thermal surface results processing 

 Visualising and Extracting Results 

 Deformed mesh 

 Peak values 

 Bending moment and force 

diagrams 

 Contour plots 

 Results as vectors 

 Concrete crack patterns 

 Yield of nonlinear material 

 Plotting beam stresses 

 Plotting results for assigned attributes 

 Graphing of results 

 Animation sequences 

 Printing results to the screen or a file 

 Generating a Report 

  

Results Files 

When an analysis is performed by LUSAS Solver a results file will be created. For historical 

reasons this has a .mys extension. By default the results file is automatically loaded into 

LUSAS Modeller after LUSAS Solver has been run. 

The information in the Solver results file is stored in a binary form and may only be accessed 

using LUSAS Modeller. The results file will contain the results of the analysis and sufficient 

model information to process the results. Full details of the finite element mesh (nodes and 

elements), material and geometric property numbers, support positions and equivalent nodal 

loads are stored in the results file. 
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Opening available results files for a model  

When a model is opened, Modeller will 

attempt to open all available associated results 

files for that model. The File > Open 

Available Results Files menu item also exists 

for the same purpose. Results files are loaded 

on top of the current model and results 

loadcases are added to the relevant Analysis 

entries in the Analyses  Treeview. 

Opening a model with results files enables the 

visibility of the model to be controlled by the 

assigned attributes. In addition, all model data 

including group information is present to aid 

results manipulation. Supports and loading 

attributes as assigned for each loadcase can 

also be seen. When results are loaded on top 

of a model file, only results data is loaded 

from the .mys file. Multiple results files may 

be loaded to allow accessing of results from a 

number of analyses at the same time. See 

Manage Results Files for details. 

The Analyses  Treeview (right) shows a typical listing obtained when a results file is 

loaded for a model. 

Closing Results Files 

All results files for all analyses can be closed by selecting the File> Close all Results Files 

menu item. 

 Results files for an individual analysis can be closed by using the context menu item Close 

Results File that is provided on each loadcase. Note that if the results loadcase selected was 

the first results loadcase loaded (meaning that by default it contains mesh data used by all 

other results files opened after it was loaded), all results files will be closed.  
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Results Selection 

Setting the Active Loadcase 

The active loadcase is the loadcase that provides the 

results for the current window. It is set by choosing the 

Set Active menu item from the context menu of a 

loadcase in the Analyses  Treeview. In this way a 

single window is used to plot results from a single 

loadcase, and multiple windows can be used to compare 

results from different loadcases. 

 

 

 

 

Setting the Active Fibre Location  

For plotting diagram results on bars and beams only, 

the active fibre location for which results will be plotted 

must be chosen. It is set by choosing the Set Fibre 

Active menu item from the context menu of a fibre 

entry held within a geometric line attribute in the 

Attributes  Treeview. Fibre locations can visualised 

by double-clicking on the Geometric Line name and 

selecting the Visualise button on the dialog presented. 

Setting the Fibre Active shows results for just that fibre. 

Setting the Name Active shows results for all similarly 

named fibres throughout the model. 

Setting the Active Composite Layer  

With composites analysis, in order to plot results on 

composites laminae a particular lamina must be made 

active. It is set by choosing the Set Lamina Active 

menu item from the context menu of a lamina entry 

held within a Laminate stack attribute in the Attributes 

 Treeview. Setting a Lamina active shows results for 

just that lamina. Composites layer information can be 

seen and visualised by double-clicking on the Laminate 

stack name and selecting the Visualise button on the 

dialog presented.  
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Results Types 

There are several different types of results entities available in each results file. Full details of 

the results available for each element type may be found in Appendix K of the Element 

Reference Manual.  

Each time results are displayed the results entity must be specified. Only result entities that 

are actually contained in the loaded results file are presented for selection. The following is a 

summary of all the results types: 

Structural Analysis 
   

Thermal Analysis 

 Displacement 

 Stress 

 Strain 

 Loading 

 Reaction 

 Reaction Stress 

 Residual 

 Velocity 

 Acceleration 

 Plastic Strain 

 Creep Strain 

 Rubber Stretch  

 Strain energy 

 Plastic work 

 Slideline 

 Named variables 

 State variables 

 Slab Design (RC) 

  
 Potentials  

 Fluxes  

 Gradients  

 Thermal Surface 

Notes 

 Stresses are stress resultants for beams, plates and shells (i.e. forces for beams and 

force/unit width for plates and shells). 

 For plates and shells top, middle and bottom stress and strain are available. 

 When applicable, Wood Armer results, composite failure values, design factors and 

beam stresses are available from the Stress results type. 

 The results calculation and display may be controlled independently using the Result 

Plots dialog activated from the top level of the Groups context menu. See Groups for 

details. 

 See  Results Transformation for general notes regarding the orientation of results. 



  Chapter 7 

    

411 

Results Transformation 

Viewing Results in a Consistent Direction  

When viewing results in Modeller it is important to note that: 

 By default, displacements, loads, reactions, residuals, velocities and accelerations 

are output relative to the global Cartesian axis system. 

 By default, stress/strain and creep/plastic strain results (except for beam/bar 

elements and interface elements) are output relative to the global axes. Forces 

and moments (stress resultants) for beams, shells and joints are output relative to 

the element local axes. 

 For shell and plate elements, and in accordance with established theory, moments 

are given along the chosen axis. For beams results moments are given about the 

chosen axis. 

If the elements in a model are orientated such that their local axes vary from one another (and 

note for surfaces they may also vary from the surface orientation), or if an alternative 

coordinate system is required, the results may be transformed to a consistent direction. 

 Results displayed on contour, values or vector layers in a particular view window can 

be transformed using the Transform results button on the layer properties dialog for 

each layer.  

 Results plotted using the graph wizard, or obtained using the print results wizard, or 

the report writer can be transformed using the Transform results button on their 

respective dialogs. 

Results may be transformed to the following directions: 

 No transformation applied (consult Solver manual) Results may be in global and/or 

element local axes according to element formulation. Depending upon the type of 

model and elements used a results transformation may be required. 

 Local axes or element/node Transforms nodal results (displacements, reactions etc.) 

according to the local transformed freedoms or element results (stresses, strains etc.) to 

element local directions. 

 Local coordinate of parent feature Transforms element results according to the local 

axes of the line, surface or volume feature. 

 Global axes Transforms nodal or element results to the global axes. 

 Material direction Transforms element results to the local element material 

directions. 

 Specified local coordinate Transforms results to a consistent direction using a local 

coordinate.  
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 Shell plane for resultants enables the plane for shell moments and shear forces to be 

defined when using cylindrical or spherical coordinates. See Shell plane for 

resultants below. 

 Reference path Transforms nodal or element results relative to the angle or route of a 

reference path. 

Notes 

 Different model view windows can each have different Results Transformation 

settings. 

  Beam and bar elements always have their local x direction along the length of the 

element. 

 For plates and shells the normal direction is defined by the local element z axis and 

this cannot be transformed. A results transformation only applies to the orientation of 

the local element x and y directions in the plane of the shell element. 

Top/Middle/Bottom, Wood Armer top and bottom, and sign conventions rely on the 

element z axis. 

 When viewing Wood Armer results a transformation is used to set the direction of the 

X reinforcement. A skew angle may then be set independently to define the Y 

reinforcement direction. The default skew angle is 90 degrees. 

 When viewing shell moments and shear stresses using a cylindrical or spherical local 

coordinate the shell plane for resultants needs to be defined as theta/z, r/theta or r/z. 

 Using the transformation options for joint elements has no effect. 

 With the exception of the No transformation applied option the type of 

transformation used is written to the Contour key. 

Shell plane for resultants 

The following diagram illustrates the shell planes available for a cylindrical coordinate 

system.  
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The following diagram illustrates the shell planes available for a spherical coordinate system.  

 

Combinations and Envelopes 

Combinations and envelopes enable the results from several loadcases to be presented as a 

single set of results. 

Basic combinations 

These enable results from individual loadcases (possibly from more than one analysis), other 

basic combinations, smart combinations or envelopes to be factored and added together. 

Smart combinations 

These enable results from individual loadcases (possibly from more than one analysis), basic 

combinations, other smart combinations or envelopes to be factored with an adverse or 

relieving factor and added together.  

 A Permanent load factor is always applied 

 A Variable load factor is only applied if the effect is adverse. This means a 

maximum smart combination (Max) will assemble results from the loadcases selected 

using just the permanent factors for negative load effects, and using permanent and 

variable factors for positive load effects, and a minimum smart combination (Min) will 

assemble results from the loadcases selected using just the permanent factors for 

positive load effects, and using permanent and variable factors for negative load 

effects. 

The Permanent load factor and Variable load factor names may be optionally displayed as 

Beneficial load factor and Adverse load factor if the check box on the  Combination and 

envelope options dialog (see later) has been selected. Note that: 

 Beneficial load factor = Permanent load factor 

 Adverse load factor = Permanent load factor + Variable load factor 

To support combinations for design codes check box options can be used to limit the total 

number of loadcases and the number of variable loadcases to be included in the smart 

combination: 
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 If the Loadcases to consider option is chosen and an appropriate number entered, the 

smart combinations will be assembled in the manner described above, but the number 

of loadcases considered will be restricted to the number of loadcases specified. The 

loadcases used will be the most adverse for each combination i.e. the most positive for 

maximum combinations and the most negative for minimum combinations. All other 

load effects will be discarded. 

 If the Variable loadcases option is chosen and an appropriate number entered, the 

smart combinations will be assembled in the manner described above, but two further 

criteria will be invoked. The number of variable load factors used will be restricted to 

the number specified. The most adverse variable factors will be used in each 

combination and the remaining loadcases, which produce load effects of the correct 

sign, will be included with their permanent factors only. 

Envelopes 

Envelopes enable the maximum and minimum results from individual loadcases (possibly 

from more than one analysis) or other from other combinations or envelopes to be 

determined. 

Defining a Combination or Envelope 

The Analyses menu is used to define 

a combination or envelope. 

Combinations or envelopes may be 

defined at either the modelling stage 

prior to analysis, or at the results 

processing stage. Once defined, 

combinations and envelopes are 

treated as loadcases and are listed in 

 Post processing folder in the 

Analyses  Treeview. Their 

properties may be edited by double-

clicking on the relevant  Basic or 

Smart combination, or  Envelope 

entry.  

User-defined loadcases such as 

envelopes, basic and smart 

combinations, and fatique, IMD and 

target values loadcases (that are also 

held in the  Post processing 

folder) are held with the model file. 

Other results loadcases are held for 

each analysis entry that is present in 

the Analyses  Treeview. 
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Combinations and envelopes definitions are saved in the model file when it is saved. 

Superposition 

Combinations  are only generally applicable to linear elastic analyses. This is because the 

principal of linear superposition is used where, if Load A produces Effect A and Load B 

produces Effect B, then Load A and Load B applied together produce an effect equal to Effect 

A + Effect B. In a linear static analysis this assumption holds true for all results components 

that are calculated by a LUSAS Solver, but note that it does not hold true for all results 

components that can be calculated by LUSAS Modeller. For example, Wood Armer 

calculations are not linear calculations - so superposition is not safe for these. Similarly, the 

definition of any user-defined results components (that can be used within combinations) may 

include equations with terms or constants that are not scalable, meaning that care should be 

taken when using these also. Superposition also is not true when lift-off or contact supports 

are used in loadcases  used in load combinations. 

Expanding a basic combination 

LUSAS assumes superposition is valid when combinations are assembled. In situations when 

superposition may not hold true (as when lift-off supports are present) a nonlinear solution 

may be required. The factored loadcases from a basic combination may be created as a new 

loadcase from the basic combination definition provided the basic combination does not 

include any smart combinations or envelopes. 

A basic combination can be expanded to create a new loadcase for single or multiple 

combinations by using the context menu for a combination or for the post processing folder. 

Combination and envelope options 

When the first load combination or envelope is added to the Analyses  Treeview, a  

Combination and envelope options object is also created. Double-clicking on this object 

displays a dialog on which results components can be selected for calculating and saving in 

the Modeller results file. When results components are selected prior to an analysis being 

carried out the results for the primary components chosen will be available for results 

processing immediately after the results file is loaded because results for these components 

will have been automatically saved (cached) in the Modeller results file. When results 

components are selected on the Combination and envelope options dialog after an analysis 

has been carried out an option to calculate results for the components selected is provided. 

These results will also be cached in the Modeller results file to speed-up results viewing. If a 

model is saved these calculated results will also be saved. 

Visualising the results from Combinations and Envelopes 

Once defined, combinations and envelopes may be manipulated in the same way as other 

loadcases.  In the Analyses  Treeview, right-click on a combination or envelope and select 

Set Active to view results.  

When using smart combinations or envelopes the Set Active menu item will prompt for the 

primary component on which to base the combination or envelope. For an envelope this 
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component will be used to decide which is the maximum or minimum loadcase and for a 

smart combination which factor to apply to each loadcase. When displaying or printing 

results the values shown for other components will be the coincident effects. For envelopes, if 

no component is specified all components are enveloped independently.  

An active loadcase is identified by a coloured icon in the Analyses  Treeview. Non-active 

loadcases are greyed-out. For envelopes and smart combinations either the maximum or 

minimum can be set active. 

Notes 

 When an envelope or smart combination includes another envelope or smart 

combination both the (Max) and (Min) loadsets should be included in the definition. 

The envelope or smart combination (Max) will ignore the envelope (Min) or smart 

combination (Min) loadsets and the envelope or smart combination (Min) will ignore 

the envelope (Max) or smart combination (Max) loadsets. 

 Sometimes it may be convenient to split the loadcases into more than one analysis. 

The loadcases from the separate analyses may then be subsequently enveloped or 

combined. 

 When envelopes of envelopes or combination results are calculated they are 

automatically cached. Saving the model will also save the cached results to the 

Modeller Results File so they are available for future use. Subsequent access to these 

results will be similar in speed to accessing results from a single loadcase. 

 When combining or enveloping results from multiple results files the mesh must be 

identical across all results files. 

 If the loadcase IDs which contain the most adverse effects are not required, 

enveloping can be significantly speeded up by placing the envelope within an 

envelope as the results will then be cached. 

 Spectral (IMD) loadcases can be combined with other loadcases such as those 

defining dead and live loads. Since spectral loadcases are computed from an 

eigenvalue analysis the sign of the displacements are always positive but the most 

adverse effects can be obtained by creating a combination including dead/live load 

and a spectral loadcase both with load factors of 1 and then creating a combination 

including a dead/live load with a load factor of 1 and a spectral loadcase with a load 

factor of -1. 

 For further examples regarding Smart Combinations see Appendix A. 



  Chapter 7 

    

417 

Basic Combination Example 
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Smart Combination Example 

 

For details of smart combination calculations see Appendix A 
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Enveloping Example 

Individual Loadcase Bending Moment Results 

 

Maximum Enveloped Bending Moment Diagram 

 

Minimum Enveloped Bending Moment Diagram 

 

Fatigue Calculations 

Fatigue calculations can be performed on the results of a linear finite element stress analysis 

using the total life approach. This can be done for continuum elements only. The fatigue life 

may be expressed in terms of the damage that is done to the structure by a prescribed loading 

sequence or as the number of repeats of the sequence that will cause failure of the structure. 

Contour plots illustrating the fatigue life of the entire structure can be generated. The results 

from fatigue calculations may be viewed using any of the standard plotting techniques. 

Fatigue calculations of the life of a structure are defined from the Utilities> Fatigue menu 

item. 

S-N Curves 

S-N curves contain the variation in stress/strain values with the number of cycles to failure 

and are defined on a Log Log scale. An S-N curve is used to calculate the number of cycles to 

failure for each loadcase. Miner's rule is then used to combine the damage for each loadcase 

to give the total damage to the structure for the specified loading sequence. 
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Notes 

 Log values are used because of the large variation in magnitude of the input data. 

 If plotting the number of cycles to failure, then the number of cycles entered in the 

fatigue spectrum should sum to unity. 

 For information on standard S-N curves refer to BS5400. 

Fatigue loadcase  

Fatigue loadcases contain the loading spectrum 

defining the loading sequence in terms of a series 

of loadcases, each of which has an associated 

load factor, the number of cycles, and the 

component to be used in the fatigue calculation. 

Once defined fatigue loadcases are saved in the 

Analyses  Treeview. Their properties may be 

edited by double-clicking on the fatigue 

loadcase. 

Fatigue Results 

Results from the fatigue calculations may be viewed using any of the standard methods, once 

the loadcase is set active. Fatigue results come from a component of stress, which is specified 

in the Fatigue loadcase. Two results are obtained from the calculations: 
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 Loglife is the life expectancy of the structure based on the applied load. Results are 

presented as log10 of the number of cycles to failure. 

 Damage is a factor representing the damage the material has sustained due to the 

applied loading and number of cycles. A value greater than 1 indicates failure. 

Notes 

 Fatigue calculations are only applicable to linear elastic analyses and for continuum 

elements only. 

 Fatigue loadcases may be saved in the model file or in a new model file when a results 

file only is opened. 

Interactive Modal Dynamics 

The Interactive Modal Dynamics (IMD) facility within Modeller calculates the modal 

response of a system to a given input using the eigen modes and eigenvectors from an eigen 

analysis. (Note that the eigen analysis must have been performed with mass normalised eigen 

modes). An IMDPlus software option extends this capability to solve 2D and 3D seismic and 

moving load analyses using modal superposition techniques in the time domain. For details 

see the IMDPlus User Manual 

Interactive Modal Dynamics calculations within Modeller may be performed on single or 

multiple eigen modes, and at a single node or over the whole structure: 

 Response at a node Use the Graph Wizard to produce a graph of a specified results 

type against sample frequency range or series of time steps. 

 Response for all nodes Use an IMD loadcase to calculate the modal response of the 

whole structure to a specific frequency or at a particular response time. The results 

from the IMD calculation are then viewed using any of the standard plotting 

techniques such as contouring. 

Assumptions 

The working assumptions for the modal dynamics facility are as follows: 

 Linear The system is linear in terms of geometry, material properties and boundary 

conditions.  

 No Cross-Coupling There is no cross-coupling of modes caused by damping. This is 

reasonable as long as the damping of the structure does not exceed 10% of critical 

damping. 

 Low Modes Dominant The response is dominated by the lowest few modes. 

Performing Modal Response Calculations 

Both the Graph Wizard and IMD Loadcase commands are initiated from the Utilities 

menu. The basic steps for both methods are as follows: 
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1. Decide whether to perform a response analysis on a single node (Graph Wizard), or 

the whole structure (IMD loadcase). 

2. Select Eigen Modes Specify which modes to include in the analysis. 

3. Damping Specify the amount of modal damping. 

4. Excitation Apply a form of dynamic excitation to a specific node or at the supports. 

5. Results Type Choose the IMD calculation required, then set the required parameters. 

Modal Damping 

Modal damping is the damping associated with the displacements defined by the 

eigenvectors. Its value has no physical significance since the eigenvector contains an arbitrary 

normalising factor. 

Damping values can be specified explicitly or alternatively can be extracted from the results 

file. LUSAS Solver will only provide modal damping estimates if the relevant damping 

control data has been included in the eigenvalue analysis. By default, LUSAS Solver values 

will be zero. Damping is specified using percentage viscous and structural damping values. 

Notes 

 Structural damping is not used in modal response calculations in the time domain. 

 Structural damping is not applicable in spectral response calculations. 

 All damping ratios are expressed as percentages of critical damping. 

 Modal superposition techniques are not usually appropriate for structures with 

damping ratios higher than 10%, due to coupling between modes. Step-by-step 

dynamic analysis should be considered in such cases. 

Dynamic Excitation 

Eigenvalue analyses do not consider any applied load. Therefore, to carry out a dynamic 

structural analysis a load must be applied to the structure. These loads are specified either in 

terms of forces, or as motion by use of the large mass method: 

 Point Force To set the modal excitation to point force via a node number and a nodal 

freedom. This is equivalent to applying a unit concentrated force at the selected nodal 

degree of freedom. The value of the unit force depends on the chosen system of units. 

In the case of SI units, a force of 1 Newton or a moment of 1 Newton metre will be 

applied. The amplitude of the load may be specified. 

 Point Displacement (Large mass method) Sets the modal excitation to point 

displacement via a node number and a nodal freedom. A force equal to the large mass 

is applied at the support point, thereby inducing a unit acceleration response, see note 

on large mass. Displacement control is effected by integrating the response twice in 
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the frequency domain. Time domain displacement excitation is not currently 

supported. 

 Point Velocity (Large mass method) Sets the modal excitation to point velocity via a 

node number and a nodal freedom. A force equal to the large mass is applied at the 

'support' point, thereby inducing a unit acceleration response, see note on large mass. 

Velocity control is effected by integrating the response once in the frequency domain. 

Time domain velocity excitation is not currently supported. 

 Point Acceleration (Large mass method) Sets the modal excitation to point 

acceleration via a node number and a nodal freedom. A force equal to the large mass is 

applied at the 'support' point, thereby inducing a unit acceleration response, see note 

on large mass. 

 Real/Imaginary/Real & Imaginary Loading A load vector is extracted from 

specified eigenvalues (loadcases). In this case the modal forces are complex and 

therefore the modal forces are stored in two arrays - one for the real component and 

one for the imaginary. (For excitation types other than these the imaginary components 

will always be zero). Note that it is assumed that all applied forces are in phase. The 

chosen load vector need not be in the same results file as the eigenvectors used for the 

response calculation - typically only one load vector will be stored with the modes.  

 Support Motion To set the modal excitation to support motion. This is used when all 

the supports move together, for example in the analysis of an earthquake or when a 

small component attached to an airframe or vehicle chassis has a known vibration 

level. The calculations are based on participation factors calculated by LUSAS Solver. 

A participation factor defines the modal force resulting from a unit acceleration 

loading applied to the whole model in a specified direction. The participation factors 

for each mode in each of the global directions are stored in the results file and are used 

as modal forces in the support motion calculations. X, Y, Z direction motion or motion 

in any vector direction can be represented. General support motion can be modelled by 

applying a unit acceleration field to the model using body force loading, and selecting 

the resulting equivalent nodal forces as modal excitation. In the frequency domain 

absolute or relative support motion may be selected, the default being relative. 

Notes 

 Displacement and velocity excitations are not allowed for modal response calculations 

in the time domain. 

 Support Motion excitation may be the most appropriate if all the supports move 

together. 

 Large Mass point displacement, velocity or acceleration excitation may be the most 

appropriate if the supports do not move together. 

 For Point Displacement, Velocity and Acceleration excitation, the displacement 

response is absolute and not relative to supports. 
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 When using Support Motion excitation in the frequency domain, the displacement 

response may be specified as relative or absolute. If absolute is chosen then the 

motion of the support is added to the structural motion to give motion with respect to 

ground. This is useful for comparison with measured data. 

 When using the IMD Impulse excitation option, the magnitude of input will be the 

Impulse value (not strictly a force). The Impulse unit will be [force x time]. 

The Large Mass Method 

Interactive Modal Dynamics frequently employs an analysis technique referred to as the 

Large Mass Method. The reason for this is to earth the structure via a ‘moveable’ object 

rather than a strict support to ground. This allows subsequent application of a force to the 

mass, in effect applying an acceleration to the structure. The size of this mass should be 

sufficient to ensure mass dominated local response, so that the motion of the point is 

described by Newton's Second Law (i.e. F = ma). A mass of 1E6 kg works well for most 

structures. Unduly large values may cause ill-conditioning problems. A force equal to the 

large mass is applied at the support point, thereby inducing a unit acceleration response. 

 

Modal Dynamics Results Types 

 Frequency domain response Harmonic, or forced, response analysis is used to 

investigate the effects of structural resonance (where structures are forced to vibrate 

harmonically at or near their own natural frequencies). Solution of the harmonic 

response problem as a modal analysis avoids the need to perform a full transient 

dynamic analysis. Simultaneously applied excitations may contain phase differences. 

 Time domain response (impulse or step-by-step dynamics) to dynamic excitation. 

The forcing function and the consequent response of a structure are defined in terms of 

time histories. The Fourier transform of the time domain gives the corresponding 

quantity in the frequency domain. 

 Spectral response analysis An analysis in which a defined response spectra for a 

generic earthquake ground motion is used to estimate the maximum displacement or 

pseudo-velocity or acceleration during the earthquake, without the need for direct 

integration of the model over the complete duration of the event. Dynamic excitation 

is applied to all the supports simultaneously. A response spectrum curve defines the 
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magnitude of excitation. If the damping in the response spectrum curve differs from 

that defined for the model a damping correction may be applied using one of formula 

provided. The maximum displacements, forces and stresses are computed throughout 

the structure for each eigenmode. These values may then combined to produce a single 

positive result using a spectral combinations. The spectral combinations available are 

CQC (default), SRSS and Absolute Sum. For further details see the LUSAS Theory 

Manual. 

 Power Spectral Density (PSD) Analyses the frequency response to a random modal 

vibration, such as aerodynamic loads acting on an aircraft component. A frequency 

PSD defines the frequency content of the random loading. Dynamic excitation should 

be applied to all the supports via support motion excitation.  

Frequency and Time Domain Response 

Frequency and time domain response calculations are the most commonly used. Usually, a 

node is excited across a frequency (or time) range to generate a graph for the frequency or 

time response (using the Utilities> Graph Wizard menu item). From the response across a 

range, a single frequency may be selected to perform an IMD calculation on the whole 

structure (using an IMD loadcase). The following diagrams illustrate this procedure: 

Results across a frequency range, or time history 

Response at a node calculated across a specified 
frequency range 

Response at a node calculated across a specified 
time history 
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Results at a specific frequency, or time step 

Response calculated at a specified frequency for the 
whole structure  

Response calculated at a specified time for the 
whole structure 

  

  

Frequency Power Spectral Density 

A Power Spectral Density (PSD) defines the frequency content of a random loading, such as 

turbulent pressure acting on an aircraft component, and are for use in modal random vibration 

response analysis. At present, random modal vibration calculations are restricted to single-

input systems, where the loading at all points is fully correlated. 

The value of PSD used in response calculations will be interpolated from a table of 

frequency/PSD values. A range of linear and logarithmic interpolation schemes are provided, 

in accordance with typical PSD specifications. Dialog input requires: Interpolation type, 

options are: Linear/Linear, Log/Linear, Linear/Log, Log/Log; Frequency; Amplitude. More 

copious PSD tables may more easily be defined by copying and pasting the data from a text 

file or spreadsheet.  

Response Spectrum 

Response spectrums for use in spectral analyses are defined from the IMD loadcase dialog.  

The value of the frequency used in spectral calculations will be interpolated from a table of 

frequency-amplitude or period-amplitude values. More copious Response Spectrum tables 

may more easily be defined by copying and pasting the data from a text file or spreadsheet.  

 Frequency/Period/Displacement/Velocity/Acceleration The value of the frequency 

used in spectral calculations is interpolated from the values defined. The type of values 



  Chapter 7 

    

427 

entered, i.e. displacement, velocity, or acceleration should match the type of support 

motion which is used to excite the structure. For earthquake analyses it is usual to 

specify Acceleration, and to later specify a support motion using acceleration. 

 Spectral curve damping This value defines the percentage damping inherent in the 

response spectrum curve itself. If the Eurocode or Kapra damping correction formula 

are specified, the spectral response curve is adjusted to the viscous modal damping 

value specified in the IMD loadcase. When using other damping correction formulae 

the spectral curve is adjusted using only the viscous damping. For more details see 

Theory Manual. 

 

Case Study. Forced Vibration of a Simply Supported Cantilever 

Consider the forced vibration of a simply supported cantilever beam. The beam is supported 

at one end and subjected to a uniformly distributed load. An eigenvalue analysis is carried out 

for 9 modes. Normalisation with respect to Global mass must be selected when defining the 

eigen control.  

Calculation of the modal results in the frequency domain is required for Displacement type 

response for the end node for the Y-direction displacement. Results are to be calculated over 

a suitable frequency range using a specified frequency step. The results type required will be 

Amplitude.  

Modal response calculations are carried out as follows: 

1. Read in the results file from the eigenvalue analysis. Use File> Open and specify the 

results file name. 

2. Click on Utilities> Graph Wizard. Choose Modal Expansion then click on the Next 

button. 

3. Click on Frequency to specify the frequency domain. 

4. Choose a Point force excitation, then click on the Set button to define the parameters. 

Excite the structure at the unsupported end node in the Y-direction. Enter the node 

number or, if the node is selected, choose the number from the drop-down list. Click 

on the OK button, then click on the Next button. 

5. Specify the results entity as Displacement, component DY and the results type as 

Amplitude. Take care to specify a realistic start, end and frequency step. Specify 

which node to calculate the response at, then click on the Next button. 

6. Specify a Title and X and Y axis labels, then click on the Finish button. This will 

create a standard frequency vs. amplitude plot for the response from the specified 

excitation. Two graph datasets will be created, the first containing the frequency range 

in the steps specified and the second containing the required amplitude values. 
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Target Values 

The target values facility is a post-processing facility that provides a general method of 

varying load factors in a linear analysis to try and achieve target values defined for particular 

feature types or results components. Target values can be set by use of the Analyses > Target 

Values menu item. By using the tabbed dialog presented, a solution method is selected, and 

model or results loadcases specified to try and achieve any target values defined. An 'exact' 

method, an optimisation facility and two best-fit solution methods are provided. The target 

values loadset created is similar to a combination, but the load factors are calculated 

automatically by the facility in response to the defined targets. Double-clicking a target 

values loadset in the Analyses  Treeview (or selecting Edit from its context menu) will 

show the settings used to create it. 

Loadcases 

In the calculation of target values each included loadcase can be marked as having a 

Constant factor meaning that the loadcase is used by the optimisation algorithm with a 

constant load factor, or marked as having a Calculated factor meaning that the loadcase will 

be factored by the optimisation algorithm to try to achieve the defined target values. 

For a loadcase marked as having a calculated factor this must be set as either Positive, or 

Allow negative. For loadcases marked as having a constant factor this choice is not available.  

Loadcases marked as having a calculated factor may have an Importance level assigned to 

them (a weighting) but only in an optimised solution. A default value of 1.0 is applied for 

each if an importance level is not specified. 

Cable tuning analysis 

Cable tuning analysis is possible using this general target values method but is simplified by 

using the Cable tuning analysis facility, which automatically assigns an initial axial stress of 

unity to all lines representing cables and automates the definition and assignment of the 

various loadcases required.  

Solution types 

The choice of solution type can be made on any of the target values dialog pages.  
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The type of solution that can be chosen is dependent upon the number of lines selected and 

the number of equality conditions as seen in the Condition column on the Targets grid. The 

solution type can be set to be: 

 Exact. This requires the number of equality conditions (as seen in the Condition 

column on the Targets grid) to be the same as the number of lines (representing 

cables) present in the Included panel on the Cables page. No inequality conditions 

can be defined for the exact method. Using this option, only one solution is possible. 

Note that the exact solution for a given set of target values may produce negative factors for 

some loading arrangements. If this occurs an optimised solution should be investigated 

where all of the points of interest are permitted to move a small distance to try and achieve a 

better solution. In the case of Points being used to restrict displacement in a bridge deck this 

would amount to specifying a distance that would slacken the cables. 

  

  

  

 Optimised(an under-determined solution) requires the number of equality conditions 

(as seen in the Condition column on the Targets grid) to be less than the number of 

lines (representing cables) present in the Included panel on the Cables page that are 

marked as having a Calculated factor. Any number of targets specifying inequality 

conditions can be defined. For this option a range of solutions is possible provided 

that they are not mutually exclusive. For this option a range of solutions is possible. 

Options to minimise or maximise the calculated factors for a variety of in-built or specified 

criteria are provided on the optimisation criteria page. 

  

 Best fit (discrete least squares) and Best fit (Chebyshev)(both over-determined 

solutions) require the number of equality conditions (as seen in the Condition column 

on the Targets grid) to be greater than or equal to the number of loadcases in the 

Included panel on the Cables page that have a Calculated factor stated for them. Any 

number of targets specifying equality or inequality conditions can be defined. For this 

approach no unique solution is guaranteed. 

 Discrete least squares provides positive and negative load factors. No 

inequality conditions can be stated for this option. 

 Chebyshev will always produce positive load factors. Inequality conditions 

can be stated for this option. 

  

Related pages 

The target values dialog pages Loadcases, Targets and Optimisation criteria should be 

visited to specify all data required for a target values calculation. 

Validating target values parameters 

 Validate input The Validate Input button should be used to check if the number of 

equality conditions and the number of loadcases marked as having a calculated factor 

are valid for the chosen Solution method. Three different outcomes exist. 

 Input is valid - the analysis can proceed. 
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 An error message regarding an imbalance in the equality conditions and the 

number of loadcases marked as having a calculated factor will be displayed, 

requiring correction. 

 The message "Exact solution type required" will appear indicating that, because 

the number of equality conditions and number of lines representing cables is the 

same, an optimised or best fit solution cannot be obtained. An Exact solution 

should be used instead. 

Identifying a feature in the grid 

 Identify selection locates a selected feature (a point or a line) in a model. When the 

row for a feature is selected in the grid on the dialog, and this checkbox is ‘on’, the 

corresponding feature (point/line) is located in the View window by animating 

concentric shrinking squares. 

Saving target values parameters 

When the OK or Apply button is pressed all input is saved even if it contains 

errors/inconsistencies. If the input was valid a Target values entry  will be added to a Post 

processing folder in the Analyses  Treeview. A Target values entry  will also be added. 

If the input is invalid the invalid data sign  will appear instead and corrective measures will 

be needed. 

Solving a target values loadset 

To solve a target values loadset press the Solve button  on the main toolbar menu.  

Target values results options 

When a model containing target value data has been solved the context menu for each target 

values loadset  will contain the following menu items: 

 Calculated Factors - displays the load factors calculated to achieve the target values. 

All entries in the grid are read-only. 

 Create Combination - creates a load combination using the load factors as calculated 

by the target values analysis. The menu item is greyed out unless the loadset has been 

solved. 

 Create Loadcase - creates a loadcase (that could be used in a nonlinear analysis) of all 

the separate variable loadcases with each factored by the load factor that was 

calculated by the target values analysis. The menu item is greyed out unless the loadset 

has been solved. 

 Factor loadcases - similar to Create Combination but modifies the original input 

loadcases via their assignment factors. The menu item is greyed out unless the loadset 

has been solved. 
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Wood Armer Reinforcement 

The Wood Armer facility allows reinforced concrete slabs to be designed to resist a 

combination of moments [Mx, My] and a twisting moment [Mxy] using orthogonal (or skew) 

reinforcement.  Following a linear elastic analysis the Wood Armer facility determines the 

design moments [Mx(T), My(T), Mx(B), My(B)]. The procedure was originally developed 

for a moment field obtained from a plate analysis but may also be applied to shell or grillage 

analyses. 

For a slab modelled as a shell, subject to a moment field [Mx, My, Mxy] and a stress field 

[Nx, Ny, Nxy] the Wood Armer principles are extended (using the Clark Neilsen calculation). 

The final output [Nx(T), Nx(B), Ny(T), Ny(B), Fc(T) and Fc(B)] incorporates both bending 

and in-plane load effects. In order to obtain equivalent in-plane forces from the applied 

moments, it is necessary to establish the distances between the centroid of the reinforcement 

layers and the middle surface of the slab. This is calculated using the thickness of the shell 

elements entered in the geometric properties and the distance to the reinforcement centroid 

from the face of the slab, entered in the Wood Armer dialog. 

An approximate approach is also available for grillage elements whereby bending and 

twisting moments are converted into ‘equivalent’ plate moments so that the Wood-Armer 

equations can then be used. An extra geometric property, 'effective width', has to be defined 

for the grillage to compute these equivalent moments. The effective width is defined in the 

grillage geometric attribute. 

Wood Armer properties are specified on the Wood Armer dialog that is activated when a 

Wood Armer component is selected from the contour, values or vector layer properties or 

from the print results wizard. The properties specified in the Wood Armer dialog are 

applicable to all layers. 

Wood Armer Assessment 

The Wood Armer calculation is generally based on a rationalised set of equations intended to 

enable efficient design. However, it is sometimes necessary to consider arrangements of 

reinforcement which have design strengths based on a different rationale. A typical 

application is the assessment of an existing structure. 

If the capacity of the section in the direction of the reinforcement is known the 'utilisation 

factor' based on optimal use of the available capacity can be computed. A utilisation factor 

greater than 1 signifies the slab is under-reinforced and extra reinforcement is required.  

Alternatively, the Wood Armer 'K factor' may be entered to proportion the applied twisting 

moment between the reinforcement directions. This allows any spare capacity that exists in 

either direction to be utilised. 

Notes 

 Grillage Wood-Armer results are only valid for small skew angles.  

 Wood Armer skew angles are measured anticlockwise from the x-axis towards the y-

axis. 
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 Wood Armer results for grillage models are only valid if they are relative to the 

grillage member directions. 

 For grillage models where members are not in either the global X or Y directions, 

Wood Armer components (given in global directions) must be transformed such that 

they are given relative to the local grillage member directions. An angle between the 

global axes and the local axes in the XY plane can be set. 

 
 

Wood Armer moment (MXB) in global X axis for a 

grillage model 

Wood Armer moment (MXB in global X axis ) for the 

equivalent plate model  

 

 

 Wood Armer moment (MXB) in transformed angle 

direction for a grillage model 

Wood Armer moment (MXB) in transformed angle 

direction for the equivalent plate model 

 Comparison of untransformed and transformed values for grillage and plate models 

See the Theory Manual for further information. 
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 Crack Width Calculation Methods 

Crack width calculations and plotting of crack width contours and values can be carried out: 

 For plane strain and solid models, when using the Smoothed Multi Crack Concrete 

Model (Model 102). See LUSAS Multi Crack Concrete Models. 

 For slabs, for design codes that support crack width calculation using the RC Slab 

Designer. For more details see RC Slab Designer: Overview. 

 In accordance with EN 1992-1-1:2004 Eurocode 2 when using the Crack Widths 

calculation utility with the Smoothed Multi Crack Concrete Model (Model 102). See 

Crack Width Calculation to EN 1992-1-1. 

Fourier Results 

Before the results for the Fourier can be established, it is necessary to define a combination in 

which the Fourier harmonics are combined to provide an overall result. The combination is 

created using Utilities> Load Combination> Basic… menu item. 

Once the combination has been generated for all the harmonics required and the analysis run 

to create a results file, the combination loadcase should be set active. 

There are then two ways to view results from a Fourier analysis: 

 By manually specifying the angle around the circumference at which the results are 

required and using contours, values and vectors to view the results at that position in 

the model. 

 By using the graph wizard to display the variation of results around the circumference 

for a specified node. 

Design Factors 

Design factors provide a means of assessing the reserve strength capacity of a component or 

structure. To use this facility the results file must be loaded on top of the model file. The 

material strength and design factor are defined from the Attributes> Design Strength menu 

item and assigned to the model. The reserve strength can then be visualised over the entire 

model using the Utilities> Design Factors menu item. The following criteria are available: 

 Maximum Stress Theory (Rankine) 

 Maximum Shear Theory (Coulomb, Tresca) 

 Maximum Strain Energy Theory (Beltrami) 

 Maximum Distortion Energy Theory (Huber, von Mises, Hencky) 

 Maximum Strain Theory (St Venant) 

Results from each of the above criteria can be displayed as: 
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Design Factor  Calculation  Failure 

Failure/Yield Index actual/allowable >1 

Factored Failure/Yield Index (DF*actual)/allowable >1 

Factor of Safety allowable/actual <DF 

Reserve Factor (RF) allowable/(DF*actual) <1 

Margin of Safety RF-1 <0 

  

where:  

DF = Design factor defined with material strength 

allowable = allowable stress 

actual = actual stress 

See the Theory Manual for further information. 

Composite Layers 

When viewing composite results it is often useful to change the results orientation to material 

directions to view the results in fibre and off fibre directions. See Local and Global Results 

for more details. A layer of a solid composite element is treated like a shell. Thus top, middle 

or bottom stresses can be obtained. 

Composite Failure Criteria 

Composite failure criteria is defined as an attribute from the Composite> Composite Failure 

menu item. It provides a means of assessing the reserve strength capacity of composite 

components without carrying out a full nonlinear analysis. To use this facility the results file 

must be loaded on top of the model file. 

 Longitudinal and transverse tensile and compressive strengths must be defined along 

with a shear strength (which cannot be zero) 

 Interaction type can be set to use Default, User, or Cowin values 

Once created the Composite Failure attribute should be assigned to the model geometry so 

that the reserve strength can be visualised over the entire model. Once assigned to the model 

the following stress components are available for display via selections made on the Contours 

properties dialog: 

 Tsai Hill 

 Hoffman 

 Tsai Wu 

 Hashin Fibre 

 Hashin Matrix 

Results may be printed or displayed using standard results processing facilities. Note that a 

failure criteria greater than 1 indicates failure. See the Theory Manual for further information. 
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Composite Failure Contours 

When using the Hashin failure material model the failure indicator (IFFLR) can be contoured. 

The indicator has the following values: 

Indicator (IFFLR)  Description 

0-1  No failure 

1-2  Matrix failure 

2-3  Fibre failure 

3+  Matrix and fibre failure 

Results may be printed or displayed using standard results processing facilities. 

User Defined Results 

Defining expressions 

 The User Defined Results dialog is accessed from the Utilities> User Defined Results menu 

item. It allows results components to be defined by creating arithmetic expressions based 

upon LUSAS results entities, components, model data and other user-defined results 

component calculations. A component name and description can also be entered.  

User defined results expressions are normally created after a solve has been done and with 

results loaded, but they can also be defined as part of the modelling process after all relevant 

features have been assigned an element mesh. 

 

 Clicking on the drop-list button  in the Entity cell lists all entities available for the 

particular results file loaded.  

 Clicking on the launch dialog button  in the Expression cell displays a dialog 

populated with valid variables for the selection made in the Entity field. By use of 
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these variables and usual arithmetic syntax a user defined results expression can be 

built and assigned a name and a description. 

For details of expressions and functions supported see Input and Output of Real Numbers 

in LUSAS in Appendix E. 

Using named expressions 

After definition, the user defined results components created can be selected by name from 

the Component drop-down list on the Contours, Values, and Diagrams layers properties 

dialogs. All standard LUSAS results processing, viewing, animating, graphing, printing and 

report capabilities can be used with any user-defined results components. 

 

 

 

Visualising The Results 

Results visualisation is performed using results layers in the Layers  Treeview. Each 

method of viewing results, described below, requires the relevant layer to be present in the 

Layers  Treeview for the active current window. The properties of the results layers may 

then be set to display the required results in the specified style.  

 Deformed Mesh Draws the deformed mesh shape of a structure when subjected to 

applied load or due to mode of vibration. Note that when influences are being 

examined the Deformed Mesh layer is named Influence shape. 

 Contour Display the results on the model as colour fringes or lines of equal value.  

 Vector Displays vector results quantities as an arrow (or pair of arrows) on the model. 

 Values Marks result values on the model as symbols and/or values.  

 Diagrams Displays beam element shear force and bending moment diagrams. 

In addition to those layers listed above, an Annotation layer is used to display contour key 

and other annotation data that may be added to the results viewing window. 
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Results Orientation 

When viewing results in Modeller it is important to note that: 

 By default, displacements, loads, reactions, residuals, velocities and accelerations 

are output relative to the global Cartesian axis system. 

 By default, stress/strain and creep/plastic strain results (except for beam/bar 

elements and interface elements) are output relative to the global axes. Forces 

and moments (stress resultants) for beams, shells and joints are output relative to 

the element local axes. 

 For shell and plate elements, and in accordance with established theory, 

moments are given along the chosen axis. For beams results moments are given 

about the chosen axis. 

 If the elements in a model are orientated such that their local axes vary from one another 

(and note for surfaces they may also vary from the surface orientation), or if an alternative 

coordinate system is required, the results may need to be transformed to a consistent 

direction. See Results Transformation. 

Active loadcases 

All results visualising uses the results from the active loadcase for the current window. The 

active loadcase is shown with a coloured icon in the Analyses  Treeview, and may be 

changed using the Set Active menu item from the loadcase context menu. Non-active 

loadcases are shown with a greyed-out icon. An analysis that contains an active loadcase is 

identified by the addition of a black dot to its analysis icon .  

 Depending upon the elements used it may be necessary to transform the results to make them 

consistent. See Results Transformation for details. 

Inserting a Results Visualisation Layer into the Current 

Window 

 Layers can be added (or removed) from the current window using the View> Drawing 

Layers menu item. A tick is displayed on the menu next to each layer being displayed in the 

current window. Alternatively, with nothing selected, right-click in the model view window 

to display a context menu and choose the appropriate layer. Another alternative is to select a 

layer name from the context menu of the Window name in the  Treeview. 

The display of layers in the current window can be turned on or off by right-clicking on the 

layer name in the  Treeview and selecting / deselecting the On/Off option. See Using 

Layers for more information 
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Tips 

 Use the annotation tools to label the display. The annotation toolbar may be 

displayed using the View> Toolbars menu item. 

 When comparing different loadcases for the same results type using multiple 

windows, use a global scale (and a global contour range) so that scaling and 

contouring in each window is relative to the first window. 

 For animations, fix the scale instead of using an auto calculated scale. 

Layer names for results layers 

Contours, Diagrams, Vectors and 

Values results layer names as added 

to and seen in the Layers  

Treeview have the component (such 

as Mx, My or Fz, for example), 

appended to the layer name followed 

by the entity type such as 

(Force/Moment - Thick 3D Beam). If 

different component and entities are selected at a later time the layer name in the Layers  

Treeview is updated to reflect the chosen selection. 

Deformed Mesh Plots 

The deformed mesh may be displayed at any time for a 

single loadcase. For a structural analysis this is the 

shape under load, whereas for an eigenvalue analysis 

this is the shape corresponding to the selected eigen 

mode. 

 Mesh Scaling is specified as either a 

deformation factor or a deformation magnitude. 

The deformation magnitude specifies the 

maximum deformation to be displayed on the 

page in millimetres. 

 Mesh Style The deformed mesh style may be 

altered as required using wireframe, solid 

colour, hidden mesh, and element effects.  

Drawing the mesh and the deformed mesh together but 

in different pens and with a suitable scale factor for the 

deformed mesh is useful for visualising and clarify the 

deformations.  
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Notes 

 Other results visualisations may be displayed on the undeformed or deformed shape as 

required. 

 When carrying out contact analysis a unit deformation factor should be used to avoid 

misleading results. 

 When an analysis involves the activation and deactivation of elements, inactive 

elements may be shown using the  Show activated only option on the View tab of the 

View properties dialog. 

Contours 

Contours display the results of the active loadcase on the model as colour fringes or lines of 

equal results value.  

Contour Display Features 

 Contours may be plotted using colour fill and/or contour lines. Fill and line contours 

displayed together are useful for emphasising the contour levels. Contour labels are 

available if required. 

 Contours may be plotted on the deformed (loaded) shape or the undeformed shape. 

 Contours may be plotted using averaged nodal results (smoothed) to give a smoothed 

plot, or use unaveraged (unsmoothed) nodal results to contour the results on an 

element-by-element basis, revealing any inter-element discontinuities. This is useful 

for checking mesh discretisation error and for displaying results across geometry or 

material discontinuities. 

 Contours can be plotted on shells, solids, bar and beam elements, on fleshed members, 

on layers of composite elements, on slidelines, thermal surfaces, slices and influence 

shapes (for the Direct Method Influence only) 

 The maximum and/or minimum results value and node location can be annotated. 

 The appearance of the contour key can be adjusted to specify the number of significant 

figures, draw an outline around each colour in the key and draw red or blue uppermost. 
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Setting the Contour Levels 

By default the levels at which contours are plotted are calculated automatically but they can 

also be set explicitly. A contour level corresponds to the boundary between adjacent colour 

fringes, or the line of equal value. 

 Setting the range automatically can be done by specifying either the number of 

contours or the interval value between contours.  

 Automatic contours levels can be set to pass through a certain value. The maximum 

and minimum contours may also be specified. 

 A global range can be used to fix the contour levels between different contour 

windows. It is useful to fix the contour levels manually when comparing results from 

different loadcases. In both these cases the loadcase containing the maximum value of 

interest would normally be used to set the contour range. 

 For animations use a manual range to ensure all frames use the same range 

Tip. Contours use the colour map to define the colours used. It is often useful to adjust the 

colour map so that low stress contours are set to white. This makes contour plots easier to 

understand, and also avoids excessive use of a particular coloured ink when printing.  

See LUSAS Multi Crack Concrete Models (Model 94 and Model 102) for details of 

plotting contours and values of crack widths. 

Vectors 

Vectors are used to visualise both the magnitude and direction of specified results 

components. Vectors may be displayed at either nodes or Gauss points.  

Scale 

By default, vectors will be scaled such that a vector length of 6mm represents the maximum 

displayed results component. Alternatively, a scale factor can be specified.  
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Style 

Vectors may be drawn as lines or arrows. By default the colours used for drawing vectors in 

tension and compression are red and blue but the pens can be altered as required. 

Deformed Shape 

This image shows displacement vectors displayed on the deformed shape. 

 

Values 

Values are used to identify the location and value of results for both averaged nodal 

(smoothed), element nodal (unaveraged) and Gauss point values. Either maximum and/or 

minimum values may be visualised, and a percentage may be specified to determine whether 

values lying within a maximum/minimum range are displayed. Values may also be displayed 

at selected nodes. 

The Values layer is also used to display the locations of yield symbols and of concrete 

cracking planes and symbols denoting regions of localised crushing. See Nonlinear Material 

Plots for details. 

 

 
 

Maximum and minimum values marked 

 

Values plotted for selected (shrunk) elements 
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Visualisation of yielded material Visualisation of concrete crack patterns on a 2D model 

Tips: 

 The percentage range sets the range of values to display, starting from the maximum 

and/or maximum values. Setting this value to 100% displays all values, this is useful 

for displaying nodal results on the screen for a subset of a model. Setting this value to 

0% shows only the extreme maximum and/or minimum setting. 

 To prevent text labels from overlapping each other the elements on which that are 

drawn may be shrunk by specifying a percentage score of elements length remaining 

on the Mesh layer properties dialog. Additionally text may be given a rotation angle 

on the Values layer properties dialog to prevent text labels from overlapping each 

other. 

 Use the Show values of selection option to isolate only those values of interest, or to 

restrict labelling on complex models to selected nodes and elements only. 

 Gauss point values display the computed values from the analysis. These values may 

be particularly useful when examining results for nonlinear materials. 

 Unaveraged values display the computed values after they have been extrapolated to 

the element nodes but before they have been averaged. These values may be of 

particular interest when examining results around discontinuities in geometry of 

materials. 

Diagrams 

Bending moment and force diagrams may be drawn for any 2 or 3 dimensional frame 

structure comprised of bar or beam elements. All of the results for diagrams are located 

within the Stress results entity, and the results components available will depend upon the 

element type (see Element Reference Manual). The diagrams may be drawn using the element 

axes or screen axes. 

The following quantities may be represented: 

 Axial Forces local x direction beam forces. 

 Shear Forces through-thickness shear forces. 

 Bending Moments bending moment results. 

 Torsional Moments 
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Plotting Results for Groups 

By default results are computed and displayed on the visible model. When appropriate layers 

are present in Layers  Treeview, results can be selectively plotted for groups held in the  

Treeview by choosing the following Results Plots context menu items for each named group: 

 Show Results  

 Do Not Show Results  

 Show Results Only On This Group / Attribute 

When combined with group visibility options that can also be accessed via the context menu 

for each group name parts of the model can be isolated and have results plotted just for those 

regions.  

Pairs of symbols adjacent to each group name in the  Treeview show the status of model 

visibility and results display. 

 When viewing results: 

 (green tick) All of the objects in this group are visible, but no results are being shown. 

 (blue tick) Some of the objects in this group are visible, but no results are being shown. 

 (red cross) None of the objects in this group are visible and no results are being shown. 

 (green tick, green border) All of the objects in this group are visible and showing results. 
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 (blue tick, blue border) Some of the objects in this group are visible and some are 

showing results. 

 (green tick, blue border) All of the objects in this group are visible but only some are 

showing results 

Notes 

 When choosing to show results for a material, geometric property or element mesh 

type that does not support (for example) the same Contour entity as that used for the 

previously plotted item, no results will be shown until a valid Entity and Component 

for the new selection is picked on the Contours property dialog accessed via the 

Layers  Treeview. 

 A black dot next to a group symbol  denotes the current group into which all new 

geometry will be added when created and hence has no relevance when viewing 

results.  

Plotting Results for Assigned Attributes 

By default results are computed and displayed on the visible model. With appropriate layers 

present in Layers  Treeview, results can be selectively plotted for attributes held in the 

Attributes  Treeview by right-clicking on the attribute name and then choosing Results 

Plots. The following context menu commands are available for Results Plots: 

 Show Results 

 Do Not Show Results 

 Show Results Only On This Attribute 

When combined with visibility options that can also be accessed via the context menu for 

each attribute selected features of the model can be isolated and have results plotted just for 

those features. This provides a means of producing isolated results for particular material 

types, geometry, or element mesh types without having to define individual groups for each 

of these items. But, if required, groups of features or elements may be defined and the Results 

Plots entry may be used to display selected results for a chosen group. 

Notes 

 When choosing to show results for a material, geometric property or element mesh 

type that does not support (for example) the same Contour entity as that used for the 

previously plotted item, no results will be shown until a valid Entity and Component 

for the new attribute selection is picked on the Contours property dialog accessed via 

the Layers  Treeview. 
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Nonlinear Material Results Display 

Two types of nonlinear material results may be displayed. Yield flags and crack/crush 

patterns. The availability of each depends on the material model assigned to the elements 

during the modelling stage. Crack and crush patterns are available for concrete models and 

yield flags are available for all nonlinear materials. 

  

 Yielded material 

Available from the Values layer, 

specify the results entity as Stress, 

and the type as Yield. Yield flags 

show the extent of the yielded 

material within a structure and are 

plotted at Gauss points. The 

nonlinear example here 

demonstrates how the spread of 

yielded material is visualised 

using a symbol at element Gauss 

points. 

  

This display is especially useful when used in conjunction with contours or an 

animated sequence when the onset and spread of yield can be highlighted.  

 Crack patterns and Crushing Crack patterns and crushing symbols can be 

displayed for models that use the concrete material models 94 and 102. These are 

visualised using the Values layer by specifying the Results Entity as Stress and the 

Type as Crack/Crush. Three types of display are possible:  

 Localised crushing is shown by black star symbols  

 For the Multi Crack Concrete model regions of cracking are shown by crack 

planes drawn in red full lines, and closed cracks are shown by crack planes 

drawn in red dashed lines. 

 For the Smoothed Multi Crack Concrete Model crack planes are drawn in a 

common line style and pen colour whether open or closed in nature. 
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Open and closed crack planes and crush symbols resulting from 

 the loading and unloading of a 2D concrete shell model 

Notes 

 When a model includes a nonlinear material model the Plastic strain entity is 

available for all elements (even though some elements are not valid) 

 See LUSAS Multi Crack Concrete Models (Model 94 and Model 102) for details 

of plotting contours and values of crack widths. 

Results On Sections / Slices Through A Model 

Results can be plotted on sections or slices through a model by choosing the following menu 

commands available from the Utilities menu: 

 Section through 3D Cross-sections may be taken through a three-dimensional solid 

model to display results on a slice. Results are calculated at pseudo-nodes formed at 

the intersections of the slice with the element edges by linear interpolation of the nodal 

results. 

 Graph through 2D Graphs of results may be created along a line through a 2D 

continuum model or on a line through a section from a 3D model. Results are 

calculated at the intersections of the line section and the element edges hence a finer 

mesh will produce more sampling points. Force and moment values along the slice 

may also be computed. 

Section Through a 3D Model 

Slice sections may be cut at arbitrary positions through the model using the cursor to define 

either a horizontal or vertical slice in the View window. Slices may be generated in any plane 

by rotating the model to the desired orientation before a section is cut. 
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By default the location of an arbitrary slice 

section through a model is not saved with 

the model. However, when cutting a slice 

section through the model an option to 

create an annotation polygon is provided. 

This annotation polygon effectively defines 

the location and orientation of the cutting 

plane and does get saved with the model. 

Annotation polygons may be re-selected if a 

model is reloaded at a later date in order to 

create a slice at the same location.  

Slice sections can also be created using surfaces that are created at slice section locations. 

These surfaces do not have to surround a model, they must simply be defined in the 

orientation of the cutting plane required. 

To use a saved cutting plane or a surface defining in cutting plane instead of indicating the cut 

using the cursor, the annotation polygon or surface should be selected before choosing the 

Utilities> Slice through 3D menu item, and By selected polygon / surface option. 

Notes 

 No results visualisation or printed results for slices are available unless the Display on 

slice(s) option has been selected on the Contours and Values properties dialogs or on 

the Print Results wizard dialog. 

 3D sectioning/slicing is only available for 3-Dimensional solid models. For surface 

models refer to Graph Through 2D below. 

 A slice can form the basis for a line section using Graph Through 2D to graph 

results along a line through the centre of a three dimensional solid. 
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Manipulating The Slice 

Once a 3D slice section has been defined, a slice 

exists as a group in the  Treeview, and may be 

manipulated using the View> Group menu item or 

from the group's context menu. For more details on 

viewing results on groups see Plotting Results for 

Groups.  

Notes 

 The mesh and nodes on the slice are 

displayed using the mesh layer  

properties. 

 The slice local axes and origin are displayed 

and moved from the slice properties accessed from the slice context menu. 

 The resultant local forces on the slice and the slice properties may be printed from the 

slice context menu. 

 Groups created from slice sectioning a 3D model cannot currently be retained when a 

model is saved. 

Graph Through 2D 

Arbitrary line sections may be taken through any surface model or on a slice cut through a 

three dimensional solid model. The process of cutting a slice will generate two graph datasets, 

the first containing the distance along the line section and the second containing the specified 

results along the line. The graph datasets are plotted automatically using the Graph Wizard. 

Graph datasets are stored in the Utilities  Treeview.  

By default line sections may be cut at arbitrary positions through the model using the cursor. 

Lines can also be defined to start and finish at points located on an underlying grid. When 

cutting a line section through the model an option to create an annotation line is provided. 

This may be used later for repeating the cut if a graph along the same line is required. To use 

an existing line (or annotation line), instead of indicating the cut using the cursor, the line (or 

annotation line) should be selected before choosing the Utilities > Graph through 2Dmenu 

item. 

Notes 

 Care should be taken when slicing through voids, or holes, in the model as this can 

give misleading results. 

 Care should be taken when slices pass through parts of the model with non-uniform 

properties, such as parts of different materials or of different thickness. 
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 Sometimes, due to model size, grid points are too close together to be usable. In these 

cases simply increase the grid size so that individual grid points can be selected. 

Graph Wizard 

Two types of graphs may be plotted: 

 Results quantities Any available result entity may be plotted against distance along 

the slice. 

 Axial force and bending moment This generates three datasets of distance, axial and 

bending stress along a line through a section: the axial force per unit width, moment 

per unit width and distance of the neutral axis to the midpoint of this line. For 

axisymmetric solids the moment per unit radian is printed as well. From these datasets, 

graphs of axial and bending stress versus depth of section are plotted. 

For more details on viewing results on graphs see Plotting Results on a Graph. 

Displaying Beam Stresses 

Beam stresses can be displayed on the fleshed section or at selected fibre locations. These 

stresses are computed using engineering beam theory which assumes that the normal stress is 

constant across the width of the beam cross section. This assumption can introduces 

significant errors due to shear lag when wide flanged sections are being used so these stresses 

should be used with caution. 

Beam stresses can be displayed as contours on the fleshed section or as values, diagrams or 

beam contours at fibre locations using the standard layer controls. When viewing stresses at 

fibre locations the value, diagram or contour is drawn at the actual position of the fibre on the 

cross section. 

Examples follow: 
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Filled contours plotted on fleshed beam sections  

 
 

Line contours plotted on fleshed beam sections 

  



  Chapter 7 

    

451 

 
 

Line contours plotted at top beam fibre location 

 
 

Line contours and diagram stress results plotted at bottom beam fibre location  
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Fibre locations 

When plotting selected contour or 

diagram results for beams, a fibre 

location must be used to specify the 

place(s) on the beam section at which 

the results should be calculated and 

plotted. Results for individual fibres 

are plotted by setting that fibre 

location active for a particular 

geometric line attribute in the  

Treeview. The active fibre is denoted 

with a black dot next to the fibre 

name.  

 Right-clicking on a fibre name 

in the  Treeview and 

choosing Set Fibre Active 

will display results for just that fibre. 

 Right-clicking on a fibre name in the  Treeview and choosing Set Fibre Name will 

display results on all members with that fibre name. 

Notes 

 Standard sections extracted from the section library include extreme fibre locations for 

all sections.  

 The standard section property calculator automatically includes extreme fibre 

locations for all cross- sections that it supports. 

 Models created prior to version 14.2 will not have any fibre locations data stored for 

each beam. However, the relevant fibre location data can be added automatically by 

double-clicking on each Geometric line entry in the  Treeview and re-selecting the 

same section size from the appropriate sections library. 

 User-defined beam cross-sections require fibre locations to be defined manually in 

order for stresses to be displayed on the diagrams and values layers. 

Beam Stress Resultants From Beams and Shells 

Equivalent beam stress resultants can be calculated for flat or curved thin and thick shell 

models by use of the Utilities> Slice resultants from beams and shells menu item. This 

allows the conversion of the results of a complex shell model into an equivalent beam 

analogy for use in design codes of practice.  
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Orientation of model 

Prior to defining slice locations, the model should generally be viewed along one of the 

primary view axes that relate to a plan (usually) or elevation view of the model. Once slice 

locations have been defined the slice resultants are computed using valid visible 3D beam and 

shell elements. Invisible elements are ignored. 

 

Model viewed along Z axis (plan view) with path selected prior to defining section slice 

locations 

Slice locations 

The slice locations are defined using a path which can consist of straight lines and arcs or 

combined lines that contain straight lines and arcs in the selection. The path must be 

continuous without any branching characteristics. The slice path orientation is defined by 

either the order of selection when more than one line/arc is selected or the orientation of the 

line/arc if only a single line/arc has been selected. The locations for the slices along the path 

can be defined using three methods: 

 From points or nodes in the selection If nodes or points are selected, these are 

projected onto the path perpendicular to the appropriate path segment tangent to obtain 

the slicing locations 

 Incremental distances from start of path Incremental distances can be entered to 

define the distances along the path for the slicing. Distances can be both positive and 

negative but the running total distance should remain within the length of the path. For 

example, 1@0;1@10;1@-5 will cut slices at distances of 0, 10 and 5 along the path 

 Absolute distances from start of path Absolute distances can be entered to define the 

distances along the path for the slicing. Distances must be positive and within the 

length of the path. For example, 0;5;10 will cut slices at distances of 0, 5 and 10 along 

the path 

 The Distance from reference origin to start of path can be also be entered. If this 

value is non-zero, the value is added to the distances along the path. 

The orientation of the slice local axes is different from the sign convention used in 

accordance with beam theory where the beam local x axis is orientated along the beam. The 

orientation of the slice local axes is defined from both the tangent of the path at the location 

of the slice and the direction that the model is viewed from. If the slicing path is in the plane 

of the screen the positive slice local z axis will be defined by the tangent of the path and the 
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positive slice local y axis will be orientated in the out of screen sense. If the slicing path is not 

in the plane of the screen, the positive slice local y axis will be defined perpendicular to the 

path tangent in the path tangent/out of screen plane. The positive slice local x axis will be 

defined perpendicular to both the slice local y and z axes.  

 

Isometric view of beam and shell model showing slice locations and slice local axes used. 

Inset shows beam local axis. 

Slice options 

 The calculation of moments can be about either the Neutral axis or the Path 

intersection with the slice plane.  

Note: For the calculation of beam stress resultants it has to be assumed that plane sections 

remain plane under the action of the loading. The strain distribution over the whole section 

also is assumed to remain linear. The location of the neutral axis can therefore be calculated 

directly from the areas and stiffness of the contributing materials in the composite cross-

section (see Gere & Timoshenko, Mechanics of Materials, 3rd SI Ed., pg 301-). For the 

calculation of the neutral axis location, the Transformed-Section Method is used which 

incorporates Modular Ratio techniques. 

Additional options available to control the slicing include: 

 Effective width If the effective width option is selected, the width of visible elements 

to include in the calculations can be specified. This effective width is centred on the 

slicing path in the screen plane at a perpendicular to the path. If the effective width is 

not used, all valid visible elements will be included in this direction. For both options, 

the slice is infinitely deep in the slice local y axis 

 Include whole elements only If the effective width option is selected, the option to 

include whole elements only is available. If selected, partial elements intersected by 

the current slice will be ignored in the calculations 
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 Smooth corners on path If the smooth corners on path option is selected, the average 

tangent of the path at a connection between two lines/arcs will be used for the slicing 

if the distance along the slice path exactly matches this path connection. If the smooth 

corners on path option is not selected, two slices will be taken at the connection using 

the tangents for both of the lines/arcs connecting at this location 

 Slicename prefix Allows user to input a user defined prefix for the slice names 

Loadcase 

Slice resultant results can be output for one or more loadcases 

 Active - prints slice results for the active loadcase to a slice output window. 

 All - prints slice results for all loadcases to a text file named 

SliceResultantsBeamsShells.prn in the current working directory. 

 Selected - prints slice results for entered loadcases to a text file named 

SliceResultantsBeamsShells.prn in the current working directory. As an example, 

entering 1-5,7 would select loadcases 1 to 7 excluding loadcase 6. 

Notes 

 The assumption that plane sections remain plane which is required for the calculation. 

 Linear variation of stress is assumed for the approach and therefore low order flat 

shells are supported (3 or 4 noded thin and thick shells) and high order flat shells are 

calculated ignoring the mid-side nodes if they are coplanar with collinear edges. For 

curved high order shells the element is subdivided into constituent pseudo elements 

and each pseudo element interrogated using linear interpolation. 

 The slicing path must be defined using straight lines, arcs or combined lines 

containing only these two line types. Splines and annotation lines cannot be used. 

 Slice forces can only be computed relative to the intersection of the slicing path with 

the slice plane or the neutral axis based on the sliced section. No facilities are 

available for the transformation of slices without defining a separate path and 

recalculating the slices. 

 Taking slices at the free end of a structure can lead to overestimation of the forces and 

moments on the section. This occurs due to the stresses in the section not returning to 

zero at a free and unloaded end. 

 Taking slices at a supported end of a structure can lead to discrepancies in the forces 

and moments when compared to a beam model due to the end effects taken into 

account by the full 3D shell modelling 

 Where a slice passes through a node in the structure, results are presented for the 

contributions of the elements on both sides of the slice. This is presented as results for 

the negative and positive local Z sides of the slice 
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 Engineering thick beam elements are supported (BMS3 and BTS3) along with thin 

beam (BS3, BS4, BSL3 and BSL4) elements 

 Option 380 must be used for BTS3 elements when using eccentricitices/offsets 

 When using 3 or 4-noded shell elements the mesh density should be sufficiently fine 

to capture the behaviour of the structure 

 When modelling curved structures it is recommend that regular quadrilateral elements 

wherever possible 

 Printing results for more than one loadcase will overwrite the text file named 

SliceResultantsBeamsShells.prn each time 

 See the worked example 'Section Slicing of 3D Shell Structure'  in the Application 

Examples Manual (Bridge, Civil and Structural) for the use of this facility. 

Slideline Results Processing 

When a results file is read into Modeller from an 

analysis that involves slidelines, a group is created for 

each slideline surface in the model. These groups can 

be accessed from the Group Treeview.  

A context menu for each group name provides options 

for making the members of a group visible or invisible 

and for selecting and deslecting the members of a 

group.  

Limited results for a selected slideline group can be 

printed by using the Print Results menu item on the 

context menu for that group. Full slideline results for 

the model as a whole can be printed using the Print 

Results Wizard. 

 

Printing Slideline Results 

The print results wizard is accessed from the Utilities menu. When Slideline results are 

selected the following six types of results can be chosen for printing: 

 Summary 

 System forces 

 Gap Forces 

 Contact forces 

 Contact Stresses 

 Section Results 

 Each type of result is described below. 
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Summary 

The summary presents a list of the maximum and minimum values of each slideline results in 

a table. 

System, Contact and Gap Forces 

There are three categories of force results: 

 System forces The normal and tangential gap forces at each slideline node are 

distributed across both slideline surfaces. These forces are assembled together and 

transformed into the global system directions to give the System Forces. 

 Gap forces Gap forces are computed from the normal penetration and the tangential 

movement of a node. They are the basic quantities used in the contact formulation. For 

example, with the penalty method the normal gap force at a node is obtained by 

multiplying the normal penetration with the contact stiffness. Coulomb’s law of 

friction also uses gap forces. To check the application of the law, the normal and 

tangential gap forces should be compared. 

 Contact forces The normal and tangential gap forces at each slideline node are 

distributed across both slideline surfaces. These forces are assembled together and 

kept in the local directions, normal and tangential to the contact surfaces, to give the 

Contact Forces. The contact pressures and stresses are based on these forces. 

Contact Stresses 

This category contains results for the contact pressure normal to the surface and the contact 

stresses tangential to the surface at each node. 

Section Results 

This category contains generic contact results. It includes the status of each node as to 

whether it is in contact or out of contact, the normal penetration for each contacted node, the 

contact stiffness, the nodal contact area and the zonal contact distance. 

Graphing Slideline Results 

To graph slideline results, the slideline group of interest must be set visible from the group 

context menu in the Group Treeview . 

For two-dimensional analyses the graph wizard can be used to generate the variation of a 

particular slideline result along the slideline surface. The variation along the surface can 

either be graphed against distance or angle. 

For three-dimensional analyses the slideline results are graphed in the same manner as other 

results. 
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Plotting Contours, Values and Vectors for Slidelines 

For three-dimensional analyses, contours of contact results can be displayed by selecting 

Slideline Results as the entity on the Contours dialog. The full list of slideline results will 

then be available in the Component combo. 

Slideline values and vectors can be displayed for both two and three-dimensional analyses by 

selecting Slideline Results on the Values or Vectors dialog. With values the full list of 

slideline results components is available, whilst with vectors only Contact and System Forces 

are available. 

Note. When looking at the deformed mesh from a contact analysis, the exaggeration factor 

should be set to 1.0 to avoid a misleading visualisation. 

Table of Slideline Results Availability 

Slideline Results components Label Contours Values Vectors Printing Graphing 

System forces             

Contact force in system x direction ForceX  Yes Yes Yes Yes Yes 

Contact force in system y direction ForceY  Yes Yes Yes Yes Yes 

Contact force in system z direction ForceZ  Yes Yes Yes Yes Yes 

Resultant contact force RsltForce  Yes Yes Yes Yes Yes 

Gap forces              

Tangential gap force in local x direction TanGapFrcX  Yes Yes   Yes Yes 

Tangential gap force in local y direction TanGapFrcY  Yes Yes   Yes Yes 

Resultant tangential gap force RsltTanFrc  Yes Yes   Yes Yes 

Gap force normal to contact surface NrmGapForc  Yes Yes   Yes Yes 

Contact forces             

Tangential contact force in local x direction TanForcex  Yes Yes Yes Yes Yes 

Tangential contact force in local y direction TanForcey  Yes Yes Yes Yes Yes 

Resultant Tangential contact force RsltTanFrc  Yes Yes Yes Yes Yes 

Contact force normal to contact surface NrmForce  Yes Yes Yes Yes Yes 

Contact stresses             

Contact stress in local x direction  ContStresx  Yes Yes   Yes Yes 

Contact stress in local y direction  ContStresy  Yes Yes   Yes Yes 

Contact pressure normal to contact surface ContPress  Yes Yes   Yes Yes 

Section Results             

Contact stiffness ContStiff  Yes Yes   Yes Yes 

Penetration normal to contact surface NrmPen  Yes Yes   Yes Yes 

In-contact/out-of-contact status ContStatus  Yes Yes   Yes Yes 
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Slideline Results components Label Contours Values Vectors Printing Graphing 

Nodal contact area  ContacArea  Yes Yes   Yes Yes 

Zonal contact parameter Zone Yes Yes   Yes Yes 

Zonal contact detection distance ZnCnDetDst  Yes Yes   Yes Yes 

Contact stiffness coefficient IntStfCoef Yes Yes   Yes Yes 

Thermal Surface Results 

The results from analyses involving thermal surfaces may be processed in a similar manner as 

other results. Extra result types are available for thermal surfaces.  

When reading a results file a group is automatically created for every thermal surface used in 

the analysis. These are accessed from the Group Treeview .  

For 2D slidelines the graph wizard can be used to generate the variation of the thermal 

surface variables along the surface or as a history though the analysis. When multiple thermal 

surfaces are present results for specific thermal surface are viewed by setting the appropriate 

surface as only visible from the group context menu.  

For 3D problems contours of the thermal surface results may be displayed on the thermal 

surface. Values and vectors can be displayed for both 2D and 3D problems. The results on a 

thermal surface are displayed by selecting the Thermal Surface Results entity on the 

appropriate property dialog.  

Thermal surface results may be printed using the print results wizard. 

  

Thermal surface flow results Label 

Gap and environmental flow GapEnvFlw 

Radiation flow between segment RadFlwSeg 

Radiation flow to environment RadFlwEnv 

Total nodal flow TotalFlw 

  

Plotting Results on a Graph 

The Graph Wizard is used to draw XY graphs. The following results graphs may be plotted if 

the results are available:  

 Time history A history for a specified results type throughout an analysis with respect 

to time or increment. Graphs may be plotted for a named variable such as Total Load 

Factor or Response Time verses a specified results quantity such as displacement in X, 

equivalent stress or sum of reaction over a set of specified nodes. The following 

history datasets are available: 

 Nodal Averaged or summed. 
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 Gauss Point results for a selected element and Gauss point (Element Gauss 

numbers may be determined using the labels layer). 

 Named Named result variables for a linear analysis such as loadcase ID, a 

transient analysis such as response time, or a nonlinear analysis such as total 

load factor. 

 Element results for all or selected elements. 

 Strain energy and plastic work Total strain energy or total plastic energy for 

the elements showing results. 

 Previously defined 

 Fourier expansion The displacements, stresses and strains output from a Fourier 

analysis are coefficients of corresponding sine and cosine functions. The evaluation of 

these functions around the circumference of the model is achieved graphically using 

the Graph Wizard. 

 Modal expansion Graphs the modal response of a structure to dynamic excitation 

using the results from an eigenvalue analysis. Various results entities may be plotted 

against a frequency range or sampling time for selected eigenmodes. 

 Load curve Graphs a defined load curve. 

 Variation Graphs a variation function. 

 Specified datasets Graphs two previously defined datasets. 

 Thermal surfaces Graphs results along a thermal surface. 

 Slideline (assigned to line) Graphs results along a slideline.  

Note: To graph a specified results entity against distance along a slice through a planar 

structure or on a slice of a three dimensional solid structures see Graph Through 2D. 

Graph Properties 

LUSAS uses the Graph Wizard to take you through each step of creating the X and Y 

datasets and placing them into a graph. The graph wizard is started from the Utilities menu. 

The X and Y datasets are then stored in the Utilities Treeview . 
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The graph window is split in to the graph area on the right and the graph data table on the 

left. 

Tip. Zoom in on a part of the graph by boxing with the mouse. To unzoom right-click on 

graph area to display the context menu and select unzoom. 

Plotting Families Of Curve Data On The Same Graph 

If a graph already exists, then further curves may be added to the first graph by choosing the 

Add to existing graph option of the final page of the Graph Wizard. In this way families of 

curves may be drawn on the same graph using a different colour for each one.  

Editing Graphs 

Once a graph has been plotted, the appearance and even the data on the graph may be 

modified. This may be done by selecting the Edit> Graph Properties menu item from the 

graph context menu. 

Editing Graph Data 

To change individual data points on the graph (for example to add an origin to a curve), make 

the graph data table editable by checking the Editable graph table box on the General Graph 

Properties page of the Graph Properties dialog. The following facilities are then available: 

 New data points may be added by adding new rows to the grid either by using Insert 

Row from the Edit menu or by pressing the Tab key when the cursor is in the final 

cell. 

 Data points may be deleted by deleting the data in the grid. 

 Blocks of data from a spreadsheet may be pasted. New rows will be added to the grid 

as necessary. 

Note. These changes are made to the graph only and are not stored in the corresponding graph 

dataset. 
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Pasting Graph Data To Spreadsheets 

 

To paste graph data to a spreadsheet, use Copy from the Edit menu when the data 

has been highlighted in the graph data table, then paste into the spreadsheet. 

It is also possible to export selected or all 

graph datasets to a .csv file by using the 

context menu for the Graph entry or 

graph dataset name in the Utilities 

treeview. Columns of data are created 

with graph dataset names being written to 

row one of each column. 

Printing Graphs 

 

Graphs may be printed using the File> Print command. Because graphs are created 

as separate windows a single graph will be printed on each page. 

 

To print multiple graphs together use Copy from the Edit menu when the graph area 

is active, then paste into a suitable word processor. 

  

Case Study. Plotting Families Of Curves 

To compare results at different nodes a graph will be plotted of the stress throughout an 

analysis at three nodes, say 6, 25, and 60. Using a suitable results file, first select the nodes 

with the cursor, then: 

1. Start the Graph Wizard from the Utilities menu.  

2. Choose Time History, click Next. 

3. For the X axis choose Named variable, click Next, choose Response Time, click 

Next. 

4. For the Y axis choose Nodal, click Next, specify the results entity as Stress, specify 

node number 6, click Next. 

5. Either type suitable graph and axes titles, or leave them blank to use default names, 

click Finish. The graph is displayed. 

6. Repeat steps 1 and 2.  

7. For the X axis choose Named variable, click Next, but this time choose Previously 

defined, click Next. Select Response Time from the drop-down list, click Next. 

8. For the Y axis choose Nodal, click Next, specify the results entity as Stress, specify 

node number 25, click Next. 
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9. Choose Add to existing graph, make sure to specify the correct graph from the list if 

there is more than one, click Finish. The new data will be added to the first graph. 

10. Repeat steps 1, 2 and 7. 

11. For the Y axis choose Nodal, click Next, specify the results entity as Stress, specify 

node number 60, click Next. 

12. Repeat step 9.  

Creating Animation Sequences 

A LUSAS animation displays a sequence of pictures showing the status of the model or 

results type for selected loadcases. Animations are useful for viewing the effects on a 

structure of a moving load, checking that a staged construction modelling process has been 

defined correctly, or visualising the changing results of a nonlinear, dynamic or transient 

analysis. Sometimes the manner in which a structure deforms is not always obvious when 

comparing its undeformed and deformed shapes, and it may be better understood using 

animation.  

The structure may be animated in two ways. Both types of animation are created from the 

Utilities> Animation Wizard menu item. 

Animating an active loadcase 

 Active Loadcase (for results loadcases only) The results from a single loadcase, or 

eigenvector mode shape, may be animated according to a deformation function (sine, 

square, saw tooth, or ramp). A full sine wave (-1 to 1) is useful for animating mode 

shapes obtained from an Eigen analysis. 

Animating Load History 

 Load History animates chosen model or results loadcases producing a animation 

frame for each.  

The load history can be animated for both model or results loadcases. 

 All loadcases animates all available results loadcases. 

 Final increment animates all available results loadcases, using only the last increment 

of each nonlinear results loadcase. 

 Specified allows a user-defined selection of model or results loadcases for animation. 

Resolution 

The resolution and aspect ratio of an animation can be set by specifying the number of pixels 

in the horizontal and vertical directions. Initial default values are related to the model view 

window size and set to be either 800 pixels horizontally or 600 pixels vertically according the 

view window aspect ratio.  
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The content of the animation sequence is defined by the contents of the current window when 

the Animation Wizard is started. For example, to animate contours on a deformed mesh, a 

contour and deformed mesh layer need to have been added to the current view window prior 

to running the animation wizard. 

 

Notes 

 If contours are to be included in an animation, it is useful to fix the contour range 

across multiple loadcases using a global or manual scale before creating the animation 

sequence. Setting the contour range will fix contour colours on each frame of the 

animation sequence relative to the others. The spread of stress, or other entity, can 

then be seen more readily. It is often useful to set an upper and lower value based 

upon the maximum and minimum values achieved across a range of loadcases. 

 When animating deformed models it is recommend that the auto resize button  is 

switched off before creating the animation to prevent re-scaling during the animated 

sequence. 

 Animation is carried out by capturing an entire set of pixels for each frame of the 

animation for the full view window and not just the extent of the model. As a result, 

for some models, any 'blank space' around a model will be also captured with each 
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animation frame saved. To reduce the amount of unwanted area captured the view 

window can be re-sized to the proportions of the model width and height.   

 The only model loadcases (that is, those loadcases that are saved with a model) 

available for inclusion in an animation are basic modelling loadcases and basic load 

combinations. Envelope and Smart Combination loadcases that are saved with a 

model cannot be animated. 

 Increasing the number of included loadcases will require a proportionately longer 

amount of time to create an animation. 

 When animating staged construction models the mesh layer display should be set to 

Show activated elements only in order to see the model building sequence. 

Controlling the Animation 

The buttons at the bottom of the animation window allow the animation to be speeded up or 

slowed down, stepped frame by frame, looped, and saved.  

Saving Animation Files 

Animation files are saved as Windows standard .avi files using the File> Save As AVI menu 

item. or by pressing the Save As AVI button on the Animation window. The “Microsoft 

Video 1” compression method is used by default with a 75% compression setting to reduce 

the file size. This produces a good reduction in file size without noticeable loss in quality and 

should be compatible with the majority of PCs.  

Using the Animation Builder Toolbar 

The animation tool builder tool bar can be found using the View> Toolbars menu item. 

Animation sequences may be edited, or can be 

created frame by frame, using the animation 

builder toolbar.  

Printing Results 

Selected results values may be output to the screen in a tabular listing format for the active 

loadcase or for selected loadcases. Once listed the results can be printed or saved to a 

spreadsheet. The results for each loadcase are displayed on a separate tab in the print results 

window. A model info tab appears in all output windows and provides basic information 

about the model. 

To print results to the screen his use the Utilities> Print Results Wizard menu item.  

When more than one loadcase is present a choice can be made: 

 Active  outputs selected results from a single loadcase. 

 Selected permits output of selected results for one or more loadcases.  



Modeller Reference Manual   

    

466 

Entity 

The Entity chosen dictates the type of results printed. When smart combinations or envelopes 

are present the primary component can be set such that all other values are associated values 

which occur at the same time as the enveloped component. Only those components applicable 

for the elements used in the model will be displayed.  

The entities and results types available (when applicable) are: 

None 

 Eigenvalues - eigenvalue, frequency and error norm. 

 Participation Factors - participation factors in X, Y and Z directions. 

 Mass participation factors - mass participation factors in X, Y and Z directions. 

 Sum of mass participation factors - sum of mass participation factors in X, Y and Z 

directions. (This enables the % of active mass in each direction to be determined, as 

the sum of the mass participation factors in each direction should be unity). 

Displacement, Residual, Reaction, Reaction Stress, Loading, 

Potential, Flux, Gradient 

 Component -  component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the model. 

Stress/Strain 

 Component - component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the model. 

 Principal - principal values in tabular format. 

 Fatigue or Damage Results - fatigue (Log Life) and damage results in tabular format. 

 Energy - strain energy and plastic work results. 

 State variables - extra nonlinear material parameters. 

Slideline results 

 Component - component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the model. 

 System forces - forces in global or current transformed directions. 

 Gap forces - forces required to reverse nodal penetration. 

 Contact forces -forces generated across contact surfaces. 

 Contact stresses - contact stresses computed as contact force/contact area in normal 

and tangential directions. 

 Section results - generic contact results e.g. contact state, normal penetration etc. 
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For more details see slideline results processing. 

Thermal surfaces results 

 Component - underlying nodal results. 

 Summary - maximum and minimum values (according to the extent specified) and 

their position on the model. 

 Flows - flow components. 

 View factors - summary of view factor sums across segments. 

Transformation of results 

 Transformed Printed results may be transformed to be relative to a specified local 

coordinate, according to element local directions for stresses, relative to the local 

element material directions, or to a specified angle in the XY plane. 

Wood Armer 

 Wood-Armer - Calculation of top and bottom reinforcement moments for plates and 

grillage elements and top and bottom reinforcement forces for shell elements. 

Location 

When applicable, printed results can be obtained for the following locations: 

 Averaged nodal - Average nodal (smoothed) results from visible elements. Nodal 

results are extrapolated from the Gauss point values within each element before 

averaging. 

 Gauss Point - Gauss point values internal to the visible elements. The most accurate 

results available from the analysis.  

 Element Nodal - Unaveraged nodal results for visible elements. Nodal results are 

extrapolated from the Gauss point values within each element. 

 Coordinates When the optional Coordinates checkbox is enabled the global X, Y and 

Z positions of the nodes or gauss points (as appropriate) are included as separate 

columns in the printed output. If a column heading is double-clicked the results will be 

sorted in ascending or descending order based upon coordinates. This enables sorting 

of nodal and gauss results data by coordinate. 

Extent 

The printed results for selected loadcases are governed by the following extent options:  

 Elements showing results - default option which prints results only for those 

elements that are displaying them in the Modeller view window. 

 Visible model - prints results all elements that are visible in the Modeller view 

window. 
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 Full model - prints results for all elements of the model regardless of whether the 

elements are visible or displaying results in the Modeller view window. 

 Specified group - prints results for a specified named group. Only active if group 

names have been defined. 

Printed results for automatically created slices 

When section slices have been defined on a 3D model (with corresponding groups being 

automatically created in the Groups treeview) the results for just the automatically-defined 

groups/slices can be printed to the print results window by selecting the Display for slice(s) 

check box. Note that the automatically created group name 'Slices' is a collective name for the 

automatically created slice group names and does not contain results. 

Results display and manipulation 

The results for each selected loadcase are displayed on a separate tab in the print results 

window. A model info tab also appears in all output windows and provides basic information 

about the model. When the Printed Results window is displayed a context menu can be 

invoked which allows for the printed results data to be manipulated:  

 Properties The number of significant figures or decimal places can be changed. 

 Sorting of data Results data can be sorted in ascending or descending order. In 

addition, data sorting can be achieved by double-clicking on a header to sort by that 

column name. A second double-click on the same header will carry-out a reverse sort.  

 Saving to a spreadsheet The contents of the current tab or all tabs can be saved to a 

spreadsheet or to a text file.  

 Copying to the clipboard Selected cells or the whole grid can be copied to the 

clipboard.  

 Printing The Print option sends the contents of the active tab to the printer. 

 

Manipulating printed loadcase results 

Printing results for Envelopes or Combinations 

When the active loadcase is an envelope or smart combination the results printed will show 

the primary component (e.g. Fx) marked with an asterisk. Additionally, for Envelopes only, 
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the loadcase in which the maximum or minimum value was extracted will be tabulated in the 

LCID (Loadcase ID) column.  

When enveloping on All components, the loadcase from which the results are extracted 

cannot be tabulated because each individual results component may have come from a 

different loadcase. 

  

 

Envelope results for primary component Fx  

showing Loadcase ID 

 

Envelope results for primary component All 

 (No Loadcase ID can be shown) 

Notes 

 Selected slice and slideline data and results may be printed from the group context 

menu. 

 To print results and include model images in a report style format see Generating 

Reports  

Printing and Saving Pictures 

Views of the LUSAS model in the graphics area may be printed directly to the default printer 

from the graphics area using the print  button.  

The File> Print Preview menu item is useful for visualising the document prior to printing 

taking place. Using the File> Print menu item allows alternative printer settings to be used. 

Note. When a model is created the default paper size (for printing use) is set from the settings 

of the default printer installed on the local PC. This helps to ensure that regional paper sizes 

are used in preference to otherwise specified sizes. 

Saving pictures for use in LUSAS reports and other applications 

Views of the LUSAS model can be saved as BMP, JPG, or WMF files using the File> 

Picture Save menu item. BMP and JPEG files are saved to a fixed size of 1800 pixels in 

width with a height proportional to the size of the graphics window when the file was saved. 

JPEG files are the most efficient to save in terms of file size. Windows Meta Files now 
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contain bitmaps instead of vectors for the modelling information with correspondingly 

smaller file sizes. Text and annotation layer information held in a WMF file is vector-based 

and is therefore scalable. 

Note. The contents of the View window can also be copied (and subsequently pasted) for use 

in other applications by clicking the right mouse button and selecting Copy from the context 

menu.  

Saving pictures for viewing in Expose 

Pictures can also be saved as LUSAS Picture Files for viewing only in the LUSAS picture 

file utility program, Expose. Note that Graphs cannot be saved in LUSAS picture file format. 

The contents of the graphics area can also be transferred to the Windows clipboard using the 

copy  button. 

Generating Reports 

Report templates (which are created, modified and 

saved in the Reports Treeview for each model) 

hold the information required to generate reports 

for model or results data. Each time a report is to 

be viewed, the report details that are specified in 

the report template are extracted from the model 

and results files, and used to create the report.  

A report is built by defining chapters that 

reference the model and results data that are to be 

included in the report. The modelling and results 

data selected can be restricted to particular model 

geometry, model attributes or loadcases, or for 

particular results entities, and data can be listed 

for all of, or just parts of a model. Additional user content such as screen captures, saved 

images or additional text can also be added. These user content items appear as separate 

chapters in the report.  

Each report template can include any number of chapters that define the model attributes and 

analysis results to be viewed. Note that the creation of results chapters is only possible when 

results are loaded on top of a model. Any number of reports templates may be created and 

saved in the  Reports Treeview of a model. The order of information in a report can be 

changed by dragging and dropping the chapter names up and down the Report Treeview. 

 Reports are viewed in a third-party industry standard report viewer called BusinessObjects 

Crystal Reports (included with in a LUSAS software installation). Report data may be 

exported to Microsoft Excel spreadsheets for additional calculations to be carried out as well 

as being exported in PDF, RTF (for use in Microsoft Word), HTML and other formats. 

If it is desired that only results values are to be viewed on screen or be selectively printed or 

output to spreadsheets the Print Results Wizard can be used. 
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Creating a Report 

A new (empty) report template is created by selecting the Utilties> Report menu item or 

from right-clicking New Report from the Reports context menu in the Report  Treeview. 

On the Report properties dialog: 

 The report Title is optional and is used as 

a title in the exported report. 

 Units for a report are, by default, the 

same as those of the model. However, it 

is possible to prepare a report in a 

different system of units, in which case 

all values seen in the report will be 

converted appropriately.  

 It is also possible to control the number 

of significant figures and decimal 

places seen in the report. These can also be specified independently for each chapter 

 If For all chapters is selected the values for significant figures or decimal places 

chosen on this dialog will be used throughout the report. This option overrides any 

different values set inside each chapter. 

 The Report name is the name added to the Report  Treeview. By default reports are 

named Report 1, Report 2 etc if no name is specified. 

Once a New Report entry has been added to the Report  Treeview, selecting the report 

name and using its context menu enables the adding of chapters to a report, modifying, 

viewing, renaming, or deleting of a report. Report templates are saved in the Report  

Treeview when a model is saved. 

Adding a Report Chapter 

Model properties, loadcase and basic combinations, envelopes and smart combination results, 

eigenvalue results and user information such as images and text may be added to a report in 

the form of chapters. Each chapter represents one single aspect of the model. Multiple 

chapters may be added and re--ordered as necessary in the Report  Treeview.  

Chapters are added to a report by selecting the Add Chapter menu item from the Report 

name context menu (accessed by right-clicking the mouse button).  
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The following chapters can be added: 

 Model Properties 

 Loadcase/Basic Combination results 

 Envelope/Smart Combination results 

 Eigenvalue results 

 User Content 

Add or Edit a Model Properties Chapter 

 

 The Model Properties tab of the Chapters dialog allows model geometry, attributes 

and loadcase/IMD loadcase information to be added to the report via the use of tick 

boxes.  

 Use the Loadcases… button to display a dialog which restricts the chapter to display 

results for All, Active or Specified loadcases or combinations. Note that, by default, 

all loadcases are selected, but for some situations (notably when reporting on loading 

attributes for a model that have been generated by vehicle load optimisation software) 

a physical limit may be met because the generated report is too big for Windows to 

display. If this occurs, use the Loadcases button to reduce the number of loadcases 

selected so that a report can be generated, and generate a separate report for the 

remaining loadcases. 

 The Report on… button displays a dialog which controls the scope of the chapters to 

be created. By default, the whole model is selected, but a report could also created for 

just the visible model or for a specified group.  

It is also possible to control the number of significant figures or decimal places for this 

chapter as presented in the report. 
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Note: It is possible to visit this dialog several times to create multiple chapters, each of which 

can have different ordering, scope and loadcase choices.  For example you can create one 

chapter describing the lines in group 1 and subsequently to create a different chapter 

describing the lines in group 2. Once created, the order of chapters in the report can be 

modified at any time by dragging and dropping them up and down the Report  Treeview. 

Add or Edit a Results Subchapter (for an Entity) 

You can create or modify a section within a results chapter. Select the Add... button on the 

Chapters dialog to display this dialog. 

 Entity chosen dictates the type of results. 

The component chosen is only appropriate to 

Envelopes and Smart Combinations and 

controls the primary component – equivalent 

to the component chosen when the Envelope 

or Combination is set active.  

 Transformed Printed results may be 

transformed to be relative to a specified 

local coordinate, according to element local 

directions for stresses, relative to the local 

element material directions, or to a specified 

angle in the XY plane.  

 Wood Armer Calculation of top and bottom 

reinforcement moments for plates and 

grillage elements and top and bottom 

reinforcement forces for shell elements 

 Use the All Components or Specify components and … buttons to control which 

results component values will be added to the report. 

 The Location drop-down specifies whether Averaged nodel, Gauss Point or 

Element Nodal results should be calculated. 

 The Summary checkbox chooses whether or not to display a summary for each results 

component chosen. This summary consists of the maximum and minimum values 

encountered, along with their location. Note that sub-reports cannot be created from 

Summary results information when listed in a report. 

 The Tabular results checkbox chooses whether or not to display a table of numerical 

results. If chosen, a value will be written to the report for each component, for each 

loadcase, for each node or gauss point chosen. Such tables can be very large. Note that 

sub-reports can be created from Tabular results information when listed in a report. 

 Additionally, Nodal coordinates can be added to the report. These take the form of 

additional columns of data in the tabular results, one each for the X, Y, and Z 

coordinates of each node. 

 The number of Significant figures or Decimal places can be specified for values 

written to the report for this chapter. 
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 Maximum components across page specifies how many columns of results 

components are expected to be able to be set-out across the width of the report page. If 

the number of results components available exceeds the number of components that 

can actually be accommodated across a page for a certain paper size and orientation a 

choice is offered of wrapping the results components or splitting the results sub-

chapter into multiple sub-chapters to avoid wrapping. Note than when results 

components need to be wrapped a separate entry is created in the Add/Edit Chapter 

dialog grid for each set of wrapped data. The Components column of the grid shows 

All for results data that is not force-ably wrapped, and Specified for results data that is 

force-ably wrapped. 

 Add or Edit a Loadcase Results Chapter 

 

  

The Loadcase/Basic Combination results tab of the Chapters dialog is only shown if a 

results file is loaded.  

The Envelope/Smart Combination results tab (not shown) is only added to the dialog if a 

model contains envelope or smart combination results.  

 Use the Add... button to add entities for inclusion in the report as results sub-chapters. 

When added, results sub-chapters are shown in a grid form at the top of the dialog. By 

selecting the Entity name in the grid you can subsequently Edit or Delete existing 

content. 

 Use Order by... to dictate the order in which the tabular results sub-headers are 

presented. This is similar to the concept of sorting data by column header in a 

spreadsheet program. The order by options are: Loadcase / Features, Features / 

Loadcase and Loadcase / Mesh. The use of the Order by facility is of particular 
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importance when exporting results to a spreadsheet format where the use of Order by 

Loadcase / Mesh is recommended because of the reduced number of blank lines it 

creates in the output file. 

 Use the Loadcases… button to display a dialog which restricts the chapter to display 

results for All, Active or Specified loadcases or combinations. By default, all 

loadcases are selected. 

 Use the Report on... button to display a dialog which controls the scope of the chapter 

to be created, for example to restrict the chapter to display results for the Full model, 

the Visible model or a Specified group only. By default, the whole model is selected. 

 Chapter name can be edited if the default or previously entered name is to be altered. 

Note: It is possible to visit this dialog several times to create multiple chapters, each of which 

can have different ordering, scope and loadcase choices.  For example you can create one 

chapter describing the displacements for the whole of a model and subsequently to create a 

different chapter describing the stress in a particular group of elements. Once created, the 

order of chapters in the report can be modified at any time by dragging and dropping them up 

and down the Report  Treeview. 

Add or Edit an Eigenvalue Results Chapter 

 

The Eigenvalue results tab of the Chapters dialog is only shown if a model contains 

eigenvalue results. The following eigenvalue results can be selected for listing: 

 Eigenvalues 

 Participation factors 

 Mass participation factors 

 Sum mass participation factors 

The number of significant figures or decimal places for this chapter can be specified. 
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The Chapter name can be specified or edited if the default or previously entered name is to 

be changed. 

Add or Edit a User Content Chapter 

 

The User Content tab of the Chapters dialog allows images or text files to be added to the 

report using the Add file... button.  

The Capture screen button takes a snap-shot of the current view window and allows it to be 

saved as a fixed-size BMP, JPG or WMF file to the working folder (by default) or to any 

other specified folder. Note that the captured image will include the full view window and not 

just the extent of the model. As a result for some models 'blank space' will appear around 

each image saved. To avoid this, the view window can be re-sized to the proportions of the 

model width and height in order to reduce the amount of unwanted area captured. 

The Caption field provides the means to associate a title with each image and have it written 

beneath each image in the report. 

Clicking the OK button adds this image to the report as a separate chapter. Only BMP files 

currently appear in the preview pane. Each image added to the report is added as a separate 

chapter.  

Note: It is possible to visit this dialog several times to create multiple chapters. Once created, 

the order of chapters in the report can be modified at any time by dragging and dropping them 

up and down the Report  Treeview. 

Chapter Extent 

The extent of data that the chapter is to report on can be specified by selecting either:   

 Elements showing results - prints results only for those elements that are displaying 

them in the Modeller view window. 
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 Visible model - prints results all elements that are visible in the Modeller view 

window. 

 Full model - defaults option which prints results for all elements of the model 

regardless of whether the elements are visible or displaying results in the Modeller 

view window. 

 Specified group - prints results for a specified named group. 

For example, if the selected chapter describes Materials, by selecting a Specified group only 

the Material assignments used in that group will be present in that chapter. 

Loadcase Selection 

The loadcases, combinations or envelopes that the chapter is to report on can be specified by 

selecting either: 

 All 

 Active 

 Specified. 

If multiple loadcases are specified, multiple entries will appear in the report. 

Viewing a Report 

Reports are viewed from the Report  Treeview by double-clicking on the report name or 

by choosing the View Report... menu item from the report name context menu. After a short 

delay whilst the report data is assembled and formatted, a report consisting of all the selected 

chapters will be displayed inside the third-party BusinessObjects Crystal Reports viewer. 

 

BusinessObjects Crystal Reports viewer 

The BusinessObjects Crystal Reports viewer is a linked-in third-party application that is 

widely used in industry to present and manipulate report data. It has a toolbar that provides 

the following buttons / facilities for viewing, manipulating, printing and exporting the 

selected LUSAS model and results data: 
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Report Viewer Toolbar Buttons 

Button Name and usage 

 
Export Report permits reports or sub-reports to be 

exported to a variety of formats to any of the following 

destinations:  

 To a file on your disk (Disk file). 

 To an Application on your computer that will 

open once the file has been created. 

 To a folder in your mail client (Exchange). 

 
Print Report prints the current report or sub-report view 

only to a specified printer. 

 
Toggle Group Tree permits the viewing of 

loadcase/feature numbers in sub-reports in a treeview style 

format. 

 
Page selection These options provide the means of 

moving or jumping to a specific page. 

 Stop Loading stops the loading of large files 

 

 
Refresh refreshes the view contents 

 
Search Text provides the means to find and jump to 

particular words in the report or sub-report. 

 
Scaling adjusts the size of the page view 

 
Close Current View closes the sub-report view leaving 

other views visible until they are closed. To go back to the 

LUSAS Modeller window the report viewer must be 

closed by using the report window's main Close button. 

Notes 

 When viewing a report using the Crystal Reports viewer no changes can be made in 

LUSAS Modeller. The only way a LUSAS model or the report listing (as held in the 

LUSAS Report Treeview) can be re-edited is to close the report view. This is to 

ensure that the report data always matches the model from which it is created. 

 When a report is first loaded into the report viewer the Page Down key will not work 

until the view has acquired focus. Simply click anywhere in the view to set the focus. 

 When saving to disk the default export directory is a temporary directory specified by 

the report viewing software that is used. Browse to your LUSAS project directory if 
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you wish to save your report file with your model. The number of pages to be 

exported or saved can be specified. 

Creating and Viewing Sub-Reports 

When viewing a report, selected sections of data may be viewed in a sub-report. This can be 

particularly useful when wanting to export selected data to another application as, for 

instance, when exporting report results data to a spreadsheet. It also provides an easy way of 

visually printing selected pages of a main report. 

  

 

 To create a sub-report from a section of a normal report double-click on the main 

body of the data where you wish a sub-report to be generated, or double-click on a 

feature or loadcase name. A new tab will appear in the report viewer next to the 

Preview tab.  

 Selecting the Toggle Group Tree  button will permit the viewing of the 

loadcase/feature numbers in the sub-reports in a treeview style format as shown on the 

following image. 
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Note that it is also possible to create a sub-report from a sub-report. For example, when a sub-

report containing results for a set of loadcases is being viewed, a sub-report for a particular 

loadcase, or for a particular feature such as a line, surface or volume, could also be created. 

 To create a sub-report from a sub-report view double-click on the loadcase name (as 

shown in the previous image) or feature for which the sub-report should be created. 

A new tab will appear in the report viewer next to the previous sub-report tab as 

shown on the following image. 

 

Notes 

 Not all sections of a report can be selected to make a sub-report. The cursor will 

change to a magnifying glass when it is over data that can be selected for a sub-report.  

 The toolbar buttons such as Export Report, Print Report, etc., act on the currently 

selected preview tab (and hence, the currently selected report view). This means that 

only those pages in the particular report or sub-report that is being viewed will be 

exported or printed. 

 To delete the visible sub-report select the Close Current View button at the top-right 

of the report viewer toolbar. 

Exporting Report Data 

When viewing a report, report data may be exported to a variety of formats to any of the 

following destinations by use of the Export Report button  

 To an Application on your computer that will open once the file has been created 

 To a file on your disk (Disk file ) 

 To a folder in your mail client (Exchange) 

In each case the number of pages to be opened or saved can be specified. 

Note that when saving to disk the default export directory is a temporary directory specified 

by the report creation software that is used. Browse to your LUSAS project directory to save 

your report file with your model if required. 
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When the number of columns in a report become too large for a portrait view use Page Setup 

(accessed from the Report Name context menu) to either change the report page margins, or 

to change the report page orientation to Landscape. 

Exporting Report Data to a Spreadsheet 

When viewing a report, report data may be exported to a spreadsheet such as Excel by use of 

the Export Report button  

 Select a Format of: Microsoft Excel 97-2000 - Data only (.XLS) 

 Select a Destination of: Application 

 Select Custom format options 

Note that use of the Results chapter Order by... option to dictate the order in which the 

tabular results sub-headers are presented is of particular importance when outputting results 

data to a spreadsheet. The option to order results data according to Loadcase / Mesh is 

recommended because of the reduced number of blank lines it creates in the output file. 

 The images that follow show an example of a sub-report created with Loadcase / Mesh order 

and the corresponding results exported to an MS Excel spreadsheet. 

This Order by option should be set prior to exporting the data as follows: 

1. In the Report  Treeview, select the Results Chapter name and use its context menu 

to the select Modify menu item which, in turn, will display the Edit Chapter dialog. 

2. Use the Order by... drop-down to select Loadcase / Mesh and click OK 

3. In the Report  Treeview, select the report name containing data to be exported and 

use its context menu to select View Report 

4. After the report is displayed in the report viewer, find the Results Chapter containing 

data to be exported and double-click in the body of the data to create a sub-report 

5. If results for a particular loadcase is to be exported, double-click on that loadcase data 

to create a further sub-report 

6. Lastly, use the Export Report button  to allow selection of the Format and 

Destination of the results data to be created. 

Example output 

The images that follow show an example of a sub-report created by LUSAS with Loadcase / 

Mesh order and the corresponding results exported to a Microsoft Excel spreadsheet. 
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Sub-report listing ordered by Loadcase / Mesh 

 

 

Sub-report data exported to a Microsoft Excel spreadsheet. 

Exporting Report Data to a Word Document 

When viewing a report, report data may be exported to a Word Document by use of the 

Export Report button  This will require you to: 

 Select a Format of: Microsoft Word - Editable (RTF) 

 Select a Destination of: Application 

 Select a page range. 

Note that the Results chapter Order by... option which dictates the order in which the tabular 

results sub-headers are written is particular use when exporting results data. If you do not 

wish to group the results per feature (e.g. per line) which is the default, then the option to 

order by Loadcase / Mesh should be used. 

This Order by... option should be set prior to exporting the data as follows: 

1. In the Report  Treeview, select the Results Chapter name and use its context menu 

to the select Modify menu item which, in turn, will display the Edit Chapter dialog. 
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2. Use the Order by... drop-down to select the Order required e.g. Loadcase / Mesh and 

click OK 

3. In the Report  Treeview, select the report name containing data to be exported and 

use its context menu to select View Report 

4. After the report is displayed in the report viewer, find the Results Chapter containing 

data to be exported and double-click in the body of the data to create a sub-report. 

5. If results for a particular loadcase is to be exported, double-click on that loadcase data 

to create a further sub-report. 

6. Lastly, use the Export Report button  to allow selection of the Format and 

Destination of the results data to be created. 

Example output 

The images that follow show an example of a report created by LUSAS and the same data 

exported to an Microsoft Word document. 

  

Report listing in the report viewer Report data exported to a Microsoft Word 

document. 

Printing Report Data 

When viewing a report, report data may be printed by selecting the Print Report button  

in the BusinessObjects Crystal Reports toolbar. 

Deleting Report Data 

To delete the visible report or sub-report select the Close Current View  button at the 

top-right of the report viewer toolbar. 
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Appendix A : Smart 

Combination 

Examples 

  

Smart Combination Examples 

The following examples demonstrate how the different factors and settings can be used in 

smart combinations. For the purposes of these examples the results at a single node are going 

to be considered. 

 Case 1 - Considers a node where long term load effects are all negative.  

 Case 2 - Considers a node where short-term load effects are of mixed sign.  

 Case 3 - Considers a node where short-term load effects are of mixed sign with the 

“Loadcases to consider” set to four.  

 Case 4 - Considers a node where short-term load effects are of mixed sign with the 

“Loadcases to consider” set to four and the “Variable loadcases” set to four.  

 Case 5 - Considers a node where short-term load effects are of mixed sign with the 

“Loadcases to consider” set to four and the “Variable loadcases” set to one.  

Smart Combination - Case 1 

Consider a node where long term load effects are all negative.  

In this instance the permanent and variable load factors are considered and will be added 

together based on the nodal result being adverse. 

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for positive 

load effects. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

Dead load -20 1.0 0.15 1.0  -20 x 1.0 = -20 

Deck surfacing  -10 1.0 0.75 1.0 -10 x 1.0 = -10 

Superimposed 
load 

-15 1.0 0.2 1.0 -15 x 1.0 = -15 

    Smart combination (Max) -45 

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects. 

  
 
Loadcase 

  
Nodal 
result 

  
Permanent 
factor 

  
Variable 
factor 

Factor used for 
maximum 
combination 

  
 
Factored nodal 
results 

Dead load -20 1.0 0.15 1.0 + 0.15 -20 x 1.15 = -23 

Deck surfacing  -10 1.0 0.75 1.0 + 0.75 -10 x 1.75 = -17.5 

Superimposed load -15 1.0 0.2 1.0 + 0.2 -15 x 1.20 = -18 

    Smart combination (Min) -58.5 

Smart Combination - Case 2 

Consider a node where short-term load effects are of mixed sign.  

In this instance the permanent and variable load factors are considered and will be added 

together based on the nodal result being adverse. However as the permanent effects have been 

set to zero, this will only combine the results that are adverse. 

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for positive 

load effects. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

Temperature -5 0 1.3 0  -5 x 0 = 0 

Wind  -5 0 1.4 0 -5 x 0 = 0 

Settlement -10 0 1.2 0 -10 x 0 = 0 

Live load 1 -20 0 1.5 0 -20 x 0 = 0 

Live load 2 -15 0 1.5 0 -15 x 0 = 0 

Live load 3 10 0 1.5 0 + 1.5 10 x 1.5 = 15 

Live load 4 -5 0 1.5 0 -5 x 0 = 0 

    Smart combination (Max) = 15 

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects. 

  
Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

Temperature -5 0 1.3 0 + 1.3 -5 x 1.3 = -6.5 

Wind  -5 0 1.4 0 + 1.4 -5 x 1.4 = -7 

Settlement -10 0 1.2 0 + 1.2 -10 x 1.2 = -12 

Live load 1 -20 0 1.5 0 + 1.5 -20 x 1.5 = -30 

Live load 2 -15 0 1.5 0 + 1.5 -15 x 1.5 = -22.5 

Live load 3 10 0 1.5 0  10 x 0 = 0 

Live load 4 -5 0 1.5 0 + 1.5 -5 x 1.5 = -5 

    Smart combination (Min) =  -83 

  

Within the smart combination facility there are also two check boxes marked “Loadcases to 

consider” and Variable loadcases”. These additional options are used for a number of bridge 

design codes that require the loadcases in the combination to be filtered. 
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Smart Combination - Case 3 

Consider a node where short-term load effects are of mixed sign with the “Loadcases to 

consider” set to four.  

In this instance the permanent and variable load factors are considered and will be added 

together based on the nodal result being adverse. With the number of “Loadcases to consider” 

set to four, only the four most positive resultants will be combined for the Max combination 

and the four most negative resultants will be combined for the Min combination. 

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for positive 

load effects. The number of load effects summed is restricted to the number of loadcases 

specified. The loadcases used are the most adverse, for example the most positive for max 

combination and all other load effects assembled are discarded. 

  
Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 0.8 0.7 -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

    Smart combination (Max) =  4.5   

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects. The number of load effects summed is restricted to the number of loadcases 

specified. The loadcases used are the most adverse, for example the most negative for min 

combination and all other load effects assembled are discarded. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Used 

Wind  -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Not 
used 

Settlement -10 0.7 0.8 0.7 + 0.8 -10 x 1.5 = -15 Used 

Live load 1 -20 0.7 0.8 0.7 + 0.8 -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 0.8 0.7 + 0.8 -15 x 1.5 = -22.5 Used 

Live load 3 10 0.7 0.8 0.7 10 x 0.7 = 7 Not 
used 

Live load 4 -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Not 
used 

    Smart combination (Min) =  -75   

Smart Combination - Case 4 

Consider a node where short-term load effects are of mixed sign with the “Loadcases to 

consider” set to four and the “Variable loadcases” set to four.  

In this instance the permanent and variable load factors will only be considered for the 

number of loadcases specified as the number of Variable loadcases to consider. The factors 

will be added together based on the nodal result being adverse. The remaining loadcases are 

considered using the permanent factor. With the number of “loadcases to consider” set to 

four, only the four most positive resultants will be combined for the Max combination and the 

four most negative resultants will be combined for the Min combination. However by setting 

the “variable loadcases” to four, only positive results will be considered for the Max 

combination and negative results for the Min combination.  

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for the number 

of positive load effects specified by the number of Variable loadcases to consider. The 

remaining positive load effects will only use the permanent factor. The number of load effects 

summed is restricted to the number of loadcases specified and the other loads are discarded. 

The loadcases used are the most adverse, for example, the most positive are used for a 

maximum combination and all other load effects assembled are discarded. Also with the 

variable loadcases set to four the max combination will include only positive load effects, all 

negative load effects are discarded. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 0.8 0.7 -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

    Smart combination (Max) =  15   

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects for number of negative load effects specified by the number of Variable 

loadcases to consider the remaining negative load effects will only use the permanent factor. 

The number of load effects summed is restricted to the number of loadcases specified and the 

other loads are also discarded. The loadcases used are the most adverse, for example the most 

negative for min combination and all other load effects assembled are discarded. Also with 

the variable loadcases set to four the min combination will include only negative load effects, 

all positive load effects are discarded. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -.5 Not 
used 

Settlement -10 0.7 0.8 0.7 + 0.8 -10 x 1.5 = -15 Used 

Live load 1 -20 0.7 0.8 0.7 + 0.8 -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 0.8 0.7 + 0.8 -15 x 1.5 = -22.5 Used 

Live load 3 10 0.7 0.8 0.7  10 x 0.7 = 7 Not 
used 

Live load 4 -5 0.7 0.8 0.7 -5 x 1.5 = -3.5 Not 
used 

    Smart combination (Min) =  -75   

Smart Combination - Case 5 

Consider a node where short-term load effects are of mixed sign with the “Loadcases to 

consider” set to four and the “Variable loadcases” set to one. The permanent and variable 

load factors will only be considered for the number of loadcases specified as the number of 

Variable loadcases to consider. The factors will be added together based on the nodal result 

being adverse. The remaining three loadcases are considered using the permanent factor. 

With the number of “loadcases to consider” set to four, only the four most positive resultants 

will be combined for the Max combination and the four most negative resultants will be 

combined for the Min combination. However by setting the “variable loadcases” only positive 

results will be considered for the Max combination and negative results for the Min 

combination.  

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for number of 

positive load effects specified by the number of Variable loadcases to consider the remaining 

positive load effects will only use the permanent factor. The number of load effects summed 

is restricted to the number of loadcases specified and the other loads are also the discarded. 

The loadcases used are the most adverse, for example the most positive for max combination 

and all other load effects assembled are discarded. Also with the variable loadcases set to one 

the max combination will include only positive load effects, all negative load effects are 

discarded. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 0.8 0.7 -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

              

    Smart combination (Max) =  15   

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects for number of negative load effects specified by the number of Variable 

loadcases to consider the remaining negative load effects will only use the permanent factor. 

The number of load effects summed is restricted to the number of loadcases specified and the 

other loads are discarded. The loadcases used are the most adverse, for example the most 

negative for min combination and all other load effects assembled are discarded. Also with 

the variable loadcases set to one the min combination will include only negative load effects, 

all positive load effects are discarded. 
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Loadcase 

Nodal 
result 

Permanent 
factor 

Variable 
factor 

Factor used for maximum 
combination 

Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Used 

Live load 1 -20 0.7 0.8 0.7 + 0.8 -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Not 
used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

              

    Smart combination (Min) =  -51   
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Appendix B : LUSAS 

Solver Trouble 

Shooting 

  

LUSAS Solver Troubleshooting 

During an analysis, warning and error messages may appear in the LUSAS Solver output file. 

An error message will terminate the solution immediately. A warning message will attempt to 

continue the analysis. The most common warning and error messages are: 

 Negative Jacobian (Error) 

 Diagonal Decay (Warning) 

 Small Pivot (Warning) 

 Negative Pivot (Warning) 

 Zero Pivot (Error) 

A description of these Warning and Error messages follows. 

Negative Jacobian Errors 

A Jacobian determinant is a measure used to give an accurate value of the current area or 

volume of an element. A magnitude of less than or equal to zero will automatically invoke 

this message and may be a result of one of the following: 

 Incorrect definition of the 2D continuum and plate elements 
 

By design, LUSAS requires these element types to have an anti-clockwise node 

numbering sequence. The order is controlled from the underlying surface feature in 

which the element resides. If this message is output, the solution is to reverse the 

ordering of the surfaces for the elements having these warning messages output. Do 

this in LUSAS Modeller with the Geometry> Surface> Reverse menu item. 

 

Note that, in LUSAS Modeller, the local axis system of the surface may be viewed 
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prior to tabulation - the xy axis system displayed on each surface represents a right 

handed axis system, from which the anti-clockwise (or positive qz definition may be 

checked). 

 Too large a loading increment causing massive deformation of one or more 

elements 

This means that the elements are inverting. Note that this is only applicable for 

nonlinear analyses 

Diagonal Decay Warnings 

The stiffness matrix is a crucial component in a finite element analysis, but it can be poorly 

conditioned. Poor conditioning may result in round-off error, which is a loss of accuracy in 

the evaluation of the terms during the reduction process of the solution. This in turn leads to 

inaccuracies in the predicted displacements and stresses. 

LUSAS monitors the round-off error by evaluating the amount of diagonal decay present 

during the Gaussian reduction process. This criterion is based on the assumption that initially 

large diagonal terms accumulate errors proportional to their size. As reduction progresses, the 

diagonal term is reduced, amplifying the errors until they become a maximum when the 

diagonal term is the pivot. An indication of probable errors may be obtained by examining the 

change in magnitude of the diagonal term. 

The tolerance threshold above which a diagonal decay warning is output is actually quite 

conservative (controlled by a system variable DECAYL, default = 0.1E5). Although a check 

would always be recommended for any Warning of this description, significant effects are not 

generally expected until the decay reaches a value of 0.1E8 or greater. 

Poor conditioning of the stiffness matrix occurs because of large variations in the magnitude 

of diagonal stiffness terms and may be due to: 

 Large stiff elements being connected to small less stiff elements. An example may 

be where a stiff beam element is being used to transfer load into the structure. The 

stiffness of the beam would need to be reduced - typically, the beam would only need 

to be 1000 times the stiffness of the local elements. 

 Elements with highly disparate stiffnesses, e.g. a beam element may have a bending 

stiffness that is orders of magnitude less than it's axial stiffness. 

 

For instance, the cantilever beam problem is notoriously problematic with respect to 

ill-conditioning because of the potential for large differences between the axial and 

shear/rotational stiffness components. A typical stiffness matrix might be 

 

The longer the beam, the greater the difference between  and . 
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Potential data input mistakes leading to poor conditioning 

Poor conditioning may be as a result of deliberate modelling strategy but, more usually, an 

error in one or more of the following data input areas: 

 Mesh description - typical mistakes: 

 The aspect ratio of some elements are greater than the recommended limits 

(see the corresponding element section in the Element Reference Manual for 

further information). An ideal value is 1:1. however, values up to 1:10 are 

reasonable. Depending on the results required, this value may be increased still 

further (a test run would be recommended first). This problem is indicated by 

the WARNING message: "Unreasonably distorted element... " The only 

exception are explicit dynamic elements which really do require aspect ratios 

of 1:1. 

 Some element shapes are too distorted (see the corresponding element section 

in the Element Reference Manual for further information). 

 Geometric properties - typical mistakes: 

 Omission of values for any shear area parameters in the geometric properties 

for beams 

 Omission of values for other important properties, such as the torsional 

constant or thickness 

 Defining incompatible 1st and 2nd moment section properties for beams 

 Material properties - typical mistakes: 

 Different units used to define the nodal coordinates and the material 

properties. 

 Incorrect nonlinear material parameters (yield stress and hardening values 

particularly) 

 Inconsistent units throughout the model. This would only be of concern for 

dynamic analyses, where SI units are recommended. 

 Incorrect definition of orthotropic properties. The inequalities given in the 

appropriate element section of the theory manual need to be adhered to. 

Numerical instabilities may result when the material characterisations 

approach their limits (see Notes on material properties orthotropic for a list 

of these inequalities). 

 Support nodes - typical mistakes: 

 The structure has not been restrained against free body translation and rotation. 
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Each of the above suggestions are of interest because they make a contribution to the stiffness 

matrix. 

A further possibility is that the LUSAS Modeller model geometry is invalid because the 

element mesh contains gaps or has discontinuities in the connection of the elements. Such 

modelling problems may be found in LUSAS Modeller by: 

 Using the Mesh layer to view only the outline of the mesh. The view will show 

lines wherever a discontinuity occurs. 

 Using the Labels layer to draw the node numbers onto the mesh to see if any 

node numbering is overwriting at any point (indicating two nodes at the same 

point). Correction would normally require either a merging or an 

equivalencing operation. 

The diagonal decay message is closely related to the small pivot WARNING message (see 

below). See also the additional notes in the Theory Manual regarding the Gaussian solution 

method. 

Small Pivot Warnings 

See the section titled Diagonal decay warnings. 

Negative Pivot Warnings And Errors 

A negative pivot could be the result of poor conditioning so make sure you have seen the 

section titled Diagonal decay warnings. However, a well conditioned stiffness matrix can 

produce a negative pivot if: 

 The system is unstable- an unstable structure could be passing through a bifurcation 

or limit point, as shown in the following diagram: 

 

Such a bifurcation point could permit another, non-physical, solution path to be 

followed because, numerically, it requires less energy. 

Every negative pivot warning occurring in the LUSAS output file represents a 

bifurcation point. A negative CSTIF value, together with a negative PIVMIN value 
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corresponds to a limit point but a positive CSTIF and a negative PIVMIN correspond 

to a bifurcation point (although this is only the first one located in each case since 

limit points are detected by a change in sign of the slope of the force displacement 

curve). See The nonlinear logfile. 

A negative pivots sometimes occurs during the iterative solution (indicating that the 

load step may be too big) but disappear when the solution has converged. If negative 

pivots occur and the solution will not converge then first try reducing the load step. 

If the solution still does not converge, a limit or bifurcation point may have been 

encountered and the solution procedure may need to be changed. Running the problem 

under arc-length control gives the best chance of negotiating a limit or bifurcation 

point. A load limit point can also be overcome by using prescribed displacement 

loading. 

 The system is not adequately restrained - for example when using a 3D beam in a 

2D analysis. 

 Mechanism has been excited - This is a further possibility when reduced integration 

is used. The use of Option 18 will normally solve this problem. If the problem persists, 

continue with the use of the option but refine the mesh further. 

A count of the number of negative pivots is given in the LUSAS log file (parameter NSCH). 

Initially NSCH = 0 since, initially, a stable path is assumed. When NSCH = 1, an unstable 

point (limit or bifurcation) has been reached, PIVMN will give the value of the minimum 

pivot at this point. 

Notes 

 The use of LUSAS Option 62 is not recommended until all other checks have been 

carried out to ensure model integrity. 

 Before modifying the solution procedure to arc-length, the checklist given in the 

section above on small pivots should be checked. 

Zero Pivot Errors 

LUSAS uses a Gaussian reduction solution technique to solve the finite element equations. 

This technique requires the structure stiffness matrix to be non-singular. This means that for 

static analyses the structure, or any components of the structure, must not permit any rigid 

body displacements or rotations. Failure to comply with this criterion will result in a zero 

pivot message. 

The error message includes the node and variable number that may be affected by the poor 

conditioning - these variables should be investigated in the model. Typical mistakes can 

include: 

 Omission of a support condition in one or more of the rigid body directions for the 

structure. 
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 Insufficient additional restraint when connecting a beam element to a continuum 

element. In this case a rigid body torsional spin about the axis of the beam may occur. 

 Six degrees of freedom have been specified for a thick shell element, but the drilling 

rotation has not been correspondingly restrained. 

 Insufficiently large slideline interface stiffness coefficients allowing the two bodies to 

pass through each other as rigid bodies. The load increment may also be too large. 

 Incorrect nonlinear material parameters, such as a zero yield stress. 

 Joint elements may require investigation as the stiffnesses operate in local directions 

and can be easily defined incorrectly - as a result, the joint stiffnesses will not be 

providing support in the required directions. 

 There may be totally or partially unconnected elements within the structure as a result 

of incomplete merging or equivalencing of the model.  

Other Warnings 

Other warnings that may be found in the LUSAS output file include: 

 Aspect ratios warnings - See the appendix on element restrictions in the Element 

Reference Manual for more information. 

 Excessive curvature for beams warnings - See the appendix on element restrictions 

in the Element Reference Manual for more information. 

Notes On Orthotropic Material Properties 

For orthotropic material models the D matrix must be symmetric and a number of further 

relations must also be satisfied: 

Material properties orthotropic (e.g., QPM4) 

To maintain symmetry:  

nyx = nxy * Ey/Ex 

and to obtain a valid material: 

nxy < (Ex/Ey)1/2 

This applies to Fourier elements as a special case to simulate a bladed structure. 

Material properties orthotropic plane strain (e.g. QPN4).  

Ey * (nxy*Ez + nyz*nxz*Ex) = Ex * (nxy*Ez + nxz*nyz*Ey) 

Material properties orthotropic axisymmetric (e.g. QAX4).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

nzx = nzx * Ez/Ex 

nzy = nyz * Ez/Ey 

and to obtain a valid material: 
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nxy < (Ex/Ey)½ 

nxz < (Ex/Ez)½ 

nyz < (Ey/Ez)½ 

Material properties orthotropic solid (e.g. HX8, QSL8).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

nzx = nxz * Ex/Ez 

nzy = nyz * Ez/Ey 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

nxz < (Ex/Ez)½ 

nyz < (Ey/Ez)½ 

Material properties orthotropic thick (e.g. QSC4).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

Notes 

 Option 16 can be used to override non-convergence as a result of poor conditioning. 

When Option 16 is specified and an increment has failed to converge within the 

maximum number of iterations allowed, LUSAS assumes convergence, writes the 

output/plot file results, and then continues with the next increment. Load step 

reductions can also be suppressed via the STEP REDUCTION section under the 

NONLINEAR CONTROL data chapter. Using these procedures may help to locate 

the source of the problem when investigating an unconverged configuration in the 

LUSAS Modeller post-processor. 

 A pivot refers to the diagonal element of the upper triangular matrix that is formed 

after elimination has been completed. Note that in the frontal solution these pivots are 

computed as soon as all the relevant equations have been assembled. 

 Computation of det(K) as part of a nonlinear solution scheme is not necessary since a 

count of the number of negative pivots (NSCH in the log file) together with the value 

of PIVMN gives all the information required. 

 A zero pivot implies that det(K)=0. 

 If NSCH=2 then another unstable point has been reached and implies that det(K)>0. 
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Eigenvalue Analysis: Troubleshooting 

It is good practice to perform a linear static analysis prior to the eigenvalue analysis. This 

eliminates the added complexities of the dynamic variables and will enable a check on the 

basic stiffness matrix for the structure. Any warning or error messages in the LUSAS output 

file (such as zero, negative or small pivots) should be investigated.  

In the event of problems occurring after completing the linear static and the eigenvalue 

analysis consider some of the more common queries and their typical solutions as listed 

below.  

Eigenvalues are missing 

A Sturm sequence check is performed by default to indicate the number of modes which may 

be missing. 

 Check for Warnings or Errors Check the output file for any other warnings or 

errors. There may be diagonal decay or pivot warnings that will indicate node and 

element numbers and help to identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of the 

modes are close together, the default magnitude for this parameter may not be 

sufficient to allow accurate resolution in their extraction. 

 Convergence Tolerance Tighten the convergence tolerance since, again, some modes 

may be close together. This would normally also require an increase in the number of 

iterations permitted. 

 Convergence Achieved Ensure the solution converged correctly. If not, then increase 

the number of iterations permitted. 

 Mesh Refinement Increase the mesh refinement of the model in order to increase the 

number of degrees of freedom in the structure to simulate all the modes expected. 

 Symmetry Taking advantage of symmetry in an eigenvalue analysis may cause the 

inadvertent omission of several eigenvalues as a result of the corresponding symmetry 

supports restraining certain non-symmetric eigenmodes. 

 Increase Shift If a shift has been used to eliminate rigid body motions when analysing 

unsupported structures, then it may be that the value used is insufficient. The solution 

is typically not overly sensitive to changes in this parameter and, therefore, any 

changes tried should be in terms of orders of magnitude. 

 Constraint Equations If constraint equations have been defined in the problem the 

Sturm sequence check may prove unreliable. This is a limitation of the Lagrange 

multiplier technique used in LUSAS. 

The Solution Did Not Converge 

 Check for Warnings or Errors Check the output file for any other warnings or 

errors. There may be diagonal decay or pivot warnings that will contain node and 

element numbers, and help identify any suspect areas of the mesh. 
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 Iteration Vectors Increase the number of starting iteration vectors. If any of the 

modes are close together, the default magnitude for this parameter may not be 

sufficient to allow accurate resolution in their extraction. Increasing this parameter is 

also essential if only requesting a small number of eigenvalues (1-2). Ten iteration 

vectors would be a reasonable starting value for such a situation. This parameter is not 

used for Lanczos extraction. 

 Convergence Tolerance The convergence tolerance criteria may be too tight - try 

slackening this criteria. This would normally also require an increase in the number of 

iterations permitted. 

 Increase Shift If a shift has been used to eliminate rigid body problems when 

analysing unsupported structures, then it may be that the value used is not sufficient. 

The solution is typically not overly sensitive to changes in this parameter and, 

therefore, any changes tried may be in terms of orders of magnitude. 

Negative Eigenvalues Are Calculated 

 Check for Warnings or Errors Check the output file for any other warnings or 

errors. There may be diagonal decay or pivot warnings that will indicate node and 

element numbers and help to identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of the 

modes are close together the default magnitude for this parameter may not be 

sufficient to allow accurate resolution in their extraction. Increasing this parameter is 

also essential if only requesting a small number of eigenvalues (1-2). Ten iteration 

vectors would be a reasonable starting value for such a situation. 

 Convergence Achieved Ensure that the solution converged correctly. If not, then 

increase the number of iterations permitted. 

 Convergence Tolerance Tighten the convergence tolerance, since some modes may 

be close together and require greater numerical resolution. This may also require an 

increase in the number of iterations permitted. 

 Reduce Load Level Reduce the load applied to ensure that it is below the lowest 

expected buckling mode of the structure. A negative eigenvalue in a buckling analysis 

could also simply mean that the applied loading is in the opposite direction to that 

which would cause buckling; e.g. a strut subjected to tensile load instead of 

compression. 

 Alternative Buckling QSL8 elements have given negative eigenvalues for thin 

structures and resulted in negative projected mass errors. The remedy is to use the 

alternative buckling algorithm where positive eigenvalues should be obtained. This is 

always the case except when the buckling load factor is less than unity. Adjust the load 

level to ensure that all the load factors are greater than 1 if this occurs. Additionally, 

use Option 18 (fine integration rule for the element) to overcome the excitation of any 

element mechanisms. 
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Why Loading is Ignored in an Eigenvalue Analysis 

In a standard eigenvalue analysis, the loading will be ignored completely. For a linear 

analysis, once the eigen-pairs have been obtained, the stress distribution s for each mode 

shape F is evaluated using: 

s = D * B * F 

where D and B are the elastic constitutive and strain-displacement matrices 

respectively.  

The reason that the forces have no effect on the vibrational behaviour is because the loading 

conditions in a linear analysis do not affect the D or B matrices. To include their effects, a 

nonlinear D and B matrix must be evaluated prior to the eigen analysis. This is achieved by 

performing a static nonlinear analysis (with a geometrically nonlinear option) followed by an 

eigenvalue analysis. In this way the effects of the loads are included via the updated B matrix 

(and D matrix if a nonlinear material has been specified). 
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Appendix C : 

Keyboard Shortcuts 

  

Keyboard Shortcuts 

Selecting Model Features 

Features displayed in the View window may be selected using either specific cursors or by 

using normal cursor mode in conjunction with specific keys: 

Feature / Mesh Object Selection Options 

Hold the key shown down when using the left mouse button.  

Specific cursor  = Normal cursor + key 

  

  All geometry selection  

  

=  + G key 

    

  Point selection  =  + P key 

  Line selection  =  + L key 

  Surface selection  =  + S key 

  Volume selection  =  + V key 

  Mesh selection =  + M key 

  Node selection =  + N key 

  Edge selection =  + B key 



Modeller Reference Manual   

    

506 

  Face selection =  + F key 

  Element selection  =  + E key 

  Annotation selection  =  + A key 

Note. Key shortcuts can be used to override specific cursor selections. 

Area Selection Options 

Rectangular, circular, or polygonal areas can be selected by using specific area toolbar 

buttons or by using normal cursor mode with a specific key: 

Specific cursor  = Normal 
cursor + key 

  

  Click and drag the cursor to the opposite diagonal corner. 

  

=  

  Click the centre of the circle and drag the cursor to the required 

radius. 

=   + C 

key 

  Click each corner of a polygon and either double click to close the 

polygon or select Close Polygon from the context menu.  

=   + X 

key 

Memory shortcuts 

After features have been selected: 

Ctrl + M key = Set selected items into Selection Memory 

Selection Modifiers for All Cursors 

Features displayed in the View window may be added to, or removed from, any initial 

selection using these selection modifers: 

Shift key = Add to current selection 

Ctrl key = Toggle (include /exclude selection) 

Ctrl + Shift key = Remove from current selection 

Tab key = Cycle (items at the same location) 

Shift + Tab key = Cycle previous 

Alt key = Intersect mode. By default all items completely enclosed in a selected area will be 

selected. By holding down the Alt key, items intersecting the selection perimeter will also be 

selected. The Alt key may be used with, or independently from, the Shift or Ctrl keys. The 

Alt key can also be used with feature selection shortcuts e.g. Alt + Shft + L adds lines to the 

current selection. 

Alt + Return key = Display properties of item 
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'Datatip' + Return key = Adds current item to selection 

Mapping of Keyboard Modifiers for Cursor and Area 

Selection 

The Cursor drop-down menu contains a Keyboard Mapping... menu item which allows the 

default Windows-based cursor and area selection keyboard modifiers to be changed to suit 

those that are generally used with CAD modelling systems or be user-defined. For more 

information see Selection of model features. 

Browsing Selected Features 

Items in the current selection may be viewed in the Browse Selection window which can be 

displayed from the View> Browse Selection menu item. This window can also be triggered 

by a right mouse button click in the Selected area of the status bar at the bottom of the 

Modeller user interface, or by right-clicking in a View window. Selected features can be 

deselected and reselected as necessary from those listed. 

Model Viewing Shortcuts 

The model can be rotated, zoomed, panned, and viewed at predefined orthogonal and non-

orthogonal views using specific cursors or view buttons, or by using normal cursor mode in 

conjunction with specific keys. Rotation, zoom and pan can also be carried out in other cursor 

input modes such as when defining lines by cursor or section slicing for example. 

Dynamic Pan (Drag) 

Specific cursor  = Normal cursor + key 

  

  Hold down the left mouse button to 

pan the model. 

  

=  + D key 

=  + Middle mouse button 

Note. Hold down the key(s) to restrain the pan for either specific or normal cursor mode 

about the axis stated: 

X or Shift key = Restrain in the screen X axis  

Y or Ctrl key = Restrain in the screen Y axis 

Dynamic Rotation 

Specific cursor  = Normal cursor + key 

  

  Rotates the model around various 

multiple axes. 

  

  

=  + D key 

=  + Middle + Left or  Right mouse 
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button 

Note. The model is rotated about its centre unless any part of the model is selected in which 

case the model is rotated about the centre of the selection. Hold down the key(s) to restrain 

rotation about the axis stated: 

X or Shift key = Restrain in the screen X axis  

Y or Ctrl + Shift keys = Restrain in the screen Y axis 

Z or Ctrl key = Restrain in the screen Z axis  

Dynamic Zoom 

Specific cursor  = Normal cursor + key 

  

 Hold down the left mouse button and 

move the mouse. 

  

=  + Scroll mouse wheel 

=  + Z key 

Note. If any part of the model is selected it is used as the centre of the zoom. 

Zoom 

  Drag a box around the region to be enlarged or click the left mouse button to zoom in 

progressively with each click. 

Ctrl key = Zoom out (when held at same time) 

Note. The cursor position dictates the centre of the zoom. 

Orthogonal Model Views 

These buttons are located in the status bar. 

  = View along the +X axis towards the origin 

  = View along the +Y axis towards the origin 

  = View along the +Z axis towards the origin 

Any of the views along these axes can be modified by using these key sequences which select 

an alternative view orientation: 

Shift key +  = View along the -X axis towards the origin   

Ctrl key +  = View along the -Y axis towards the origin 

Ctrl + Shift key +  = View along the -Z axis towards the origin 

Equivalent toolbar buttons for these view shortcuts can be found on the customisable toolbar 

dialog or by clicking the right mouse button on the orthogonal model view buttons. 
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Non-Orthogonal Model Views 

  = Isometric view 

Ctrl key +  = Reverse isometric view 

  = Dimetric view 

Ctrl key +  = Reverse dimetric view 

  = Trimetric view 

Ctrl key +  = Reverse trimetric view 

Useful Windows Shortcuts 

The following standard Windows shortcuts are useful when creating and printing models in 

LUSAS Modeller: 

Ctrl key + N key  = New 

Ctrl key + O key = Open 

Ctrl key + S  key = Save 

Ctrl key + P  key = Print 

Ctrl key + A  key = Select all items 

Ctrl key + C  key = Copy 

Ctrl key + X  key = Cut (for text only) 

Ctrl key + V  key = Paste 

Ctrl key + Z  key = Undo 

F2 key = Rename (when name is selected)  

F5 key = Redraw 
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Appendix D : Tip of 

the Day 

  

Tip of the Day 

When starting LUSAS Modeller useful tips can be optionally displayed. This is done by 

selecting the Help > Tip of the Day... menu item and ensuring that Show tips at Startup is 

selected. Next and Previous tips can be browsed. 

The following is the list of tips supplied in the current release version: 

 If you haven't already done so, please read the 'Getting Started' leaflet. 

 The 'Keyboard Shortcut Guide' will help you use LUSAS in an efficient manner 

 If you lose unsaved edits because of a power, hardware or software failure, restart 

LUSAS, open the model again and chose 'yes' when prompted to recover. 

 Saving your work frequently prevents data loss and makes undo/redo work faster. 

 Help is available even for greyed out buttons and menus. First click on the Help 

button on the main toolbar, then click on any menu item or toolbar button. 

 Right-clicking in a window displays a context menu relevant to both that window and 

any selection within it. 

 Toolbar buttons with a small triangle to the right hand side are menu buttons. Press 

the left hand side to use the top button, or the right hand side to display other 

buttons.Holding down the Shift key while selecting will add to the current selection. 

 Holding down the Ctrl key while selecting will toggle an object's selection state. 

 Holding down the Alt key while selecting will additionally select items that intersect 

(cross) the selection perimeter. 

 Ctrl-A selects everything visible in the current window. 

 You may filter your selection to include only Volumes, Surfaces, Lines, Points, 

Elements, Nodes or Annotation by respectively holding down the V, S, L, P, E, N or 

A key while selecting. 

 Alt-Enter displays the properties of the current selection. 

 If you the hover the cursor over an object, a data tip will appear providing details of 

that object. 

 Pressing Enter whilst a data tip is showing will select the object described. 
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 To Zoom, Drag or Rotate the model hold the Z, D or R key down whilst moving the 

mouse. 

 Using the dynamic rotation while holding down the Ctrl key rotates the model in the 

plane of the screen. 

 Using the dynamic rotation while holding down the Shift key rotates the model about 

the screen X axis. 

 Using the dynamic rotation while holding down the Ctrl & Shift keys rotates the 

model about the screen Y axis. 

 Using the drag tool while holding down the Ctrl key drags the model up and down. 

 Using the drag tool while holding down the Shift key drags the model left and right. 

 If you have a 3 button wheel mouse, the wheel will zoom, holding the middle button 

will drag and holding the middle button and either of the other two buttons will rotate. 

 To change the rotation increment, visit the 'View' tab on the View Properties dialog 

(right click in the current view) 

 To change the style of the XYZ axes arrows, visit the 'View Axes' tab on the View 

Properties dialog (right click in the current view) 

 To change the selection or background colours, visit the 'General' tab on the View 

Properties dialog (right click in the current view) 

 Most context menu functionality for attributes is also available for groups of 

attributes. This helps you check your model. 

 Dragging an attribute from the treeview and dropping it on a window assigns it to 

anything selected in that window. 

 Dragging and dropping layers in the layers treeview changes the order in which they 

are drawn. This is useful if, for example, your solid model is eclipsing your labels. 

 Dragging and dropping loadcases in the Analyses treeview changes the order in which 

they are analysed. 

 Dragging and dropping controls, attributes, or groups of attributes, in the Analyses 

treeview assigns them to a different loadcase. 

 The 'Selected' box in the status bar shows the number of objects are currently selected. 

 Pressing 'Tab' or clicking in the 'Selected' box in the status bar cycles through all the 

objects which could have been selected at the last mouse click. 

 Right-clicking in the 'Selected' box in the status bar allows access to a menu of 

selected objects. Choose 'Previous' when you have cycled the selection once too 

many! 

 The 'browse selection' window gives useful feedback on which items are currently 

selected. 

 The 'browse cyclable items' window shows all items which could possibly be selected 

at the chosen position. 

 To select an item with a known name, use the 'Advanced Selection' dialog. 

 To show the location of a named item, select it using 'Advanced Selection', right click 

on it in the 'Browse Selection' window, and chose 'find' from the menu. 

 If a message in the text output window refers to a particular object by name, double 

click on the message for help finding that object. 
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 Clicking in the 'Z' box in the status bar views the model from the positive end of the Z 

axis - and similarly with X and Y. (Hold down Ctrl while clicking to view from the 

reverse side). 

 Clicking the 'advanced' button on the LPI command bar lets you define macros for 

frequently used commands 

 The members of a group can be examined from the group's property page 

 The 'jump to' button on the 'hierarchy' tab of an object's property page can be used to 

select and show the properties of connected objects. 

 The 'assigned in active loadcase' option on an object's property page allows you to 

view either assignments in the active loadcase, or in any loadcase. 

 Treeviews can be moved to different tree frames by drag and drop. This is useful if 

you prefer to see more than one treeview at the same time. 

 Attributes can be assigned to the contents of groups by copying the attribute and 

pasting it onto a group in the treeview. 

 By saving a view using the Window menu, and naming it 'default', every new window 

will use the saved view. 

 Pressing the Ctrl and Break keys together will interrupt the current process. 

 For larger models save time by setting the manual redraw option (Window menu) and 

manually redraw (F5 key) at any time. 

 For larger models save time by setting the manual resize option (Window menu) and 

manually resize at any time. 

 For larger models save time by locking the mesh whilst making several geometry or 

mesh changes. Either manually remesh, or unlock once finished to reinstate automatic 

meshing 

 It is usually much quicker to undo several events all at once than to undo them 

individually 

 Many additional toolbar buttons are available via the View>Toolbars>Customise 

menu item 

 Selection is possible using several different criteria (e.g. connectivity, element type) - 

see the 'Advanced Selection' dialog 

 To retain a record of the commands used in a session, use the File>Script>Start 

Recording menu item. 

 You may use the Esc key to close any dialog. 

 Holding down the Shift and Control keys while selecting will remove from the current 

selection. For example, the current selection could be trimmed from a perpendicular 

view orientation to achieve a 3D selection. 

 A selection may be filtered to include only Geometry, Volumes, Surfaces, Lines, 

Points, Mesh, Elements, Nodes or Annotation by respectively holding down the G, V, 

S, L, P, M, E, N or A key while selecting. 

 Element faces may be selected by holding down the F key while selecting (LUSAS 

HPM users only) 

  LUSAS Solver can be paused by pressing the Pause key on your keyboard to 

temporarily free up PC resources if required. Press the Esc key to resume Solver. 



Modeller Reference Manual   

    

514 

 Errors and warnings reported in the Text Output window can be double-clicked to 

open the Identify Object facility which can be used to locate the referenced items. 

Editing and adding your own tips 

You can add your own tips by editing the text file named tips.txt which is held in the 

<LUSAS installation folder>\Programs\Config directory. 
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Appendix E : Real 

Numbers and 

Expressions in 

LUSAS 

  

Input and Output of Real Numbers in LUSAS 

The precision of user-entered real numbers is preserved both internally within LUSAS 

Modeller, and when re-displayed on dialogs.  

All real numbers are displayed in engineering-style notation (that is in 3,6,9 etc, powers of 

10; as in 89.6E3) rather than 8.96E4 or 0.896E5. This applies to all text entry fields, including 

the grids used in many places throughout the Modeller user interface.  

For cosmetic numbers that are system generated, like the current zoom factor, only a sensible 

number of significant figures is shown. This does not alter the precision stored, which will 

always be the maximum allowed by the operating system. 

Expressions and Functions Supported 

Expressions may be entered anywhere in LUSAS Modeller where numbers may be input. For 

example, in point definition, it is possible to enter 3+10, 4*6, and 5-1 as valid co-ordinates. 

All arithmetic operators including braces are available, as well as the standard trigonometry 

functions sin, cos, log etc. This facility is available in all text entry fields throughout the 

Modeller user interface. 

The following functions are also supported: 

Arithmetic 

(A), -A, A+B, A-B, A*B, A/B, A^B, ceil(A), floor(A), abs(A), 

max(A, B), min(A, B), pow(val, exp), mod(val, div) 
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Trigonometric 

sin, cos, tan, asin, acos, atan, sinh, cosh, tanh, sind, 

cosd, tand, asind, acosd, atand, atan2, atan2d 

Mathematical 

exp, log, log10, sqrt 

Logical 

A > B, A < B, A = B, not(A), and(A, B), or(A, B), boolEq(A, 

B), boolNE(A, B), gt(A, B), ge(A, B), lt(A, B), le(A, B), 

eq(A, B), ne(A, B), if (condition, then, else) 

Other 

Radians(angle) Converts an angle entered in degrees into an 

angle in radians 

Degrees(angle) Converts an angle entered in radians into an 

angle in degrees 
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Appendix F : 

Treeview Icons 

  

Treeview Icons 

The Tree Frame has six tabbed panels each with its own Treeview. The Treeviews provide 

access to model and results data and show a list of objects of a particular type. The Treeview 

panels comprise: 

 Layers  

 Groups  

 Attributes  

 Analyses   

 Utilities   

 Reports   

Whilst the icons seen in the various Treeview panels are generally described in relevant 

sections of the Modeller User Manual for completeness they are also summarised here. 

Layers Treeview 

A symbol adjacent to each layer name in the Layers  Treeview shows the display status of 

each layer:  

 The display of a layer has been turned 'on' (coloured layers image) 

 The display of a layer has been turned 'off' (greyed-out layers image) 

 No results are loaded or currently available for this layer, or inappropriate settings have 

been defined (red circle with a line through it) 

 View properties: options and settings 
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Groups Treeview 

A symbol adjacent to each group name in the Groups  Treeview shows the visibility and 

status of each group. 

When modelling: 

 A black dot next to a symbol denotes the current group into which all new geometry will 

be added when created.  

 All of the objects in this group are visible (green tick)  

 Some of the objects in this group are visible (blue tick)  

 None of the objects in this group are visible (red cross)  

When a results file is loaded: 

 All of the objects in this group are showing results (green tick, green border) 

 Some of the objects in this group are visible and some are showing results (blue tick, 

blue border) 

 All of the objects in this group are visible but only some are showing results (green tick, 

blue border) 

Attributes Treeview 

A symbol adjacent to each attribute in the Attributes  Treeview shows the status of each 

attribute present. 

 An attribute has been assigned to the model or used in the definition of another attribute 

(coloured image) 

 An attribute has yet to be assigned to the model or used in the definition of another 

attribute (greyed-out image) 

 Active fibre in a structural analysis, or active lamina in a composite analysis 

 An attribute has been set as default, meaning it will automatically be assigned to features 

of the model as they are generated. (coloured or greyed-out attribute with a surrounding red 

box) 

 If any attributes that were previously created by a Multiple tendon Prestress Wizard are 

edited outside of the wizard, or some other aspect of the model has been changed (for 

example the geometry or mesh) then the attributes will be marked with a warning symbol to 

show that the wizard must be re-run to recalculate new values. 

 Influence assignments are pending 

 Direction definition options 
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Analyses Treeview 

A symbol adjacent to each analysis or loadcase related entry in the Analyses  Treeview 

shows the status of each entry. 

 A 'base' analysis on which any other analyses present may be dependent upon (green 

'solve' symbol) 

 An analysis that may be dependent upon a 'base' analysis (cyan 'solve' symbol) 

 A black dot on an analysis icon (green or cyan) indicates the analysis contains the active 

loadcase 

Load curves 

 Active load curve (coloured load curve image) 

 Inactive load curve (greyed-out image) 

 Loading assignments should be moved to the load curves 

Loadcases 

 Active loadcase (coloured loadcase image) 

 Inactive loadcase (greyed-out image) 

 Active loadcase with gravity assigned as a property of the loadcase (coloured loadcase 

image with a loading arrow) 

 Inactive loadcase with gravity assigned as a property of the loadcase (greyed loadcase and 

loading arrow) 

 Active influence prior to being solved 

 Inactive influence prior to being solved 

 Active loadcase has results available (coloured results contour image)  

 Inactive loadcase has results available (coloured results contour image)  

 Active loadcase has results available and gravity was assigned to the loadcase as a 

property of the loadcase (coloured results contour image with a loading arrow) 

 Inactive loadcase has results available and gravity was assigned to the loadcase as a 

property of the loadcase (greyed-out results contour image with a loading arrow) 

 Active loadcase has gravity assigned to the loadcase as a property of the loadcase but the 

loadcase is turned off for solving (coloured loading arrow with a red cross) 

 Inactive loadcase has gravity assigned to the loadcase as a property of the loadcase but the 

loadcase is turned off for solving (greyed-out loading arrow with a red cross) 

 Active loadcase does not have gravity assigned to it as a property of the loadcase and the 

loadcase has been turned off for solving. (red cross) 
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 Inactive loadcase does not have gravity assigned to it as a property of the loadcase and the 

loadcase has been turned off for solving. (grey cross) 

 Combination and envelope results options; Nonlinear and Transient options; Nonlinear 

options 

Post processing 

 Active load combination (coloured loadcase image with a plus symbol) 

 Inactive load combination (greyed-out loadcase image and plus symbol) 

 Active load combination containing a combination of data that warrants a warning 

(coloured loadcase image with a plus symbol and warning triangle). Hovering over the icon 

will show a datatip stating why the warning has been issued. 

 Inactive load combination containing a combination of data that warrants a warning 

(coloured loadcase image with a plus symbol and warning triangle) Hovering over the icon 

will show a datatip stating why the warning has been issued. 

 Active envelope (coloured loadcase image with an envelope symbol) 

 Inactive envelope (greyed-out loadcase image and an envelope symbol) 

 Active load envelope containing a combination of data that warrants a warning (coloured 

loadcase image with an envelope and warning triangle). Hovering over the icon will show a 

datatip stating why the warning has been issued. 

 Inactive load envelope containing a combination of data that warrants a warning (greyed-

out loadcase, envelope and warning triangle). Hovering over the icon will show a datatip 

stating why the warning has been issued. 

Cable tuning 

 Active cable tuning results loadcase (coloured cable stay image) 

 Inactive cable tuning results loadcase (greyed-out cable stay image) 

 Inappropriate settings have been defined (red circle with a line through it) 

Target values 

 Active target values loadcase (coloured target image) 

 Inactive target values loadcase (greyed-out target image) 

 Inappropriate settings have been defined (red circle with a line through it) 

Influence analysis 

Influence point defined 
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Other 

 Model properties options and controls; Coupled analysis options; Solver options; 

Combination and Envelope options 

Utilities Treeview 

Symbols used in the Utilities  Treeview: 

 Used for all entries in the Utilities Treeview 

Reports Treeview 

Symbols used in the Report  Treeview: 

 Report entry 

 Chapter entry in a report 

 Image entry in a report 
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Index 

A 

absolute envelope, 413 

Acceleration loading, 246 

activation/deactivation of elements, 290 

active composite lamina, 277 

active composite layer, 409 

active fibre, 409 

active loadcase, 409 

active mesh, 132 

advanced selection, 37 

Age, 310 

Akhras-Dhatt optimiser, 397 

Analyses treeview, 351 

analysis, 397, 400 

failed, 399 

Analysis 

running, 398 

analysis control, 358 

analysis control parameters, 316 

animations, 463 

annotating the screen, 46 

frame coordinates, 48 

model coordinates, 48 

arbitrary sections 

calculation of properties, 347 

arc line, 95 

arc-length control, 363 

area 

selection by cursor, 35 

Area 

selection modifers, 36 

Area Selection, 506 

assign, 127 

associativity, 85 

attributes, 127, 128, 131, 132, 235 

dependency across analyses, 355 

manipulation, 129 

transfer between models, 69 

visualising, 130 

Australia steel sections, 168 

automatic equivalencing, 297 

axes, 268 

changing element orientation, 123 

displaying element axes, 134 

local coordinate systems, 267 

axisymmetric, 387 

B 

background grid, 142 

backup, 56 

Backups, 60 

base analyses, 355, 356 

Base analyses 

creating, 355 

basic combination, 413, 417 

beam cross-section, 160, 161 

beam loads, 244 

beam stress recovery, 452 
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beam stresses, 449 

bending moment diagrams, 436 

BFP loading, 241 

birth and death, 290 

BMP, 469 

boolean geometry, 110 

boundary discretisation, 140 

bro Combinations, 12 

browse selection, 11 

Browsing Selected Features, 507 

buckling analysis, 371, 377 

C 

cable tuning analysis, 393 

CAD, 126 

Canada steel sections, 168 

case studies, 51, 126, 138 

geometry, 126 

meshing, 138 

case study 

arbitrary section calculation of a 

compound section, 349 

cable stay analysis, 304, 306 

CBF loading, 241, 258 

centripetal stiffening, 375 

China steel sections, 168 

Chinese Creep, 217 

Cholesky  solver, 396 

CL loading, 240, 241, 257 

combinations, 413, 485 

Combinations and envelopes, 413 

combined line, 85, 98 

command bar, 9 

command files, 66 

command line, 9 

composite analysis, 270, 434 

Composite Damage Model, 200 

Composite layup 

defining, 272 

definition methods, 270 

visualisation, 274 

Composite model data 

visualisation, 276 

concentrated load, 240 

concrete heat of hydration, 180 

concrete material model, 180, 192, 445 

conduction, 311 

conjugate gradient solver, 396 

consolidation analysis, 370 

constant body force, 240 

constraint equations, 284 

dependency across analyses/loadcases, 

288 

contact, 277, 311 

contact support, 231 

Context menus, 12 

contouring, 436 

contouring attributes, 130 

convection, 311 

coordinate system, 267 

coplanar neighbours 

selecting, 37 

copying geometry, 112 

coupled analysis, 384 

crack patterns, 445 

Crack width calculation methods, 433 

crash recovery, 403 

creating, 463 

creep, 180, 199, 211, 212, 215, 218, 370 

Cross-section, 163 

crushing material model, 207 

crushing symbols, 445 

crystal reports, 477 

cursor, 91, 93, 100 



  Index 

    

525 

selection filters, 34 

selection tool, 33 

Cursor 

selection modifiers, 36 

customise startup templates, 51 

Cuthill-McKee optimiser, 396 

cycling geometric features, 123 

D 

Damage, 200 

damping, 290 

DAT, 61, 80 

data tips, 12 

deactivate elements, 290 

deassigning attributes, 131 

deassigning supports, 235 

default assignment, 165 

default attribute assignment, 128 

defining surface, 165 

definition for Surface, 165 

deformed mesh, 436 

delamination model, 153, 204 

deleting geometric features, 85 

design factors, 433 

Diagonal Decay, 496 

diagonal solver, 396 

diagrams, 442 

dimetric, 509 

Direct Method Influence, 300 

Direction Definition, 338 

discrete loads, 247 

editing, 255 

discretisation, 132 

displacement loading, 245 

distance interpretation 

multiple varying sections, 170 

Distributed Flux, 258 

distributed load, 241 

distributed mass, 152 

drained/undrained soil, 202 

draping, 272 

Draping grid 

extending, 276 

visualisation, 275 

drawing attribute labels, 132 

Drucker-Prager material model, 190 

DXF, 74 

dynamic analysis, 379, 381 

E 

earth pressure 

tri-linear joint material, 226 

Eccentricities, 163 

multiple varying sections, 171 

Eccentricity, 165 

edge collapsing, 139 

eigenvalue analysis, 371, 378, 502 

elasto-plastic material, 180, 183, 184, 

185, 187, 190 

ELDS loading, 244 

emulating behaviour, 18 

end releases for beam elements, 136 

envelopes, 413, 414 

environmental load, 258 

ENVT/TDET loading, 258 

equivalencing, 296 

error reporting 

automated, 403 

manual, 403 

errors, 495 

EU steel sections, 168 
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excel, 481 

Export 

files, 73 

Exporting a Solver data file, 81 

Expressions 

supported, 515 

F 

facet, 87 

failed analysis, 399 

fatigue analysis, 419 

feature based models, 22 

Feature Selection, 505 

feature-based models, 22 

FiberSIM 

defining composite stack, 271 

Fibre directions 

visualisation, 275 

Fibre locations, 452 

definition, 162 

field analysis, 381 

field loads, 257 

File 

backups, 60 

File and folder naming 

260 character path limit, 61 

file locations, 60 

file types, 55, 56, 61, 62, 65, 66, 67, 69 

Fixing Mesh Problems, 147 

FLD loading, 242 

fleshing, 166 

flow, 232 

Flux, 257, 258 

foam material model, 207 

Fourier   expansion, 460 

Fourier analysis, 386 

Fourier results, 433, 459 

frequency analysis, 371 

frequency response, 425 

Friction Pendulum, 223 

Frictional slideline, 277 

function, 324 

Functions 

supported, 515 

G 

general loads, 247 

geometric Attributes, 163 

Geometric Attributes, 165 

geometric nonlinearity, 361 

Geometric Properties, 159 

geometry, 85 

geometry orientation, 123 

geostatic control, 371 

getting help, 13 

gnl, 361 

graph wizard, 448, 459 

graphing, 459, 460 

gravity loading, 239 

groups, 39 

Guyan reduction analysis, 289, 373 

H 

HA/HB loading, 247 

Hashin failure contours, 435 

Hashin material model, 200 

Heat of Hydration, 181 

heat transfer, 311 

Heat transfer, 311 
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help, 12 

hexahedral, 106 

highway load, 247 

Hill yield criteria, 185 

Hoffman yield criteria, 185 

holes, 101 

hollow volume, 108 

home view, 43 

hook contact, 224 

Hydration, 181 

hyper-elasticity, 205 

I 

IFFLR, 435 

IGES, 76 

IMD, 378, 421, 459 

IMDPlus, 421 

impact analysis, 277, 381 

Import 

files, 72 

interface file data, 71 

options, 71, 73 

Influence Analysis, 389 

Influence Analysis Attributes, 390 

Influence Attributes, 298, 300 

Influence solutions 

accuracy, 392 

Initial Acceleration, 245 

Integration   options, 28 

interactive modal dynamics, 421 

interface elements, 149, 153 

interface files, 68 

interface material models, 445 

internal heat generation, 257 

inverse iteration solver, 375 

Isometric, 509 

isotropic material, 180 

J 

Joint 

defining and assigning, 149 

local axes, 151 

material properties, 152 

Joint and interface elements, 148 

joint material models, 222 

Joint Models, 222, 223 

JPG, 469 

K 

keyboard 

mapping modifiers, 36 

Keyboard modifiers, 507 

keyboard shortcuts, 505 

knife edge load, 247 

KS steel sections, 168 

L 

labels, 90, 132 

Lamina thicknesses, 273 

Lanczos, 375 

lane load, 247 

large strains, 205 

layers 

using, 31 

layup 

methods, 270 

Layup 

defining a composite stack, 272 
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visualisation, 274 

Lead Rubber Bearings, 223 

libraries, 168, 179, 350 

library files, 349 

Licensing, 16, 397 

lift-off, 224 

lift-off support, 230 

Line by manifolding, 94 

line elements, 156 

line feature, 85, 92 

linear, 222 

LMS CADA-X Files, 77 

load combinations, 413 

load curves, 318 

load envelopes, 413 

Load train, 247 

loadcases 

creating, 314 

manipulating, 317 

viewing assignments, 318 

Loadcases 

creating, 315 

loading, 237 

assignment of, 238 

dependency across analyses/loadcases, 

239 

visualising, 165, 239 

local and global results, 411 

local coordinate, 267 

local sections, 169 

LT, 18 

lumped mass, 152 

M 

Manifolding, 105 

manipulating attributes, 128 

manipulating geometric features, 123 

manipulating the view, 43 

mass lumping, 152 

master degrees of freedom, 289 

master slideline, 278 

material data 

editing, 179 

material libraries, 179, 350 

material models, 180, 182, 183, 184, 185, 

187, 188, 190, 199, 200, 201, 202, 204, 

205, 207, 210, 211, 212, 215, 218, 222 

concrete, 192 

damage, 219 

modified mohr coulomb, 189 

material properties, 177 

materials 

dependency across analyses, 166, 179 

maximum value plots, 436 

maximum/minimum load, 413 

menus, 9 

merging geometric features, 115 

mesh, 111, 132 

refinement, 148 

mesh divisions, 132 

mesh lock, 148 

mesh objects, 21 

Mesh only models, 22 

mesh reset, 148 

mesh utilities, 147 

meshing techniques, 140 

Mesh-only models, 22 

message window, 9 

minimum value plots, 436 

mirror plane, 113 

Modal damping, 374 

modal dynamics, 421 

model file, 56 

Model folders, 60 
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Model Properties, 23 

model recovery, 403 

model types, 21 

Model:, 60 

modeller licence selection, 16 

Modeller Results Files, 65 

modified mohr coulomb, 189 

Mohr-Coulomb material model, 188 

moving geometry, 112 

Multiple varying sections, 169 

distance types and methods of 

assignment, 174 

N 

named components, 39 

Negative Jacobian Errors, 495 

Negative Pivot, 498 

nodal equivalencing, 296 

Nodal results 

sorting of, 467 

nodes, elements, geometry, 339 

nonlinear, 222 

nonlinear analysis, 177, 359, 365 

Non-Orthogonal Model Views, 509 

Non-structural mass elements, 152 

O 

orientation of geometry, 123 

Orthogonal Model Views, 508 

orthotropic material model, 180 

output, 405, 436 

P 

page layout, 46 

panning, 43 

patch load, 247 

Paths, 333 

PATRAN, 81 

PDSP/TPDSP loading, 258 

peak value plots, 436 

pen colour 

of selected items, 39 

pen library, 31 

pentahedral, 106 

picture files, 66 

pictures, 469 

Pivot Errors, 499 

pivot problems, 495 

Planar, 92 

playback 

script, 66 

Plotting results for attributes, 444 

Plotting results for groups, 443 

plotting results on a graph, 459 

plus elements, 155 

point feature, 85, 91 

point load, 247 

point mass, 152 

polymer material model, 218, 219 

pore pressure, 202, 232 

power spectral density, 426 

prescribed loads, 245 

printed output, 465 

Printing and Saving Pictures, 469 

properties, 177, 290, 311 

properties dialog, 9 

PSD response, 421 
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R 

radiation properties, 311 

Real numbers, 515 

Reciprocal Theorem, 298 

record 

script, 66 

Reference path, 333 

reference paths 

defining, 334 

deleting, 335 

Renumbering, 339 

report 

add chapter, 471 

add eigenvalue data, 475 

add image, 476 

add loadcase data, 474 

add model data, 472 

add user data, 476 

creating, 471 

creating subreports, 479 

delete, 483 

exporting, 480 

printing, 483 

results subchapter, 473 

spreadsheet output, 481 

viewing, 477 

word output, 482 

report generator, 470 

report template, 470 

reports, 470 

resize the model to fit the screen, 43 

results, 405, 411, 436, 459, 463 

orientation by default, 437 

results file, 405 

results files, 407 

closing, 408 

management of, 63 

opening, 408 

results transformation, 411 

retained freedoms, 289 

reversing geometric features, 123 

right-click menu, 9 

rigidities, 182 

RIHG loading, 258 

rotating the model, 43 

rubber material models, 205 

S 

saving a view, 30 

scaling geometry, 112 

script 

recording, 51 

script files, 65 

Scripts 

running with toolbar buttons, 53 

scrolling the model, 43 

search areas, 260 

processing loads outside, 262 

section library, 168 

Section property calculation, 345 

multiple varying sections, 172 

section through the model, 446 

seismic isolator, 223 

selecting model features, 33, 505 

selection 

advanced, 37 

chanbging pen colour, 39 

cycling through items, 37 

selection memory, 39 

Selection Modifiers, 506 

sending files to LUSAS technical support, 

402 

Sending files to LUSAS technical 

support, 403 

server sections, 169 

session file, 66 
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set default, 128 

setting active composite lamina, 277 

setting active loadcase, 318 

setting the environment colours and style, 

49 

shape wizard, 109 

shear force diagrams, 436 

shear lag 

with wide flanged sections, 449 

short-cut menu, 9 

Simulayt, 271 

slave degrees of freedom, 289 

slave slideline, 277 

slice, 446 

slidelines, 277, 460 

results, 456 

Sloan optimiser, 397 

smart combinations, 485 

Smart combinations, 413 

S-N curve, 419 

soil material modelling, 202 

solver, 397 

solver results files, 62 

Sorting of nodal results, 467 

spectral response, 378, 422 

splitting geometric features, 97, 103 

splitting options, 103 

SSI and SSR loading, 243 

Standard sections 

calculation of properties, 345 

startup templates, 51 

status bar, 12 

STEP, 82 

stiffness analysis, 371 

STL, 82 

stress and strain, 243 

stress potential, 185 

stress resultant material model, 183 

stress vectors, 440 

structural damping, 290 

structural loads, 240 

structural supports, 230 

Sturm sequence check, 374 

subreports, 479 

subspace iteration solver, 372 

superelements, 289 

Support tool, 403 

supports, 230 

assigning, 233 

dependency across analyses/loadcases, 

234 

visualising, 235 

surface elements, 157 

surface feature, 85, 100 

sweeping geomtry, 112 

T 

tabulating a solver data file, 81 

Tapering, 161 

target values, 428 

TDET loading, 258 

TEMP loading, 242 

temperature loading, 242 

text output window, 11 

thermal analysis, 257, 311, 381, 382 

thermal loading, 257 

thermal supports, 233 

thermal surface graphs, 459 

Thermal Surface Results, 459 

thermal surfaces, 311 

Thermal surfaces, 311 

thermo-mechanical coupled analysis, 384 
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Thickness, 165 

Tied slidelines, 277 

time history, 425 

Tip, 511 

Tips, 511 

TMPE loading, 242 

toolbar buttons 

user-defined, 52 

toolbar groups, 52 

customising layout, 52 

toolbars, 10, 52 

TPDSP loading, 258 

transferring data between models, 69 

transformations, 112 

transforming results, 411 

transient analysis, 379, 381, 383 

translating geometry, 112 

Tree frames, 10 

Treeviews, 10 

Tresca material model, 184 

trimetric, 509 

troubleshooting, 495 

trouble-shooting, 502 

two-phase analysis, 202 

U 

UDL loading, 242 

UK steel sections, 168 

undo / redo, 45 

uniformly distributed load, 242 

US steel sections, 168 

User, 169 

utilities, 323 

V 

values, 441 

variations, 324 

Varying attributes over features, 324 

vbs, 65 

vectored results plots, 436 

vehicle load optimisation, 393 

vehicle loading, 247 

Velocity loading, 246 

vertical axis, 337 

view, 30, 507 

View Properties, 49 

view windows, 10 

viscosity, 180, 201 

Viscous dampers, 223 

viscous damping, 290 

visual basic, 65 

Visualise, 160 

visualise users, 128 

visualising, 86, 297, 436, 446, 459 

contour plots, 439 

deformed mesh, 438 

results, 436, 446, 459, 463 

Visualising 

composite properties, 276 

visualising attribute assignments, 130 

volume 

orientating axes, 108 

volume elements, 158 

volume feature, 85, 106 

volumetric crushing material model, 207 

von-Mises material model, 185, 187 
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W 

windows, 30, 509 

WMF, 469 

wood armer, 467 

Wood Armer, 431 

Y 

yielded material visualisation, 445 

Z 

Zoom, 507 

zooming, 43 
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